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Civil 3D interface

Interface introduction
Last updated: 2021-11-09

Total video time:  21:24

Welcome screen

c3d-intrfc-intro-01.mp4 9:41

What you will find on the Welcome screen are:

 1. Short video tutorials, such as: user interface, surfaces, alignments, profiles, corridors, intersections 
and pipe networks.

 2. Exercise tutorials, show step-by-step processes on broader topics.
 3. What's New, explores new features in Civil 3D for the current year.

Info: Most of these are web-based and will need internet connection.

Tip: To turn-off the start screen, in the command line type Startmode, press Enter, type 0, 
press Enter.

Tip: To turn-on start screen, select Help button (? button in upper right), option listed in drop-
down.

Application menu browser

c3d-intrfc-intro-02.mp4 3:15

 1. Large C icon in upper left corner.
 2. When selected once, it allows access to the general production menu. When selected twice, Civil 

3D will close.
 3. Menu includes

 A. New - new drawing or sheet set
 B. Open - opens a drawing, not a template
 C. Save
 D. Save As - has different formats
 E. Export - has different formats
 F. Publish - one example, eTransmit packages all the files attached to your project, including 

Xrefs and data shortcuts.
 G. Print - Plot, batch plot, plot preview, page setup, etc.
 H. Drawing utilities - Set drawing properties, drawing settings, units, audit, purge, recover, etc.
 I. Close - To close all drawings or current drawing.

 4. Options button - Opens a dialog box with options.
 5. Search bar at the top, to find commands within the ribbon.
 6. Application menu also lists currently open and recently used files. Pin a drawing here to find it 

quickly.
 7. Exit button for exiting Civil 3D.

Quick Access toolbar
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c3d-intrfc-intro-03.mp4 1:04

 1. Found to the right of the Application menu browser button at the top of the screen.
 2. Allows access to general commands; new, open, save, plot, undo/redo, and others.
 3. To add your own choice of command to the Quick Access menu

 A. Select dropdown > More Commands...
 B. Customize User Interface dialog box 

 I. Select command name you want to add > OK
 4. To show the menu bar

 A. Select dropdown > Show Menu Bar
 B. Menu bar will appear above the tabs of the ribbon

Ribbon

 1. The ribbon is a user interface tool that allows all of the icon selection in Civil 3D to be centralized in 
a space sufficient area.

 2. The ribbon is organized into tabs that manage the different tools available.
 3. Each tab is subdivided into panels that contain the icons for the tools. If there are more tools than 

shown, a panel pulldown (arrow in lower right corner of panel) will display.

Tip: To keep the panel expanded while using a tool repeatedly, select the thumbtack (icon 
found in lower left corner of expanded panel).

Toolbars

c3d-intrfc-intro-04.mp4 1:25

 1. Toolbars are the command structures for base AutoCAD, prior to the ribbon. Transparent com-
mands is the only toolbar open by default. All other toolbars have been added to the ribbon.

 2. Selecting the dash line (found at the top or left side of the bar) you can move the bar. Right-click in 
the gray space of the toolbar to access a list of old toolbars.

Command Line

c3d-intrfc-intro-05.mp4 2:16

 1. The command line can be found at the bottom of the screen. It is used for the typed version of com-
mands.

 2. The command line is in a tool palette and can be moved.  Like other toolbars, select the dash line 
(found on the left side) and drag to new location, even another screen.

 3. The command line is not in use when it displays "Type a command". Once you have typed a com-
mand, it will prompt you through to command.

Status bar

c3d-intrfc-intro-06.mp4 2:13

 1. The status bar can be found below the command line. It is a series of icons that will allow for set-
tings for certain functions within AutoCAD and Civil 3D.

 2. The status bar displays the cursor location, drawing tools, and tools that affect your drawing envir-
onment.
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 3. The status bar provides quick access to some of the most commonly used drawing tools. There are 
function key alternatives for most of these icons, but not all.

 4. Some of the tools include; Snap mode, Ortho mode, Polar Tracking, Object Snap (OSnap), Annota-
tion scale, and Workspace.

Drawing Scale

c3d-intrfc-intro-07.mp4 1:27

 1. The drawing scale is a representation of the drawing area the you have and is 1" = 1".
 2. The annotation scale is found at the bottom in the status bar. Use the arrow to activate a flyout 

menu and change the scale of your drawing.
 3. The drawing scale controls the size of text; text in labels, text in dimension labels, and text in mul-

tileaders, and space between section views in an array.

Ribbon and tabs
Last updated: 2021-10-22

Total video time: 8:14

Ribbon interface

c3d-intrfc-rbn-01.mp4 4:21

The ribbon is a management style of keeping commands at the top of the screen. The ribbon management 
area includes tabs, panels, and icons.

 1. Tabs contain a grouping of command panels.
 2. Panels are a grouping of similar command icons.
 3. Icons start the commands directly.

Tabs

c3d-intrfc-rbn-02.mp4 3:53

The tabs are found on top of the ribbon directly below the Quick Access toolbar.  Some of the tabs included 
are: Home, Insert, Annotate, Modify, Analyze, View, Output, Manage, and so on. The tabs also include 
WisDOT Design and WisDOT Sheets.

Panels

Panels are labeled on the bottom of the ribbon. Each panel contains tool/commands that are related to that 
panel.  If the panel's name has an arrow next to it, select to see additional tools/commands. This is called a 
fly-out menu and once a tool/command is selected it will minimize.

Icons

Icons are tools/commands. If there is an arrow next to the icon, select it for a dropdown menu of additional 
related commands.
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Minimize ribbon

To minimize the ribbon to have more drafting room, select the last icon within the row of tabs.  This button 
has 4 options, and must be clicked each time to activate.

 1. First click, Minimize to Panel Buttons
 2. Second click, Minimize to Panel Titles
 3. Third click, Minimize to Tabs
 4. Forth click, Show full ribbon

Toolspace
Last updated: 2021-11-09

Total video time: 38:07

Toolspace overview

c3d-intrfc-tlspc-01.mp4 4:52

Toolspace palette is the area on the left side of the screen. This palette is where you can find the objects 
created and manage them.  The palette, by default, is docked on the left side of the display, but it can be 
moved.

Toolspace area includes

 1. Tabs; Prospector, Settings, Survey and Toolbox
Tabs can be toggled on/off to save space

 2. Preview window
Area located at the bottom of the Toolspace.  Used to look at the data of an object. For example, 
select Points, all the point numbers and information about each point will be displayed. If Select Pre-
view is turned on in the Toolspace area, a graphic image could be displayed in the preview window.

 3. Active drawing view/Master view
This is located at the top of the Toolspace and decides what is displayed in the Toolspace.

Active Drawing View option will give you the active drawing and all of its objects, listing them as one 
single drawing. It will also include a listing of the data shortcuts.

Master View will give a listing of every drawing file that is open and a list of all of objects. The current 
active drawing will be in bold print.

 A. Projects Area is the Vault connection.

Info: The Projects collection of the Prospector tree is is not visible if you have 
installed Autodesk Vault Client and Server Application. WisDOT does not use Vault.

 B. Drawing Templates area lists all of the drawing templates in a specific, preset file location.  
Templates can be accessed to check the standards.

Toolspace tabs

c3d-intrfc-tlspc-02.mp4 8:01

Toolspace palette is the area on the left side of the screen. This area includes tabs, preview window, and 
active drawing view/master view.
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The Toolspace docking options, for more drafting space

 1. Hold left-click and drag to new location. It's a floating dock window.
 2. Right-click next to Toolspace name for a menu

 A. checkmark Allow Docking
 B. Select either Anchor Left or Anchor Right

Tip: This will anchor the Toolspace and autohide it.

If the Toolspace palette is closed, to reopen

Ribbon > Home tab > Palettes panel > Toolspace

This Toolspace button is a toggle for turning it on and off.  The little icons to the right of the Toolspace button 
are toggles for the tabs mentioned below.  The order in which they are selected will decide the order they 
are displayed in the Toolspace palette.

Tabs

Tabs are located on the right side of the Toolspace palette. Tabs can be toggled on/off.

Prospector tab

Used to create and edit or manage objects

 1. Drawing object access
 A. Objects include points, point groups, surfaces, alignments (profile & sections), sites (grading 

& parcels), catchments, pipe networks (including interference objects), corridors, assem-
blies, intersections, and view frame groups.

 B. The plus sign [+] next to the object name expands for more specific objects used within your 
project.

Settings tab

Comprehensive list of styles for each object, found in Civil 3D.

If Surface is expanded, it includes surface styles, label styles, table styles, and commands. Some objects 
may not have these styles, but include criteria and rules.

Survey tab

Survey database are external and available to any drawing.

Toolbox tab

To toggle a tab on/off

Ribbon > Home tab > Palettes panel

Next to the Toolspace toggle are mini toggles, one for each tab. Blue background is active, white back-
ground is inactive.  The order you turn them on will be the order they display in the Toolspace palette.

Active Drawing View/Master View

This is located at the top of the Toolspace and decides what is displayed in the Toolspace.

 1. Active Drawing View option will give you the active drawing and all of its objects, listing them as one 
single drawing. It will also include a listing of the data shortcuts.
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 2. Master View will give a listing of every drawing file that is open and a list of all of objects.
 A. Open Drawings, lists all open drawing files. The current active drawing will be in bold-type. 

You can switch between drawings by selecting "Switch to" in the right-click menu.
 B. Data Shortcuts
 C. Drawing Templates area lists all of the drawing templates, folder and available types in a 

preselected location.

More overview of the Prospector tab

Used to create and edit objects

 1. Drawing object access
 A. Objects include points, point groups, surfaces, alignments (profile & sections), sites (grading 

& parcels), catchments, pipe networks (including interference objects), corridors, assem-
blies, intersections, and view frame groups.

 2. Data Shortcuts
 A. Reference files including surfaces, alignments (and profiles), pipe networks, corridors, and 

view frame groups.
 B. An external point or access point to a specific project, and are referenced into a file you are 

currently in.
 3. Managing objects

 A. Right-click object names for properties and edit customizations.

Prospector tab

c3d-intrfc-tlspc-03.mp4 3:52

Toolspace palette > Prospector tab > expand drawing name all objects listed

 1. Objects include points, point groups, surfaces, alignments (profile & sections), sites (grading & par-
cels), catchments, pipe networks (including interference objects), corridors, assemblies, inter-
sections, and view frame groups.

 2. The plus sign [+] next to the object name expands for more specific objects.
 3. A small arrow before the name of an object indicates it is a data shortcut. No arrow means that the 

object is live and has been defined in the drawing file.
 4. Right-click menu options

 A. Properties and styles
 B. Synchronize or promote
 C. Select, zoom to, or pan to
 D. Lock or unlock
 E. Export
 F. Refresh

Data Shortcuts

 1. Objects include surfaces, alignments, pipe networks, pressure networks, corridors, and view frame 
groups.

Settings tab

c3d-intrfc-tlspc-04.mp4 2:49

Toolspace > Settings tab
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The Settings tab is a comprehensive list of styles, for each object, found in Civil 3D. Styles including label 
styles, table styles, and commands. Some objects styles may different settings, like criteria or rules.

Styles overview

You can select on any object to use the below process.  Surface is our example.

Surface

Toolspace > expand active drawing > expand Surface

 1. Surface Styles
 A. Expand to see list of styles that can be applied to the surface.
 B. This list can also be found through the active drawing, in the surface properties. 

 I. Select the surface of your drawing > right-click and select Surface Properties... 
 a. Surface Properties dialog box 

 i. Information tab > select Surface Styles dropdown

Info: When there is a orange marker in front of the style name, in the Toolspace, it means the 
style is active/live in the drawing.  It doesn't define where it is used, but if edited it will affect 
your drawing. View it as a warning.

 2. Label Styles
 A. Contains sub-styles; Contour, Slope, Spot Elevation, and Watershed.
 B. Some sub-styles contain Expressions, used to build a mathematical model.

 3. Tables Styles
 A. Table objects from base AutoCAD that are created in a form that responds to surface 

objects.
 B. Contains sub-styles; Directions, Elevation, Slope, Slope Arrow, Contour, Watershed, and 

User-Defined Contour.
 4. Commands

Macros for creation settings

 A. Right-click on a command and select "Edit Command Settings..." to change the default set-
tings and overall drawing settings.

Edit feature settings

Toolspace > Settings tab > right-click Surface > select Edit Feature Settings...

Use to access default settings

Edit drawing settings

Toolspace palette > Settings tab > right-click drawing name > select Edit Drawing Settings...

Drawing Settings dialog box

 1. Units and Zone tab
 A. Drawing or Angular units
 B. Imperial to Metric conversion, should be set to US Survey Foot
 C. Scale or Custom scale
 D. Zone

 2. Transformation tab
 A. Transform zone, grid factor or sea factor

 3. Object Layers tab
 A. Assigns default layer assignment to each object
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 4. Abbreviation tab
 A. List of label abbreviations

 5. Ambient Settings tab
 A. Set global ambient settings here, Apply and OK.

Survey tab

c3d-intrfc-tlspc-05.mp4 3:01

Toolspace palette > Survey tab

 1. Survey Database
 A. External and are available to any drawing. Survey databases, that are created inside the sur-

vey tab, are available per project.
 B. To add a new survey database 

 I. Right-click on header, select "New local survey database..."
 2. Equipment Database

 A. A repository for survey equipment and data sheets for the equipment being used.
 3. Figure Prefix Database

 A. Linework coding that was shot in the field. It manages those codes, then finds linework 
styles, layers, and connectivity for the linework.

 B. Contain set up for WisDOT Topography 
 I. Right-click WisDOT Topography > Manage Figure Prefix Database, to open Fig-

ure Prefix Database Manager dialog box.
 4. Linework Code Sets

 A. What the surveyor used in the field to identify certain points connected the linework.
 B. Contains linework set up for WisDOT Proposed

Toolbox tab

c3d-intrfc-tlspc-06.mp4 2:53

Toolspace palette > Toolbox tab

 1. Reports Manager
 A. Contains predefined report types for alignments, corridors, parcels, pipes, points, profiles, 

parcel_CCW, surfaces, and breaklines.
 B. To run a report 

 I. Right-click on report name, select "Execute..."
 2. Subscription Extension Manager

 A. Contains Autodesk subscription advantage packs
 3. Miscellaneous Utilities

 A. Includes Reports, Coordinate Geometry, Export KML, Parcels, Survey, Surfaces, and 
CAiCE Translator

 4. SHP Import/Export Utilities

Survey database

c3d-intrfc-tlspc-07.mp4 3:35

Toolspace palette > Survey tab
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 1. Survey Database
 A. External to any drawing file, external source.
 B. Survey Database is per project.

 2. Equipment Database
 A. Set up to aid in analysis
 B. Right-Click Equipment Database > New..., opens New Equipment Database dialog box.

Here is where you can set up a new database.

 C. Expand Equipment Database > right-click New > Select Manage Equipment Database...
Here you can edit units, angle, Electronic Distance Meter (EDM), prism, and Standard Devi-
ations.

 3. Figure Prefix Database
 A. Contain set up for WisDOT Topography
 B. Right-click WisDOT Topography > Manage Figure Prefix Database, to open Figure Prefix 

Database Manager dialog box. 3. You can edit the Breakline, Lot Line, Layer, Style and Site 
via checkboxes or dropdown menus.

 4. Linework Code
 A. Contains linework set up for WisDOT Proposed
 B. Right-click WisDOT Proposed > Edit, to see information dialog box.

User Settings

Icon (Tripod w/person) found at top of Toolspace palette, are set to the WisDOT package

Survey User Settings dialog box

 1. Miscellaneous
 2. Survey Database Defaults
 3. Equipment Defaults
 4. Linework Processing Defaults

 A. Option: Process linework during import
 5. Figure Defaults

 A. Option: Current figure prefix database, WisDOT Topography
 6. Interactive Graphics
 7. Import Defaults
 8. Export Defaults
 9. Network Preview

 10. Setup Preview
 11. Figure Review
 12. Change Reporting

Command shortcuts and hotkeys
Last updated: 2021-11-09

Total video time: 5:53

Exercise files: c3d-intrfc-data-c3d20.zip

ProjectID\SheetsPlan\STH25-XS.dwg

c3d-intrfc-cmnd-shrtct-htky-01.mp4 9:27

All commands have a typed alternative

Some typed commands are quicker than switching ribbon tabs 
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Tip: This is not a comprehensive list – just some helpful ones

AutoCAD Keyboard Shortcuts is an Autodesk webpage with a more complete listing of AutoCAD-specific 
keyboard shortcuts.

Hotkeys

 l Esc = Exit a command                 

 l Spacebar = Enter

 l F1 = Opens Help to topic you are working with

 l F2 = Expands command line to a window

 l F3 = OSNAPS toggle

 l Shift + Right-Click – Temporary OSNAP Overrides

 l Shift + Spacebar = selection cycling

 l Ctrl + Left-click select for some labels

 l Ctrl + 9 = toggles Command Line palette

 l Ctrl + 3 = toggles tool palettes

Command line commands

 l z enter e enter = Zoom Extent ("Fit View")

 l z enter enter = "real-time" zoom

 l P enter = Pan

 l Delete = Erase

 l E = Erase

 l PL for polyline

 l PEfor polyline edit

 l DI for Distance command (slightly different than ribbon version) 

 l FILEDIA, setting should = 1

 l CMDDIA, setting, should =1 

 l GEOMARKERVISIBLITY = 0

 l OSNAPZ = if 1 then snaps to 3D objects (x/y/z), if 0 then snaps to X/Y but ignores elevation z

 l OPTIONS = opens OPTIONS dialog box

 l XREF = opens Xreference manager dialog box

 l OOPS = Brings back last deleted selection

 l REA = Regenerates graphics

Basic mouse operations
Last updated: 2021-11-09

Total video time: 9:19
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Exercise files: c3d-intrfc-data-c3d20.zip

ProjectID\SheetsPlan\STH25-XS.dwg

c3d-intrfc-basc-mous-01.mp4 12:24

Exercise file: STH25-XS.dwg

Three-button wheel mouse 

Click = select

Right-click = context menus

Wheel operation

 l Roll forward/backward = zoom in/out 
 l Click wheel = pan
 l Double-click wheel = zoom extents

Keyboard & mouse clicks

Shift + Right-click = Temporary OSNAPS menu 

 Shift + wheel-button = Orbit

Ctrl + Click for some objects allows individual label editing

Shift + Click  = remove from selection set 

MBUTTONPAN

= 1, pan

= 0, Temporary OSNAP menu

Options > User Preference tab > Right-click Customization button  = Right-click customization

Context sensitive

Repeat Last command

Steering wheel control
Last updated: 2021-10-22

c3d-intrfc-strng-whl-01.mp4 5:08

Steering wheel control is found in the navigation toolbar on the right side of the screen.  Steering wheel con-
trol is a series of navigation controls that follow the cursor when turned on. Navigation controls include 
zoom to, pan to, orbit, and center.

Open navigation toolbar

 1. View tab > Viewport Tools panel > select Navigation Bar
 2. navbar, Enter an option: on

Steering wheel and parts

Select Full Navigation Wheel, 2nd icon from the top, to have the steering wheel appear attached to the 
cursor.
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The steering wheel has different parts that are highlight as you go over them. Place wheel where you went 
the command to start before selecting.

Outside ring:

 1. Zoom, hold left-click and move mouse forward and backward
 2. Orbit, use Center to create a pivot point and move mouse to orbit
 3. Pan, hold left-click and move around screen
 4. Rewind, rewind video

Inside ring:

 1. Walk, walk over your project
 2. Center, pivot point for the orbit
 3. Look
 4. Up/Down

To close wheel, select the X in upper right corner of wheel or use ESC.

Wheel Choices

Below the Full Navigation Wheel icon is a dropdown arrow to open a menu.  Checkmark appears before the 
selected wheel.

 1. Full Navigation Wheel, detailed above.
 2. Mini Full Navigation Wheel, smaller wheel that includes same tools as Full Navigation Wheel.
 3. Mini View Object Wheel, smaller wheel that includes pan, zoom, orbit, and rewind.
 4. Mini Tour Building Wheel, smaller wheel that includes walk, look, rewind, and up/down.
 5. Basic View Object Wheel, includes center, zoom, rewind, and orbit.
 6. Basic Tour Building Wheel, includes forward, look, rewind, and up/down.
 7. 2D Wheel, includes zoom, rewind, and pan.

Status bar
Last updated: 2021-11-09

Total video time: 6:16

Exercise files: c3d-intrfc-data-c3d20.zip

ProjectID\SheetsPlan\STH25-XS.dwg

c3d-intrfc-status-bar-01.mp4 6:16

Status bar

 l Icons...
 l Function Key Alternatives 
 l Right-Click Settings

Status bar keys

 l Constraints Ctrl+Shift+I
 l Snap/Grid F9/ F7
 l Ortho Snap F8
 l Polar Track F10
 l OSNAP F3
 l 3D OSNAP F4
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 l Object Snap Tracking F11
 l Dynamic UCS F6
 l Dynamic Input F12
 l Lineweight 
 l Transparency
 l Quick Properties Ctrl+Shift+P
 l Selection Cycling Ctrl+W
 l Annotation objects

File open, save, and new
Last updated: 2023-02-22

Total video time: 4:40

c3d-intrfc-fil-opn-sav-new-01.mp4 4:40

Overview

Opening a file

 1. There are multiple ways to open a file
 A. App menu > Open
 B. Quick Access toolbar > Open (file folder icon)
 C. Right-click File tab > right-click menu > Open...

Opening a new template

 1. There are multiple ways to open a new file
 A. App menu > New
 B. Quick Access toolbar > QNew 

 C. Right-click File tab > right-click menu > New...
 D. Plus sign next to File tab

 2. All new files start with a template (.dwt).  The template brings in the settings for the new drawing; spe-
cific object and layout styles.

 3. When opening a new template, WisDOT has template files already setup.
 A. App menu > New
 B. Select Template dialog box 

 I. Look in should be set to the Begin-dwg folder and contain starting templates; draw-
ing, plat and survey.

 II. Select design template and Open
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Saving a new file

 1. To save a new file
 A. Right-click File tab > right-click menu > Save... 

 I. Save Drawing As dialog box 
 a. Save in, browse to project folder
 b. Rename file name (.dwg)
 c. Save

 2. Once saved, there will be no drawing in the modelspace, but the styles are populated in the settings
 A. Toolspace > Settings tab > expand Surface

File, model, and layout overview
Last updated: 2021-11-09

Total video time: 5:50

c3d-intrfc-fil-mdl-lyout-01.mp4 5:50

File tabs

 1. File tabs display the current open files. They are located directly above the Toolspace palette and 
model space.

 2. To turn off display tabs
 A. Right-click in the modelspace > right-click menu > Options...
 B. Options dialog box

 I. Display tab > Window elements > uncheck box Display File Tabs

Tip: Keep the box checked to keep the tabs displayed.

 C. OK to save changes, Apply to see changes, or Cancel to exit
 3. Hover over tab to see open layouts. Each layout has the option to layout or plot.
 4. If the file name, in the tab, has an asterisk (*) at the end, it has not been saved yet. Select Save in 

the Quick Access toolbar to have to disappear.
 5. Right-click on a tab to get right-click menu dropdown. Commands include: New, Open, Save, Save 

As, Save All, Close, Close All, and Close All Other Drawings.  On the active drawing you get two 
additional commands: Copy Full File Path and Open File Location.

 6. Plus symbol, next to the tabs, will open a new file using your default template.

Model and layout tabs

 1. Model and layout tabs can be found on the lower left.
 A. Model tab is modelspace, displaying the drawing at 1:1 ratio.
 B. Layout tab is paperspace, used for plotting at scale. Paperspace includes the printable area, 

title block information, and a viewport to display portions of Modelspace.
 2. To turn off tabs

 A. In paperspace, right-click on the drawing > right-click menu > Options...
 B. Options dialog box

 I. Display tab > Layout elements > uncheck box Display Layout and Model Tabs

Tip: Keep the box checked to keep the tabs displayed.
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 3. In paperspace, the squares/rectangles are called viewports. Viewports are like picture frames into 
modelspace, the area selected to be viewed. When a viewport is selected, the scale appears in the 
bottom status bar.

 4. The ribbon displays commands based on the tab selected.
 5. Plus symbol, next to the tabs, will open a new layout.

Model space viewports
Last updated: 2021-11-09

Total video time: 4:10

c3d-intrfc-mdlspc-vwprt-01.mp4 4:10

Modelspace viewport overview

Model space can have one viewport or multiple viewports. Multiple viewports are real time windows, and 
zoom or pan can be used within each window independently.

Multiple viewports in Modelspace

 1. To change your model space into multiple viewports
 A. View tab > Model Viewports panel > Viewport Configuration dropdown
 B. Select Three Left configuration
 C. The active viewport will be highlighted with a blue box/border.

Any change made within one viewport will change in all since they are real time windows.
 2. The plus sign [+] in the top left corner of viewport for dropdown menu options

 A. Maximize Viewport
 B. Viewport Configuration List, same list as in ribbon

 3. The word next to the plus sign in brackets is the view point and can be changed. Views can be Top, 
Bottom, Left, Right, Front, Back, SW isometric, SE isometric, NE isometric, NW isometric.

 4. Name your viewports
 A. View tab > Model Viewports panel > select Named
 B. Viewports dialog box 

 I. New Viewports tab
 II. New name: My Viewport (Enter the name you would like to save it as)

 III. OK
 5. Restore to original view

 A. View tab > Model Viewports panel > select Restore
 6. Load custom configuration

 A. Select minus sign [-] in upper left corner of model space
 B. Viewport Configuration List > Custom Viewport Configuration > My Viewport

 7. Join viewports
 A. View tab > Model Viewports panel > select Join
 B. Select dominant viewport: Select a viewport
 C. Select viewport to join: Select a second viewport

External references
Last updated: 2023-02-22

Total video time: 19:23

XREFs overview
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c3d-intrfc-xref-01.mp4 8:39

XREFS are drawings used behind the drawing you are working on, and only used as a reference. Doing so, 
reduces the design drawing file size.

XREF file types

 1. DWG file, overlays
 2. DGN file, underlays
 3. Attach images
 4. Attach PDFs

XREF Manager

Where XREFs are stored and accessed.

 1. Unload, you don't see the XREF in your file but remains in The XREF Manager.
 2. Detach, removes from your drawing file and XREF Manager.
 3. Binding, inserts XREF data into your drawing file.

Fade Control

Controls how light/dark the XREF is seen with active drawing.

Ribbon > Insert tab > Reference panel pulldown

Add and manage XREFs

c3d-intrfc-xref-02.mp4 10:44

 1. Start a new file
 A. Quick Access toolbar > New (WisDOT Template file)

 2. Ribbon > Insert tab > Reference panel > select Attach
 3. Select Reference Files dialog box

 A. Look in: Local drive:\WisDOT\Projects\86753090\Design\AliProfs
 B. Select file: AliProf-51
 C. Open or Enter

 4. Attach External Reference dialog box
 A. Verify Name is AliProf-51, if not select Browse to search.
 B. Scale

 I. X = 1.00
 II. Y = 1.00

 III. Z = 1.00

Tip: Select Specify On-screen to select points on drawing.

 C. Insertion point
 I. X = 0.00

 II. Y = 0.00
 III. Z = 0.00

Tip: Select Specify On-screen to enter specific coordinates.
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 D. Rotation
 I. Angle = 0

Tip: Select Specify On-screen to pick rotation on screen.

 E. Path type
 I. Dropdown > Relative path

 F. Reference type
 I. Attachment

 G. OK

 5. Select an object, all of the XREF highlights because it is one entity.
 6. The Contextual ribbon changes to External Reference tab

 A. Edit panel 
 I. Edit Reference in Place

 II. Open Reference
 B. Clipping panel 

 I. Create Clipping Boundary
 II. Remove Clipping

 C. Options panel 
 I. External References

Create clipping boundary

 1. Select 4 points, creating a closed object around an area of the XREF
 2. Select the XREF drawing
 3. Ribbon > Clipping panel > select Create Clipping Boundary
 4. Select polyline/polygonal/rectanguar/invert clip: type SEnter
 5. Select object you created
 6. Boundary is created and only shows the XREF within it.

Remove clipping boundary

Ribbon > Clipping panel > select Remove Clipping

Fade Control

Ribbon > Insert tab > Reference panel pulldown
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Controls how light/dark the XREF is seen with active drawing.

Use the slider to control the variance or type in a percentage number.

External Reference palette aka XREF Manager

 1. Start with a new file
 2. Quick Access toolbar > New (WisDOT Template file)
 3. Command line: XREFEnter
 4. Opens XREF Manager
 5. File References, active drawing(s) listed
 6. Attach icon, first on left

Attach file types; DWG, Image, DWF, DNG, PDF, Point Cloud, or Coordination Model.

 A. Select Attach DWG...
 B. Select Reference File dialog box 

 I. Look in: Local drive:\WisDOT\Projects\86753090\Design\AliProfs
 II. Select file: AliProf-51

 III. Open or Enter
 C. Attach External Reference dialog box 

 I. Verify Name is AliProf-51, if not select Browse to search.
 II. Scale, all = 1.00

 III. Insertion point, all = 0.00
 IV. Rotation angle = 0
 V. Path type, change to Full path

 VI. Reference type, Attachment
 VII. OK

 D. File References now includes reference file, AliProf-51.

Selecting specific object(s) from XREF

 1. Command line: NCOPYEnter
 2. Select nested objects to copy: Select object(s)
 3. Enter when selection is finished
 4. Specify base point: Select Enter, it will assume the origin point is 0,0,0 and place the object

(s) in the exact same location on active drawing.
 5. Enter to end command

Unload XREF to turn off and show only NCOPY reference data.

 1. Command line: XREF
 2. XREF Manager

 A. Right-click AliProf-51 > Unload

Reload XREF to turn on all XREF data.

 1. Command line: XREF
 2. XREF Manager

 A. Right-click AliProf-51 > Reload
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Attach an XREF that isn't appearing

 1. Command line: XREF
 2. XREF Manager

 A. Right-click on missing XREF > Attach...
 B. Attach External Reference dialog box 

 I. Name: Search for XREF
 II. OK

Remove an XREF(s) from XREF Manager

 1. Command line: XREF
 2. XREF Manager

 A. Right-click on XREF to remove > Detach

Bind brings all XREF data into the active drawing

 1. Command line: XREF
 2. XREF Manager

 A. Right-click AliProf-51 > Bind...
 B. Bind Xrefs/DGN underlays dialog box 

 I. Button options 
 a. Bind will have the original drawing name listed along with all the layers.
 b. Insert will put a marker in front of it indicating it's not an original layer.

 II. Select BindOK

Editing XREF objects

 1. Edit Reference in Place
 A. Ribbon > External Reference tab > Edit Reference in Place
 B. Reference Edit dialog box

 I. Reference name: AliProf-51
 II. If there are nested objects, select  Automatically select all nested objects.

 III. OK
 C. Make changes to object
 D. Ribbon > Insert tab > Edit References panel > Save Changes

Warning: Saving changes will be saved to the original file that is being XREFed in.

 2. Open Reference
 A. Ribbon > External Reference tab > Open Reference
 B. Opens the actual XREF
 C. Make edits/changes
 D. Save

Data shortcuts
Last updated: 2021-11-09

Total video time: 10:04

Exercise files: c3d-intrfc-data-c3d20.zip

ProjectID\Design\Corridors\Corridor-STH25-4thAve.dwg

ProjectID\BaseData\Mapping\ExistSurface.dwg
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Overview

c3d-intrfc-data-shrtct-01.mp4 2:24

Exercise file: Existing Surface.dwg

Provides selective object data for use in other files

 l surfaces
 l alignments
 l profiles
 l corridors
 l pipe networks
 l pressure networks
 l view frame groups

Files must be attached to a "project"

Object geometry is in one file, can be referenced into many other files. Allows for different styles to be 
applied to the same object in different references.

Data References can be used simultaneously 

Control/distribution of geometry held in XML file

Data shortcut folder relationship

c3d-intrfc-data-shrtct-02.mp4 2:46

Working Folder = Path where projects are stored (level above project folders) 

Project Folder = in working folder path where project files are stored

"_shortcut" folder = inside Project folder, where actual data shortcuts reside 

 l The data is in XML format
 l DO NOT edit these files – this is for Civil 3D to access/manage 

If a project is moved, these locations are relative.

Data shortcut process

c3d-intrfc-data-shrtct-03.mp4 4:53

 1. Right-click on Data Shortcuts > Set Working Folder
 2. Right-click on Data Shortcuts > New (or Set) Project Folder
 3. Right-click on Data Shortcuts > Create Data Shortcuts

Now that project path and folder are established, this step is repeated throughout project.

Xreference vs data shortcut concepts
Last updated: 2021-11-09

Total video time: 4:14

Exercise files: c3d-intrfc-data-c3d20.zip
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ProjectID\SheetsPlan\STH25-XS.dwg

ProjectID\Design\AliProfs\AliProf4thSt-Best-Fit.dwg

Concepts

c3d-intrfc-xref-vs-data-shrtct-01.mp4 4:14

XREFS

 l Connects to an entire file, then items can be filtered out by layer
 l Intended for items that you cannot data shortcut (acad objects, and a few civil 3d objects, corridors 

most notably)

Data shortcuts

 l Connects to individual objects
 l Intelligent data remains intact through connection (example: you can get station offset of an align-

ment through a data shortcut, but not an xref)
 l Styles can be different per connection (you cover this well)

Info: In general, you should use the data connection intended for the object (i.e. use data shortcut for 
those objects, xref for others). The reverse is also true. You should generally not XREF objects that 
can have a data shortcut. If you happen to XREF a file that has connections to data shortcut objects, 
you can either remove the data shortcut or freeze the layer of the data shortcut object in the XREF. 
Classic example here is XREF topo and there's a DS to an alignment. That alignment will show up 
static and cannot be styled or queried. It's better to freeze the ali out of the xref and data shortcut it.

Both tools for referencing data in different ways 

 l Data Shortcuts are more Civil 3D specific. 
 l XREFs are "generally" more AutoCAD entities.
 l Civil 3D Objects will Xref and are usable

Data shortcuts usage

 l When you need data from surface, alignment, profile or pipes 
 l View Frames for plan and profile sheets
 l When object interaction is needed
 l Alignment (for sample line creation)
 l Corridors when using C3D 2018

XREFS usage

 l Background information
 l Just for labeling, but not for interaction with other objects 
 l Everything else

Inquiry tool
Last updated: 2021-11-09

Total video time: 8:56
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c3d-intrfc-inqry-01.mp4 8:56

Inquiry tool overview

Inquiry tool palette

Inquiry tools are for reporting data from Civil 3D objects.

Inquiry types include: point, surface, alignment, profile view, profile, section view, section, and corridor sec-
tion.

Example of field values include a location, x-coordinate and y-coordinate, easting or northing inde-
pendently of each other, etc.

Point inquiry

 1. Analyze tab > Inquiry panel > select Inquiry Tool > opens Inquiry Tool palette
 2. Select an inquiry type: open dropdown > expand Point > select Point Inverse
 3. Enter Values

 A. Point 1 Number: 780Enter, known data populates table
 B. Point 2 Number: 779Enter, known data populates table

Info: Values you can fill in are white, blue fields will report back.

 4. Graphically a line will appear on your drawing, indicating the points and data from the table.

Surface inquiry

 1. Inquiry Tool palette
 2. Select an inquiry type: open dropdown > expand Surface > select Surface Elevation and Grade 

at Point
 3. Enter Values

 A. Surface Name: EXIST Enter
 B. Point Coordinate: Click on Select from Screen icon, select a point on drawing, known data 

populates table

Alignment inquiry

 1. Inquiry Tool palette
 2. Select an inquiry type: open dropdown > expand Alignment > select Alignment Two Station and 

Offsets at Point
 3. Enter Values

 A. Point Coordinate: Click on Select from Screen icon, select a point on drawing, known data 
populates table

Profile inquiry

 1. Inquiry Tool palette
 2. Select an inquiry type: open dropdown > expand Profile > select Profile Station and Elevation at 

Point
 3. Select profile dialog box

 A. Select STH258estFitOK
 4. Select Station, marker will appear at geographic location
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Adding a folder link to a Civil 3D dialog
Last updated: 2023-02-22

Total video time: 3:47

c3d-intrfc-add-fldr-lnk-to-c3d-dlg-01.mp4 3:47

Creating a shortcut folder

Tip: These folders are for quick access to your project(s) and are temporary and can be deleted after 
you are done with your project.

 1. Quick Access bar > select Open (open folder icon)
 A. Select File dialog box

 I. Look in: browse to Local Drive:\WisDOT\Design\C3D
 II. Select Up one level icon

Tip: Set the shortcut folder one level higher than project folders for quick 
access to your projects.

 III. Left-click C3D folder and drag to Places list (blue bar, left side of dialog box)
 IV. Select the C3D shortcut folder to see all project folders
 V. Left-click 86753090 folder and drag it into the Places list

Removing a shortcut folder

 1. Quick Access bar > select Open (open folder icon)
 A. Select File dialog box 

 I. In Places list, right-click on 86753090 folder > Remove
 II. Prompt: Are you sure you want to remove '...C3D\86753090' from Places? Yes

 III. Select Cancel
 IV. Prompt: Would you like to save changes you made to the Places list? Yes
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WisDOT Civil 3D project setup

WisDOT standards – Civil 3D project folders
Last updated: 2023-03-20

Total video time: 06:05

prj-wisdot-stnd-c3d-prj-01.mp4 6:05

Requirement: 
FDM 15-5 Attachment 3.1 CADDS AutoCAD Civil 3D Project Folder Structure Standard

FDM 15-5 Attachment 3.3 CADDS AutoCAD Civil 3D File and Layout Naming Standard

Project folder structure is important

 l Connectivity of referenced data: Data references and external references (XREF).

 l Project consistency: The ability to find files based on the type of data.

 l Project portability: The ability to move a project internally or externally, and maintain the data con-
nectivity.

Creating the project folder structure

 l All WisDOT Civil 3D projects use data shortcuts.

 l The New Data Shortcut Projects Folder creation tool lends itself well to the WisDOT Civil 3D work-
flows.

 l The project folder structure can be created from the WisDOTProjectTemplate project folder tem-
plate: Create a Civil 3D project

Using the project folder structure

 l The top level of the project folder should never change.

 l Folders can be added underneath the top level project folder.

 l Folders created from the project folder template should never be deleted, renamed, or moved.

Create a Civil 3D project
Last updated: 2023-03-20

Total video time: 01:59

prj-creat-c3d-prj-01.mp4 1:59

Create a Civil 3D project from a project template

 1. Toolspace > Prospector tab > Right-click  Data Shortcuts > Set Working Folder.
 2. Browse to the working folder. Example: For the project data folder N:\PDS\C3D\11111111 the 

working folder is N:\PDS\C3D (The working folder is always one folder above the project data 
folder.)
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 3. Toolspace > Prospector tab > Data Shortcuts  > Right-click Data Shortcuts > New Project Data 
Folder

 4. In the New Data Shortcut Folder dialog box:
 A. Name = 11111111
 B. Description = optional
 C. Use project template = Checked
 D. Project template = WisDOTProjectTemplate
 E.  OK

Info: The default storage location for Civil 3D project templates is C:\User-
s\Public\Documents\Autodesk\Civil 3D Projects Templates

Wisconsin coordinate system settings in Civil 3D
Last updated: 2023-05-17

Info: 
The WisDOT coordinate projection zone category which was in use through Civil 3D 2016 and 2018 
has been retired and is no longer needed in Civil 3D 2020 and beyond.

Coordinate systems in Civil 3D should only be applied when a projection transformation is needed.

Projections for Civil 3D 2020 and beyond should be selected from the Zone Category: USA, Wis-
consin. WISCRS projections begin with NSRS2011 Wisconsin County CRS

Projections for Civil 3D 2016 and 2018 should be selected from the Zone Category: WisDOT.

Warning: 
In late 2016 it was discovered that project survey data was being transformed when coordinate sys-
tems were not being used uniformly throughout a Civil 3D project. This transformation occurs when 
the coordinate system selected for a LandXML import differs from the coordinate system assign-
ment for a survey database. The transformation also occurs when data from a survey database is 
inserted into a DWG file that has a coordinate system assignment different from the survey data-
base.

For more information on the issue and what can be done to identify and resolve the issue refer the 
following C3DKB topics:

Wisconsin coordinate projection issue - XML/SDB

Wisconsin coordinate projection issue - SDB/DWG

WisDOT Civil 3D coordinate system action summary

Wisconsin coordinate systems available in Civil 3D

 l SPCS – State Plane Coordinate System – FDM 9-20-26  Developed nationally by the US Coast and 
Geodetic Survey in the 1930s.  Wisconsin has three state plane zones North, Central and South that 
follow county lines.

 l WCCS – Wisconsin County Coordinate System – FDM 9-20-27  Developed in 1993 by WisDOT.  
Achieved design goal of minimal distortion between grid (map) and ground distances by creating 
individualized ellipsoids for every county.

 l WISCRS – Wisconsin Coordinate Reference System – FDM 9-20-28  Developed in 2006.  Design 
goal is to arrive at the same WCCS coordinate while utilizing one nationally recognized ellipsoid, 
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making it easier for vendors to include Wisconsin county coordinates in their software and equip-
ment.  For all counties except Jackson County, WCCS and WISCRS coordinates will essentially be 
the same for a given point.

 l WTM – Wisconsin Transverse Mercator – FDM 9-20-25.3.1  Developed by the Wisconsin DNR in 
the 1980s.  The Universal Transverse Mercator used by the Department of Defense divided Wis-
consin almost equally into two zones down the 90 degree west longitude line.  The WTM is centered 
on the 90 degree longitude line and allows Wisconsin to be covered by one WTM zone rather than 
two UTM zones.

Info: It is encouraged that new projects are surveyed in WISCRS. 

Frequently Asked Questions (FAQ)

How do I choose a coordinate system for a WisDOT dwg file?

The coordinate system that was used to collect survey data should be obtained from the surveyor or the 
WisDOT Survey Data Coordinator.  Review the Form DT1773 Geodetic Reference Documentation with the 
Survey Data Coordinator. 

Can I set the coordinate system for multiple files at once?

To set a coordinate system in multiple files at once, use Assign Coordinate System - Multiple dwgs.

What should I do with my existing project?

Check with the Region Survey Data Coordinator to verify that the correct coordinate system has been 
applied to the drawing.  Changing the coordinate system in Civil 3D will not affect the data in the drawing 
itself but may cause errors to referenced aerial photos, GIS information, or survey database data if they are 
based on a different coordinate system.

Is the survey information drawn differently for the adjustment years?

The horizontal datum versions for NAD 83 include (1986), (1991), (1997), (2007) and (2011). The dif-
ferences are fundamentally a result of upgrades and enhancements in technology, surveying meth-
odologies and computing power. In addition, as the Wisconsin Height Modernization program has worked 
its way around the state, additional measurements (horizontal and vertical) to survey stations has added 
more data to further refine the previously published coordinates.  There is no direct mathematical rela-
tionship between NAD83 adjustment years.  Therefore, any change in coordinate values due to a change in 
adjustment year should be handled by the Region Survey Data Coordinator outside of Civil 3D. 

Civil 3D is a design tool and should not be considered a survey adjustment tool.  Any questions or concerns 
regarding the project datum and adjustment should be addressed to the Region Survey Data Coordinator.  
Any changes to the project survey datum and adjustment should be overseen by the Region Survey Data 
Coordinator.

Should I translate my survey data to a newer projection?

No.  Transforming a project to another coordinate system is reserved for the Survey Data Coordinator 
and should not be done by the engineer/designer.  If survey data is collected based on the NAD 83 (2011) 
coordinates and saved to a survey database, then the project is in NAD 83 (2011) coordinates. Civil 3D pro-
jects are a Cartesian plane based on what the survey database tells the project the coordinates are.  The 
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adjustment year in the coordinate name does not include any additional information that will allow Civil 3D 
to translate coordinates between adjustment years. Only one adjustment year is provided in the "WisDOT" 
category.

Civil 3D reflects what is imported in the survey database, and if another coordinate system is needed by 
Civil 3D, then the survey data coordinator should transform the data.

What is the difference between WCCS and WISCRS?

In general, WCCS is based on a local ellipsoid (the reference surface) for each county, whereas WISCRS 
uses GRS 80 as the single reference ellipsoid for all individual coordinate systems.

Vertical differences

There is no difference in elevations between WCCS and WISCRS. It is a horizontal system only. See Ver-
sion updates for elevation version updates from NGS.

Horizontal differences

Except for Jackson County, there is negligible difference between WCCS coordinates and WISCRS 
coordinates. The goal of the WISCRS system is to replicate WCCS coordinates (from lat/long) using a ‘sim-
pler' mathematical method. The vast majority of ‘differences' between WCCS and WISCRS (over 97%) are 
less than 3 mm (0.010') and there are no differences of over 5 mm (0.016').

Jackson County WISCRS (Transverse Mercator) is a completely different projection than WCCS (Lambert 
Conformal Conic), so the user will get radically different coordinates from the same lat/long.

What coordinate system should I use for Jackson County?

Please note that only the WISCRS Jackson County coordinate projection is to be used for new WisDOT pro-
jects.  Do not use the WCCS Jackson County coordinate system for new projects.  The WCCS Jackson 
County coordinates have been retained for legacy projects.  Refer to FDM 9-20-28 Wisconsin Coordinate 
Reference System for more information.

Resources:

FDM Section 9-20 Spatial Reference Systems

Wisconsin State Cartographer's Office – Coordinate Reference Systems
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AutoCAD fundamentals

AutoCAD basic creation and editing
Last updated: 2023-01-04

Total video time: 28:31

There are several tools available in Civil 3D that are intended for basic geometry object creation. These 
basic objects can either be an end product such as with a standard detail layout or they can be used as a 
foundation from which to create Civil 3D objects. This section will focus on using basic Line, Polyline, 3D 
Polyline, Rectangle, Curve and Circle tools along with basic Object Snap settings to create geometry for a 
standard detail drawing.

Osnap & Line

Exercise files: acad-data-c3d20.zip

Start with acad-basc-creat-edit-begin.dwg

acad-basc-creat-edit-01.mp4 3:56

Line

One of the most basic geometry objects available is the Line. In Civil 3D, a single Line has two vertices with 
independent locations and elevations. The Line is often used as a starting point or guide by which other 
objects are laid out.

 1. Open acad-basc-creat-edit-begin.dwg

 2. Ribbon > Home tab > Draw panel > Line icon > Create Line  (l Enter for command line 
option)

 A. Specify first point
 I. Left-click

 B. Specify next point
 I. Left-click

 3. Enter
 4. Activate ERASE command: eEnter

 A. select lines

 B. Enter

Info: Another option for erasing objects is to select an object and press the delete key.

Info: Keying Enter immediately after a command is finished executing will repeat the same com-
mand.

Info: Keying Spacebar executes an active command the same way as keying Enter

Object snaps

When laying out object geometry or specifying a location when prompted in a command, it is often helpful to 
be able to reference existing object geometry. The object snap tool is built for just that. When Object Snaps 
are turned on (as a system variable) and you are prompted to specify a location within a command you can 
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"snap" to the exact point desired based on the type of Object Snap turned on simply by moving the cursor 
within an Object Snap tolerance distance from that point. There are multiple ways to turn on Object Snaps 
for either "one-time" use or to remain on until turned off. We will cover these and other uses of Object 
Snaps in a later training module. This section is intended to show what Object Snaps are and provide a few 
examples of their use.

 1. Continue working in acad-basc-creat-edit-begin.dwg
 2. Status Bar > right-click Object Snap icon

 A. Endpoint: checked
 B. Center: checked

 3. Status Bar > right-click Object Snap icon
 A. Object Snap Settings

 I. Object Snap On = checked
 II. OK
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 4. Ribbon > Home tab > Draw panel > Line icon > Create Line
 A. Move cursor near bottom endpoint of red guiding line on left side of Section A-A
 B. Observe Endpoint Object Snap glyph appear

 I. Left-click
 C. Move cursor near bottom endpoint of red guiding line on right side of Section A-A

 I. Left-click

 D. Esc to end command

 I. 

Info: F3 is a "hotkey" that will toggle Object Snaps on/off

 5. Tip: A common theme you will notice in Civil 3D is that there are multiple ways to access the 
same commands. Toggling Object Snaps on via Object Snaps Settings vs the F3 hotkey is 
only one example. With experience you will find the personal workflows you are comfortable 
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with, thus reducing the some of the complexity of Civil 3D.

Polyline

Start with acad-basc-creat-edit-begin.dwg

acad-basc-creat-edit-02.mp4 4:46

A Polyline is arguably one of the most versatile basic AutoCAD drawing objects. It can be edited in many 
ways including joining multiple linear geometry objects to one, adding/removing vertices, adding/removing 
curves and more. In addition, many Civil 3D objects can be created from a Polyline, thus allowing you to set 
geometry in place using the simpler Polyline object then generate more powerful objects necessary for Civil 
3D workflows. This section focuses on basic Polyline creation. It should be noted that when adding elev-
ation data to your objects, a Line can have different elevations at start and end vertices, while a Polyline 
can have only one elevation for all vertices.

 1. Continue working in acad-basc-creat-edit-begin.dwg
 2. Ribbon > Home tab > Draw panel > Line icon > Create Line

 A. left click below SECTION B-B
 B. left click at a higher point to the right of the first
 C. left click to create to create a peak shape with the line
 D. esc

 3. Ribbon > Home tab > Draw panel > Polyline 

Info: PL is a command alias that will activate the Polyline command. A command alias is an 
alternative to activating a command from the Ribbon or typing the full name of the command 
on the command line. Simply begin typing any command alias when your drawing area (i.e. 
Model space) is active to call it up on the command line

 A. Follow the command prompts and create a polyline directly below the line created in the last 
step. 

 B. Confrim in the properties of the polyline that the elevation values are the same on each ver-
tex

 C. E Enter for the ERASE command
 I. select the lines and polyline

 II. spacebar to exit command
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 4. Check to be sure Endpoint and Center object snaps are on.
 5. Command Line > PL spacebar

 A. Move cursor near  red guiding circle on left side of Section A-A
 I. left click

 B. Move cursor near  red guiding circle on just to the left of of Section A-A
 I. left click

 C. Mid-command option: A
 I. Enter

 II. Move cursor near endpoint of subgrade Line
 a. Left click

 b. Enter

 6. Ribbon > Home tab > Draw panel > Polyline
 A. Begin drawing Polyline border using outermost guiding circles
 B. Command line prompt:  Close

3D polyline & rectangle

Start with acad-basc-creat-edit-begin.dwg

acad-basc-creat-edit-03.mp4 4:53

3D Polyline

A 3D Polyline behaves in many ways the same as a Polyline. The chief difference is that a 3D Polyline can 
have different elevations at each of its vertices. Having multiple vertex elevations assigned ahead of time 
can be useful when creating a Civil 3D object such as a Feature Line, Surface Breakline, or Pipe Network 
from a 3D Polyline.

 1. Continue working in acad-basc-creat-edit-begin.dwg

 2. Select Polyline border

 3. Properties palette > expand Geometry > Elevation = 100

 A. Cycle Current Vertex

 B. Observe same elevation for all vertices
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 4. Delete

 5. Ribbon > Home tab > Draw panel > Draw dropdown > 3D Polyline button
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 6. Begin drawing 3D Polyline border using outermost guiding circles

 7. command line: C

 8. Enter

Info: 3DPOLY is a command alias that will activate the 3D Polyline command. A command alias is an 
alternative to activating a command from the Ribbon or typing the full name of the command on the 
command line. Simply begin typing any command alias  on the command line to access the asso-
ciated command.

 9. Select 3D Polyline > Properties palette > expand Geometry > Elevation = 100

 10. Cycle Current Vertex

 A. Observe different elevation for other vertices

 B. These vertex elevations can be manually changed within the Properties palette.

Rectangle

The Rectangle command creates a closed Polyline with rectangle geometry. This simplifies the creation of 
a Polyline using the common rectangle shape.

 1. Continue working in acad-basc-creat-edit-begin.dwg
 2. Select 3D Polyline border

 A. delete

 3. Ribbon > Home tab > Draw panel > Rectangle button 
 A. Specify first corner

 I. Snap to upper left guiding circle
 B. Specify second corner

 I. Snap to lower right guiding circle
 4. Spacebar

 A. Repeat the last steps around "6" text on left side of drawn objects
 5. Command line: RECT Enter 

 A. Snap to guiding circle around "6" text on right side of drawn objects
 B. D

 I. Enter
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 C. 2.8
 I. Enter

 D. 11.6
 I. Enter

 E. Move cursor to upper right quadrant relative to Rectangle starting corner
 I. Left-click

Curve & Circle

Start with acad-basc-creat-edit-begin.dwg

acad-basc-creat-edit-04.mp4 4:43

Curve

The Curve command includes several variations that use existing reference objects (i.e. tangent Lines) to 
create single radius, compound, or reverse curves. The object created is referred to as an Arc. The curve 
command can be helpful when laying out geometry from which to create a smart Civil 3D object.

 1. Continue working in acad-basc-creat-edit-begin.dwg
 2. Ribbon > Home tab > Draw panel > Curve flyout > Create Curve on Two Lines  

 3. Select edge of paved median shoulder (Section A-A) as first tangent
 4. Select left edge of asphalt concrete hatch boundary as second tangent

 A. Radius: 3
 I. Enter

 5. Ribbon > Home tab > Draw panel > Curve flyout > Create Curves between Two Lines
 1. Select one Section B-B Median Foreslope Line as first tangent
 2.  Select other Section B-B Median Foreslope Line as second tangent

 A. R
 I. Enter

 B. Specify Radius: 20 Enter
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Circle

The Circle command creates an object with circular geometry. Civil 3D refers to the object as a Circle. If a 
Circle object is trimmed, it becomes an Arc object. Several options are built into the command from which to 
dictate the radius and location of the Circle.

Continue working in acad-basc-creat-edit-02.dwg

 1. Ribbon > Home tab > Draw panel > Circle flyout > Center, Radius

 2. Ensure Center Object Snap is toggled on: F3

 3. Pan and Zoom to Plan View, R3-4 signage

 4. Move cursor over existing signage Arcs to activate Center Object Snap glyph

 5. Left-click
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 6. Specify radius of circle: 2.4

 7. Zoom Extents

Object Selection

Start with acad-basc-creat-edit-02.dwg

acad-basc-creat-edit-05.mp4 5:52

In order to direct commands or apply edits to an object, the objects must be selected.  In many cases this 
can be either before or after a command is activated. This is referred to as "pick first" or "pick last". Select-
ing an object is also a way to gather information about the object via the Properties palette. Objects can be 
selected using a variety of methods. In this section we will cover simple cursor selection, Window, Cross-
ing, Lasso, Fence and Quick Selection. We will also cover ways to deselect, append and edit the current 
selection without need to start your selection over from scratch. 

Properties palette population

When the Properties palette is open, selecting an object or group of objects will populate the Properties 
palette with object information common to the entire selection. 
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 1. Open acad-basc-creat-edit-02.dwg
 2. Methods for activating the Properties palette

 A. Command line > PROPERTIES

 B. Ribbon > Home tab > Palettes panel > Properties 
 C. Ctrl + 1
 D. Select an object > right-click > Properties

 3. esc to deselect

Cursor PickBox selection

 1. Continue working in acad-basc-creat-edit-02.dwg
 A. Move cursor PickBox over any object geometry in Model space

 I. Left-click to select object
 II. esc to deselect

Left to Right Window Select

All objects completely enclosed by a left to right window selection will be included in the Selection Set. 
Objects to be selected are highlighted white in a blue background.
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 1. Continue working in acad-basc-creat-edit-02.dwg
 2. Move cursor left of desired object(s)

 A. Left-click to activate Window Selection
 B. Release mouse button
 C. Move cursor right of desired object(s)
 D. Left-click to specify selection area
 E. esc to deselect

Right to Left Crossing Window Select

All objects enclosed or crossed by a right to left crossing window selection will be included in the Selection 
Set. Objects to be selected are highlighted white in a green background.
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 1. Continue working in acad-basc-creat-edit-02.dwg
 2. Move cursor right of desired object(s)

 A. Left-click to activate Crossing Selection
 B. Release mouse button
 C. Move cursor left of desired object(s)
 D. Left-click to specify selection area
 E. esc to deselect

Fence Select

All objects crossed by a fence selection path will be included in the Selection Set. A fence can have any 
number of vertices in any direction. Objects to be selected are highlighted white.

 1. Continue working in acad-basc-creat-edit-02.dwg
 2. Move cursor to desired location of Fence

 A. Left-click to activate Selection
 I. Command Line > F

 II. Enter
 a. Left-click to create additional Fence path vertices
 b. Enter
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 c. Esc

Left to Right Window Polygon Select

Similar to the Left to Right Window Selection, all objects completely enclosed by a Left to Right Window 
Polygon Selection will be included in the Selection Set. Objects to be selected are highlighted white in a 
blue background.

 1. Continue working in acad-basc-creat-edit-02.dwg
 2. Move cursor to desired initial vertex of Window Polygon

 A. Left-click to activate Selection
 I. Command Line > WP

 II. Enter
 a. Moving clockwise, Left-click to create successive Window Polygon vertices
 b. Enter
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 c. Esc to deselect

Crossing Window Polygon Select

Similar to the standard Right to Left Crossing Window Selection, all objects at least enclosed or crossed by 
a Right to 
Left Crossing Polygon Selection will be included in the Selection Set. Objects to be selected are highlighted 
white in a green background.

 1. Continue working in acad-basc-creat-edit-02.dwg
 2. Move cursor to desired initial vertex of Window Polygon

 A. Left-click to activate Selection
 I. Command Line > CP

 II. Enter
 a. Left-click to create successive Window Polygon vertices
 b. Enter
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 c. Esc to deselect

Lasso Select

Similar to both standard Window/Crossing or Polygon Window/Crossing Selection, a Lasso selection can 
be applied either clockwise or counter-clockwise. Objects to be selected are highlighted white.

 1. Continue working in acad-basc-creat-edit-02.dwg
 2. Move cursor to desired initial start point of Lasso Selection

 A. Left-click and hold mouse button to activate Lasso Selection
 B. Move cursor along desired boundary of Lasso Selection
 C. Release mouse button
 D. esc to deselect
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Quick Select

The Quick Select tool allows you to build a selection query based on object properties. The query can either 
be inclusive (select what is queried) or exclusive (select all but what is queried). The query can also be set 
to append or replace any current selection set.

 1. Continue working in acad-basc-creat-edit-02.dwg
 A. Right-click > Quick Select

 I. Apply to = Entire drawing
 II. Object type = Line
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 III. Operator = Select All
 IV. Include in new selection set = checked
 V. Append to current selection = checked

 VI. OK
 B. esc to deselect

Editing current selection

Once multiple objects are selected, you may wish to remove certain objects from the selection set. To 
switch selection tools from selecting to deselecting, hold the Shift key while performing the selection in 
Model Space. A "-" glyph indicating deselection will appear next to the cursor when holding the Shift key 
and hovering over an object in the current selection set.

 1. Continue working in acad-basc-creat-edit-end.dwg
 A. Select multiple objects
 B. Hold Shift

 I. Use cursor selection to deselect objects from the selection set
 C. esc to deselect all
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Grips

Start with acad-basc-creat-edit-end.dwg

acad-basc-creat-edit-06.mp4 4:21

When an object is selected, Grips will be displayed along the object. These Grips make various geometric 
object edits available. They are generally located at key points along or adjacent to an object (i.e Line end-
points/midpoint or Arc endpoints/midpoint/radius point. To edit an object based on a Grip, click on a Grip or 
hover over it and choose from available Grip options. There are several advanced object edits that can be 
performed using grips. Many of these will be covered in a later training module. This section will cover a 
sample of basic grip functions. This is intended to provide a general understanding of grips as a foundation 
for further independent exploration.

Tip: When performing grip edits, displacement values can be keyed in or specified 
by mouse click.

Line grips

When a Line is selected, three Grips are displayed. The two endpoint Grips allow you move/stretch or 
lengthen the respective endpoint independently. The midpoint Grip allows you to move the Line with the 
midpoint as a basepoint, keeping all other geometry properties intact (i.e. length, rotation).
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 1. Open acad-basc-creat-edit-end.dwg
 2. Select Line representing subgrade

 A. Left-click endpoint Grip
 I. Move mouse

 II. Left-click to place new endpoint
 B. Hover over endpoint Grip

 I. Lengthen
 a. Move mouse
 b. Left-click to place new endpoint

 C. Left-click midpoint Grip
 I. Move mouse

 II. Left-click to place line in new location
 D. esc to deselect

Arc grips

When an Arc is selected, four Grips are displayed. The two endpoint vertex Grips allow you move/stretch or 
lengthen the respective vertex independently. The midpoint Grip allows you to change the radius of the arc 
keeping intact either the location of the endpoint vertices or their alignment with the radius point. The radius 
point grip allows you to move the arc with the radius point as a basepoint,  keeping all other geometry prop-
erties intact (i.e. radius).
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 1. Continue working in acad-basc-creat-edit-end.dwg
 2.  Select Arc representing median nose

 A. Left-click centerpoint Grip
 I. Move mouse

 II. Left-click to place in new location
 B. Hover over midpoint Grip

 I. Stretch
 a. Move mouse
 b. Left-click to place new endpoint

 C. Hover over midpoint Grip
 I. Radius

 a. Move mouse
 b. Left-click to set new radius

 D. Hover over endpoint Grip
 I. Stretch

 a. Move mouse
 b. Left-click to place new endpoint

 E. Hover over endpoint Grip
 I. Lengthen

 a. Move mouse
 b. Left-click to place new endpoint

 F. esc to deselect

Polyline grips

When a Polyline is selected, square Grips are displayed at all vertices and dash Grips are displayed at all 
line segment midpoints. Endpoint vertex Grips allow you stretch (i.e. move) the respective vertex inde-
pendently or add a vertex adjacent to the endpoint. The midpoint Grip allows you to stretch the line 
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segment, add a vertex between the two adjacent endpoint vertices, or convert the line segment to an arc. 
When stretching a line segment, the length and rotation geometry of the selected line segment stays intact. 
Geometry of any adjacent line segments will adjust as necessary. When converting a Polyline line segment 
to arc, a radius must be specified. A Polyline arc segment can also be converted back to a line segment.

 1. Continue working in acad-basc-creat-edit-end.dwg
 2. Select the polyline representing bottom of base course

 A. Hover over endpoint Grip
 I. Add Vertex

 a. Move mouse
 b. Left-click to place new vertex

 B. Hover over midpoint Grip
 I. Add Vertex

 a. Move mouse
 b. Left-click to place segment in new location

 C. Hover over Polyline line segment midpoint Grip
 I. Convert to Arc

 a. Move mouse
 b. Left-click to place set radius

 D. Hover over Polyline arc segment midpoint Grip
 I. Convert to Line

 E. esc to deselect

Object snaps
Last updated: 2023-01-04

Total video time: 18:14
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Object Snaps are tools built into Civil 3D that help ensure precision when laying out geometry with both 
basic objects (i.e. Line, Polyline) and smart Civil 3D objects. The idea is that when specifying location dur-
ing a command, a given Object Snap will force the location to be at the exact specified object point when 
the command is active and your cursor is within the Object Snap buffer distance. When an Object Snap is 
ready to take effect, a glyph will appear indicating the type of Object Snap and location of the snap point.

Object snap glyphs

Object 
Snap Glyph Image Object 

Snap Glyph Image

Endpoint Extension

Midpoint Insertion

Center Per-
pendicular

Geometric 
Center Tangent
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Object 
Snap Glyph Image Object 

Snap Glyph Image

Node Nearest

Quadrant Apparent 
Intersection

Inter-
section Parallel

Introduction & settings

Exercise files: acad-data-c3d20.zip

Start with acad-objct-snp-begin.dwg

acad-objct-snp-01.mp4 4:17

Access to settings

There are a few different ways to access Object Snap settings.

 1. Open acad-objct-snp-begin.dwg
 2. Status Bar > Customization

 A. 2D Object Snaps = checked
 B. Press icon to Turn on Object Snaps
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 3. Status Bar > Object Snap icon
 A. Right-click on 2D Object Snap icon
 B. Place checkmark to turn on individual Object Snaps
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 4. Status Bar > Object Snap icon

 A. Left-click flyout triangle 
 B. Observe access to running Object Snaps list

 I. Object Snap Settings...
 a. Drafting Settings dialog box, Object Snap tab
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 a. Object Snap On = checked
 b. Select All
 c. Clear All
 d. Midpoint = checked
 e. OK

 C. Ribbon > Home tab > Draw panel > Polyline button
 I. Turn on Midpoint Object Snap

 II. Move cursor over objects
 a. Observe Midpoint glyph appear
 b. esc to deselect

 5. Model space
 A.  Shift+right-click

 I. Osnap Settings...
 B. Observe access to Drafting Settings dialog, Object Snap tab

Introduction to Object Snap use

In this example you will use the Midpoint Snap to move Mtext to the correct location on a title block.

 1. Continue working in  acad-intrfc-begin.dwg
 2. Status Bar > Object Snap icon

 A. Right-click
 I. Midpoint = checked
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 3. Select "MAINTAINENCE CROSSOVER FOR FREEWAYS" Mtext object
 A. Select insertion point grip

 I. Move cursor near middle of red construction line
 II. Observe Midpoint glyph appear

 III. Left-click

 B. Select red construction line
 I. delete

Workflow efficiency

Start with acad-objct-snp-begin.dwg

acad-objct-snp-02.mp4 3:37

F3 hotkey

A "alias" is essentially a single keystroke shortcut designed to streamline execution of a task or string of 
tasks. Many hotkeys are programmed and ready for use in Civil 3D. The"F3" key is one powerful hotkey rel-
evant to Object Snap use. You might incorporate this into your typical Object Snap workflow to improve effi-
ciency.

 1. Continue working in acad-objct-snp-begin.dwg
 2. Toggle Object Snaps off: F3
 3. Toggle Object Snaps on: F3
 4. Ribbon > Home tab > Draw panel > Polyline button

 A. Hold F3
 B. Hover over a Line object
 C. Observe that Object Snaps are temporarily suppressed
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Object snap cycling

Pressing the tab key allows you to cycle through Object Snaps relevant to a given object as long as those 
Object Snaps are turned on.

 1. Continue working in acad-objct-snp-begin.dwg
 2. Status Bar > Object Snap icon

 A. Right-click
 I. Endpoint = checked

 II. Midpoint = checked
 B. Verify Object Snaps turned on

 3. Ribbon > Home tab > Draw panel > Polyline button
 A. Hover cursor over middle of EDGE OF PAVED MEDIAN SHOULDER Line

 I. Observe Midpoint glyph appear
 II. tab

 III. tab
 IV. tab

System variable: ignore elevation

By default, Civil 3D will apply existing geometry elevation  when using Object Snaps and existing geometry 
to specify location. You can change this behavior so elevation properties are ignored and only location in 
the X,Y plane are used when "snapping". This is done by resetting the OSNAPZ System Variable. When this 
is done, the elevation Z=0 will be used for new location specification.

 1. Continue working in acad-objct-snp-begin.dwg
 2. Ribbon > Home tab > Draw panel > Polyline button

 A. Draw a single Polyline
 I. Select Polyline drawn

 II. Properties Palette > Geometry
 a. Set Elevation = 100
 b. esc

 3. Ribbon > Home tab > Draw panel > Polyline button
 A. Use Endpoint Snap to specify location on end of Polyline drawn in 2.A

 I. Select Polyline drawn
 II. Properties Palette > Geometry

 a. Observe Elevation = 100
 4. Command line: OSNAPZ

 A. enter
 B. 1

 C. enter
 5. Ribbon > Home tab > Draw panel > Polyline button

 A. Use Endpoint Snap to specify location on end of Polyline drawn in 2.A
 I. Select Polyline drawn

 II. Properties Palette > Geometry
 a. Observe Elevation = 0

 6. Select previous three Polylines drawn
 A. delete

Temporary overrides

Calling up temporary Object Snap overrides either through the command line or right-click menu allows a 
"one-time use" override to current Object Snap settings. For example, you could have Endpoint Object 
Snaps currently on, then use a temporary Midpoint Object Snap override to ignore all Endpoint Snaps and 
use Midpoint Snaps for the next location specification. Alternatively you might have all running Object 
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Snaps off, then use any temporary Object Snap overrides as you need them for the next location spe-
cification. This temporary override workflow avoids the need to open a running Object Snap interface and 
thus can improve efficiency.

After a command requiring location input is activated, hold Shift key and right-click to open the temporary 
Object Snap override menu. Choose a one-time use temporary Object Snap override from this list. 
Continue location specification.

 1. Continue working in acad-objct-snp-begin.dwg
 2. Turn on running Endpoint Object Snap using your method of choice
 3. Ribbon > Home tab > Draw panel > Polyline button

 A.  Shift+Right-click
 I. Midpoint

 B. Left-click first endpoint and then second endpoint of line you want to midpoint snap to.

Example 1

Start with acad-objct-snp-begin.dwg

acad-objct-snp-03.mp4 4:48

Geometric Center

This Object Snap analyzes any closed area object and snaps to the centroid of that area. The object can be 
irregularly shaped, but must show as "closed" in the properties palette for the Geometric Center snap to 
work.

 1. Continue working in acad-objct-snp-begin.dwg
 2. Turn on running Geometric Center Object Snap using your method of choice
 3. Select "6" Mtext at right of drawing extents

 A. Select middle-center Mtext insertion point
 I. Move cursor to hover over adjacent rectangular closed Polyline

 II. Observe Geometric Center glyph appear
 III. Left-click
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Quadrant

This Object Snap grabs the location on a Circle, Ellispse or Arc object intersecting with any of the four 2D 
quadrant lines (i.e. along X or Y axis).

 1. Continue working in acad-objct-snp-begin.dwg
 2. Turn on running Node Object Snap using your method of choice.

 A. Observe the behavior of the Node Object Snap glyph as you hover over different objects.
 3. Turn on running Quadrant Object Snap using your method of choice.
 4. Select Line representing signage in the PLAN VIEW area of drawing extents

 A. M enter
 I. Shift+Right-click

 a. Midpoint
 B. Move cursor near Circle representing sign post in PLAN VIEW area of drawing extents

 I. Observe Quadrant glyph along positive X-axis appear
 II. Left-click
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 5. Turn on running Intersection Object Snap using your method of choice.
 A. Observe glyph behavior as you hover over any area of intersecting geometry. 

Examples 2

Start with acad-objct-snp-01.dwg

acad-objct-snp-04.mp4 5:32

Extension

The Extension Object Snap will find a point on a projected extension of a drawing object.

 1. Open  acad-objct-snp-01.dwg
 2. Turn on running Extension Object Snaps using your method of choice.
 3. Ribbon > Home tab > Draw panel > Polyline button

 A. Move cursor near any arc in PLAN VIEW area of drawing extents
 I. Observe Extension Object Snap glyph appear and that it shows a continuing green 

extension of the arc as you move outside of the arc.
 II. Left-click

 B. Move cursor near a line and extend along the path of the line past its endpoint and notice the 
same green extension appear. 

 C. esc

Insertion

The Insertion Object Snap will snap to the insertion point of objects such as blocks or text. 
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 1. Open  acad-objct-snp-01.dwg
 2. Turn on running Insertion Object Snaps using your method of choice
 3. Ribbon > Home tab > Draw panel > Polyline button

 A. Move cursor near any block or text in the drawing. 
 I. Observe Insertion Object Snap glyph appear at the insertion point of the object.

 B. esc

Perpendicular

The Perpendicular Object Snap will snap perpendicular to any object such as a line or polyline in relation to 
the object being drawn. 

 1. Open  acad-objct-snp-01.dwg
 2. Turn on running Perpendicular Object Snaps using your method of choice.
 3. Ribbon > Home tab > Draw panel > Polyline button

 A. Click any point in the drawing.
 B. Hover near any line or other object in the drawing for your second point. 

 I. Observe Perpendicular Object Snap glyph appear at the perpendicular point of the 
other object. 

 C. esc

Tangent

The Tangent Object Snap finds the point of tangency on a Circle, Arc, or Ellipse object coming in from any 
Line or Polyline object.

 1. Open  acad-objct-snp-01.dwg
 2. Turn on running Tangent Object Snaps using your method of choice.
 3. Ribbon > Home tab > Draw panel > Create Line

 A. Move cursor near  PLAN VIEW area of drawing extents.
 I. Left-click anywhere to place first point. 

 B. Move cursor near Circle representing median back of curb in PLAN VIEW area of drawing 
extents

 I. Observe Tangent Object Snap glyph appear
 II. Left-click to create line tangent to the circle.

Nearest

The Nearest Object Snap will anywhere on an object nearest to where the user clicks. 

 1. Open  acad-objct-snp-01.dwg
 2. Turn on running Nearest Object Snaps using your method of choice
 3. Ribbon > Home tab > Draw panel > Polyline button

 A. Click any point in the drawing.
 B. Hover near any line or other object in the drawing and observe the Nearest Object Snap 

glyph appear. 
 C. esc

Parallel and Apparent Intersection

Use the Parallel Object Snap to lay out new linear objects while referencing existing linear objects for dir-
ectional orientation. You will first start the new linear object command (i.e. Line), then hover over the 
desired linear reference object. This will activate the Parellel Object Snap and you will see a dashed exten-
sion line as a preview of your new linear object draw parallel to that existing. Apparent Intersection Object 
Snap allows a user to snap to where two objects would intersect even if they do not actually connect. This 
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object snap will extrapolate the linework to find the point at which the objects would intersect if they were 
extended far enough to intersect. 

 1. Continue working in  acad-objct-snp-01.dwg
 2. Turn on running Enpoint, Apparent Intersection and Parallel Object Snaps using your method of 

choice
 3. Ribbon > Home tab > Draw panel > Line flyout > Polyline button

 A. Move cursor near upper right of SECTION A-A, CRUSHED AGGREGATE BASE COURSE 
border Line

 I. Observe Endpoint Object Snap glyph appear
 II. Left-click

 B. Move cursor to hover over adjacent TOPSOIL Line
 I.  Observe Parallel Object Snap glyph appear

 C. Move cursor along path from the new Line starting vertex parallel to TOPSOIL Line
 I. Observe Parallel preview line appear

 D. Move cursor to point of intersection of parallel preview line and existing BOTTOM OF 
MEDIAN Line.

 I. Observe Apparent Intersection Object Snap glyph appear
 II. Left-click

Polar and osnap tracking
Last updated: 2023-01-04

Total video time: 14:01

Both Polar Tracking and Object Snap (aka Osnap) Tracking are tools designed to streamline the process of 
specifying location precisely when executing a command. Polar tracking allows "snapping" along vectors 
based on preset angle increments around an initially specified point. Osnap Tracking allows projection out 
from existing Osnap locations to specify the next command location. These projection vectors can come 
from multiple Osnap locations and can use current Polar Tracking angles to form the projections. Once you 
become familiar with the tools, both Polar Tracking and Object Tracking can greatly improve efficiency 
when specifying command location.

Polar Tracking

Exercise files: acad-data-c3d20.zip

Start with acad-polr-osnp-trak-begin.dwg

acad-polr-osnp-trak-01.mp4 4:33

Basics

This section will get you started using Polar Tracking with an example exercise laying out title block Lines.

 1. Open acad-polr-osnp-trak-begin.dwg
 2. Status Bar > Customization flyout

 A. Polar Tracking = checked
 3. Status Bar

 A. Polar Tracking on
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 4. Ribbon > Home tab > Draw panel > Polyline button
 A. Left-click anywhere in Model space to specify first points
 B. Rotate cursor around first point location
 C. Observe Polar Tracking vector "snapping"

 5. Status Bar > Polar Tracking icon
 A. Right-click

 I. Increment = 45, 90, 135, 180...

 6. Status Bar
 A. Dynamic Input off
 B. Polar Tracking off
 C. Center Object Snap on

 7. Zoom to lower right of drawing extents
 8. Ribbon > Home tab > Draw panel > Polyline button

 A. Snap to bottom red guiding Circle for first point
 I. @26<180 Enter

 II. Enter
 B. Enter
 C. Status Bar

 I. Dynamic Input on
 D. Snap to middle red guiding Circle for first point

 I. 26

 II. tab
 III. 180

 a. Enter
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 9. Status Bar
 A. Dynamic Input off
 B. Polar Tracking on

 I. Increment = 90, 180, 270, 360...
 10. Ribbon > Home tab > Draw panel > Polyline button

 A. Snap to top red guiding Circle for first point
 I. Move cursor until 180 deg Polar Tracking vector appears

 a. 26
 i. enter

 II. Move cursor until 270 deg Polar Tracking vector appears
 a. 16.5

 i. enter

Access to settings

Start with acad-polr-osnp-trak-01.dwg

acad-polr-osnp-trak-02.mp4 3:46

You can customize the way Polar Tracking works based on your preferences and/or workflow needs. Here 
you will be able to add increment angles, additional angles (single angle relative to 0 deg), set display pref-
erences, set Osnap Tracking interaction preferences, and toggle between relative (direction of last drawn 
line segment is assumed as 0 deg) and absolute angle measurement. This section will walk you through 
these settings and their effect on Polar Tracking function.
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 1. Open acad-polr-osnp-trak-begin.dwg
 2. Status Bar > Polar Tracking icon > Polar Tracking flyout > Tracking Settings

 A. Polar Tracking On = checked
 B. Polar Angle Settings

 I. Increment angle = 60
 C. OK

 3. Ribbon > Home tab > Draw panel > Polyline button
 A. Left-click in anywhere in Model space to specify first point

 I. Rotate cursor around first point
 II. Observe 60 deg Polar Tracking angle increments

 B. esc
 4. Status Bar > Polar Tracking icon > Polar Tracking flyout > Tracking Settings

 A. Polar Angle Settings
 I. Additional angles = checked

 II. New
 III. 75

 B. OK
 5. Ribbon > Home tab > Draw panel > Polyline button

 A. Left-click in anywhere in Model space to specify first point
 I. Rotate cursor around first point

 II. Observe 75 deg Polar Tracking additional angle
 B. esc

 6. Status Bar > Polar Tracking icon > Polar Tracking flyout > Tracking Settings
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Info: Clicking on the Options button inside of the Tracking Settings dialog box brings up the 
Options dialog box. Located in the upper-right corner are the on-screen visual options for 
AutoTrack which can be toggled ON/OFF.

Object Snap Tracking

Start with acad-polr-osnp-trak-02.dwg

acad-polr-osnp-trak-03.mp4 5:42

In this section you will be introduced to the Object Snap (aka Osnap) Tracking tool including functionality 
when combined with Polar Tracking and Dynamic Input. Keep in mind that for Object Snap Tracking to take 
effect, you will first need to have at least one Osnap turned on.

Basics

 1. Open acad-polr-osnp-trak-02.dwg
 2. Status Bar

 A. Polar Tracking on
 B. Object Snap Tracking on
 C. Object Snap on

 3. Status Bar > Polar Tracking icon > Polar Tracking flyout
 A. Increment = 45, 90, 135, 180...

 4. Status Bar > Object Snap icon > Object Snap flyout
 A. Endpoint = checked

 5. Ribbon > Home tab > Draw panel > Polyline button
 6. Move cursor to hover over a Line endpoint

 A. Observe Object Snap Tracking activate
 B. Rotate cursor around active Object Snap Tracking location
 C. Observe Tracking vectors available based on Polar Tracking increments

 7. Move cursor to hover over additional endpoint
 A. Move cursor until Tracking vectors intersect
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 8. Status Bar > Polar Tracking icon > Polar Tracking flyout > Tracking Settings...
 A. Object Snap Tracking Settings

 I. Track orthogonally only = checked
 B. OK

 9. Ribbon > Home tab > Draw panel > Polyline button
 A. Move cursor to hover over a Line endpoint
 B. Observe Object Snap Tracking activate
 C. Rotate cursor around active Object Snap Tracking location
 D. Observe Tracking vectors available based on x and y-axes only

 10. Move cursor to hover over activated Object Snap Tracking location again to deactivate

Exercise: align objects

 1. Continue working in acad-polr-osnp-trak-02.dwg
 2. Status Bar > Object Snap icon > Object Snap flyout

 A. Midpoint = checked
 B. Insertion Point = checked

 3. Select both SECTION A-A and SECTION B-B Mtext objects
 A. Hold shift

 I. Select middle insertion point grips on both Mtext objects
 II. Note grip color change to red

 A. Release shift
 4. Select one red Mtext grip to begin Move command

 A. Move cursor to hover over insertion point grip
 I. Observe insertion point Osnap Tracking activate

 B. Move cursor to hover over midpoint of top sheet border Line
 I. Observe midpoint Osnap Tracking activate

 C. Move cursor to intersection of Osnap Tracking vectors
 D. Left-click to specify destination location for Move command
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Exercise: lay out geometry

 1. Continue working in acad-polr-osnp-trak-02.dwg
 2. Status Bar > Object Snap icon > Object Snap flyout

 A. Endpoint = checked
 3. Status Bar

 A. Object Snap Tracking on
 B. Polar Tracking on
 C. Dynamic Input on

 4. Ribbon > Home tab > Draw panel > Polyline button
 A. Move cursor to hover over lower right sheet border Line endpoint

 I. Observe Object Snap Tracking activation
 II. Move cursor left of Endpoint Snap location along 180 deg Object Snap Tracking vec-

tor 
 a. 26 enter
 b. Move cursor above Line first point along 90 deg Object Snap Tracking vector

 i. 16.5 enter
 c. Move cursor right of Line second point along 0 deg Object Snap Tracking vec-

tor
 i. 26 enter
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AutoCAD modify
Last updated: 2023-01-04

Total video time: 44:42

Modify commands are used to make changes to objects that have already been drawn. These commands 
can greatly improve workflow efficiency by eliminating the need to re-create objects, streamlining object cre-
ation and location specification, combining multiple commands, and otherwise utilize existing geometry 
objects.

Move & Copy

Exercise files: acad-data-c3d20.zip

Start with acad-modify-begin.dwg

acad-modify-01.mp4 4:54

Move

The Move command allows you to relocate objects either by keying in X, Y, Z displacement or by cursor-
selecting a base point and destination point.
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 1. Open acad-modify-begin.dwg
 2. Ribbon > Home tab > Modify panel > Move 

Info: m is a command line "alias" that also invokes the move command.

 A. Select objects: SD.D.11.A 1-3 text in lower right of drawing extents 

 B. spacebar

 C. Specify base point: lower right Endpoint of sheet border Line

 D. Specify second point: pick anywhere to place new base point location

 E. Ctrl+z  to undo previous command.

 3. sRibbon > Home tab > Modify panel > Move
 A. Select objects: SD.D.11.A 1-3 text in lower right of drawing extents 
 B. Displacement 

 I. Enter
 C. -50,0,0

 I. enter
 D. Ctrl+z to undo previous command.

Copy

The Copy command allows you to duplicate an existing object and then paste it to a location either by key-
ing in X, Y, Z displacement or by cursor-selecting a base point and destination point.

 1. Continue working in acad-modify-begin.dwg
 2. Ribbon > Home tab > Modify panel > Copy 

Info: co is a command line "alias" that also invokes the copy command.

 A. Select objects: SD.D.11.A 1-3 text in lower right of drawing extents 

 I. Right-click or spacebar

 B. Specify second point: lower left Endpoint of sheet border Line

 C. Left-click multiple additional destination points

 D. Select copies made in above step and delete

 3. Ribbon > Home tab > Modify panel > Copy
 A. Select objects: SD.D.11.A 1-3 text in lower right of drawing extents 

 I. Right-click or spacebar
 B. Displacement

 I. enter
 C. -50,0,0

 I. enter
 D. Ctrl+z to undo previous command.

 4. Ribbon > Home tab > Modify panel > Copy
 A. Select text to copy

 I. Right-click or spacebar
 B. Mode

 I. Multiple (allows multiple copies of selected objects)
 C. spacebar to end command

Rotate & Scale
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Continue with acad-modify-begin.dwg

acad-modify-02.mp4 5:27

Rotate

The Rotate command allows you to rotate an object in the XY plane about a point either by keying in a rota-
tion angle, selecting a relative rotation point, or picking two points to form a reference "line" and two points 
to form a destination rotation "line". 

 1. Continue working in acad-modify-begin.dwg
 2. Select SD.D.11.A 1-3 text in lower middle of drawing extents 

 A. Select the square grip on the text
 B. Place the grip at the lower left corner of the sheet border to move the text

 3. Ribbon > Home tab > Modify panel > Rotate (roEnter for command line hotkey option)

Info: ro is a command line "alias" that also invokes the rotate command.

 A. Specify base point: lower left corner of the sheet border

 B. Specify rotation angle: 180 enter

 4. Ribbon > Home tab > Modify panel > Rotate
 A. Select SD.D.11.A 1-3 text

 I. Right-click or spacebar
 II. Specify base point: lower left corner of the sheet border

 III. Reference
 a. Left-click first and second reference angle points 

 b. Specify the new angle: p

 i. enter

 c. Left-click first and second new angle points 
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Scale

The Scale command allows you to resize a selection of objects while holding a specified base point either 
by keying in a scale factor or referencing existing objects.

 1. Continue working in acad-modify-begin.dwg
 2. Double-click middle mouse wheel to Zoom Extents
 3. Window-Select full-sized "PLAN VIEW"

 A. delete
 4. Ribbon > Home tab > Modify panel > Scale

Info: sc is a command line "alias" that also invokes the scale command.

 A. Select objects: Window-Select half-size objects to left of full-size objects

 B. Specify base point: lower right of half-size border Line

 C. Specify scale factor: 2 enter

 D. Ctrl+z to undo last command

 5. SC enter
 A. Window-Select half-sized objects to left of full-size objects
 B. Specify base point: lower right of half-size border Line
 C. R enter for Reference
 D. Specify reference length: Left-click beginning and end of bottom half-size border Line
 E. Specify new length: P enter

 I. Left-click beginning and end of bottom full-sized border Line
 6. Window Select "PLAN VIEW" objects that were Scaled up

 A. m enter
 B. Specify base point: lower left of bottom border Line that was Scaled up
 C. Specify second point: lower left of original full-size bottom border Line

 7. Select redundant border Lines
 A. delete

 8. Double-click middle mouse wheel to Zoom Extents

Join & Explode

Start with acad-modify-01.dwg

acad-modify-03.mp4 5:23

Join

The Join command will take all Line and/or Arcs objects included in a selection set that share common start 
and end point coordinates (same X,Y,Z) and combine them into a single Polyline.

 1. Open acad-modify-01.dwg

 2. Pan and zoom to PLAN VIEW detail

 3. Ribbon > Home tab > Modify panel flyout > Join 

Info: j is a command line "alias" that also invokes the join command.

 4. Select Lines and Arc representing median back of curb

 A. spacebar
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 5. Repeat above step on the other side. 
 6. Ribbon > Home tab > Modify panel flyout > Join
 7. Select all "breakline symbol" Polylines along right side of PLAN VIEW detail

 A. enter
 8. Observe "0 objects joined, 6 objects discarded..." on command line history
 9. Select  "breakline symbol" Polyline near bottom right of PLAN VIEW detail

 A. Left-click vertex grip
 B. Use Endpoint Object Snap to set vertex at same location as adjacent Polyline vertex
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 10. esc
 11. Ribbon > Home tab > Modify panel flyout > Join

 A. Select two Polylines whose vertices were aligned in previous step. 
 B. enter
 C. Observe "5 segments joined into 1 polyline" on command line history

 12. Ribbon > Home tab > Modify panel flyout > Join
 A. Select all 4 sides of sheet border.
 B. enter
 C. Observe "3 objects converted to 1 polyline, 1 objects discarded..." on command line history

 I. In the Properties palette, observe that the left sheet border line has a different elev-
ation at its vertices than the polyline created with the previous join command. 

 II. Set the Z axis on the left line to 0.

Info: All linework must be have the same elevation (Z) value in order for the 
join command to work. 

 D. Ribbon > Home tab > Modify panel flyout > Join
 I. Select all sheet border linework.

 II. enter
 III. Observe that the border is 1 polyline. 
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Explode

The Explode command will break objects down into foundational pieces. For example, a single Polyline can 
be Exploded into multiple Lines and/or Arcs that make up the Polyline geometry.

Warning: Never Explode a Civil 3D Object (i.e. Alignment, Surface, Corridor). This will cause you to 
lose dynamic updating, labeling, data referencing and other powerful object functionality. Thus, the 
Explode command should be limited to simple AutoCAD objects as demonstrated in this section.

 

 1. Continue working in acad-modify-01.dwg

 2. Ribbon > Home tab > Modify panel > Explode

Info: x is a command line "alias" that also invokes the explode command.

 3. Select PLAN VIEW median Polyline previously Joined

 A. enter

 4. Zoom and pan to R3-4 signage detail

 5. x enter

 A. Select R3-4 Block

 B. enter

 6. x enter

 A. Select outermost Polyline resulting from the Exploded R3-4 Block

 B. enter
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Erase & Stretch

Continue with acad-modify-01.dwg

acad-modify-04.mp4 3:02

Erase

The Erase command allows you to remove a selection set of objects from a drawing. You can either invoke 
the command and then select objects to remove using your selection method of choice or vice-versa.

Tip: It is a good idea to hit esc a couple times before selecting objects to erase. This will ensure that 
you do not have objects selected that you do not intend to erase. Selected objects are not always vis-
ible depending your current Zoom level and Pan location. Your Properties Palette is a good place to 
check on what is included in the current selection set.

 

 1. Continue working in acad-modify-01.dwg

 2. Ribbon > Home tab > Modify panel > Erase

Info: e is a command line "alias" that also invokes the erase command.

 3. Select outermost Lines surrounding the R3-4 and R3-4A details
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 A. enter

Stretch

The Stretch command allows you to move objects and simultaneously lengthen and reorient adjacent 
objects while maintaining the original attachment location. After invoking the Stretch command, any objects 
completely enclosed in a Crossing selection will be moved and any objects partially enclosed in the same 
Crossing selection will be lengthened and reoriented.

 1. Continue working in acad-modify-01.dwg

 2. Ribbon > Home tab > Modify panel > Stretch

Info: str is a command line "alias" that also invokes the stretch command.

 3. Use a Window Selection to select all "breakline symbol" Polylines on the left side of the PLAN VIEW 
detail

 A. enter
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 B. Right-click to finish selection

 I. Left-click to specify base point

 II. Move Cursor and Left-click to specify second point

 III. Observe move-only behavior

 4. Ctrl+z to undo last command.

 5. Ribbon > Home tab > Modify panel > Stretch

 6. Use a Crossing Selection to select all "breakline symbol" Polylines on the left side of the PLAN 
VIEW detail

 A. enter
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 B. Right-click to finish selection

 I. Left-click to specify base point

 II. Move Cursor and Left-click to specify second point

 III. Observe intended Stretch behavior

Mirror & Offset

Start with acad-modify-02.dwg

acad-modify-05.mp4 5:52

Mirror

The Mirror command allows you to essentially copy, rotate, and paste an object in the X-Y plane about a 
mirror line you specify. You can then choose to keep or remove the original object you have mirrored. This 
can greatly reduce your task time  whenever you are creating object with an axis of symmetry in the X-Y 
plane.

 1. Open acad-modify-02.dwg

 2. Zoom and Pan to PLAN VIEW detail area of drawing

 3. Ribbon > Home tab > Modify panel > Mirror

Info: mi is a command line "alias" that also invokes the mirror command.

 4. Select "section line arrow" and "B" Text in upper pavement area of PLAN VIEW detail
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 A. Right-click

 B. Turn on Quadrant Osnap

 C. Use Quadrant Osnap to specify first point of mirror line at quadrant point on median Arc

 D. Use Quadrant Osnap to specify second point of mirror line at center of opposite median Arc

 A. Erase source objects: N

 I. enter

 5. mi enter

 A. Select "THROUGH PAVEMENT" Text and adjacent "arrow symbol"

 B. Right-click

 C. Turn on Midpoint Osnap

 D. Use Midpoint Osnap to specify first point of mirror line at upper midpoint of edge-of-pave-
ment Line

 E. Use Midpoint Osnap to specify second point of mirror line at lower midpoint of edge-of-pave-
ment Line
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 F. Erase source objects: N

 I. enter

 6. Select newly created "THROUGH PAVEMENT" Text and adjacent "arrow symbol"

 7. m enter

 A. Specify base point and second point to move objects to lower pavement area of PLAN VIEW 
detail

Offset

The Offset command allows you to create an object in reference to existing Polyline, Line or Arc objects. 
The geometry of the newly created objects is dictated by a constant distance measured perpendicularly 
from the source object. You can call out the offset distance using a known numeric value or by specifying 
an offset location using your cursor. This tool is especially helpful when laying out proposed roadway or par-
cel linework (i.e. Edge of Pavement, ROW)

Tip: Using modify commands such as Offset to manipulate Polylines is a great way to lay the found-
ation for dynamic Civil 3D Objects. This is because many dynamic Civil 3D Objects (i.e. Alignment, 
Feature Line) can be initially created from simpler AutoCAD Objects (i.e. Polyline). 

 

 1. Continue working with acad-modify-02.dwg
 2. Zoom and Pan to SECTION A-A detail area of drawing
 3. Ribbon > Home tab > Modify panel > Offset button

Info: of is a command line "alias" that also invokes the offset command.

 A. Specify offset distance: 1.5

 B. enter
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 C. Select object to offset: select subgrade Line on left side of SECTION A-A detail

 D. Specify point on side to offset:  left-click above subgrade Line

 A. enter or esc to end command.

 4. Of enter
 A. Specify offset distance: Through

 B. Turn on Endpoint Osnap
 C. Specify through point: Endpoint of median nose Arc

 D. Select object to offset: select "CRUSHED AGGREATED BASE COURSE 
SHOULDER" Line on right side of SECTION A-A detail

 E. Specify through point: Endpoint of median nose Arc on right side of SECTION A-A 
detail

 5. of enter
 A. select object to offset: MEDIAN FORESLOPES Polyline in SECTION B-B detail
 B. Specify offset distance: 10

 I. enter
 C. specify point on side to offset: above selected Polyline
 D. Repeat above steps selecting previously offset Polyline as object to offset

 I. Observe disappearance of Arc segment on offset Polyline
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Trim, Extend & Lengthen

Continue with acad-modify-02.dwg

acad-modify-06.mp4 5:36

Trim

The Trim command allows you to modify existing geometry such that a section is removed based on inter-
section with other referenced existing geometry. For example, a Line can be shortened to the point at which 
it intersects with another Line. The Trim command applies to objects such as Line, Polyline, Circle, Ellipse, 
and Arc.

 1. Continue working with acad-modify-02.dwg
 2. Zoom and Pan to SECTION A-A detail area of drawing
 3. Ribbon > Home tab > Modify panel > Trim

Info: tr is a command line "alias" that also invokes the trim command.

 A. Select Objects: select smaller Arc intersecting with Line representing AGGREGATE 
SHOULDER

 B. spacebar

 C. Trim: select segment of Line you wish to trim

 D. enter or esc to end command. 
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Extend

The Extend command is essentially the reverse of the Trim command. Extend allows you to lengthen a geo-
metry object (i.e. Line, Polyline, Arc) up to the point where it would intersect referenced existing geometry.

 1. Continue working with acad-modify-02.dwg
 2. Ribbon > Home tab > Modify panel > Extend

Info: ex is a command line "alias" that also invokes the extend command.

 A. Select Objects: select median nose Arc on right side of SECTION A-A detail

 B. spacebar

 C. Extend: select Line you wish to extend

 D. enter or esc to end command. 
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Tip: 
Hold shift while the Trim command is active in order to switch to the Extend command on the fly.

While selecting objects to Extend or Trim, choose the mid-command option <select all>. This 
allows you to use any existing geometry object as a potential Extend boundary or Trim cutting 
edge.

Lengthen

The Lengthen command allows you to continue an object along it's current direction without the need for 
existing geometry to serve as a boundary to extend to. You can use Object Snaps to specify the amount 
you wish to lengthen the object. The Lengthen command also includes mid-command options to measure 
selected object geometry.

 1. Continue working with acad-modify-02.dwg
 2. Ribbon > Home tab > Modify flyout > Lengthen

Info: len is a command line "alias" that also invokes the length command.

 A. Select an object to measure or: DY
 I. enter

 B. Select an object to change: select Line on left side of SECTION A-A representing 
SUBGRADE

 C. specify new end point: use Endpoint Osnap to select the end of the Line rep-
resenting CRUSHED AGGREGATE BASE COURSE SHOULDER on the right side of 
SECTION A-A detail

 D. enter
 E. tr enter

 I. Trim the middle of the lengthened line using the 2 should arcs. 

Fillet & Break

Start with acad-modify-03.dwg

acad-modify-07.mp4 6:14
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Fillet

The Fillet command allows you to insert an Arc at the intersection (or apparent intersection) of two Lines (or 
Polylines) and trim the Lines at the points of tangency of the Arc. Fillet mid-command options allow you to 
specify Radius, apply Fillets to all line segment intersections on a Polyline, or continue the command and 
apply it multiple times consecutively.

 1. Open acad-modify-03.dwg
 2. Zoom and Pan to R3-4 sign above PLAN VIEW detail
 3. Ribbon > Home tab > Modify panel > Fillet

Info: f is a command line "alias" that also invokes the fillet command.

 A. Select first object or: R

 I. enter

 B. specify fillet radius: 0

 I. enter

 C. Select first object: select one of the outermost R3-4 detail Lines

 D. Select second object to apply corner: select adjacent R3-4 detail Line

 4. f enter
 A. Select first object or: R

 I. enter
 B. specify fillet radius: 0.35

 I. enter
 C. Select first object: select one of the outermost R3-4 detail Lines
 D. Select second object to apply corner: select adjacent R3-4 detail Line
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 5. f enter
 A. Select first object or: Multiple

 I. enter
 B. Apply Fillets to all remaining outermost R3-4 detail Lines

 I. enter
 6. Select all four innermost Lines on R3-4 detail

 A. j enter

 B. f enter
 C. Select first object or: R

 I. enter
 D. specify fillet radius: 0.2

 I. enter
 E. Select first object or: polyline

 I. enter
 F. Select 2d polyline: select Polyline formed in Step 6.A

Tip: Use the Fillet command with radius=0 to extend line segments to their point of apparent inter-
section. The arc segment will then be omitted.

Break

The Break command allows you to create two Lines or Polylines from a single existing Line. You have the 
option to Break the Line at a single point so that the two resulting Lines share a common endpoint location 
or to Break the Line at two points so that a gap is formed between the two resulting Lines.

 1. Continue working with acad-modify-03.dwg
 2. Zoom and Pan to PLAN VIEW detail area of drawing
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 3. Ribbon > Home tab > Modify flyout > Break

Info: br is a command line "alias" that also invokes the break command.

 A. Select object: select Line bounding MEDIAN SHOULDER on bottom side of 
PLAN VIEW detail tangent to median Arc

 B. Specify second break point or: first point

 C. Specify first break point: Use Endpoint Osnap to select intersection of median 
Arc and Line

 D. Specify second break point or: Use Endpoint Osnap to select intersection of 
median Arc and Line on opposite side of median crossover detail

 4. Ribbon > Home tab > Modify flyout > Break at Point

 A. Select object: select Line bounding MEDIAN SHOULDER on top side of 
PLAN VIEW detail tangent to median Arc
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 B. Specify second break point: Use Endpoint Osnap to select intersection of median 
Arc and Line

 5. Repeat the previous step on the opposite side of median crossover detail.

 6. Select and delete the middle line that was created from the previous 2 steps. 

Array

Continue with acad-modify-04.dwg

acad-modify-08.mp4 4:36

The Array command allows you to copy a selected object and paste the object repetitively in a Rectangular, 
Polar, or Path based Array. A Rectangular Array is arranges the copied object in rows and columns. A Polar 
Array arranges the copied object at a radius and incremental angle about a specified location. A Path Array 
arranges the copied object at a specified location along a path based on an existing Line or Polyline. This 
section will cover the Rectangular Array.

 1. Open acad-modify-04.dwg
 2. Zoom and Pan to PLAN VIEW detail area of drawing
 3. Select Polyline representing "breakline symbol"
 4. Ribbon > Home tab > Modify panel > Array (Rectangular)

Info: ar is a command line "alias" that also invokes the array command.

 A. Ribbon > Array contextual tab > Columns panel

 I. Columns = 1

Page: 94

Published on: 5/1/2024

AutoCAD modify

https://c3dkb.dot.wi.gov/video/acad/acad-modify-08.mp4


 B. Ribbon > Array contextual tab > Rows panel

 I. Rows =6

 C. Select grip to edit array or: Spacing

 I. enter

 D. Specify distance between rows: Use Endpoint Osnap to select two similar points 
on "breakline symbol" Polylines on left side of PLAN VIEW

 I. enter

 II. enter or esc to end command. 

Reverse & Align

Continue with acad-modify-04.dwg

acad-modify-09.mp4 3:38

Reverse

The Reverse command will change the order of Polyline vertices. This is helpful when you wish to add a ver-
tex to the end of an existing Polyline. By default, Civil 3D will add the vertex in front of the highest numbered 
vertex (the last vertex placed). If you want to add a vertex to the end of the lowest numbered vertex (vertex 
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1), it will instead be placed between vertex 1 and 2. The order of Polyline and Line vertices also affects how 
a Linetype is generated. Linetypes will start at vertex 1.

 1. Continue working with acad-modify-04.dwg
 2. Open Properties Palette

 A. props
 I. enter

 3. Select Polyline drawn along bottom of 10" CRUSHED AGGREGATE BASE COURSE Hatch
 A. Properties palette > Geometry dropdown > Current Vertex
 B. Toggle between numbered vertices
 C. Observe glyph showing vertex location in drawing area

 D. Hover cursor over vertex 1
 I. Add vertex

 II. Observe default placement of new vertex
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 E. Ribbon > Home tab > Modify flyout > Reverse
 I. Properties palette > Geometry dropdown > Current Vertex

 II. Observe reversed order of Polyline vertices
 F. Hover cursor over vertex 5

 I. Add vertex
 II. Observe default placement of new vertex

 III. Use desired Osnap to place new vertex

Align

The Align command combines the functionality of the Move, Rotate, and Scale commands. Most basic 
AutoCAD objects can be affected by the Align command (i.e. Polyline, Block, Hatch, Text). Once the com-
mand is activated, you will select objects to Align then select at least two source and destination points. If 
any rotation, repositioning, or scaling is necessary to replace the source points with destination points, the 
Align tool will do this for you.

 1. Continue working with acad-modify-04.dwg
 2. Zoom and Pan to area including SECTION A-A detail and misaligned objects above sheet border 

Line
 3. Ribbon > Home tab > Modify flyout > Align

Info: al is a command line "alias" that also invokes the align command.

 A. Select objects: select misaligned objects above sheet border Line

 I. Right-click

 B. Specify first source point: use Endpoint Osnap to select lower left Polyline ver-
tex

 C. Specify first destination point: use Endpoint Osnap to select analogous des-
tination point on SECTION A-A detail
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 D. Specify second source point: use Endpoint Osnap to select lower right Polyline 
vertex

 E. Specify second destination point: use Endpoint Osnap to select analogous 
destination point on SECTION A-A detail

 F. specify third source point or <continue>:

 I. spacebar

 G. Scale objects base on alignment point?: y

 I. enter

Hatch
Last updated: 2023-01-04

Total video time: 15:15

A Hatch is an object that fills in a bounded area and displays either a Solid, Pattern, or Gradient. The dis-
play of the Hatch can be affected by setting a hatch scale, rotation, color (typically ByLayer), and/or trans-
parency. The origin of the Hatch pattern can be reset so that it displays appropriately depending on the 
shape of the area filled, the hatch rotation, and the hatch scale.

There are also options to associate the Hatch with a boundary object such as a Polyline, so that a change 
to the boundary object will affect the Hatch accordingly such as with a Move, Scale or Rotate command. A 
Hatch object can be made Annotative so that the scale of the drawing dictates the scale of the Hatch. There 
are several additional Hatch options such as Match Properties and Separate Hatches that affect the way a 
Hatch is defined.

Warning: Having a large number of Hatch objects can significantly reduce drawing performance and 
stability. This is especially true if Hatch transparency and/or associative hatches are used.

Info: Many of the desired effects of a Hatch object are handled by Styles when working with Civil 3D 
objects (i.e. Surface, Pipe Network, or Corridor objects). This has the benefit of the "hatched" area of 
the Civil 3D object being created automatically as part of the object, being dynamically linked to the 
object, and being turned on/off at any time by editing Style display settings.
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Hatch Creation, Pattern, & Properties

Exercise files: acad-data-c3d20.zip

Start with acad-htch-begin.dwg

acad-htch-01.mp4 7:11

Hatch creation

 1. Open acad-htch-begin.dwg
 2. Zoom and Pan to SECTION A-A detail
 3. Ribbon > Home tab > Draw panel > Hatch

 4. Hatch Pick internal point or: leave default to pick internal point
 A. Or, if necessary, Hatch Select objects or: pick internal point
 B. Move cursor inside area bounded by Lines representing 4" ASPHALTIC CONCRETE
 C. Observe Hatch preview

 D. Left-click to place Hatch
 E. enter

 F. Select previously created Hatch
 I. delete

Page: 99

Published on: 5/1/2024

Hatch

https://c3dkb.dot.wi.gov/data/acad/acad-data-c3d20.zip
https://c3dkb.dot.wi.gov/video/acad/acad-htch-01.mp4


 5. Ribbon > Home tab > Draw panel > Hatch
 A. Ribbon > Hatch contextual tab > Boundaries panel > Select

 B. Or, if necessary, Hatch Select objects or: pick internal point
 C. Select individual Lines bounding SECTION A-A PAVEMENT area

 I. enter

 D. Select previously created Hatch
 I. delete

 6. Select individual Lines bounding SECTION A-A PAVEMENT area
 A. j enter

 7. Ribbon > Home tab > Draw panel > Hatch
 A. Ribbon > Hatch contextual tab > Boundaries panel > Select
 B. Select single Polyline bounding SECTION A-A PAVEMENT area

 I. enter
 8. Ribbon > Home tab > Draw panel > Hatch

 A. Ribbon > Hatch contextual tab > Pattern panel > ANSI31
 B. Ribbon > Hatch contextual tab > Boundaries panel > Pick Points
 C. Left-click inside Lines bounding both SECTION A-A TOPSOIL areas

 I. enter

 9. Ribbon > Home tab > Draw panel > Polyline
 A. Use Endpoint Osnap to pick vertices bounding SECTION A-A 10" CRUSHED AGGREGATE 

BASE COURSE area
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Tip: It may be necessary to create a Polyline to help with Hatch creation if existing linework does not 
get you the results you are after. You can delete the Polyline afterward if desired and still retain the 
Hatch.

Pattern & Properties

Use the Pattern panel flyout found on the Hatch contextual tab to choose from the available Patterns. Use 
the Properties panel to set fill type (Pattern, Solid, or Gradient), scale, rotation angle, and transparency. A 
Hatch scale will work in combination with the drawing scale if the Hatch is set to be annotative (see Asso-
ciative & Annotative section). 

 10. Ribbon > Home tab > Draw panel > Hatch
 A. Ribbon > Hatch contextual tab > Pattern panel > ANGLE
 B. Ribbon > Hatch contextual tab > Boundaries panel > Select

 I. Select Polyline bounding SECTION A-A 10" CRUSHED AGGREGATE BASE 
COURSE area

 a. enter
 II. Select Polyline bounding SECTION A-A 10" CRUSHED AGGREGATE BASE 

COURSE area
 a. delete

 11. Select previously created TOPSOIL Hatch
 A. Ribbon > Hatch contextual tab > Properties panel

 I. Hatch pattern scale = 10
 B. Ribbon > Hatch contextual tab > Pattern panel flyout

 I. Patten = AR-SAND

Associative & Annotative

Start with acad-htch-01.dwg

acad-htch-02.mp4 5:04

Page: 101

Published on: 5/1/2024

Hatch

https://c3dkb.dot.wi.gov/video/acad/acad-htch-02.mp4


Associative Boundaries

A Hatch is an independent object. As such, it does not depend on the presence of a boundary object in 
order to be retained after it is first generated. If desired, however, a Region or Polyline boundary can be cre-
ated to aid in moving or retaining the original shape of a Hatch. For example, a Polyline boundary provides 
basepoint grips when performing a Move command on a Hatch. A Region will retain the original shape of 
the Hatch in the event the Hatch needs to be rebuilt. In order for the Hatch to move with or respond to edit to 
the boundary, the boundary must be made associative.

 1. Open acad-htch-01.dwg
 2. Zoom and Pan to left side of SECTION B-B detail
 3. Select Hatch representing PAVEMENT section

 A. M enter
 I. Select basepoint and second points

 a. Observe lack of Hatch boundary

 4. Select Hatch
 A. Observe available grips
 B. M enter

 I. Observe lack of grips during Move command
 II. esc

 5. Ctrl+z to undo initial Move
 6. Select Hatch

 A. Ribbon > Hatch contextual tab > Boundaries panel > Recreate
 I. Enter type of boundary object: Polyline

 a. enter
 II. Associate hatch with new boundary? Y

 a. enter
 B. esc

 7. Select Hatch boundary Polyline
 A. M enter

 I. Select basepoint and second point
 II. Observe Hatch association with Polyline

 8. Select Hatch boundary Polyline
 A. M enter

 I. Use Endpoint Osnap to move Polyline back to original location
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Annotative

Annotative scaling is used to dynamically set an annotative object's displayed scale based on the current 
drawing scale. It can also be used control visibility of annotative objects based on inclusion of scales in an 
object's annotative scales list. The end goal here is to display objects at the correct scale when plotting lay-
outs. More detail on annotative scaling in general can be found in the training module dedicated to the 
topic. This section will walk you through making a Hatch annotative and managing the annotative scales 
list. You will also see how the Hatch pattern scale is different from a Hatch annotative scale, and how the 
two can work together.

 1. Continue working in acad-htch-01.dwg
 2. Select Hatch representing PAVEMENT section on left side of SECTION B-B detail

 A. Ribbon > Hatch contextual tab > Properties panel
 I. Observe Hatch pattern scale = 5.0000

 B. Properties palette > Pattern dropdown 
 I. Annotative = Yes
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 A. Observe Hatch pattern displayed scale change
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 B. Ribbon > Hatch contextual tab > Properties panel
 I. Hatch pattern scale: 0.5

 3. Status bar > Current drawing scale flyout
 A. Select 1 IN:5 FT
 B. Observe no change in Hatch pattern displayed scale

 4. Status bar > Current drawing scale flyout
 A. Select 1 IN: 10 FT

 5. Select Hatch representing PAVEMENT section on left side of SECTION B-B detail
 A. Ribbon > Hatch contextual tab > Properties panel

 I. Pattern dropdown > Annotative scale > dialog box icon
 a. Annotation Object Scale dialog

 i.  Add...
 i. Add Scales to Object dialog

 i. 1 IN:5 FT
 ii. OK
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 6. Status bar > Current drawing scale flyout
 A. Select 1 IN:5 FT
 B. Observe change in Hatch pattern displayed scale

Match Properties & Separate Hatches

Continue with acad-htch-01.dwg

acad-htch-03.mp4 3:00

Match Properties

Use the Match Properties button found on the Hatch contextual tab to push pattern, color, transparency, 
and Hatch pattern scale from a source to destination Hatch. This saves you time if you need to update mul-
tiple Hatches to have similar Hatch properties. 
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 1. Continue working in acad-htch-01.dwg
 A. Select PAVED SHOULDER Hatch on left side of SECTION B-B detail
 B. Ribbon > Hatch contextual tab > Options panel > Match Properties

 I. Select FINISHED SHOULDER as source Hatch

Separate Hatches

You can set your Hatch creation options so that picking multiple bounded areas while in a single Hatch com-
mand creates either a single Hatch throughout all bounded areas or individual Hatch objects for each 
bounded area. You can also break an existing single Hatch that covers multiple bounded areas into sep-
arate Hatch objects for each bounded area.
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 1. Continue working in acad-htch-01.dwg
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 A. Zoom and Pan to PLAN VIEW detail
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 B. Ribbon > Home tab > Draw panel > Hatch
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 I. Ribbon > Hatch contextual tab > Options flyout
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 a. Hatch and Gradient dialog
 i. Create separate hatches = unchecked

Page: 112

Published on: 5/1/2024

Hatch



 II. Pick internal points in the three bounded areas along top of PLAN VIEW detail
 a. enter
 b. Observe a single Hatch object created that covers all three bounded areas

 C. Ribbon > Home tab > Draw panel > Hatch
 I. Ribbon > Hatch contextual tab > Options flyout

 a. Hatch and Gradient dialog
 i. Create separate hatches = checked

 II. Pick internal points in the MEDIAN SHOULDER and median crossover areas 
through center of PLAN VIEW detail

 a. enter
 b. Observe multiple Hatch objects created for the bounded areas

 D. Select Hatch created in step 1.B
 I. Ribbon > Hatch contextual tab > Options dropdown > Separate Hatches

 II. Observe single Hatch split into multiple Hatches

Grips
Last updated: 2023-01-04

Total video time: 22:50

Object Grips are used to interact with and edit objects in through the drawing view (i.e. Model Space). Upon 
selecting an object, available Grips will display for the object(s) selected. Depending on the type of object 
selected, you may have Multifunction Grips allowing access to several options for Grip editing. Additionally, 
for all Grips, you can cycle between Grip Modes including Move, Rotate, Scale, and Mirror. Though many 
of the edits you perform using Grips can be handled elsewhere, utilizing Grip edits in combination with 
object snaps, polar tracking, and dynamic input can significantly expedite your object editing workflow.
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Basics: stretch vs move

Exercise files: acad-data-c3d20.zip

Start with acad-grips-begin.dwg

acad-grips-01.mp4 3:50

Arguably the most basic Grip function is the Stretch. Within the category of Stretch Grip functions, are two 
distinct types of editing behavior: Stretch and "move". In general, an endpoint  Grip has a Stretch behavior 
and a midpoint or insertion Grip has "move" behavior. The Stretch behavior relocates the Grip and changes 
the length or radius and rotation or center point of an object as necessary. The "move" behavior will relo-
cate the Grip and object while retaining all other object geometry properties such as length and rotation.

Grips with Stretch function exhibiting "stretch" behavior:

 l Polyline vertex and endpoint
 l Line endpoint
 l Arc endpoint

Grips with Stretch function exhibiting "move" behavior

 l Text insertion point 
 l Line midpoint
 l Circle center
 l Block insertion point
 l COGO Point

Info: The COGO Point is a Civil 3D object. COGO Points are covered in detail in later training mod-
ules and thus are not included in the example workflows here.

 1. Open acad-grips-begin.dwg
 2. Select CRUSHED AGGREGATE BASE COURSE SHOULDER Line on left side of SECTION A-A 

detail
 A. Observe display of two endpoint Grips and one midpoint Grip
 B. Left-click midpoint Grip to activate

 I. Move cursor and observe behavior
 II. esc to deselect
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 3. Select R3-4 Block at top of PLAN VIEW detail
 A. Observe display of insertion point Grip
 B. Left-click insertion point Grip to activate

 I. Move cursor and observe behavior
 II. esc to deselect

 4. Select SECTION A-A Text
 A. Properties palette > Text dropdown > Justify

 I. Observe Justify = Center
 B. Left-click insertion point Grip

 I. Move cursor and observe behavior
 II. esc to deselect

 5. Zoom & Pan left of SECTION A-A detail
 6. Select red guiding Circle

 A. Observe display of four quadrant Grips and one center Grip
 B. Left-click center Grip to activate

 I. Move cursor and observe behavior
 II. esc to deselect

 7. Select CRUSHED AGGREGATE BASE COURSE SHOULDER Line on left side of SECTION A-A 
detail

 A. Left-click endpoint Grip to activate
 I. Move cursor and observe behavior

 II. esc to deselect

 8. Select the Polyline bounding 10" CRUSHED AGGREGATE BASE COURSE Hatch
 A. Left-click insertion Grip to activate

 I. Move cursor and observe behavior
 II. esc to deselect

 9. Select the SECTION A-A detail median nose Arc
 A. Left-click center Grip to activate

 I. Move cursor and observe behavior
 II. esc to deselect

Shift+select multiple

Continue with acad-grips-begin.dwg

acad-grips-02.mp4 6:08
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Hold the Shift key and select multiple Grips to simultaneously apply a similar Grip edit to multiple object 
Grip locations. The Grips will display red once selected and activated. Release the Shift key and select one 
of the activated Grips to apply a Grip edit as normal. The Grip edit will then be applied to all Grips included 
in the selection.

 1. Continue working in acad-grips-begin.dwg
 2. Zoom and Pan left of SECTION A-A detail
 3. Observe location of red guiding Circles
 4. Turn on Center and Endpoint Object Snaps
 5. Select BOTTOM OF MEDIAN Line

 A. Left-click left-most endpoint Grip
 I. Specify stretch point or:

 a.  Use Osnaps to relocate Line endpoint at center of guiding Circle

 6. Select both CRUSHED AGGREGATE BASE COURSE and SUBGRADE Lines
 A. shift+select both leftmost endpoint Grips

 I. Release shift key
 II. Left-click one of the shift+selected Grips

 a. Use Osnaps to relocate Line endpoints at center of guiding Circles

 III. esc to deselect
 7. Select PAVED MEDIAN SHOULDER Line

 A. Verify Dynamic Input is on
 I. Status bar > Customization button

 a. Dynamic Input = checked
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 II. Status bar
 a. Dynamic Input toggled on

 B. Hover cursor over leftmost Line endpoint
 I. Observe Dynamic Input tooltip

 a. Lengthen
 II. Specify end point: 5 enter

 III. Use Osnaps to Lengthen Line to center of red guiding Circle
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 8. Select both CRUSHED AGGREGATE BASE COURSE and SUBGRADE Lines
 A. shift+select both leftmost endpoint Grips

 I. Release shift key
 II. Left-click one of the shift+selected Grips

 a. ctrl to cycle Grip function = Lengthen

 B. Use Osnaps to Lengthen Lines to leftmost endpoint of PAVED MEDIAN SHOULDER Line
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 C. esc to deselect
 9. Pan to right of SECTION A-A detail

 A. Use crossing selection to select TOPSOIL Hatch and bounding Lines

 A. shift-select appropriate endpoints of selected objects
 I. Release shift key

 II. Select rightmost endpoint of BOTTOM OF MEDIAN Line
 a. Move cursor and observe behavior
 b. Use Osnaps to uniformly relocate selected linework endpoints

Ctrl+select to copy

Continue with acad-grips-begin.dwg

acad-grips-03.mp4 2:10

Hold the ctrl key when selecting a Grip to make a copy of the objects attached to the Grip. For example, 
ctrl+select a Text Grip to copy the full Text object. Ctrl+select a Polyline vertex to copy and  the Line sege-
ments touching the selected Grip(s). You can combine the ctrl+select  technique with the shift+select tech-
nique to copy multiple objects attached to the shift+selected Grips
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 1. Continue with acad-grips-begin.dwg
 2. Select SECTION A-A Text

 A. ctrl+select insertion point Grip
 I. Release ctrl key

 II. Pan to SECTION B-B detail
 a. Use Osnaps to place copied Text at center red guiding Circle
 b. esc to deselect

 3. Pan to PLAN VIEW detail
 4. Select breakline symbol Polyline at top-right of PLAN VIEW detail

 A. shift+select all vertex Grips
 B. Release shift key

 I. ctrl+select righ-most vertex Grip
 II. Release ctrl key

 a. Use Osnaps to place copies at all remaining red guiding Circles
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 b. esc to deselect

Grip modes

Start with acad-grips-01.dwg

acad-grips-04.mp4 6:57

In addition to object-specific Grip edit behavior, all Grips have the ability to edit associated objects using 
four standard behaviors. These standard Grip editing behaviors are known as Grip Modes. They include 
Move, Rotate, Scale, and Mirror.  Once an object is selected and a Grip is activated, use the enter key to 
cycle between Grip Modes. Once you begin cycling, you are limited to one of the four standard Grip Modes. 
Hit esc and re-activate a Grip to perform a non-Grip Mode edit such as Stretch or Lengthen.

 1. Open acad-grips-01.dwg
 2. Zoom and Pan to PLAN VIEW detail
 3. Select  Line just below R3-4A signage

 A. Left-click topmost endpoint Grip
 I. Observe command line prompt Specify stretch point or:

 II. Move cursor and observe behavior
 a. enter

 III. Observe command line prompt change Specify stretch Move or:
 IV. Repeat steps 3.A.I - 3.A.III to cycle all Grip Modes
 V. esc

 B. esc to deselect
 4. Zoom and Pan to SECTION A-A detail
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 5. Select CRUSHED AGGREGATE BASE COURSE SHOULDER Multileader
 A. Left-click leader Grip

 I. enter
 II. Specify move point or: Copy

 a. Left-click to place a copy of Multileader on right side of SECTION A-A detail
 b. esc to deselect

 6. Pan to SECTION B-B detail
 7. Verify midpoint Object Snap is on
 8. Window select breakline symbol Polyline and Hatch near EDGE OF PAVEMENT Multileader

 9. Left-click one of the displayed Grips
 A. enter to cycle to Mirror Grip Mode

 I. Specify second point or: Base point
 a. Use midpoint Object Snap to specify midpoint of 4" ASPHALTIC 

CONCRETE Polyline
 II. specify second point or: copy

 a. Hold shift for temporary Orthomode
 b. Left-click second mirror point above basepoint
 c. esc to deselect
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 10. Select PAVED SHOULDER Hatch one left side of SECTION B-B detail
 A. Left-click a displayed Grip

 I. Right-click
 a. Mirror

 i. Specify second point or: Base point
 i. Use midpoint Object Snap to specify midpoint of 4" 

ASPHALTIC CONCRETE Polyline
 ii. specify second point or: copy

 i. Hold shift for temporary Orthomode
 ii. Left-click second mirror point above basepoint
 iii. esc to deselect
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Multifunction grips

Continue with acad-grips-01.dwg

acad-grips-05.mp4 3:45

In addition to the four standard Grip Modes, some objects have Multifunction Grips. The first example we 
saw of this was the Line endpoint Grip. This is a Multifunction Grip with Stretch and Lengthen functions. 
Once a Multifunction Grip is activated, use the ctrl key to cycle between Grip functions. When only a single 
Multifunction Grip is activated, hover your cursor over the Grip to see a Multifunction Grip menu. This menu 
will not display when multiple Grips are activated such as when shift+selecting multiple Grips. 

 1. Continue with acad-grips-01.dwg
 2. Zoom and Pan to SECTION B-B detail
 3. Select MEDIAN FORESLOPES APPROACHING CROSSOVER Multileader

 A. Left-click the leader landing Grip
 I. ctrl to cycle Grip functions to Add Leader

 a.  specify leader arrowhead location:
 i. Use endpoint Object Snap to specify location at Arc endpoint
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 II. ctrl to cycle Grip functions to Stretch
 a. Use red guiding Circle to relocate leader vertex

 B. Select Polyline representing MEDIAN FORESLOPES APPROACHING CROSSOVER
 I. Left-click Polyline arc segment midpoint Grip

 a. ctrl to cycle Grip functions to Convert to Line
 b. enter

 C. Select Polyline representing MEDIAN FORESLOPES APPROACHING CROSSOVER
 I. Left-click Polyline line segment midpoint Grip

 a. ctrl to cycle Grip functions to Convert to Arc
 i. specify midpoint of arc segment:

 i. Use Osnaps to place specify center of red guiding Circle 
 ii. esc to deselect

Layers and their properties
Last updated: 2023-01-04

Total video time: 29:42

Layer basics

Exercise files: acad-data-c3d20.zip

Start with acad-layr-prprtis-begin.dwg

acad-layr-prprtis-01.mp4 4:53

Layers in AutoCAD are used to control object display properties, visibility, plotting, object selection, and 
organization. All objects in a drawing will reside on a Layer. The Layer an individual object resides on is 
known as the Object Layer. When AutoCAD objects are created, they will be placed on the Current Layer. 
You can set which Layer is the Current Layer either through the Ribbon Layer Panel or Layer Properties 
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Manager. Some of the most commonly used/edited Layer properties are On/off, Isolate/unisolate, 
Freeze/thaw, Lock/unlock.

Info: 
Civil 3D objects are made up of components. For example, an Alignment can have Line, Curve, 
Spiral, and/or other components. The object and it's components can all be on unique layers. When 
Civil 3D objects (i.e. Alignments, Corridors, Surfaces) are created, they will be placed on the default 
Object Layer specified in the Drawing Settings dialog.

An optional Layer name wildcard can be included that will append the default Object Layer name 
with the name you give to the Object. In this way, a new Layer will be created for each named Civil 
3D Object created. For example, the default Object Layer for Alignments in the WisDOT design tem-
plate is P_ALI_*. The * character is the wildcard. If an Alignment is named HWY 14, the default 
Object Layer created will be P_ALI_HWY 14.

 1. Open acad-layr-prprtis-begin.dwg
 2. Ribbon > Home tab > Layers panel

 A. Observe Current Layer = E_ALI
 B. Change Current Layer to E_ALI_CPI

 I. Layer of an object can be changed in the Properties palette. 
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 3. Application menu dropdown > Drawing Utilities > Drawing Settings > Object Layers tab
 A. Observe default Civil 3D Object Layers
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Info: The Ribbon Layer Panel dropdown shows the Current Layer if no object is selected. It 
shows the selected Object Layer if an object is selected.

 4. Select BOTTOM OF MEDIAN Line on right side of SECTION A-A detail
 A. Ribbon > Home tab > Layers panel dropdown

 I. Observe Object Layer = P_XS_FinalBorrow
 5. Select BOTTOM OF MEDIAN Line on right side of SECTION A-A detail

 A. Ribbon > Home tab > Layers panel > Make Current
 6. Properties palette > General 

 A. Observe Object Layer = P_XS_FinalBorrow
 7. esc
 8. PLINE enter

 A. Ribbon > Home tab > Layers panel dropdown
 I. Observe Current Layer = P_XS_FinalBorrow

 B. Draw Polyline with two vertices anywhere between SECTION A-A and SECTION B-B 
details

 9. Select any other polyline
 A. Ribbon > Home tab > Layers panel > Make Current

 I. Observe that Current Layer changes accordingly

Layer commands: off, freeze, isolate, lock
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Start with acad-layr-prprtis-begin.dwg

acad-layr-prprtis-02.mp4 5:56

Commonly edited Layer properties

Layer property Description

On/off
When a Layer is turned off, objects residing on that Layer will not display, 
although they will be accounted for when processing object display, such as 
when you Zoom Extents or Regen.

Isolate/unisolate Depending on Layer settings, Layer Isolate will either Lock and fade display or 
turn off all Layer except those of selected objects.

Freeze/thaw
When a Layer is frozen, objects residing on that Layer will not display and will 
not be accounted for when processing object display. Freezing a Layer with an 
extraordinarily large number of objects can help drawing performance.

Lock/unlock
Objects on a locked Layer cannot be deleted or edited. Locking Layers can be 
helpful when you wish to use objects on a Locked Layer for visual reference or 
to snap to while also protecting alteration of the geometry.

On/  off

 1. Continue working in acad-layr-prprtis-begin.dwg
 2. Ribbon > Home tab > Layer panel > Off

 3. Select an object on the layer to be turned off 
 A. Select multiple objects below SECTION A-A detail
 B. esc
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 4. Double-click middle mouse wheel
 A. Observe Zoom Extents is still accounting for Layers turned off

 5. Ribbon > Home tab > Layer panel > Turn All Layers On

Freeze/  thaw

 1. Continue working in acad-layr-prprtis-begin.dwg
 2. Ribbon > Home tab > Layer panel > Freeze

 3. Select an object on the layer to be Frozen
 A. Select multiple objects below SECTION A-A detail
 B. esc
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 4. Double-click middle mouse wheel
 A. Observe Zoom Extents not accounting for frozen Layers

 5. Ribbon > Home tab > Layer panel > Thaw All Layers

Isolate/  unisolate

 1. Continue working in acad-layr-prprtis-begin.dwg
 2. Ribbon > Home tab > Layer panel > Isolate

 3. Select an object on the layer to be Isolated
 A. Select BOTTOM OF MEDIAN Line on right side of SECTION A-A detail
 B. enter
 C. Observe non-isolated Layers fade and lock

 4. Ribbon > Home tab > Layer panel > Isolate

 A. Select an object on the layer to be Isolated or Settings
 I. Off

 a. This will turn non-isolated layers off rather than fading and locking them. 
 5. Ribbon > Home tab > Layer panel flyout

 A. Adjust Locked Layer Fading with slider

 6. Ribbon > Home tab > Layer panel > Unisolate

Lock/  unlock

 1. Ribbon > Home tab > Layer panel > Lock

 2. Select an object on the layer to be Locked
 A. Select BOTTOM OF MEDIAN Line on right side of SECTION A-A detail
 B. enter
 C. Observe Locked layer display fade
 D. Hover cursor over object on locked Layer
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 E. Observe "padlock" glyph indicating the Layer is locked

 3. Ribbon > Home tab > Layer panel > Unlock
 A. Select an object on locked P_XS_FinalBorrow Layer

Layer properties manager: interface & editing

Start with acad-layr-prprtis-begin.dwg

acad-layr-prprtis-03.mp4 7:49

The Layer Properties Manager is where you can sort, create and delete Layers or edit Layer properties 
such as Layer name, description, display color, visibility (on/off or freeze/thaw), plot style name (how thick a 
lines will plot), whether the Layer will plot or not, etc. Take advantage of shift+select and ctrl+select to affect 
multiple Layers at once.

 1. Continue with acad-layr-prprtis-begin.dwg
 2. Ribbon > Home tab > Layer panel > Layer Properties

 A. Observe "366 total Layers" listed along bottom of Layer Properties Manager palette
 B. Observe the layer filters on the left side of the palette.
 C. Notice that the columns width can be adjusted for readability.

 3. Set a Layer Current by selecting a row and clicking the Set Current button  or double-clicking a 
row in Layer Properties Manager

Page: 132

Published on: 5/1/2024

Layers and their properties

https://c3dkb.dot.wi.gov/video/acad/acad-layr-prprtis-03.mp4


 A. Layer Properties Manager
 I. Observe Status = Current

 4.  Select a row in by left clicking
 A. Left click once more on the Layer name to edit the name

 I. Left click elsewhere in  to cancel or finish the name edit
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 B. Toggle Layer Off
 I. "The current layer will be turned off. What do you want to do?"

 a. Turn the current layer off

 C. Toggle Layer On
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 D. Toggle Layer Freeze
 I. "This layer cannot be frozen because it is the current layer."

 a. Close

 E. Toggle lock
 I. Observe Layer display fade in Model Space

 F. Color column
 I. Click on color of any layer

 a. Observe list of colors
 b. Cancel

 G. Linetype column
 I. Click on linetype of any layer

 a. Observe list of linetypes
 b. Cancel

 H. Lineweight column
 I. Click on lineweight of any layer

 a. Observe list of lineweights
 b. Cancel

 I. Plot column
 I. Toggle plot/  noplot

 J. Plot Style column
 I. Click on any named Plot Style

 a. Observe list of Plot Styles
 b. Cancel

Warning: In pre-2018 WisDOT drawings, Named plot styles have 
been assigned intentionally to Layers included in the WisDOT design 
template. These Plot Styles dictate the plotted color (i.e. Black), line-
type and lineweight of plotted objects. Do not change these assigned 
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Plot Styles as doing so will result in non-uniformity among plotted 
WisDOT plan sets.

 K. New VP Freeze column
 I. Toggle New VP Freeze

Info: New VP Freeze affect creation of new Viewports. Viewports are used for 
plan production to "look" from your plan sheet Layout (Paper Space) into your 
Civil 3D model (Model Space). The concepts and use of Layouts, Viewports 
and Paper Space vs Model Space will be covered in more depth in later train-
ing modules.

 L. Layer Properties Manager
 I. Right-click any column header

 a. Maximize all columns
 II. Right-click Name column header

 a. Freeze column
 i. Observe static display of Name and Status Column while scrolling 

left-right
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Layer properties manager: create new & layer notification

Continue with acad-layr-prprtis-begin.dwg

acad-layr-prprtis-04.mp4 3:44

 1. Continue with acad-layr-prprtis-begin.dwg
 2. Layer Properties Manager

 A. Select E_ALI row
 B. Create New Layer

 I. Layer name = E_ALI2

Info: When creating a new Layer in the Layer Properties Manager, all prop-
erties of the selected Layer other than the Layer name will be assigned to the 
new Layer created.
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Requirement: When creating a new layer, follow the WisDOT Layer naming 
convention. For example, E_ALI_<object name> ("E for existing or P for pro-
posed"_"three or four letters for object type"_"optional additional sections of 
three or four letters for object type"_ "object name or description")

 C. Select E_ALI2
 I. Right-click > Merge selected layer(s) to...

 a. Select E_ALI
 b. OK
 c. "The selected layers will be merged into layer E_ALI. Do you want to con-

tinue?"
 i. Yes

 D. Layer Settings
 I. New Layer Notification = checked

 II. Evaluate new layers added to drawing = checked
 III. Evaluate all new layers = filled

 E. Select E_ALI
 F. Create new Layer
 G. Right click newly created Layer 1

 I. Reconcile Layer

Layer properties manager: properties filter & settings

Continue with acad-layr-prprtis-begin.dwg

acad-layr-prprtis-05.mp4 2:56

Layer Properties Filters essentially query all the Layers in your drawing based on Layer name text or other 
Layer properties. This allows you to reduce the Layers listed in Layer Properties Manager, making Layers 
easier to find and work with. You can also use the search field in the upper right corner of Layer Properties 
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Manager to filter the Layers shown based on Layer name. Using Layer Settings, you can also apply the cur-
rent Layer Properties Filter to the Ribbon Layer Panel dropdown list.

 1. Continue working in acad-layr-prprtis-begin.dwg
 2. Layer Properties Manager

 A. Filters
 I. Alignment

 a. Observe reduced list of Layers displayed in Layer Properties Manager
 b. Observe Layer quantification note in lower-left of Layer Properties Manager 

window

 II. Right-click Alignment Layer Filter > Properties
 a. Observe Layer Filter Properties name-based query

 III. Right-click All Used Layers Filter
 a. Observe inability to modify properties or delete this filter
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Info: The All Used Layers Filter is one of the default Layer Filters auto-
matically created in any drawing. These default Layer Filters cannot 
be modified or deleted. Additional default Layer Filters include 
External Reference, Non-External Reference, Unreconciled Layers 
and Viewport Overrides.

Info: When Layers are referenced by a Civil 3D Style included in a 
drawing or template, the Layers are included in the All Used Layers Fil-
ter and cannot be deleted. This is true even if there are no Civil 3D 
objects in the drawing. For example the Alignment Civil 3D Style lay-
ers are included in the WisDOT design template even before any Align-
ments are created.

 3. Layer Properties Manager > New Property Filter

Info: Layer Filters using Name filtering can use a * as a wildcard on either end of the name 
to capture unique layer names that fit the layer filter criteria. 

Layer states & layer walk

Continue with acad-layr-prprtis-begin.dwg

acad-layr-prprtis-06.mp4 4:24

Layer states

A Layer State is a saved version of the way a drawings Layer properties are set up. The properties saved in 
a Layer State include Layer On/ off, Freeze/ thaw, Lock/ unlock, Color, Linetype, Lineweight, Transparency, 
Plot style, Plot/ no plot, New VP Freeze and VP Freeze. Layer States can be imported, saved from the cur-
rent Layer Properties setup, or restored in a drawing at any time. Restoring a Layer State will reset all Layer 
properties currently set in a drawing to those saved in the Layer State. Use Layer States to quickly and 
accurately switch to a desired Layer properties setup for specific design, external referencing, or plotting 
workflows. Some key Layer States are included in the WisDOT design template and on the Ribbon 
WisDOT Standards tab. The Layer States on the WisDOT Standards tab can be imported through the Lay-
ers Tool Palette.

 1. Continue working in acad-layr-prprtis-begin.dwg
 2. Ribbon > Home tab > Layers panel flyout > Layer State dropdown > New Layer State

 A. New layer state name = color
 B. OK
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 3. Layer Properties Manager
 A. Shift+select all Layers
 B. Click any Layer Color field

 I. Color = red
 II. OK

 4. Ribbon > Home tab > Layers panel flyout > Layer State dropdown > New Layer State
 A. New layer state name = Red
 B. OK

 5. Ribbon > Home tab > Layers panel flyout > Layer State dropdown > Color
 A. Observe all Layer Color properties restored based on color Layer State

 6. Ribbon > Home tab > Layers panel flyout > Layer State dropdown > Red
 A. Observe all Layer Color properties changed to red

Layer walk

The Layer Walk command allows you to sort and select Layers from a list or your drawing area and see 
them displayed in real time. You can use Layer Walk to efficiently select a group of Layers either by name 
or by selecting objects in the drawing area, then create a Layer State based on that selection from within 
the Layer Walk dialog. The Layer State created from within the Layer Walk command will only affect vis-
ibility through the Layer on/ off property. All other properties will remain unchanged.

 1. Ribbon > Home tab > Layers panel flyout > Layer Walk
 A. Layer Walk dialog

 I.  Right-click in Layer list
 a.  Select all
 b. Observe Layers displayed in drawing area

 II. Select only P_XS_Final Borrow

 a. Right-click P_XS_Final Borrow
 i.  Save Layer State

 i. New layer state name = Layer State
 ii. OK

 III. Close

Blocks and external references
Last updated: 2023-01-04

Total video time: 80:01

Both Block References (aka Blocks) and External References (aka Xrefs) allow you to bring previously cre-
ated, external objects into your Civil 3D drawing. 
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A Block is an object type that is made up of one or more other drawings objects. When objects are con-
tained in a Block, they are easily inserted into any drawing to avoid duplicated work in assembling the vari-
ous objects making up the Block. Blocks are typically used for Survey Point Markers, standard construction 
or plan details, plan set sheet text and typical plan-view linework. Blocks can be dynamics in that you have 
special control options for visibility or editing. They can also contain attributes, which are text objects whose 
content can be edited while locking down the text Style/Layer/etc.

You can think of an Xref as a view in a destination drawing back to a source drawing. In the destination 
drawing, the Xref source objects are protected from editing beyond Layer display control. Additionally, a 
source drawing can be Externally Referenced into multiple destination drawings simultaneously. Whenever 
a change is made to an Xref source drawing, you are prompted in the destination drawing to update the 
Xref. In this way, the referenced source content is easily kept up to date and consistent throughout all des-
tination drawings. Xrefs can be used in design drawings to see and reference linework or other objects for 
the purposes of design without actually having those reference objects in your current drawing. Another use 
for an Xref is for displaying existing conditions or other site objects needed on multiple plan sheets. If you 
only want to display certain objects from the Xref on certain plan sheets, you can accomplish this through 
Viewport Freezing Layer control. More detailed information on plan production will be covered in later train-
ing module. 

Block creation basics

Exercise files: acad-data-c3d20.zip

Start with acad-blk-xref-begin.dwg

acad-blk-xref-01.mp4 5:07

In this exercise, you will create a Block such that you have Layer control of the Block once created. You will 
do this by setting the objects making up the Block on Layer 0.

 1. Open acad-blk-xref-begin.dwg
 2. Set Current Layer = 0
 3. Ribbon > Home tab > Draw panel > Circle

 A. Draw a Circle
 I. Radius = 15±

 B.  Ribbon > Home tab > Draw panel > Polyline
 I. Draw a Polyline within the circle at its quadrants using quadrant Osnap.

 4. Ribbon > Insert tab > Block panel > Create

Info: bl is a command line "alias" that also invokes the block command.

 A. Name = test

 B. Base Point

 I. Specify on-screen = unchecked

 II.  Pick point

 a. Use Osnaps to specify center of Circle

 C. Settings

 I. Block unit = unitless

 D. Objects

 I. Specify on-screen = unchecked

 II. Convert to block = filled
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 III. Select objects

 a. Select Circle and Polyline

 b. enter

 E. Behavior

 I. Annotative = unchecked

 II. Scale uniformly = checked

 III. Allow exploding = checked

 F. OK

 5. Select test Block
 A. Properties palette > General

 I. Layer = E_ALI_Marker
 II. Observe Layer properties take effect

Info: In order to have Layer control of a Block Reference, the objects included in the 
Block must be placed on Layer 0. The Block itself can then be placed on any Layer 
as needed and the Layer properties will take effect.

Block creation continued, attributes & editing

Continue with acad-blk-xref-begin.dwg

acad-blk-xref-02.mp4 8:00
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In this exercise, you will create a Block such that you do not have Layer control, then edit the Block so that 
you do have Layer control. You will also learn how to add a Block Attribute, which is a text object contained 
in the Block whose properties are protected and whose content value can be edited  in a user-friendly inter-
face. When you insert an Attributed Block into a drawing, you will be prompted to enter specific information 
for the attribute content. Block Attributes are a great way to ensure that necessary text information is 
entered and that it is in the correct format. In the process of completing this exercise, you will take an intro-
ductory look at the Block Editor interface.

 1. Continue working in acad-blk-xref-begin.dwg
 2. Current Layer = E_ALI
 3. Ribbon > Home tab > Draw panel > Circle

 A. Draw a Circle
 I. Radius = 15±

 B. Ribbon > Home tab > Draw panel > Polyline
 I. Draw a Polyline within the circle at its quadrants using quadrant Osnap.

 4. bl enter
 A. Name = test2
 B. Base Point

 I.  Pick point
 a. Use Osnaps to specify center of Circle

 5. Objects
 A. Select objects

 I. Select Circle and Polyline
 II. enter

 6. Select test2 Block
 A. Properties palette > General

 I. Layer = E_ALI_Marker
 II. Observe Layer properties not taking effect

Info: If a Block has been created such that you do not have Layer control, you can 
enter Block Editor and place the objects contained in the Block on Layer 0. Then you 
will have Layer control of the Block.

 7. Ribbon > Insert tab > Block panel > Edit

Info: Two alternative ways to open block editor is by simply double-clicking on the block on 
choose it from the list, or by right-clicking and selecting edit block.

 A. Block to create or edit = test2

 B. OK

 I. Select Circle and Polyline

 a. Properties > General

 i. Layer = 0

 II. Block Editor Ribbon > Close panel > Close Block Editor

 a. Save the changes to test2

 8. Observe Layer properties take effect
 9.  Select test2 Block

 A. Properties palette > General
 I. Layer = E_ALI
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 10. Double-click test2 Block
 A. Block to create or edit = test2
 B. OK

 I. Block Editor Ribbon > Action Parameters panel > Attribute Definition
 a. Attribute

 i. Tag = Marker_ID
 ii. Prompt = Enter Marker ID
 iii. Default = Default ID

 b. Text Settings
 i. Annotative = unchecked
 ii. Text Height = 1

 c. OK
 II. Specify insertion point of Attribute within Circle

 C. Block Editor Ribbon > Close panel > Close Block Editor
 I. Save the changes to test2

 11. Ribbon > Insert tab > Blocks panel flyout > Synchronize Attributes
 A. Enter an option: Select

 B. Select test2 Block
 C. enter

 12. Double-click test2 Block
 A. Enhanced Attribute Editor > Attribute tab

 I. Value = 12345
 II. OK

Insert from block definition & edit insertion point

Continue with acad-blk-xref-begin.dwg

acad-blk-xref-03.mp4 3:53

In this exercise you will learn to insert a Block from the definition stored in the current drawing. You will also 
learn two methods to reset a Block insertion point in Block Editor.

 1. Continue with acad-blk-xref-begin.dwg
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 2. Ribbon > Insert tab > Block panel > Insert dropdown > Recent Blocks 
 A. Click test2 block

 I. Insertion point = checked
 II. Uniform Scale = unchecked

 a. value = 1
 III. Rotation = unchecked

 a. value = 0
 IV. Drag and drop block test2 into Model Space. 

 a. Edit Attributes
 i. Enter Marker ID = 6789

 b. OK
 3. Block Editor opens automatically

 A. Select all block objects
 B. m enter

 I. Specify base point: bottom quadrant of circle
 II. Specify second point: 0,0 enter

 III.  
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 C. Block Editor Ribbon > Close panel > Close Block Editor
 I. Save the changes to test2

 II. Notice grip edit has moved to lower quadrant of circle.
 4. be enter 

 A. choose test2 from list 
 I. OK

 B.  Block Editor Ribbon > Action Parameters panel > Basepoint
 I. Select the center of the circle using Osnap. 

 C. Block Editor Ribbon > Close panel > Close Block Editor
 I. Save the changes to test2

 II. Notice grip edit has moved to the center of circle.

Write block (WBLOCK)

Continue with acad-blk-xref-begin.dwg

acad-blk-xref-04.mp4 3:28

The WBLOCK command will write a Block Definition based on either existing Blocks or objects in the current 
drawing or the entire current drawing to a new, external drawing. This workflow is commonly used to write 
an entire drawing that has become corrupt to Block in order to leave behind those elements causing the cor-
ruption. This Block can then be inserted into a new drawing created from the appropriate template.

 1. Continue with acad-blk-xref-begin.dwg
 2. wblock enter

Info: When an entire drawing is written to a Block Definition using WBLOCK, the insertion 
point for the newly written Block will be at the same location relative to the newly written Block 
objects as the 0,0 coordinate in the original drawing was to the original drawing objects. 

Tip: In the case where WBLOCK is used to insert an entire drawing  into a blank drawing star-
ted from an appropriate template in order to leave behind corruption, the Insertion point: Spe-
cify on-screen option is typically unchecked. This way the objects in the original drawing and 
the Block inserted into the new drawing will be a the same coordinates. Additionally, the 
Explode option is typically checked. This way the newly inserted Block is automatically 
broken down to the level of the objects in the original drawing,

 A. Source = Entire drawing

 B. Destination

 I. File name and path: ...

 a. Browse to folder containing acad-blk-xref-begin.dwg

 b. File name = new block.dwg

 c. Save

 C. Insert units = unitless

 D. OK

 E. Include AutoCAD Map information in the export?

 I. No
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 3. Ribbon > Insert tab > Block panel > Insert
 A. Recent blocks:

 I. Choose new block and drag into Model Space
 4. x enter for explode

 A. select new block
 I. enter

 II. Notice that the block has been exploded into the two blocks contained within new 
block. This is called a nested block. 

 5. Windows File Explorer
 A. Browse to folder containing new block.dwg
 B. Select new block.dwg

 I. Drag and drop into Civil 3D drawing area
 6. Specify insertion point near other drawing objects

 A. Enter x scale factor <1>:
 I. enter

 B. Enter y scale factor <use x scale factor>:
 I. enter

 C. Specify rotation angle <0>:
 I. enter

Block Definitions, Insert Methods, Purge

Start with acad-blk-xref-01.dwg

acad-blk-xref-05.mp4 10:07

In this video you will how it is possible to purge Block Definitions if they are not currently inserted into the 
drawing are or referenced by Civil 3D or AutoCAD Styles. You will then use the Add Marker Symbols tool 
located on the Ribbon WisDOT Standards tab to bring those Block Definitions back into the drawing. The 
Add Marker Symbols tool can be used to add the standard WisDOT Marker Blocks into any drawing regard-
less of whether that drawing ever had those Block Definitions or not.

 1. Open acad-blk-xref-01.dwg
 2. Delete all blocks in Model Space. 
 3. Ribbon > Insert tab > Block panel > Insert dropdown 

 A. Observe test, test2 and new block listed. 
 B. Choose block A/C

 I. Insert block into Model Space. 
 4. Ribbon > WisDOT Sheets tab > Standards Components panel > Block Symbols
 5. Ribbon > Insert tab > Block panel > Insert dropdown

 A. Observe many new blocks in the list. 
 6. Ribbon > Insert tab > Block panel > Insert dropdown > Recent blocks

 A. Switch to Current Drawing tab in Blocks palette
 B. Select block ZOR

 I. Insertion Point = checked
 II. Place block in Model Space.

 7. Delete all blocks in Model Space.
 8. Verify that all block definitions still exist in the Insert dropdown list. 
 9. PU enter to run the purge command. 

 A. Items not used in drawing

 I. select Blocks

 B. Purge Checked Items

 C. Purge All Checked Items
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 D. Notice blocks test and test2 now show up in the purge list. This is because these were nes-
ted blocks within the new block definition. Once new block was purged, these two block 
definitions were added to the drawing. 

 I. Repeat the above steps to purge test and test2

Info: Alternatively, the option purge nested items could have been checked in 
order to remove test and test2 since these were nested blocks. 

 I. Close

 10. Ribbon > Insert tab > Block panel > Insert dropdown
 A. Observe ZOR, test, test2 and new block not listed

 11. Ribbon > WisDOT Sheets tab > Standards Components panel > Block Symbols to add all 
WisDOT block definitions back into the drawing. 

 12. Ribbon > Insert tab > Block panel > Insert dropdown
 A. Observe ZOR listed

Design center: Insert block

Continue with acad-blk-xref-01.dwg

acad-blk-xref-06.mp4 5:06

In this exercise you will explore options to insert a Block Definition from an external drawing when it is not 
available through the WisDOT contextual tabs. You can either insert an entire external drawing using the 
INSERT command or pick which Block(s) to insert from an external drawing using the Design Center inter-
face.
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 1. Continue working in acad-blk-xref-01.dwg
 2. Ribbon > Insert tab > Block panel > Insert dropdown

 A. Select new block
 B. Specify insertion point anywhere in drawing area

 3. i enter
 A. Drag and drop new block from the Blocks palette.

 4. Delete the blocks placed in above steps. 
 5. Purge enter

 A. Items not used in drawing
 I. select Blocks

 B. Purge Checked Items
 C. Purge This Item
 D. Repeat the above steps to remove the block definition test which was a nested block. 

 6. Ribbon > Home tab > Palettes panel flyout > Design Center

Info: dc is a command line "alias" that also invokes the Design Center palette. Alternatively,  
ctrl + 2 will also open Design Center. 

 A. Folders tab > expand Folder list to new block.dwg

 A.  A. Select Blocks
 B. Drag and drop test2 into drawing area

Info: Another way to insert a block is to right-click on the block in Design Center, and 
choose Insert Block. All insert options can be modified in the resulting Insert dialog 
box. 
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 7. Edit Attributes
 A. Enter Marker ID: WisDOT
 B. OK

WisDOT sheets tab: topo tool palette

Start with acad-blk-xref-02.dwg

acad-blk-xref-07.mp4 2:47

The topography Blocks used as Point Markers in Civil 3D Point Styles can be found and inserted directly as 
Blocks into any drawing through the WisDOT Topo Tool Palette, which is found on the WisDOT Sheets con-
textual Ribbon. The Blocks inserted from these Tool Palettes are defined in external source drawings that 
install with the WisDOT Standards package.

 1. Open acad-blk-xref-02.dwg
 2. Ribbon > WisDOT Sheets

 A. Sheet Creation Components panel > Topo
 B. Tools panel > Palettes ON/OFF

 I. Topo Tool Palette > BuildingFencesTrees tab
 a. Tree Stump

 i. Specify insertion point near other drawing objects
 3. Select STMP Block

 A. Properties palette > General
 I. Layer = E_LAND_Vegetation

 4. Select STMP Block
 5. Ribbon > Home tab > Layers > Make Current

Info: The Blocks included on the Topo Tool Palette are also included as Block 
Definitions in most of the WisDOT templates. They are referenced as Point Mark-
ers in Civil 3D Point Styles which are also included in the WisDOT templates. More 
detailed information on Civil 3D Point Styles and Markers can be found in the 
Points training module.

Automatic scaling: block units & insertion units

Continue with acad-blk-xref-02.dwg

acad-blk-xref-08.mp4 7:40

When a Block is inserted into a drawing it will be automatically scaled by a factor based on the drawing 
Insertion Units and the individual Block Units. The scale factor applied to a Block upon insertion will  rep-
resent the Block in terms of the drawing Insertion Units. For example, a Block with Block Units of "inches" 
and a length magnitude of 24 that is inserted into a drawing with Insertion Units of "feet" will be scaled by a 
factor of 1/12 and will be have a length magnitude of 2 after insertion. Both the Insertion Units and the Block 
Units must be set to a value other than "unitless" in order for this form of automatic scaling to take place. If 
either is set to unitless in the source drawing, the Block will come in with the same length quantity as that in 
the source drawing.

Info: Note that automatic Block scaling is not Annotative scaling, which will be 
covered in later training modules. 
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 1. Continue working in acad-blk-xref-02.dwg
 2. Select STMP Block
 3. Properties palette > Misc

 A. Observe Block Unit = Unitless
 B. Observe that this field is not editable here

 4. BE enter
 A. Block to create or edit = STMP

 B. OK

 C. Properties palette > Block

 I. Units = Inches

 D. Block Editor Ribbon > Close panel > Close Block Editor

 I. Save the changes to STMP

Warning: The Blocks included in the WisDOT Tool Palettes and various Tem-
plates should not be edited by the end user. This training module exercise is 
intended to teach you general Block behavior. You may need to edit Blocks 
coming from outside of WisDOT, however.

 5. units enter
 A. Units to scale inserted content to: feet
 B. OK

 6. i enter
 A. drag and drop the STMP block into Model Space.
 B. Select the block and open the Properties palette. 

 I.  Misc
 a. Observe Unit factor = 0.0833

 II.  Geometry
 a. Observe Scale = 0.0833

 III. esc
 C. Select the first block that was placed in the exercise and open the Properties palette. 

 I.  Misc
 a. Observe Unit factor = 0.0833

 II.  Geometry
 a. Observe Scale = 12

 III. esc
 7. Topo Tool Palette  > BuildingFencesTrees tab

 A. Tree Stump

 I. Specify insertion point near other objects

 II. Observe lack of automatic scaling

Info: When a Block is inserted from an external Block Definition, such as the source 
drawing used by the WisDOT Topo Tool Palette, the Block will scale based on the 
units in that external source drawing even if the Block Definition in the current draw-
ing has been edited to have different Block units. To avoid this, the Block Definition 
in the source drawing would need to be edited.

 8. Topo Tool Palette  > BuildingFencesTrees tab
 A. Right-click Tree Stump
 B. Redefine
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 C. Select the smallest block and open the Properties palette. 
 I.  Misc

 a. Block Unit: Unitless
 b. Observe Unit factor = 1

 II.  Geometry
 a. Observe Scale = 0.0833

 III. esc
 D. Select one of the larger blocks and open the Properties palette. 

 I.  Misc
 a. Block Unit: Unitless
 b. Observe Unit factor = 1

 II.  Geometry
 a. Observe Scale = 1

 III. esc
 9. qselect enter

 A. Object type = block reference
 B. Properties = name
 C. Value = STMP
 D. OK
 E. Observe that X and Y coordinate *VARIES* on the Properties palette
 F. Set Scale = 1

 I. Observe that the small block is not the same size as the other 2 blocks. 

Automatic scaling: redefine block from design center

Continue with acad-blk-xref-02.dwg

acad-blk-xref-09.mp4 7:41

The Blocks included on the WisDOT Tool Palettes can be redefined in a drawing by right-clicking on the cor-
responding Tool Palette button and choosing Redefine. For those Blocks not included on the WisDOT Tool 
Palettes, you can redefine the drawing Block Definition by browsing to the source drawing through Design 
Center. This exercise goes through the workflow to redefine a Block through Design Center.

 1. Continue with acad-blk-xref-02.dwg
 2. Select test2 Block
 3. BE enter

 A. Block to create or edit = test2
 B. OK

 4. Properties palette > Block
 A. Units = Inches
 B. Block Editor Ribbon > Close panel > Close Block Editor

 I. Save the changes to test2
 5. i enter

 A. Drag and drop test2 into Model Space. 
 B. OK
 C. Observe that this block is smaller than the one that was already in the drawing due to chan-

ging the units to inches in the block definition.
 6. DC enter

 A. Folders
 I.  Browse to new block.dwg

 a. Blocks
 i. Drag & drop test2 into Model Space. 
 ii. OK
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 7. Properties palette
 A.  Geometry

 I. Observe Scale = 12

Info: In order to Insert a Block from an external source, such as through a Design Center, and have 
that external Block Definition update that in the current drawing, the Block in the external source 
drawing must be edited. Then you can browse to that Block in the external source through Design 
Center and redefine any instances of that Block Definition in the current drawing. This is the same 
functionality that is found by right-clicking a WisDOT Tool Palette button and choosing Redefine, but 
it applies to any Block even if it is not included in the WisDOT Tool Palette.

 8. Open new block.dwg
 9. BE enter

 A. Block to create or edit = test2
 B. OK

 10. Properties palette > Block
 A. Units = Inches
 B. Block Editor Ribbon > Close panel > Close Block Editor

 I. Save the changes to test2
 11. Application menu > SaveAs

 A. File name = new block1.dwg
 B. Save

 12. DC enter
 A. Folders

 I. Browse to new block 1.dwg
 a. Blocks
 b. right-click test2

 i. Redfine only
 13. qselect enter

 A. Object type = block reference
 B. Properties = name
 C. Value = test2
 D. OK

 14. Open Properties palette
 A. Observe that there are 3 blocks selected in Properties palette
 B. Properties palette > Geometry

 I. Scale = 1

WisDOT sheets tab: signs tool palette

Start with acad-blk-xref-03.dwg

acad-blk-xref-10.mp4 3:24

This exercise will walk you through the unique features included in the WisDOT Signs Tool Palette. The 
Blocks included on this tool palette represent the WisDOT standard signage details. These Dynamic Blocks 
include the ability to choose a version of each block from a dropdown list (Visibility Set) as well as a hyper-
link to quickly view the associated WisDOT standard detail sheets. 

 1. Open acad-blk-xref-03.dwg
 2. Ribbon > WisDOT Sheets tab > Sheet Creation Components panel > Signs
 3.  Ribbon > WisDOT Sheets tab > Sheet Creation Components panel > Palettes ON/OFF

 A. D-Signs tab
 I. D1-51

 a. Specify insertion point anywhere in drawing area
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 4. Select D1-51 Block
 A. Visibility set dropdown
 B. Choose alternative Visibilty from list
 C. esc

 5. Double-click D1-51Block
 A. Enhanced Attribute Editor

 I. Select SIZE row
 II. Value = 120"X15"

 III. OK
 IV. Observe update to D1-51 Block in drawing area

 6. Ctrl+click D1-51 Block
 A. Observe web browser open the WisDOT signage detail D1-51.pdf

WisDOT design tab: intersections, beam guards & general blocks

Continue with acad-blk-xref-03.dwg

acad-blk-xref-11.mp4 5:47

The WisDOT Intersection Blocks and Beam Guard Tool Palattes contain dynamic Blocks which include eas-
ily editable linework to get started with your geometric layout. Insert these Blocks and use the Properties 
palette or dynamic Block grips to edit the linework. The WisDOT Design Ribbon tab also includes the 
Autodesk Palettes button. This will populate your Tool Palette with all of the default Autodesk Tool Palette 
tabs. Some of these default Tool Palette tabs contain default Autodesk Blocks that could potentially be use-
ful to convey your design intentions.

 1. Continue working in acad-blk-xref-03.dwg
 2. Ribbon > WisDOT Design > Parametric Design panel > Intersection Blocks 

 A. Int-Type-A-Q-Grtr-80-In-Curve
 B. Specify insertion point near other drawing objects
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 3. Select Int-Type-A-Q-Grtr-80-In-Curve Block
 A. Select Grip along incoming intersection centerline

 I. Specify point location for centerline
 B. Select Visibility Set dropdown

 I. Graphics Mode = checked
 C. Properties palette > Custom

 I. Observe editable parameters in tabulated form
 D. esc

 4. Ribbon > WisDOT Design >  Parametric Design panel > Beam Guard Blocks
 A. BG EAT R Right Curve
 B. Specify insertion point near other drawing objects
 C. OK 

 5. Select BG EAT R Right Curve Block
 A. Observe grips to edit linework geometry
 B. Properties palette > Custom

 I. Observe editable parameters in tabulated form
 C. esc

 6. Ribbon > WisDOT Design >  Autodesk panel > Autodesk Palettes
 A. Left-click "stacked" tabs at bottom of Tool Palette
 B. Scroll down in list

 I. Highways
 a. Scroll to explore available out-of-the-box Blocks

 II. External Works
 a. Scroll to explore available out-of-the-box Blocks

Xref: overlay vs attach

Start with acad-blk-xref-04.dwg, acad-blk-xref-05.dwg and acad-blk-xref-06.dwg

acad-blk-xref-12.mp4 7:00

This exercise will introduce you to the External Referencing (Xref) workflow. You will create an Overlay Xref 
then change it to an Attach Xref and observe behavioral differences between the two. When an Xref is cre-
ated as the type "Overlay", the Externally Referenced source drawing will not be carried forward if the des-
tination drawing is then Externally Referenced into another drawing. When an Xref is created as the type 
"Attach", the Externally Referenced source drawing will be carried forward.

 1. Open acad-blk-xref-04.dwg, acad-blk-xref-05.dwg and acad-blk-xref-06.dwg
 2. File tab > acad-blk-xref-05
 3. Ribbon > Home tab > Palettes panel flyout > External Reference Manager

 

 4. External References palette > Attach dropdown > Attach DWG
 A. Browse to acad-blk-xref-04.dwg

 I. Open
 5. Attach External Reference

 A. Reference Type = Overlay
 B. Insertion Point > Specify On Screen = unchecked
 C. OK

 6. Ribbon > Home tab > Layers panel > Layer Properties
 A. Observe presence of Xref Layer Filters and Xref Layers

Page: 156

Published on: 5/1/2024

Blocks and external references

https://c3dkb.dot.wi.gov/video/acad/acad-blk-xref-12.mp4


 7. File tab > acad-blk-xref-06
 8. xr enter
 9. External References palette > Attach dropdown > Attach DWG

 A. Browse to acad-blk-xref-05.dwg
 I. Open

 B. Info: 
When acad-blk-xref-05.dwg is externally referenced into acad-blk-xref-06.dwg, no 
objects are displayed in acad-blk-xref-06.dwg. This is because the objects displayed 
in acad-blk-xref-05.dwg are only an "Overlay" xref of acad-blk-xref-04.dwg. "Over-
lay" xrefs are not carried forward when their destination drawing is then used as an 
xref source drawing in another drawing. "Attach" xrefs are carried forward in this 
manner, however.

When acad-blk-xref-05.dwg is externally referenced into acad-blk-xref-06.dwg, xref 
Layers prefixed with acad-blk-xref-05 are created and are similar to the Layers in 
acad-blk-xref-04.dwg. This is because both acad-blk-xref-04.dwg and acad-blk-xref-
05.dwg were started from the same template (wisdot16.dwt) and this template 
includes all of those Layers.
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 10. File tab > acad-blk-xref-05
 11. xr enter
 12. External References palette

 A. click on acad-blk-xref-04
 B. Details > Type = Attach

 13. Save acad-blk-xref-05.dwg
 14. File tab > acad-blk-xref-06

 A. xr enter
 I. Observe that acad-blk-xref-05.dwg needs reloading

 II. Right-click on acad-blk-xref-05.dwg and Reload.

Xref source path: full vs relative

Continue with acad-blk-xref-04.dwg, acad-blk-xref-05.dwg and acad-blk-xref-06.dwg

acad-blk-xref-13.mp4 6:05

You have three options to specify how the Xref file path relationship between the source drawing and des-
tination drawing is defined. A Full Path Xref requires that the source drawing exist at the exact drive location 
called out in the destination drawing when the Xref was created. If not, the Xref source file will not be read 
and a notification will be displayed. A Relative Path Xref requires that the source drawing exist at the same 
folder hierarchy location relative to the destination drawing. In other words, the source and destination draw-
ings must be the same number of folders away from each other in order for the Xref source drawing to be 
read. There is also a No Path option which requires that the path to the source drawing be included in the 
Civil 3D profile options support file search path list. This No Path Xref type is less common and will not be 
covered in this exercise.

 1. Continue working in acad-blk-xref-04.dwg, acad-blk-xref-05.dwg and acad-blk-xref-06.dwg
 2. Open External Reference Manager

 A. Observe full path displayed in acad-blk-xref-04 row, Saved Path column
 3. File tab > Close acad-blk-xref-04
 4. Windows File Explorer

 A. Browse to acad-blk-xref-04.dwg
 B. Move acad-blk-xref-04.dwg into XREF folder

 5. External References palette > right-click acad-blk-xref-04
 A. Reload
 B. Observe "Not Found" displayed in acad-blk-xref-04 row, Status column

 6. Windows File Explorer
 A. Browse to acad-blk-xref-04.dwg
 B. Move acad-blk-xref-04.dwg to location displayed in Saved Path column of External Refer-

ences palette
 7. External References palette > right-click acad-blk-xref-04

 A. Reload
 B. Observe "Loaded" displayed in acad-blk-xref-04 row, Status column
 C. Right-click acad-blk-xref-04

 I. Change Path Type > Make Relative
 II. Observe partial file path displayed in acad-blk-xref-04 row, Saved Path column

 8. Save acad-blk-xref-05.dwg
 9. File tab > Close acad-blk-xref-05

 10. Windows File Explorer
 A. Browse to acad-blk-xref-04.dwg
 B. Move acad-blk-xref-04.dwg and acad-blk-xref-05.dwg into XREF folder

 11. Open acad-blk-xref-05.dwg
 12. External References Manager

 A. Observe "Loaded" displayed in acad-blk-xref-04 row, Status column
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Bind xref

Start with acad-blk-xref-07.dwg

acad-blk-xref-14.mp4 3:56

Once an Xref is created in a drawing, you can insert the source objects, styles, Block Definitions and Layers 
through the BIND command. This will insert the source drawing content and create or merge similar content 
(i.e. similarly named Layers or Blocks) depending on the type of Bind you specify. In this exercise, you will 
Bind an Xref using both types of the Bind command and observe behavioral differences between the two.

 1. Open acad-blk-xref-07.dwg
 2. xr enter

 A. Attach DWG
 I. Browse to acad-blk-xref-04.dwg

 a. Open
 B. Attach External Reference

 I. OK
 3. External References palette > Right-click acad-blk-xref-04

 A. Bind
 B. Bind Xrefs/DGN underlays

 I. Bind Type = Bind
 II. OK

Info: When you Bind an Xref using the type Bind, any content in the source drawing 
similarly named in the destination drawing will be duplicated. That duplicated con-
tent will be named with a prefix based on the source drawing name. When you Bind 
using the type Insert, any content in the source drawing similarly named in the des-
tination drawing will be merged. The version of that similar content in the destination 
drawing will be used.

 4. Ribbon > Home tab > Layers panel > Layer Properties
 A. Observe duplicate Layer naming convention
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 5. Select all drawing objects
 A. Properties

 I. Observe selected object is a Block Reference
 II. Misc

 a. Observe name = acad-blk-xref-04
 B. esc

 6. Quick Access toolbar > Undo dropdown > Xref
 7. External Reference Manager

 A. Attach DWG
 I. Browse to acad-blk-xref-04.dwg

 a. Open
 B. Attach External Reference

 I. OK
 8. External References palette > Right-click acad-blk-xref-04

 A. Bind
 B. Bind Xrefs/DGN underlays

 I. Bind Type = Insert
 II. OK
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 9. Select acad-blk-xref-04 Block
 10. Ribbon > Home tab > Layers panel > Layer Properties

 A. Observe no duplicate Layers created

Annotation
Last updated: 2023-01-04

Total video time: 41:03

This section will cover annotation tools used to add notes and callouts to a drawing. We will go over 
AutoCAD tools to create Multiline Text (text-only notes), Multileaders (callouts with text and pointer), and 
Dimensions as well as their associated styles. It should be noted that any Civil 3D objects have their own 
Label Styles which can automatically label key design features and dynamically update based on changes 
to associated Civil 3D objects. These Civil 3D Labels Styles should always be used where possible as they 
reduce the potential for human error and eliminate tedious, manual annotation work.  The annotation tools 
covered in this section are typically reserved for cases where Civil 3D Label Styles are not applicable. For 
example, they can be used for things like construction details, title sheets, and plan sheet borders.

Multiline text

Exercise files: acad-data-c3d20.zip

Start with acad-annotatn-begin.dwg

acad-annotatn-01.mp4 6:51

Info: Multiline text is the preferred method in WisDOT for typing or inserting general notes.

 1. Open acad-annotatn-begin.dwg
 2. Ribbon > Annotate tab > Text panel

 A. text style  dropdown: CalibriLight
 B. textsize: 0.10

 3.  Ribbon > Annotate tab > Text panel > Multiline Text
 A. Specify first corner:

 I. Use Osnaps to pick upper left corner of title block box
 B. Specify opposite corner:

 I. Use Osnaps to pick lower right corner of title block box
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 C. Type notes in  Mtext box
 D. Open maintainence crossover.txt in Notepad

 I. Copy text content
 II. Paste text content into Mtext box

 4. Select previously created Mtext with single click
 A. Observe insertion, column height and column width Grips displayed
 B. esc

 5. Double click previously created Mtext
 A. Observe Mtext contextual Ribbon displayed
 B. Mtext Ribbon

 I.  Formatting panel > Text style dropdown
 a. Choose alternative Text style
 b. Set back to CallibriLight

 II. Style panel > Text height field
 a. Key in new Text height
 b. Set back to 0.1000

 III. Paragraph panel > Justification dropdown
 a. Choose Middle Center

 C. Left-click outside Mtext editing box
 6. Select Mtext object

 A. Use Geometric Center Osnap to place insertion point at centroid of title block area
 B. esc

 7. Ribbon > Annotate tab > Text panel > Mulitline Text
 A. Specify first corner:

 I. Pick lower endpoint of green guiding Line
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 B. Specify opposite corner:

 C. Type general notes into Mtext box
 D. Highlight general notes text content
 E. Mtext Ribbon > Formatting panel > Change case dropdown

 I. Uppercase
 F. Mtext Ribbon > Tools panel flyout > Import Text

 I. Browse to general notes.txt
 II. Open

 G. Select part of the Mtext content
 H. Mtext Ribbon

 I.  Formatting panel > Text style dropdown
 a. Change Text style

 II. Style panel > Text height field
 a. Change Text height
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 III. Formatting panel > Match
 a. Highlight Text content with source formatting
 b. Highlight Text content for which to apply formatting

 IV. Highlight entire Mtext content
 a. Style panel > Text height field

 i. Text height = 0.1250
 V. Insert panel > Columns dropdown > No Columns

 a. Right click top of Mext box
 i. Set Mtext width = 38
 ii. OK

 I. Left-click outside Mtext box to finish editing

Text editing & legacy text

Continue with acad-annotatn-begin.dwg

acad-annotatn-02.mp4 5:32

In this exercise, you will learn some time-saving text editing functions including Change Case, Convert to 
Mtext, Text Align, Match Properties, Check Spelling, and Find/ Replace as well as  the differences between 
Multiline Text (Mtext) and Text (aka Dtext). Essentially, Text is the old version of Mtext. Where Mtext can 
have multiple lines of text content sorted into columns and rows as desired, Text is single line and has no 
column sorting ability built in. You can type mulitple lines of text content in a Text object, but each line will 
result in its own individual Text object. There is much less editing ability with Text vs Mtext and no asso-
ciated contextual Ribbon. All that said, many older drawings or Civil 3D drawings with content imported 
from Microstation will contain the older legacy Text.

 1. Continue working in acad-annotatn-begin.dwg
 2. Ribbon > Annotate tab > Text panel > Multiline text dropdown > Single Line

 A. Specify start point of text or
 I. Pick bottom endpoint of the green Line above SECTION B-B detail

 B. Specify paper height <0.1000>
 I. enter

 C. Specify rotation angle of text <0>
 I. enter

 D. Type section a-a
 I. Left-click outside of Text object

 II. esc
 3. Select section a-aText

 A. tcase enter
 B. TCASE dialog box : UPPER CASE
 C. OK

 4. Ribbon > Home tab > Clipboard panel > Match properties 

Info: Command can also be invoked at command line using MA

 A. Select source object

 I. Left click SECTION B-B Text

 B. Select destination object

 I. Left click SECTION A-A Text

 5. Select SECTION A-A Text
 A. Properties palette > Text

 I. Justify = Center
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 6.  Ribbon > Express tools tab > Text panel > Convert to Mtext
 A. Select objects

 I. Select STATE OF WISCONSIN DEPARTMENT OF Text
 II. Select TRANSPORTATION Text

 III. enter
 7. Select STATE OF WISCONSIN DEPARTMENT OF TRANSPORTATION Mtext

 A. Properties palette > Text
 I. Justify = Middle Center

 II. esc
 8. Ribbon > Annotate tab > Text panel > Text Align

 A. Select text objects to align
 I. SECTION B-B Text

 II. SECTION A-A Text
 III. enter
 IV. Select text object to align to

 a.  SECTION A-A Text
 b. Pick second point

 i.  shift + left click below SECTION A-A Text
 9. Ribbon > Annotate tab > Text panel > Check Spelling

 A. Start
 B. Add to Dictionary
 C. Close

 10. Ribbon > Annotate tab > Text panel
 A. Find and Replace field: shld
 B.  Find and Replace

 I. Replace with: SHOULDER
 II. Replace All

 III. Done

Text Styles

Continue with acad-annotatn-begin.dwg

acad-blk-xref-03.mp4 3:43

Whenever creating either Mtext or Text, the first step is to choose a Text Style. You pick this from a drop-
down list on your Ribbon. As with other Civil 3D and AutoCAD Styles, the Text Styles available are asso-
ciated with a drawing or template. The WisDOT Design templates come with the standard WisDOT Text 
Styles pre-loaded, though you may need to create or edit one when working with a drawing not created 
from the WisDOT template. A Text Style mainly controls font, text height, and annotative scaling func-
tionality. In the following exercise you will learn how to interface with, edit and create a Text Style.

 1. Continue with acad-annotatn-begin.dwg
 2. Ribbon > Annotate tab > Text panel > Text Style flyout button or type STYLE at the command 

line.
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 3. Current Text Style: CalibriLight
 4. New

 A. Style Name: style 2
 B. OK

 I. Font Name: Cambria
 II. Font Style: Regular

 III. Paper Text Height = 0.0000

Info: When Paper Text Height = 0 in a Text Style, the height set in the TEXTSIZE sys-
tem variable or the last Text Height used is applied.

 IV. Font Name: cdm.shx
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Info: Two basic font types can be used in Civil 3D. They are True Type or SHX. 
Whereas True Type fonts such as Arial and Calibri can have unique shapes and thick-
ness, the older, SHX fonts are only one pixel wide and are more limited in styling 
options. WisDOT Text Styles as well as most design firms and software applications 
in general use True Type fonts. Note the different icons in the Font Name dropdown.

Multileader creation

Start with acad-annotatn-01.dwg

acad-annotatn-04.mp4 4:27

A Multileader (aka Mleader) is an annotation object consisting of a combination of a text and one or more 
leader/pointers. It is used to manually add notes pointing to a specific area of interest. The text portion 
behaves just like Mtext and the leader portion is dynamically attached to the text portion. The behavior of an 
Mleader is quite flexible. For instance, you can add multiple leaders on one or both sides of the text portion 
of an Mleader if you like. A typical use case for an Mleader would be for manual annotation of construction 
details or title sheets. In the following exercise, you will learn how to create and edit Mleaders.

Keep in mind that Civil 3D objects have their own automatically generated Civil 3D Labels that will auto-
matically annotate key information like Alignment stationing, Points of Curvature/Tangency, PVIs, Corridor 
Cross Section information, etc and thus do not require manually created Mleaders for annotation. More 
information on Civil 3D Label Styles will be covered in other training modules. Use of Mleaders should be 
reserved for cases where you are either not dealing with a Civil 3D object or need to add extra information 
not feasible to put into a Civil 3D Label. 
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 1. Open acad-annotatn-01.dwg
 2. Select BOTTOM OF MEDIAN Mleader on right of SECTION A-A detail

 A. Double-click on the text portion
 B. Observe Mtext contextual Ribbon populated
 C. Left-click away from Mleader 

 3. Ribbon > Annotate tab > Leaders panel > Multileader
 A. Specify leader arrowhead location

 I. Use Nearest Osnap to pick bottom of TOPSOIL Line on right side of SECTION A-A 
detail

 B. Specify leader landing location
 I. Pick below and left of arrowhead location

 C. Type TOPSOIL
 I. Left-click away from Mleader

 4. Repeat Steps 3.A - 3.C for 10:1 MAX 20:1 NORMAL Mleader

 5. Select TOPSOIL Mleader
 A. Select arrow Grip

 I. Specify stretch point
 a. Pick to left of TOPSOIL text portion

Info: Note that the Leader portion of the Mleader is dynamically attached to 
the text portion. Once the specified location of the Leader arrow crosses the 
middle of the text portion, the Leader landing will automatically flip to the other 
side of the text.

 B. Select text insertion Grip
 I. Specify stretch point

 a. Left-click a new location
 C. Hover cursor over Leader landing Grip to reveal menu options

 I. Stretch
 a. Move text location just as in previous step

 II. Lengthen landing
 a. Specify leader landing endpoint

 i. Left-click new location
 III. Add Leader

 a. Specify leader arrowhead location
 i. Left-click multiple new locations

 D. Hover cursor over arrow Grip
 I. Remove Leader
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 E. Ribbon > Annotate tab > Leaders panel > Remove Leader
 I. Specify leaders to remove

 a. Select Leader
 b. enter

 F. Ribbon > Annotate tab > Leaders panel > Align
 I. Select multileaders

 a. Select TOPSOIL and 10:1 MAX 20:1 NORMAL Mleaders
 b. enter

 II. Select Multilieader to align to
 a. Select 10:1 MAX 20:1 NORMAL Mleader

 III. Specify direction
 a. shift + left-click left of 10:1 MAX 20:1 NORMAL Mleader

Multileader styles

Continue with acad-annotatn-01.dwg

acad-annotatn-05.mp4 7:30

Whenever creating an Mleader, you want to be aware of the currently set Mleader Style. You set this 
through the Ribbon Mleader Style Manager button. Mleader Styles control what Text Style is used for the 
Text portion, what the Leader and arrow portion looks like, whether a user-defined Block is used for either 
the arrow or in place of the text, and whether the Mleader is affected by Annotative Scaling among other 
things.  Through the following exercise, you will learn how to set the current Mleader Style, how to create or 
edit an Mleader Style, and what key Mleader parameters are set through the Mleader Style. The WisDOT 
templates come pre-loaded with standard WisDOT Mleader Styles and as with other Civil 3D or AutoCAD 
Styles, these should be used to streamline the plan production workflow and maintain a standard appear-
ance across WisDOT plan sets.

 1. Continue working in acad-annotatn-01.dwg
 2. Select TOPSOIL Mleader

 A. Properties palette > Misc
 I. Observe Multileader style = 070

 3. Ribbon > Annotate tab > Leaders panel > Mleader Style Manager flyout button or type 
MLEADERSTYLE at the command line.
 

 A. Current mulitleader style: 070
 B. Modify
 C. Leader Format tab:

 I. General
 a. Type = Straight

 II. Arrowhead
 a. Symbol = Dot

 III. OK
 D. Close
 E. Observe update to existing Mleaders with 070 Mleader Style
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 4. Ribbon > Annotate tab > Leaders panel > Mleader Style Manager flyout button
 A. Modify
 B. Leader Format tab

 I. Arrowhead
 a. Symbol = Closed filled

 II. Leader break
 a. Break size = 0.0700

 III. OK
 C. Close

 5. Select TOPSOIL and 10:1 MAX 20:1 NORMAL Mleaders
 A. Use Mleader Grips to relocate  Leader landings such that Leader lines cross

 6. Ribbon > Annotate tab > Dimensions panel > Break
 A. Select dimension to add/remove break

 I. Select 10:1 MAX 20:1 NORMAL Mleader
 B. Select object to break dimension

 I. Select TOPSOIL Mleader
 II. enter

Tip: The "object to break dimension" does not need to be an Mleader or Dimension. 
This could be most any Civil 3D or AutoCAD object
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 7. Ribbon > Annotate tab > Leaders panel > Mleader Style Manager flyout button
 A. Modify
 B. Leader Structure tab

 I. Constraints
 a. Maximum leader points = 3

Info: Setting Maximum leader points = 3 or greater means you will be prompted for 
intermediate vertex points between the arrowhead and Leader landing when creating 
an Mleader. If Maximum leader points = 2, you can still place additional Leader ver-
tices manually by hovering your cursor over an Mleader arrowhead Grip and choos-
ing Add vertex.

 C. OK
 D. Close

 8. Ribbon > Annotate tab > Leaders panel > Multileader
 A. Specify leader arrowhead location

 I. Pick any location for arrowhead
 B. Specify next point

 I. Pick any location to place break in leader line
 C. Specify leader landing location

 D. Pick any location for landing placement

Info: This can also be achieved even if Maximum leader points is set to 2 by right-clicking on 
the arrow and selecting Add Vertex. 

 9. Repeat above steps to change Maximum leader points back to 2. 
 10. Ribbon > Annotate tab > Leaders panel > Mleader Style Manager flyout button

 A. Content tab
 I. Multileader type = Block

 a. Block options
 i. Source block = Detail Callout

 B. OK
 11. Ribbon > Annotate tab > Leaders panel > Multileader

 A. Specify leader arrowhead location
 I. Pick any location

 B. Specify leader landing location
 I. Pick any location

 C. Edit Attributes
 I. Enter view number = 1

 II. Enter sheet number = 2
 D. OK

 12. Place a multileader in the drawing
 A. Multileader type = Mtext

 I. Text options
 a. Text Style = Calibri Light
 b. The button to the right opens the Text Style Manager 
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 a. Cancel
 II. Leader connection

 a. Observe options affecting Horizontal, Vertical Leader landing attachment

Dimension creation

Start with acad-annotatn-02.dwg

acad-annotatn-06.mp4 3:19

In Civil 3D, a Dimension is an object used to call out an angle or distance (length, radius, etc) in your draw-
ing. It is made up of Dimension lines, Tick marks, and an automatically generated and dynamic Dimension 
value derived from the object or points you specify, the drawing units, and the Dimension Style units. The 
following exercise will walk you though how to create a Dimension as well as the importance of setting the 
correct Dimension Style.

 1. Open both acad-annotatn-02.dwg and acad-annotatn-end.dwg
 2. acad-annotatn-end filetab

 A. Observe 20'-0"V.C. Dimension in SECTION B-B detail
 B. Observe 3' CRUSHED AGGREGATE BASE COURSE and 12' Dimensions in SECTION 

A-A detail
 3. acad-annotatn-02 filetab

 A. Ribbon > Annotate tab > Dimensions panel > Dimension Style dropdown > 070-PLAN-
CONVENTIONAL
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 B. Dim Layer Override = Use Current
 C. Ribbon Home tab > Layers panel > Layer dropdown > P_MISC
 D. Ribbon > Annotate tab > Dimensions panel > Dimension type dropdown > Linear
 E.  Linear

 I. Specify first extension line origin
 a. Left end of arc in SECTION B-B

 II. Specify first extension line origin
 a. Right end of arc in SECTION B-B

 III. Specify dimension line location
 a. Above arc

 4. acad-annotatn-end filetab
 A. Double click 20'-0" V.C. Dimension

 I. Observe that all text in cell is highlighted 

Info: The highlighted text in a Dimension is automatically generated based on the 
geometry of the Dimension along with the Dimension Style. It can include a prefix or 
suffix such as "ft" etc. among other things

Dimension styles

Exercise files: acad-data-c3d20.zip

Continue with acad-annotatn-02.dwg

acad-annotatn-07.mp4 5:24

 1. Continue with both acad-annotatn-02.dwg and acad-annotatn-end.dwg
 2. acad-annotatn-02 filetab

 A. Select 20.00' Dimension
 I. Properties palette > Misc

 a. Observe Dim Style = 070-PLAN-CONVENTIONAL
 II. Ribbon > Annotate tab > Dimensions panel > Dimension Style Manager flyout 

button or type DIMSTYLE at the command line.

 III. Styles
 a.  Select 070-PLAN-CONVENTIONAL

 i. Set Current
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 IV. New...
 a. Annotative: checked
 b. Continue
 c. New Dimension Style dialog

 i.  Primary Units tab
 i. Unit format = Engineering
 ii. Precision = 0'-0"
 iii. Suffix = V.C.

 d. OK
 V. Close

 3. Select 20.00' Dimension
 A. Properties palette > Misc

 I. Dim Style = Copy(2) of 070-PLAN CONVENTIONAL
 4. Ribbon > Annotate tab > Dimensions panel > Dimension Style Manager flyout button

 A. Select Copy(2) of 070-PLAN CONVENTIONAL Dimension Style
 B. Modify

 I. Primary Units tab
 a. Linear dimensions

 i. Scale factor = 12
 b. Place a space before V.C. in the suffix
 c. Zero suppression

 i. 0 feet = unchecked
 ii. 0 inches = unchecked
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 C. OK
 D. Close

 

Additional Dimension Tools

Continue with acad-annotatn-02.dwg

acad-annotatn-08.mp4 4:17

 1. Continue with both acad-annotatn-02.dwg and acad-annotatn-end.dwg
 2. acad-annotatn-end filetab

 A. Observe dimensions for SECTION A-A
 3. acad-annotatn-02 filetab
 4.  Ribbon > Annotate tab > Dimensions panel > Dimension Style dropdown

 A. Select Copy of 070-PLAN CONVENTIONAL
 5. Ribbon > Annotate tab > Dimensions panel > Linear

 A. Specify first extension line origin
 I. Left endpoint of pavement in SECTION A-A
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 B. Specify second extension line origin
 I. Crown endpoint of pavement in SECTION A-A

 C. Specify dimesion line location
 I. Above SECTION A-A detail

 6. Ribbon > Annotate tab > Dimensions panel > Continue
 A. Specify Second extension line origin

 I. Right endpoint of pavement in SECTION A-A
 B. Specify second extension line origin

 I. Right endpoint of SECTION A-A Crushed Aggregate Shoulder
 II. enter

 7. Select previously drawn Dimensions
 8. delete
 9. Status bar > Selection cycling = on

 10. Ribbon > Annotate tab > Dimensions panel > Quick
 A. Select geometry to dimension

 I. Select Lines on top of SECTION A-A Pavement
 II. enter

 B. Specify dimension line position
 I. Above SECTION A-A detail

 11. Ribbon > Annotate tab > Dimensions panel > Quick
 A. Select geometry to dimension

 I. Select the four arcs in SECTION A-A
 II. enter

 III. Right-click Radius 
 IV. Delete these dimensions when finished. 

 12. Ribbon > Annotate tab > Dimension panel > Continue
 A. Specify Second extension line origin

 I. Select the right side linear dimension in SECTION A-A from the previous steps
 B. Specify second extension line origin

 I. Select endpoint of subgrade line in SECTION A-A
 13. Repeat the last step on the left side of SECTION A-A
 14. Double click 3' Dimension

 A. Place cursor after auto-generated Dimension text
 B. Type CRUSHED AGGREGATE BASE COURSE SHOULDER

 15. Repeat the last step for other 3' Dimension
 16. Select 3' CRUSHED AGGREGATE BASE COURSE SHOULDER Dimension

 A. Hover cursor over text Insertion Grip
 I. Move Text Only

 II. Relocate Dimension text beside outer Dimension extension line
 17. Repeat the last step for other 3' CRUSHED AGGREGATE BASE COURSE SHOULDER Dimen-

sion
 18. Double-click 3' CRUSHED AGGREGATE BASE COURSE SHOULDER Dimension

 A. Right-click width icon Set Mtext Width
 B. Reset width to 12 units

 19. Repeat the last step for other 3' CRUSHED AGGREGATE BASE COURSE SHOULDER Dimen-
sion

 20. Ribbon > Annotate tab > Dimension panel > Dimension

Info: This is a dynamic dimension tool which will intuitively place the appropriate dimension type 
according to the selected objects. 

Annotative scale
Last updated: 2023-01-04

Total video time: 16:24
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Annotative scaling is a way to control display and scaling of certain annotation-related AutoCAD objects 
when setting up a sheet layout to plot. The purpose of this scaling is to maintain readability of your plan 
sheet regardless of the sheet  scale. For instance, you may want to label individual property parcels on a 1 
IN:40 FT scale, but omit the parcel labels at a 1 IN:200 FT scale since they would not be readable. You may 
want to label street or highway names at a constant plotted text height on both a 1 IN:40 FT scale sheet and 
a 1 IN:200 FT sheet. You can accomplish both of these scenarios without  creating duplicate text objects 
and Layers for different sheet sizes. It should be noted that Civil 3D objects will be labeled automatically 
based on their Label Style and these Labels will automatically scale similarly to AutoCAD objects affected 
by Annotative scaling.

Any object that will be affected by Annotative Scaling is said to be Annotative. AutoCAD objects available to 
be Annotative include Multiline Text, legacy single line Text, Blocks, Hatch objects, Dimensions and 
Multileaders. Many of the text-related WisDOT Styles (Multiline Text, Dimension and Multileader Styles) 
are already set up to be Annotative. You can also change any Non-annotative Multiline Text, legacy single 
line Text, Block, Hatch object, Dimension or Multileader to be Annotative through the Properties Palette.

This training module will familiarize you with basic sheet Layout concepts necessary to understand Annot-
ative Scaling, how Annotative Scaling works and tools/best practices for managing Annotative objects. 
More detailed information on sheet Layouts and plotting will be covered in other training modules.

Model vs paper, layouts & viewports

Exercise files: acad-data-c3d20.zip

Start with acad-annotatv-scl-begin.dwg

acad-annotatv-scl-01.mp4 5:08

This exercise will introduce you to the concepts of Model space vs Paper space, Layouts, Viewports, and 
Viewport Scales. Model space is the interface you will design your Civil 3D model in. It includes all of the 
Civil 3D and AutoCAD objects you will create to represent your modeled design. You can switch from 
Model space to a Layout interface where you will set up what your plotted plan sheet will look like. In a Lay-
out, you can either draw objects in Paper space, which will not affect Model space, or have a Viewport 
object that acts as a window looking into Model space. You will learn how to switch between Model space 
and a Layout, how to work in Paper space and Model space within a Layout, and how to create a Viewport 
and work with the Viewport scale. 

 1. Open acad-annotatv-scl-begin.dwg
 2. Observe the Model tab and Layout tab in the bottom left of your interface

 A. Click S11A103 Layout tab to activate the Layout
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 3. Status Bar
 A.  Customization 

 I. Paper space = checked
 B. Paper space active
 C. Draw a Circle on your Layout in Paper space

 4. Click Model tab to activate Model space
 A. Observe no Circle displayed in Model space

 5. S11A103 Layout tab
 A. Delete the Circle drawn in the above step.

 6. Status Bar
 A. Model space active

Info: Activating Model space by toggling the Status Bar PAPER/MODEL button allows you to 
work in Model space through your Layout Viewport. This is not the same as switching to 
Model space by clicking the Model tab in the bottom left of your interface.

 B. Draw a Circle on your Layout in Model space
 7.   Model 

 A. Observe Circle displayed in Model space
 8.   S11A103 Layout tab

 A. Delete the Circle drawn in Model space

Info: Double-click in an empty area outside your Viewport as an alternative method to activ-
ate Paper space. Double-click in area inside a Viewport as an alternative method to activate 
Model space.

 9. Select Viewport
 A. delete
 B. Observe Model space objects not displayed

 10. Ribbon > Home tab > Layers panel > Layer Properties
 A. Filters

 I. All = checked
 B. P_MISC_NoPlot = Current

 11. MVIEW enter
 A. Specify corner of viewport: 0,0

 I. enter
 B. Specify opposite corner: 17,11

 I. enter
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 12. Select the Viewport created in the previous step
 A. Observe that the Viewport scale ≠ 1IN:10 FT
 B. Viewport scale dropdown > 1IN:10 FT

 13. Status bar
 A. Lock Viewport scale

 B. Zoom in/out
 I. Observe Viewport scale unchanged

 14. Status bar
 A. Unlock Viewport scale
 B. Double-click inside Viewport to activate Model space
 C. Zoom in/out

 I. Observe Viewport scale changed
 D. Undo Zoom command to reverse Viewport scale change

Scaling factor, display options & object scales list

Continue with acad-annotatv-scl-01.dwg

acad-annotatv-scl-02.mp4 5:52

In this exercise you will learn how Annotative Scale factors are applied based on the currently set Annot-
ative Scale (aka Viewport Scale). Annotative objects have a constant Paper space size and a Model space 
size that depends on the current Annotative Scale. After completing this exercise, you will learn how to 
manually add scales to an Annotative Object's scales list to enable Annotative Scaling of the object. Addi-
tionally, you will learn how to utilize Annotative scaling Status Bar options to control when Annotative 
Objects are displayed and whether scales are added to Annotative Objects automatically.

 1. Continue working in acad-annotatv-scl-01.dwg
 2. Select S.T.H. 25 Annotative Mtext near 557+00

 A. Properties Palette > Text
 I. Observe Paper Text Height = 0.1250, Model Text Height = 5.0000

 3. Status Bar
 A. Observe current view Annotative Scale = 1 IN:40 FT

Info: For Annotative Objects, the Paper size is set manually or by the object Style. The cur-
rent view Annotative Scale is set manually by selecting from a dropdown list on the Status 
Bar. The Model size is set automatically and is a product of the Paper Size and the current 
Annotative Scale (i.e. Model Text Height = Paper Text Height x Annotative Scale = 0.1250" x 
(40'/1") = 5.0000'

 4. Click 1IN_40FT - 4 Layout tab
 5. Verify Paper text height

 A. Dist enter
 B. Specify first point

 I. Left-click near bottom of S.T.H. 25 Mtext
 C. Specify second point

 I. Move cursor near top of S.T.H. 25 Mtext
 II. Observe tooltip displaying approx. 0.1250
 I. esc
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 6. Verify Model text height
 A. Double-click inside plan  Viewport
 B. Repeat steps above on S.T.H. 25 Mtext

 I. Observe tooltip displaying approx. 5.0000
 C. esc

 7. 1IN_200FT - 1
 8. Status Bar

 A. Show annotation objects = on

Turning "Show annotation objects" on allows all Annotative objects to be displayed regardless of 
whether they have the current view Annotative Scale added to their object Scales List or not. If 
objects do have the current view Annotative Scale added to their object Scales List, they will be 
scaled using the current view Annotative Scale. If not, they will be displayed  using the original Annot-
ative Scale added to their scales list.

 B. Observe all Annotative Objects displayed in plan view Viewport
 9. Select one of the S.T.H. 25 Mtext objects.

 A. Properties > Text 
 I. Observe Annotative scale = 1IN:40 FT

 B. Right-click menu > Annotative Object Scale > Add/Delete Scales
 I. Add

 a. 1 IN:200 FT
 b. OK

 10. Select S.T.H. 25 Mtext from above step. 
 A. Properties > Text

 I. Observe Annotative scale = 1 IN:200 FT
 II. Observe multiple scale previews displayed

 B. Use insertion grip to move Mtext
 I. Observe only the display of the 1IN:200 FT scaled Mtext is moved

Info: When an Annotative Object has multiple scales, you have different locations 
for the display of the object at each scale. Do this by setting the scale of the display 
you want to move as the current Annotative Scale, then use the displayed Insertion 
Grip to move the object. The object will not be moved for the remaining object 
scales.

 II. esc
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 11. Select 4TH AVE Mtext
 A. Right-click menu > Annotative Object Scale > Add Current Scale

 12. Select 4TH AVE Mtext
 A. Use insertion grip to move Mtext for readability

 13. Status Bar
 A. Show annotation objects = off
 B. Observe annotative objects lacking the current Annotation Scale in their object scales list no 

longer displayed

Use cases & scales list best practices

Continue with acad-annotatv-scl-01.dwg

acad-annotatv-scl-03.mp4 5:24

In this exercise, you will learn best practices for Annotative object management including how to use the 
Annotative Scaling Status Bar options, strategies for object Scales List management, how to clean up mul-
tiple insertion points for objects with multiple object scales.

 1. Continue working in acad-annotatv-scl-01.dwg
 2. Click Model tab
 3. Status bar

 A. Add scales to annotative objects when the annotation scale changes = on
 B. Note that the above Status bar option is commonly referred to as "Add scales automatically" 

or similar

 4. Status bar > Annotation scale dropdown > 1 IN:200 FT
 A. Observe scaling of both AutoCAD Annotative objects and Civil 3D Labels

Info: When the "Add scales automatically" Status Bar option is turned on and you change the 
current view Annotative scale, the new Annotative scale will be automatically added to all 
Annotative object Scales lists in the drawing.

Warning: If you find yourself switching the current view Annotative scale often, it is best to 
leave the "Add scales automatically" Status Bar option turned off. This will prevent you from 
adding extraneous object scales to Annotative objects unintentionally. You may not want all 
Annotative objects displayed at a given scale and thus should be more selective about 
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adding Annotative Scales to object Scales lists. Additionally Civil 3D must read all object 
Scales for display generation and this can become a significant resource drain if the number 
of object scales is too great.

 5. Select one of the S.T.H. 25 Mtext objects
 A. Properties palette > Text

 I. Observe Annotative scale = 1 IN:200 FT
 6. 1IN_200FT - 1

 A. Observe all Annotative objects now displayed at 1 IN:200 FT scale

 7. Model
 A. Status bar > Annotation scale dropdown > 1 IN:40 FT

 8. Select all Annotative Mtext objects
 A. Right-click menu > Annotative Object Scale > Add/Delete Scale

 I. List all scales for selected objects = checked
 II. 1 IN:200 FT

 a. Delete
 III. OK

 9. Status bar
 A.  Add scales automatically = off
 B. Current view Annotative Scale dropdown > 1 IN:200 FT

 10. Select 4TH AVE Mtext and S.T.H. 25 Mtext near 380+00
 A. Right-click menu > Annotative Object Scale > Add Current Scale

 11. Select the Mtext from the above step.
 A. Relocate respective insertion points for readability
 B. esc
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 12. Select 4TH AVE Mtext
 A. Right-click menu > Annotative Object Scale > Synchronize multiple scale positions

Info: When running Synchronize multiple scale positions, the insertion point location used for 
synchronization is that associated with the current view Annotative Scale. Conveniently, this 
will be this insertion point whose Grip is displayed.

Text styles - fonts
Last updated: 2016-03-11

2016 fonts

All of the custom DOT-fonts and DOT .shx font files are being retired as of the Civil 3D 2016 release. 
WisDOT Civil 3D 2016 standard fonts are now all Windows True-Type fonts. 

The old fonts will be provided for legacy purposes during the transition from Civil 3D 2014 to Civil 3D 2016, 
but should not be used going forward.  The legacy text styles that use the DOT fonts are not included in the 
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2016 startup templates or sheet templates. The following is a list of the new 2016 Text Styles with cor-
responding fonts.

Style Name Font Name Font Style Annotative

ArialBlack Arial Black Regular Yes

ArialNarrow Arial Narrow Regular Yes

ArialNarrowBold Arial Narrow Bold Bold Yes

ArialRegular Arial Regular Regular Yes

CalibriLight Calibri Light Regular Yes

CalibriRegular Calibri Regular Yes

Legend Calibri Regular No

Standard Arial Regular No

Annotative text styles

The default for all but two of these Text Styles is Annotative. The text height is set to 0.00 in each style. The 
size of text should be addressed at the Civil 3D style level or annotation tool level and not at the Text Style 
level. This allows to leverage the civil annotation tools without the need for multiple styles with different 
sizes. To maintain typical WisDOT production standards it is unnecessary to develop any other Text Styles.

Legacy text styles & DOT fonts vs. Civil 3D 2016 text styles

The default for all but two of these Text Styles is Annotative. The text height is set to 0.00 in each style. The 
size of text should be addressed at the Civil 3D style level or annotation tool level and not at the Text Style 
level. This allows to leverage the civil annotation tools without the need for multiple styles with different 
sizes. To maintain typical WisDOT production standards it is unnecessary to develop any other Text Styles.

Legacy 2016 and beyond  Legacy 2016 and beyond
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C3D Text Style C3D  Text Style  DOT Font C3D  Text Style

080 CalibriLight  DOT_FONT_5 CalibriLight

100 CalibriLight  Dot_Font_10 CalibriLight

120 CalibriLight  dot_font15 ArialRegular

140 CalibriLight  dot_font20 CalibriLight

175 CalibriLight  dot_font25 TBD

200 CalibriLight  dot_font35 ArialBlack

350 CalibriLight  dot_font44 TBD

TPP_240 ArialRegular  dot_font45 ArialRegular

TPP_280 ArialRegular  dot_font49 TBD

TPP_400 ArialRegular  dot_font55 CalibriRegular

TPP_500 ArialRegular  dot_font125 TBD

TPP_525 ArialRegular    

Light drafting techniques
Last updated: 2022-03-14

Total video time: 4:56

Exercise files: acad-lit-drfting-data-C3D20.zip

acad-lit-drfting.mp4 4:56

Light drafting technique

 1. c3d > 12345678 > Design > AliProfs
 A. Open file AliProf-Sth-15-Alt3.dwg

 2. Scroll down to Data Shortcuts
 A. Right-Click on Data Shortcuts > Set Working Folder

 I. Set to folder 2 folders above shortcut folder
 a. C3D and OK

 B. Right-Click on Data Shortcuts > Set Data Shortcut Project Folder > choose project folder 
> 

 I. OK
 3. Data Shortcuts pull down > Surfaces > right-click on Exist > Create Reference

 A. OK
 4. Double Click on wheel mouse to Zoom.
 5. Data Shortcuts pull down > Alignments > centerline alignments > right-click on 15-Alt1 > Create 

Reference
 A.  OK

 6. Left-Click on the surface > Modify panel > Surfaces Properties
 7.  A. Information tab > Surface style = EX Contours 5'Major:1'Minor
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 B. OK.
 C. ESC

 8. Draw panel of the Ribbon > Polyline
 A. Starting from the left hand side and working to the right click a series of points. 
 B. Enter 

 9. Annotate tab of the Ribbon > Text panel > Multiline Text
 10. Left-Click to create a text box.
 11. Type in the box Passing lane 150' - widen 12'
 12. Left-Click to enter text box.
 13. SC Enter
 14. Click on text and type in 10.
 15. Enter

TrueView navigating and measuring
Last updated: 2021-03-18

Total video time: 3:35

Exercise files: acad-truvu-nvigat-mesur-data-C3D20.zip

acad-truvu-nvigat-mesur.mp4 3:35

TrueView navigating and measuring

 1. c3d > 12345678 > SheetsOther

 A. Open file Stoneridge Road Aerial.dwg

Info: Ignore missing SHX files if prompted. 

 2. Scroll with the wheel to zoom in.
 3. Push the wheel to pan.
 4. View ribbon  > Unsaved View > 

 A. West
 B. North
 C. East
 D. Intersection

 5. Navigation ribbon > Extents

Info: Zoom Extents is also done by double-clicking on the scroll button of the mouse. 

 6. Zoom to Intersection saved view. 
 7. Measure ribbon > Measure > Distance

 A. Object Snap toolbar > Endpoint
 B. Left-Click on the end of driveway
 C. Object Snap toolbar > Intersection
 D. Left-Click where two road ways intersect.

Points

Civil 3D point basics
Last updated: 2021-06-17
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Total video time: 05:31

pnt-basc-01.mp4 5:31

Exercise Files:pnt-basc-data-begin-c3d20.zip

Point types

AutoCAD Point (aka Node)

 1. XYZ marker, marks Cartesian coordinate location. 
 2. Not used for most Civil 3D workflows.
 3. PTYPE Enter

 A. Point Style dialog box
 B. Select a Point Style (style will affect every AutoCAD point in the file).
 C. OK

 4. Limited display control; only Layers.

COGO Points

 1. Typically used for proposed construction staking points, not existing survey data predominantly.
 2. Appearance is controlled by Civil 3D Styles with Description Key Set.  Point Style for the symbol, 

Point Label Style for the text.
 3. Select on marker or text is all one unit.

Survey Points

 1. Survey Points are COGO points held in the Survey Database and can only be edited in the Survey 
Database.

 2. Survey points are imported into the file from the Survey Database.
 3. Appearance can be changed through Civil 3D Styles and Description Key Sets the same as COGO 

points.
 4. When inserting Survey Database Points into a file, use the Survey Template so the correct Styles 

are available for the survey points.
 A. Toolspace > Survey tab > Survey Databases

Description Key Set

Toolspace > Settings tab > Point > Description Key Sets

 1. Uses point data to place the point on the designated layer, assigned style or label, and other prop-
erties.

Point Groups

Toolspace > Prospector tab > Point Groups

 1. Point Groups section off groupings of points so point style or labels can be assigned.  Also you can 
gather points by a common characteristic or control need, such as, surface definition points.

 2. A point can be a part of as many point groups as they have been defined to. The Toolspace listing of 
point group names is a priority listing of style assignment when any point is part of more then one 
conflicting point group style.

 3. Point Groups can hold both survey and COGO points. 
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Accessing Civil 3D points
Last updated: 2023-03-24

Total video time: 05:19

pnt-accs-01.mp4 5:19

Points in Civil 3D can be accessed in several different ways.

                     Model space                 

Directly selecting a COGO or Survey Point in Model space opens the respective Contextual Ribbon. A Con-
textual Ribbon is not available when multiple survey points are selected.

Toolspace

Points

 1. Toolspace palette > Prospector tab > Points 
 2. Left-click Points (populates Toolspace Preview window)

 A. right-click  Points > Edit Points... (opens Panorama window)

Point Groups

 1. Toolspace palette > Prospector tab > Point Groups
 2. Left-click Point Groups (populates Toolspace Preview window, lists Point Groups in priority order 

for style display)
 3. Expand Point Groups list, for selecting specific point groups.
 4. Right-click Point Groups (for contextual functions)

 A. right-click  Point Groups > Edit Points... (opens Panorama window)
 

Info: 
Left-click and Drag to move column headers. Left click on a column header to sort rows by selected 
column header.

Left-click on a point for editing. (Ctrl+Select) to cherry-pick multiple points, (Shift+Select) to select 
a range of points, (Ctrl+A) to select all points.

Ribbon

Access Point creation, conversion and modification tools through the Ribbon

Point Creation Tools

 1. Home tab > Create Ground Data panel > Points dropdown
 A. Point Creation Tools (toolbar with different tools to build or create points in a file)

Tip: These tools can also be found under Point Creation Tools fly-out menus.

 B. Create Point Group
 C. Convert AutoCAD Points (will convert AutoCAD points to COGO points)

Properties Palette
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Select a point > Right-click  > Select Properties…

You can see detailed information and make limited modifications in the Properties Palette. Not all Prop-
erties can be edited.

Warning: Changing information in the Properties Palette is not recommended. It may make it harder 
to find where the change is taking place. 

Point groups and styles
Last updated: 2021-06-29

Total video time: 04:22

pnt-grp-styl-01.mp4 4:22

Editing individual points

 1. Select a point
 2. Right-click > Edit Points…

Point styles

 3. Point Editor Panorama
 A. Style column

 I. Left-click  Style field
 4. Select Point Style dialog box

 A. Dropdown to select style
 B. OK

Point label style

 5. Point Editor Panorama
 A. Point Label Style column

 I. Left-click  Point Label Style field
 6. Select Label Style dialog box

 A. Dropdown to select style
 B. OK

Point layer

 7. Point Editor Panorama
 A. Point Layer column

 I. Left-click  Point Layer field
 8. Layer Selection dialog box

 A. Select existing layer
 B. New... to create a layer not available in existing list.
 C. OK

Info: The Description Key Set may assign a style, label style, and layer into these fields during cre-
ation or import.
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Description key set

Raw Description is what the surveyor or point creator entered for the description field.

Full Description is what that description is after the description key has filtered through it.

 9. Toolspace > Settings tab > Point > Description Keys Sets > right-click WisDOT Topography… > 
Edit Keys…

Editing point groups         

Toolspace > Point Groups

Point style or label style

 10. Point Groups > right-click Surface Points > Properties…
 11. Point Group Properties - Surface Points dialog box

 A. Information tab
 I. Default Styles area

 a. Point style dropdown
 b. Point label style dropdown

 12. OK

Tip: The Description Keys assigned to a point will prevent a point group from assigning styles or 
label styles. For the point group to take back control from the Description Key.

 13. Point Groups > right-click Surface Points > Properties…
 14. Point Group Properties - Surface Points dialog box

 A. Overrides tab
 I. Style: checked

 II. Point Label Style: checked
 15. OK

Point creation tools
Last updated: 2022-12-07

Total video time: 06:05

pnt-creat-tl-01.mp4 6:05

Exercise data:pnt-creat-tl-data-begin-c3d20.zip

Point Creation Tools

Point creation tools are for placing and creating COGO points, not survey points.

Two ways to access point creation tools

 1. Ribbon > Home tab > Create Ground Data tab > Points dropdown > Point Creation Tools > fly-
out menus

 2. Choose Point option       
 3. Ribbon > Home tab > Create Ground Data tab > Points dropdown > Select Point Creation Tools
 4. Create Points toolbar > Point dropdowns

 A. Choose Point option
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Tip: Point Creation toolbar (cheveron) dropdown > expand Point Creation Used to change Point 
Creation settings, such as, Prompt For Elevations or Prompt For Descriptions. Click (cheveron) 
again to close.

Create point toolbar examples

Miscellaneous points > Manual

 1. Ribbon > Home tab > Create Ground Data > Points dropdown > Left-click Point Creation Tools 
> Create Points toolbar > Miscellaneous dropdown > Manual

 A. Specify location of new point: select a location to drop point      
 B. Enter a point description: EA (Edge of Asphalt) Enter
 C. Specify a point elevation: 962.31Enter 
 D. Repeat steps 1-3 for additional points. 
 E.       Enter

Intersections > Direction/Distance

For placing points after you have other information available.

Info: Watch what the Command Line asks for.

 1. Ribbon > Home tab > Create Ground Data > Points dropdown > Left-click Point Creation Tools 
> Create Points toolbar > Intersections dropdown > Direction/Distance

 A. Specify a location for the radial point: (Shift+Right-click),  NODE and 
snap to COGO point      

 B. Enter radius: 5Enter
 C. Specify start point: (Shift+Right-click),  Node and snap to same COGO point. 
 D. Specify Direction at start point: B (Bearing) Enter
 E. Specify quadrant: (3 or select SW of start point. 
 F. Specify Bearing: 62.05Enter
 G. Specify an offset: 0Enter
 H. Enter a point description: Bldg CornerEnter
 I. Specify a point elevation: 961.55Enter
 J.       Enter
 K. Repeat steps for additional points. 
 L.       Enter

Alignments > Station offset

 1. Ribbon > Home tab > Create Ground Data > Points dropdown > Left-click Point Creation Tools 
> Create Points toolbar > Alignment dropdown > Station/Offset

 A. Select alignment: Select alignment (a red-rubberband-line keeps point perpendicular 
to alignment).      

 B. Specify station along baseline: 154Enter
 C. Specify an offset: 12Enter             (Negative numbers are left, positive numbers are right of 

alignment).
 D. Enter a point description: EA (Edge of Asphalt) Enter
 E. Specify a point elevation: 965Enter
 F.       Enter

Exercise data:pnt-creat-tl-data-end-c3d20.zip
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Importing points from a file
Last updated: 2021-06-29

Total video time: 04:12

pnt-imprt-frm-fil-01.mp4 4:12

Exercise files: pnt-imprt-frm-fil-data-begin-c3d20.zip

Contains description keys, styles, layers, etc. for points to display correctly.

Open survey template file

 1. Menu Browser > New Do not go to QNew icon. That will start a design file, not a survey file.
 A. Select Template dialog box

 I. Begin-dwg folder > survey-start.dwt
 II. Open

Info: Once open, save file in project location.

Import Point File

 2. Ribbon > Insert tab > Import panel > Points from File
 3. Browse to file
 4. Select correct File Format (ie. PNEZD - Point Number, Northing, Easting, Elevation, Description)
 5. Toggle Add Points to Point Group On/Off
 6. OK

Editing points
Last updated: 2021-06-29

Total video time: 06:22

pnt-edit-01.mp4 6:22

Exercise data: pnt-edit-data-begin-c3d20.zip

Using grips to edit points

Selecting a COGO point gives 2 grip points.

 1. Rhombus/diamond grip point
 A. Select to move point or hover over grip > Move Marker
 B. hover over grip > Rotate Marker (rotates only marker and leaves label alone)
 C. hover over grip > Rotate marker and label (rotates both marker and label together)
 D. If any of these options were used,  hover over grip > Reset options available

 2. Square grip point
 A. Select to move and get a leader line, Esc to cancel
 B. hover over grip > Rotate Label (rotates only label and leaves marker alone)
 C. hover over grip > Toggle sub item grips (allows you to move each component; point num-

ber, point description, and point elevation)
 D. If any of these options were used,  hover over grip > Reset options available
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Editing points from data

Editing points number from data

 1. Toolspace > Prospector tab > select Points
 2. In Toolspace Preview window, Right-click on a point > Renumber… (allows adding a factor to elev-

ation)
 3. Enter an additive factor to point numbers: 10000 Enter:

Info: Right-click Points > Refresh to update Preview Window.

Editing point elevation from data

 1. Toolspace > Prospector tab > select Point Groups > Survey User-Defined

Info: If point isn't in Toolspace Preview list, right-click Survey User-Defined > Update (pop-
ulates new point numbers to list).

 2. In Toolspace Preview window, Right-click on new point 10001 > select Datum… (allows adding a 
factor to elevation)

 3. Change in Elevation: 900 Enter

Editing point elevation from surface

 1. Toolspace > Prospector tab > select Point Groups > Survey User-Defined
 2. In Preview window

 A. Right-click on new point 10001 > select Elevation from Surface…
 B. Select surface dialog box, 2 options :

 I. Select a surface from dropdown list, Exist, OK
 II. Select from Screen icon

 a. Select Exist surface, OK

Transparent commands for points
Last updated: 2021-06-29

Total video time: 04:15

pnt-trnsprnt-cmnd-01.mp4 4:15

Exercise files: pnt-trnsprnt-cmnd-data-begin-c3d20.zip

Using transparent commands

Transparent commands that help you draw with point object, point number, or point name.

Transparent command for point object

 1. Ribbon > Home tab > Create Design panel > Feature Line dropdown > Create Feature Line
 2. Create Feature Lines dialog box

 A. Name: checkedEA1
 B. OK
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 3. Ribbon > Transparent tab > Point panel > Point Object
 A. Select a point
 B. Specifiy elevation: Enter
 C. Repeat steps 4-5 until all points are selected.
 D. Enter to end Transparent command.
 E. Enter to end Draw Feature Line command.

Transparent command for point numbers

Start a 3D polyline:

 4. 3dpoly Enter
 5. Ribbon > Transparent tab > Point panel > Point Number
 6. 3284,3374,3391,3400 Enter

Info: Use (,) between numbers. (Space) is Enter in the command line. Use (-) between num-
bers to draw a line between all points within a range in order. 

 7. Enter to end Transparent command.
 8. Enter to end 3D Polyline command

Creating points from alignments
Last updated: 2021-06-29

Total video time: 08:21

pnt-creat-frm-ali-01.mp4 8:21

Exercise files: pnt-frm-ali-data-begin-c3d20.zip

Creating points from alignments workflow

Home tab > Create Ground Data > Points dropdown > select Point Creation Tools

Start by setting automatic settings

 1. Open chevron  
 2. Expand Points Creation

 A. Prompt For Elevations = Automatic
 B. Prompt For Descriptions = Automatic - Object 

Info: Object part will pick up name and station of the alignment for each point. 
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 3. Minimize to close Point Creation.
 4. Expand Point Identity 

 A. Next Point Number = 10000

Info: Allows you to identify proposed points easily

 5. Chevron to close.

Creating points from alignments

 6. Point by Alignment dropdown > At Geometry Points 
 A. Select alignment: select the alignment

 I. Select a profile dialog box : <none> 
 a. OK

 B. Starting station: Enter to accept
 C. Ending station: Enter to accept
 D. Enter

 7. Point by Alignment dropdown > Profile Geometry Points 
 A. Select alignment: select the alignment

 I. Select a profile dialog box : RiverRoad-CL 
 a.  OK

 B. Starting station: Enter to accept
 C. Ending station: Enter to accept
 D. Enter
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Info: If you don’t have the Elevation Description set to Automatic, you’ll need to put 
that information in for each point.

 8. Point by Alignment dropdown > Measure Alignment 
 A. Select alignment: select the alignment

 I. Select a profile dialog box : <none>
 a.  OK

 B. Starting station: Enter to accept
 C. Ending station: Enter to accept
 D. Specify an offset: 0.000Enter 
 E. Enter an interval: 50Enter
 F. Enter

 9. Close Create Points tools dialog. 

Update new points to point groups

Toolspace > Prospector tab > right-click Point Groups > Update

Create a new point group

 10. Toolspace > Prosector tab > right-click Point Groups > New… 
 11.          Point Group Properties dialog box 

 A. Information tab 
 I. Name: RiverRoad Align

 II. Default Styles:
 a. Point Style: Basic
 b. Point Label Style: Pnt Number Raw Desc Elev

Info: Double-check these Styles. They may not be the default. 

 B. Include tab
 I. With raw description matching (checked):   RiverRoad*

 C. Select Point List tab to verify there are points there. 
 D. OK

Verifying points are taking existing ground elevation, not proposed

 12. Toolspace > Prospector tab > Point Groups > right-click RiverRoad Align 
 13. Toolspace Preview window

 A. Shift+A to select all points.
 B. Right-click > select Elevations from Surface

 I. Select surface : Exist
 II. OK

Export as *.csv, send out to the field

 14. Toolspace > Prospector tab > Point Groups > right-click RiverRoad Align > Export Points… 
 15. Export Points dialog box 

 A. Format dropdown: PNEZD (comma delimited)
 B. Destination File: browse folder

 I. Look in dropdown: project folder Other
 II. File Name: RiverRoad Align

 III. Files of Type: *.csv
 IV. Open
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 C. Limit to Points in Point Group (checked)
 D. OK

Surfaces

Accessing Civil 3D surfaces
Last updated: 2021-06-29

Total video time: 5:20

Exercise files: srfc-accs-data-begin-c3d20.zip

Start with 12345678\Design\Surfaces\Surf-Ex .dwg

srfc-accs-01.mp4 5:20

Accessing surfaces from Home Ribbon

Context Ribbon > Home tab > Create Ground Data panel > select Surfaces dropdown

 1. Create Surface creates a surface with no definition.
 A. In the dialog box you can control the surface type and properties.

 2. Create Surface with a file; DEM, Point Cloud, TIN, etc.

Accessing surfaces from Toolspace

 3. Toolspace > Prospector tab > right-click Surfaces
 A. Create surface options 
 B. Export file options. This will export all surfaces in surface area. 

 4. Toolspace > Prospector tab > expand Surfaces > right-click Exist
 A. Edit properties and styles, rebuild, work with Snapshots, delete, or use other basic AutoCAD 

tools.
 5. Toolspace > Prospector tab > expand Surfaces > expand Exist

 A. Create or edit Masks
 B. Create or edit Watersheds
 C. Expand Definitions

 I. Add data to define the surface; boundaries, adding breaklines to a surface, creating 
a surface from contours, DEM file, drawing objects, edits, import point files or point 
groups, or survey queries.

Accessing surfaces from Context Ribbon

 6. Left-click surface in file > opens Context Ribbon (opens tools specifically for the surface)
 A. Label & Tables tab

 I. Add Labels; Slope labels, Spot elevations, or Contour labels
 II. Add Legend, tables.

 B. General Tools tab
 I. Inquiry; add points to check elevation or distance.

 II. AutoCAD properties of objects
 C. Modify Tools tab

 I. C3D Surface properties or edit surface styles.
 II. Add Data, same tools listed as Toolspace Definition.

 III. Edit Surface dropdown > Paste Surface is an important tool used with WisDOT sur-
faces.
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 D. Analyze Tools tab
 I. Waterdrop and Catchment Area (basic analysis of waterflow over a surface)

 II. Create a Volume Dashboard
 III. Visibility Check
 IV. Analyze tab dropdown 

 a. Check for Contours Problems
 b. Stage Storage for potential ponds.

 E. Surface Tools tab
 I. Drape an Image

 a. Extract from Surface dropdown
 i. Create Cropped Surface, if surface is too large
 ii. Extract an Object; triangle lines, border, or contours lines
 iii.  Export to DEM

 F. Launch Pad tab
 I. Create a Profile

 II. Data Shortcut
 III. Grading Tools
 IV. Quick Profile to troubleshoot an area 

Surface styles
Last updated: 2021-06-29

Total video time: 04:08

Exercise files: srfc-styl-data-begin-c3d20.zip Surf-Ex.dwg

srfc-styl-01.mp4 4:08

Two ways to access surface styles

Contextual Ribbon

 1. Click on surface to select     
 2. Context Ribbon > Modify panel > click Surface Properties

 A. Surface Properties dialog box             
 I. Information tab > Surface style dropdown and select style                 Click Apply to view the 

surface selected before clicking OK.               
 II. OK               

Toolspace

 3. Click on surface to select     
 4. Toolspace > Prospector tab > expand Surfaces > right-click Exist > Surface Properties...

 A. Surface Properties dialog box             
 I.                  Information tab > Surface style dropdown and select style                 Click Apply to view the 

surface selected before clicking OK.               
 II. OK               

Copy a surface style

Warning: Do not use Edit Surface Style option for WisDOT projects. This will cause conflicts with 
the currently assigned style from the WisDOT template file, which should remain as standards. Copy 
the style and edit the copy instead.
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 5. Click on surface to select     
 6. Context Ribbon > Modify panel > click Surface Properties

 A. Surface Properties dialog box             
 I.                  Information tab > Surface style dropdown: P Contours 5' Major:1' Minor

 II.                  select Edit icon dropdown > Copy Current Selection                 Copy will take ALL of the set-
tings from selected surface style.                 

 a. Surface Style [Copy] dialog box 
 i. Information tab > Name: P Contours 5' Major
 ii. Display tab > Minor Contours: turn off (lightbulb)
 iii. Display tab > Major Contours: change color to green

 b. OK
 III. Apply to view or OK to set style               

Surface basics
Last updated: 2021-06-29

Total video time: 03:58

Exercise files: srfc-basc-data-begin-c3d20.zip

Start with 12345678\Design\Surfaces\Surf-Ex.dwg

srfc-basc-01.mp4 3:58

Civil 3D surfaces are a dynamic object representing elevation through a series of triangles; TIN surface tri-
angles or gridded surface triangles.

Change surface style

 1. Select surface > right-click menu > select Surface Properties...
 A. Surface Properties dialog box  

 I. Default styles box 
 a. Surface style dropdown: EX TrianglesOK

Tip: TIN triangles are irregular.  Gridded triangles are even or squared; two right-triangles that define 
the grid.

Surface borders and boundaries

Borders: Indicates where the edge of the triangles is located.

Outer Boundaries: Prevent triangles from being made outside the boundary line.

Inner or Hide Boundaries (aka Void boundaries): Prevents triangles from being made inside its shape.

Show Boundary: Drawn inside the Hide Boundary and are used to display triangles that the Hide Boundary 
removed.

Volume surface

Comparison of volume between two surfaces, TIN or grid.
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 2. Toolspace > Prospector tab > right-click Surfaces > select Create Surface
 A. Create Surface dialog box  

 I. Type dropdown: TIN volume surface
 II. Properties box 

 a. Surface style dropdown: EX TrianglesOK
 b. Name: TIN Vol
 c. Base Surface: Exist
 d. Comparison Surface: Grading

 III. OK
 3. Toolspace > Prospector tab > expand Surfaces > right-click TIN Vol > Surface Properties...
 4. Surface Properties - TIN Vol dialog box 

 A. Surface style: Vol Elevation
 B. OK 

Surface properties - General
Last updated: 2021-06-29

Total video time: 03:51

Exercise files: srfc-prprtis-gnrl-data-begin-c3d20.zip Surf-Ex.dwg

srfc-prprtis-gnrl-01.mp4 3:51

Surface properties overview

3 ways to locate surface properties

 1. Toolspace > Prospector tab > expand Surfaces > right-click Exist (name of surface) > Surface 
Properties... opens dialog box

 2. Select surface > Contextual Ribbon > Modify panel > Surface Properties clicking on button/icon 
to launch dialog box

 3. Select surface > right-click surface > Surface Properties... opens dialog box

About surface dialog box

Surface dialog box has 4 tabs

 4. Information
 A. surface name, description, create or manage surface styles, and change render material.

 5. Definition (See video above)
 6. Analysis

 A. User can run analysis on the surface, baking the information into the surface to be displayed 
through tables or styles that are applied to the surface. Color schemes can be used to help 
with visibility of analysis on the surface.

 B. Types of analysis; contours, direction, elevation, slopes, slope arrows, user-defined, or 
watersheds.

 C. Set range and range details
 7. Statistics

 A. General, coordinates and elevation information.
 B. Extended, surface areas and slopes.
 C. TIN, triangle information; number of triangles, area, and lengths.

Info: This information is not editable.
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Surface properties - Definition
Last updated: 2021-06-29

Total video time: 07:09

Exercise files: srfc-prprtis-defnitn-data-begin-c3d20.zipSurf-Ex.dwg

srfc-prprtis-defnitn-01.mp4 7:09

The definition tab will provide an area where the user can control what rules the surface has to follow to be 
built, any limitations, as well as a list of all edits.

Tab location

 1. Select on surface
 2. Context Ribbon > Modify panel > Surface Properties

 A. Surface Properties dialog box 
 I. Definition tab 

 a. Definition options: build options, rules and limitations
 b. Operation type: list of edits

Changing long triangles

Sometimes found along outside edges of the surface

 3. Surface Properties dialog box 
 A. Definition tab 

 I. Expand Build 
 a. Use maximum triangle length: Yes
 b. Maximum triangle length: 85

 B. OK
 4. Surface Properties - Rebuild Surface dialog box > Rebuild the surface

Info: Void areas, areas where the triangles exceeded 85 feet. This might be an area where 
the user could use a boundary to clear out the triangles.

Tell the surface to use or ignore crossing breaklines

 5. Surface Properties dialog box         
 A. Definition tab 

 I. Operation Type: check box Add breakline, Breakline set1
 B. Apply

 6. Surface Properties - Rebuild Surface dialog box > Rebuild the surface
 7. Surface Properties dialog box         

 A. Definition tab 
 I. Operation Type: check box Add breakline, Breakline set2

 B. Apply
 8.          Surface Properties - Rebuild Surface dialog box > Rebuild the surface
 9. Panorama > Events tab > Error         Info: Error says breakline is not being used because it is cross-

ing over.        
 A. select Green Check Mark to close
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 10. To correct the crossing breakline error, Context Ribbon > Modify panel > Surface Properties
 A. Surface Properties dialog box 

 I. Definition tab 
 a. Operation Type: uncheck box Add breakline, Breakline set2
 b. Definition Option > Allow Crossing breaklines: Yes
 c. Definition Option > Elevation to use: Use last breakline elevation at inter-

section
 d. Operation Type: check box Add breakline, Breakline set2

 II. Apply
 11. Surface Properties - Rebuild Surface dialog box > Rebuild the surface
 12. Panorama > Events tab > Information       

Changing the order of operation definition

 13. Surface Properties dialog box         
 A. Definition tab             

 I. Operation Type > select Add breakline, Breakline set2
 II. Click Up Arrow button

Info: Orange markers will appear whenever you make a change to the order, 
telling you to take notice.

          
 B. Apply

 14. Surface Properties - Rebuild Surface dialog box > Rebuild the surface
 15. OK
 16.          Parorama box > select Green Check Mark to close  

Exercise files: srfc-prprtis-defnitn-data-end-c3d20.zipSurf-Ex.dwg     

Surface breaklines
Last updated: 2021-06-29

Total video time: 07:04

Exercise files: srfc-brklin-data-begin-c3d20.zip

Start with 12345678\Design\Surfaces\srfc-brklin.dwg

srfc-brklin-01.mp4 7:04

Surface breaklines are 3-dimensional lines that prevent a surface from triangulating in areas that it should 
not. 

Standard breaklines

Info: 3D polylines or feature lines are the best to use for breaklines.

 1. Toolspace > Prospector tab > expand Surfaces > expand Exist (surface file) > expand Defin-
ition > right-click Breaklines > Add...

 A. Add Breaklines dialog box 
 I. Type: Standard

 II. OK
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Info: If you are creating a proposed surface using breaklines, using File link options 
will allow to set certain factors for the triangles. 

 B. Select feature line and Enter

Proximity breaklines

Proximity breaklines are 2D polylines that will translate into 3D data.

 2. Toolspace > Prospector tab > expand Surfaces > expand Exist (surface file) > expand Defin-
ition > right-click Breaklines > Add...

 A. Add Breaklines dialog box
 I. Type: Proximity

 II. OK
 B. Select feature line and Enter

Wall breaklines

If the surveyor only has top or bottom points of a wall in the file, and height documented, this is how the user 
can add the other points of a wall.

 3. Toolspace > Prospector tab > expand Surfaces > expand Exist (surface file) > expand Defin-
ition > right-click Breaklines > Add...

 A. Add Breaklines dialog box 
 I. Type: Wall

 II. OK
 4. Select object: PolylineEnter
 5. Pick offset side: select south side of line 
 6. Enter option for wall height: All Enter        All is all of the points will take the same height.  

Individual is each vertex point will have a different height. 
 7. Enter elevation difference for offset points: 5Enter

Info: Right-click surface > Object viewer... will allow user to view/confirm the wall.

Non-destructive breakline

The elevation for each new point is extracted from the original surface triangle, therefore maintaining the 
integrity of the original surface.

 8. Toolspace > Prospector tab > expand Surfaces > expand Exist (surface file) > expand Defin-
ition > right-click Breaklines > Add...

 A. Add Breaklines dialog box
 I. Type: Non-destructive

 II. OK
 9. Select feature line and Enter

From file breaklines

 10. Toolspace > Prospector tab > expand Surfaces > expand Exist (surface file) > expand Defin-
ition > right-click Breaklines > Add...

 A. Add Breaklines dialog box  
 I. Type: From file

 II. From link options: Break link to file
 III. OK
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 B. Import Breakline File > Exist.flt > Open

Exercise files: srfc-brklin-data-end-c3d20.zip

Surface creation
Last updated: 2021-06-15

Total video time: 04:05

Exercise files: srfc-creat-data-begin-c3d20.zip

Start with 12345678\Design\Surfaces\Surf-Ex .dwg

srfc-creat-01.mp4 4:05

Build a surface

 1. Ribbon > Home tab > Create Ground Data panel > Surfaces dropdown > Create Surface
 2. Create Surface dialog box

 A. Properties box 
 I. Name: Exist

 II. Style: EX Contour 10' Major:2' MinorOK
 B. OK

 3. Toolspace > Prospector tab > expand Surfaces > expand Exist (surface file) > expand Defin-
ition > right-click Point Files > Add...

 A. Add Point File dialog box
 I. Select File: Browse > EXIST.pnt > Open

 II. Specify point file format: PENZ (space delimited)
 III. OK

 4. Toolspace > Prospector tab > expand Surfaces > expand Exist (surface file) > expand Defin-
ition > right-click Breaklines > Add...

 A. Add Breaklines dialog box 
 I. Type: From file

 II. File link option: Break link to file
 III. OK

 B. Import Breakline File > EXIST.flt > Open

Exercise files: srfc-creat-data-end-c3d20.zip

Surface boundaries
Last updated: 2021-06-29

Total video time: 06:57

Exercise files: srfc-bndry-data-begin-c3d20.zip

Start with 12345678\Design\Surfaces\Surf-Ex .dwg

Data Clip and Outer boundaries

srfc-bndry-01.mp4 3:56
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Data Clip boundaries

Data Clip boundaries are placed before you have a surface definition, preventing the definition from being 
too large.

 1. Start with a closed polyline shape.

Tip: Closed polyline shape is important, otherwise the boundary tool will close it for you and you may 
get a result you weren't expecting. 

 2. Toolspace > Prospector tab > right-click Surfaces > select Create Surfaces
 A. Create Surfaces dialog box 

 I. Properties box 
 a. Name: Exist
 b. Style: EX TrianglesOK

 II. OK
 3. Toolspace > Prospector tab > expand Surfaces > expand Exist > expand Definition > right-click 

Boundaries > select Add...
 A. Add Boundaries dialog box 

 I. Name: Data
 II. Type dropdown: Data Clip

 III. OK
 B. Select polyline

 4. Select Polyline drawn in Step 1
 5. Toolspace > Prospector tab > expand Surfaces > expand Exist > expand Definition > right-click 

Point Files > select Add...
 A. Add Point File dialog box 

 I. Selected Files: Add (+) 
 a. Select Source dialog box 

 i. Exist.pnt
 ii. Open

 II. Specify point file format: PENZ (space delimited)
 B. OK

Outer boundaries

Outer boundaries are placed after the surface has been created.

 6. Context Ribbon > Draw tab > select Polyline tool
 A. Draw a closed polyline

Tip: At second to last point, press "C" to close the shape. 

 7. Toolspace > Prospector tab > expand Surfaces > expand Exist > expand Definition > right-click 
Boundaries > select Add...

 A. Add Boundaries dialog box 
 I. Name: Outer

 II. Type dropdown: Outer
 III. OK

 B. Select polyline

Info: Non-destructive stops triangles up to the edge of the boundary line. Destructive ends at 
the triangle just past the boundary line.

Hide and Show boundaries
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srfc-bndry-02.mp4 3:01

Hide and Show Boundaries are meant to prevent surface triangles from being created inside the area you 
area working in.

Hide boundary

 1. Toolspace > Prospector tab > expand Surfaces > expand Exist > expand Definition > Right-
click Boundaries > select Add... This step is going to add a new boundary. 

 A. Add Boundaries dialog box 
 I. Name: Treeline

 II. Type dropdown: Hide
 III. Non-destructive breakline: checked                 Non-destructive stops triangles up to the edge 

of the boundary line. Destructive ends at the triangle just past the boundary line. 
 IV. OK

 2. Select polyline shape 
 3. Right-click for dropdown, Enter

Show boundary

A space with triangles inside a Hide Boundary.

 4. Select closed polyline shape inside Hide Boundary.
 5.  Toolspace > Prospector tab > expand Surfaces > expand Exist > expand Definition > Right-

click Boundaries > select Add...
 A. Add Boundaries dialog box 

 I. Name: Show
 II. Type dropdown: Show

 III. Non-destructive breakline: checked
 IV. OK

 6. Select polyline, Enter

Info: Show boundaries remember where the triangles were before the Hide boundary was created.  
Show boundaries cannot be created on their own, they need a Hide boundary first.

Surface masks
Last updated: 2021-06-29

Total video time: 02:37

Exercise files: srfc-msk-data-begin-c3d20.zip

Start with 12345678\Design\Surfaces\Surf-Ex.dwg

srfc-msk-01.mp4 2:37

Surface masks are meant to cover up or obscure the surface definition in an area without removing surface 
triangles from the definition.

Info: Only allowed one mask per surface.

 1. Toolspace > Prospector tab, expand Surfaces > expand Exist (surface 
file) > right-click Masks > Create Mask...

 2. Select objects:  select closed polyline shape Enter
 3. Create Mask dialog box
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 A. Properties box > Information > Name: Mask 1
 B. Masking box > Mask type: Inside

Info: Inside mask will cover everything inside the selected polyline shape.  Outside 
mask will cover everything outside the selected polyline shape.

 A. OK

Surface edits
Last updated: 2021-06-29

Total video time: 05:26

Warning: Surfaces edits should not be used on design or refinement surfaces. They can be used in 
setup and non-design surfaces.

Exercise files: srfc-edit-data-begin-c3d20.zip

Start with 12345678\Design\Surfaces\Setup-Crdr-STH25.dwg

srfc-edit-01.mp4 5:26

 1. Open file Setup-Crdr-STH25.dwg
 2. Select surface
 3. Context Ribbon > Modify panel > Edit Surfaces dropdown > Swap Edge
 4. Select a surface triangle edge
 5. Select first Tin Surface in Selection Cycling
 6. Enter

Surface point editing tool

 7. Select surface
 8. Context Ribbon > Modify tab > Surface Properties dropdown > Edit Surface Style

 A. Surface Style dialog box 
 I. Display tab 

 a. Point component, check light bulb
 B. OK
 C. Warning box, select Apply the edits for this drawing session only

Adding a surface point

 9. Select surface
 10. Context Ribbon > Modify tab > Edit Surface dropdown > Add Point
 11. Select a location to place new point
 12. New elevation: 1157.5Enter
 13. Enter to end command

Moving a surface point

 14. Select surface
 15. Context Ribbon > Modify tab > Edit Surface dropdown > Move Point
 16. Specify point to move: left-click on a point
 17. Specify a new location for the point: left-click new location
 18. Enter to end command
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Modifying a surface point

 19. Select surface
 20. Context Ribbon > Modify tab > Edit Surface dropdown > Modify Point
 21. Select point: left-click a point Enter
 22. New elevation: 1157.78Enter
 23. Enter to end command

Adding a line

 24. Select surface       
 25. Context Ribbon > Modify tab > Edit Surface dropdown > Add Line                  Needs point vertices turned 

on.       
 26. Left-click a vertex point, then select a second vertex point to add a line between       
 27. Enter to end command       

Surface properties - Analysis
Last updated: 2021-06-29

Total video time: 06:15

srfc-prprtis-anlysis-01.mp4 6:15

Analysis tools

Types of analyses you can run on a surface include elevation banding, slopes, slope arrows, specialized 
contours, user-defined contours, and watersheds.

Location of tools

 1. Select surface > Contextual Ribbon > Modify panel > Surface Properties
 A. Surface Properties dialog box             

 I. Analysis tab > Analysis type dropdown

Tip: Before you run an analysis, select or create a style that visualizes its results.

Create new surface style

 2. Surface Properties dialog box         
 A. Information tab             

 I. Default styles > Surface style > select Create button dropdown > Create New
 a. Surface Style - New Surface Style dialog box 

 i. Information tab 
 i. Name: Slope Arrows

 ii. Display tab 
 i. Slope Arrow visible, select light bulb
 ii. Triangles visible, select light bulb

 iii. Analysis tab 
 i. expand Slope arrows 

 i. Scheme: Rainbow or any color gradient that is dif-
ferent

 II. OK
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 3. Analysis tab         
 A. Analysis type: Slope Arrows
 B. Legend: WisDOT Standard
 C. check box Preview
 D. Ranges, Number: 8
 E. Select down arrow button to start the analysis in preview

Info: In Range Details, user can edit Minimum Slope, Maximum Slope, and Scheme

      
 4. OK

Create a legend table

 5.          Context Ribbon > Annotate tab > Add Tables > Add Surface Legend Table       
 6. Enter table type: A (slopeArrows) Enter      
 7. Behavior: Enter (Dynamic)       
 8. Left-click on surface to add table       

Cropped surfaces
Last updated: 2021-06-29

Total video time: 04:21

srfc-crop-01.mp4 4:21

Creating a cropped surface

 1. Home tab > Create Ground Data panel > Surfaces dropdown > Create Cropped Data
 2. Create Cropped Surface dialog box 

 A. Properties box 
 I. Crop Information 

 a. Select surface to crop: Exist
 b. Select crop area: click (...) Ellipsis button 

 i. P Enter                        Press F3 to turn off OSNAPS 
 ii. Click polygon points in drawing, C Enter to close last point.

 II. New Surface 
 a. Drawing for new surface: Select an open drawing
 b. Select Open drawing: Surf-Exist-Cropped.dwg
 c. New Surface name: Exist-crop
 d. Surface Style > (...) Ellipsis button > EX TrianglesOK
 e. Layer >  (...) Ellipsis button > E_SURFOK

 III. OK
 3. Select Surf-Exist-Cropped file tab 

The cropped surface is linked to the original surface. Any changes made to the original surface will not 
appear on the cropped surface until you do the following:

 4. Toolspace > Prospector tab > expand Surface
 5. Right-click Exist-crop > Rebuild Snapshot
 6. Right-clck Exist-crop > Rebuild

Changes should appear in cropped surface.
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Create Exist surface from mapping
Last updated: 2021-06-29

Total video time: 8:22

Create Exist surface file

srfc-creat-exst-frm-map-01.mp4 3:00

Exercise data: srfc-creat-exst-frm-map-data-begin-c3d20.zip

 1. Menu browser > New
 2. Surface template dialog box

 A. Look in: Begin-dwg folder
 B. Select template survey-start.dwt
 C. Click Open

 3. Menu browser > Save As
 4. Save Drawing As dialog box

 A. Browse to Local drive:\PDS\C3D\11701902\BaseData
 B. Rename file, File name: Surf-Ex
 C. Save

Create data clip boundary

Add Xref Data

 5. Ribbon > WisDOT Survey tab > Manage panel > Load Xref on Layer
 6. Select a File to Xref dialog box

 A. Browse for file, Look in: 11701902\BaseData
 B. Select file Topo-Ex.dwg
 C. Click Open

 7. Use Zoom Extents (Z+Enter, E+Enter) to see Xref is in place

Create Boundary

 8. Scroll/Zoom to project area 
 9. Commandline: Type PL

Tip: Polyline command can also be found in Home tab > Draw panel > Polyline

 10. Select a start point near the surface. Continue adding polyline vertices around the surface. At last 
point, type C to close the polyline shape. 

Save file

Quick Access bar > Save

Transform SRV to PNT/FLT files

srfc-creat-exst-frm-map-02.mp4 2:17
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 1.  Desktop > open WisDOT Civil 3D Apps 
 2. WisDOT Civil 3D Apps dialog box

 A. SRV to PNT/FLT tab
 B. Select folder icon to browse 

 I. Select SRV File dialog box 
 a. Browse to Local Drive:\PDS\C3D\11701902\BaseData\Mapping
 b. Select SRV file
 c. Click Open

 C. OK
 D. Select OK to any Convert SRV dialogs regarding missing files
 E. Select OK to any messages regarding the location of the PNT and FLT files.

 3. Repeat steps B-E for each SRV file available. 
 4. Open Civil 3D

Info: This step is not necessary but is to confirm the files created from the SRV. In Windows 
Explorer, browse to the project folder, 11701902\BaseData\Mapping and confirm the *.pnt, 
*.flt, *-bldg.flt and *-obsc.flt were created. There may also be *-weak.flt and *-ewbdy.flt files 
created here, depending on your project.

Create surface from PNT/FLT files

srfc-creat-exst-frm-map-03.mp4 3:05

 1. WisDOT Survey tab > Mapping panel > Surface from PNT/FLT
 2. Open dialog box

 A. Browse Local drive:/PDS/C3D/11701902/BaseData/Mapping
 B. SHIFT+Select all PNT and FLT files (no folders)
 C. Open

 3. Select outer boundary Polyline ESC for none: Select polyline representing bound-
ary on surface

 4. Enter name of new Surface: default is Exist, select Enter to accept default name.
 5. Process runs. Surface will be created when done.

To locate surface

 6. Toolspace > Prospector tab > expand Surfaces > right-click Exist > select Zoom to

Rebuild surface

When you find the Exist surface in Toolspace, there might be a yellow alert symbol asking for the surface to 
be rebuilt.

 7. Right-click Exist > select Rebuild

Save file

Quick Access bar > Save

Exercise data: srfc-creat-exst-frm-map-data-end-c3d20.zip

Create surface from survey & add to Exist
Last updated: 2022-08-30
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Total video time: 10:20

Create file from survey data

srfc-creat-exst-frm-srvy-01.mp4 3:02

Exercise data: srfc-creat-exst-frm-srvy-data-begin-c3d20.zip

 1. Menu browser > New
 2. Surface template dialog box

 A. Look in: Begin-dwg folder
 B. Select template survey-start.dwt
 C. Open

 3. Menu browser > Save As
 4. Save Drawing As dialog box

 A. Browse to Local drive:\PDS\C3D\11701902\BaseData
 B. Select Survey folder
 C. Rename file, File name: type Surf-Ex-Survey
 D. Click Save

Build surface

 5. Home tab > Create Ground Data panel > Surfaces dropdown > Create Surface
 6. Create Surface dialog box

 A. Change Name to Exist-Survey
 B. OK

 7. Quick Access bar > Save

Add survey data

 8. Toolspace > Survey tab > expand Survey Databases > right-click SD-11701902 > Open for edit
 9. Expand Survey queries 

 10. Select and Select+Drag the following survey queries into file:

 o Centerlines
 o SurfaceFigures
 o SurfacePoints1
 o SurfacePoints2
 o SurfacePoints3

Info: Must drag each query individually, not as a selected group.

 11. Quick Access bar > Save

Add clip boundary

srfc-creat-exst-frm-srvy-02.mp4 2:31

Create data clip boundary

 1. Scroll/Zoom to project area 
 2. Commandline: Type PL

Tip: Polyline command can also be found Home tab > Draw panel > Polyline
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 3. Select a start point near the surface. Continue adding polyline vertices around the surface. At last 
point, type C to close the polyline shape. 

Add data clip boundary to surface definition

 4. Toolspace > Prospector tab > expand Surfaces > expand Exist-Survey > expand Definition > 
right-click Boundaries > Add...

 5. Add Boundaries dialog box
 A. Type dropdown, select Data Clip
 B. OK

 6. Select boundary on surface

Remove survey points and figures from file

 7. Toolspace > Survey tab > right-click Survey Points > Points fly-out > Remove from drawing...
 A. Are you sure you wish to remove these points from the drawing? 

Yes
 8. Toolspace > Survey tab > right-click Figures > Remove from drawing...

 A. Are you sure you wish to remove these objects from the drawing? 
Yes

 9. Quick Access bar > Save

Add survey data and create data shortcut

srfc-creat-exst-frm-srvy-03.mp4 3:00

Add survey data as a reference

 1. Survey tab > Modify panel > Survey Query
 2. Survey Queries Ribbon > Manage panel > dropdown > select SurfacePoints1
 3. Survey Queries Ribbon > Query Results panel > select Add to Surface
 4. Add Survey Query Results to Surface dialog box

 A. Add query results to this surface dropdown: select Exist-Survey
 B. Query Results: select Reference the survey database for dynamic query results
 C. Use these survey queries: Check mark the following: Centerlines, SurfaceFigures, 

SurfacePoints1, SurfacePoint2, & SurfacePoints3.
 D. OK

 5. Data is transferred in drawing file
 6. Quick Access bar > Save

Create data shortcuts

 7. Toolspace > Prospector tab > right-click Data Shortcuts > Create Data Shortcuts...
 8. Create Data Shortcuts box

 A. Select Exist-Survey
 B. OK

Remove surface triangle lines outside of boundary

There are a few triangles jumping across the boundary.

 9. Select surface > right-click menu > select Surface Porperties...
 10. Surface Properties dialog box
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 A. Surface styles: select EX Triangles
 B. Apply
 C. OK

 11. Select surface
 12. Surface tab > Modify panel > Edit Surface > Delete Line
 13. Crossing-windows select all lines outside of boundary area
 14. Enter
 15. Select surface
 16. Surface ribbon > Modify panel > select Surface Porperties...
 17. Surface Properties dialog box

 A. Surface styles: select EX Border
 B. OK

 18. Esc
 19. Quick Access bar > Save
 20. Survey Queries ribbon > Close

Paste survey surface into Exist surface

srfc-creat-exst-frm-srvy-04.mp4 1:45

Open Exist surface file

 1. Quick Access bar > Open
 2. Select File dialog box

 A. Look in: PDS\C3D\11701902\BaseData
 B. Select Surf-Ex.dwg
 C. Open

 3. Toolspace > Prospector tab > expand Data Shortcuts > expand Surfaces > expand Existing > 
right-click Exist-Survey > select Create Reference

 4. Create Surface Reference dialog box
 A. Style: set to EX Border
 B. OK

Locate surface

 5. Toolspace > Prospector tab > expand Surfaces > expand Existing > right-click Exist-Survey > 
select Zoom to

Paste survey surface into Exist surface

 6. Toolspace > Prospector tab > expand Surfaces > expand Exist > expand Definition > right-click 
Edits > select Paste Surface...

 7. Select Surface to Paste dialog box
 A. Select Exist-Survey
 B. OK

 8. Quick Access bar > Save

Exercise data: srfc-creat-exst-frm-srvy-data-end-c3d20.zip

Create a drainage analysis surface from USGS data in Civil 3D
Last updated: 2020-10-26
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Total video time: 25:10

Exercise files: srfc-create-drn-anlysis-dem-data-C3D12.zip

Download USGS DEM data

srfc-create-drn-anlysis-dem-01.mp4 6:38

This segment will demonstrate how to download USGS DEM data.

Download USGS DEM data

 1. Open the USGS National Map Viewer http://viewer.nationalmap.gov
 2. Click the Download Data button at the top of the screen.

 3. Navigate to your location
 4. Turn on the Box/Point button and drag a rectangle around the area you wish to capture

 5. On the left check the Elevation Products (3DEP)
 6. Multiple options will likely be available to you. The smaller the arc second value, the higher the point 

grid density will be. Point elevation accuracy is the same. Check the desired data set. Be sure to 
choose the ArcGrid format. 

 7. Click Find Products 
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 8. Click Add to cart. View cart Download
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 9. It will take a few minutes to download
 10. Unzip the data to your project folder \BaseData\Other\USGS-DEM\

Info: Note: 1/3 arc second is typically adequate, but download the best available. 
Later, if you are unable to load a denser point density, try a larger (less dense point 
spacing) or break the DEM into smaller pieces. This may occur on larger areas.

Create surface from USGS DEM

srfc-create-drn-anlysis-dem-02.mp4 18:32

Warning: This segment includes a large dataset and may take a long time to down-
load.

Create USGS DEM surface file

Create a new dwg file from the WisDOT template and save it as Surface-USGS-DEM_meters.dwg.

 1. In the drawing settings set the Drawing Units to Meters. Set the Zone to USA, Wisconsin and Wis-
consin County Systems: {Your project County}, Meter. Click OK.

 2. Import the project mapping into the drawing to provide spatial reference. Refer to nosrvy-bsdata-
wrk-sptl-rfrnc-DWG-img-GIS for this procedure.

 3. Draw a closed polyline around the area where the DEM Surface is needed. Make this area as small 
as possible to improve system performance.

 4. Create a new surface called USGS-DEM
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 5. Expand the surface definition in the Toolspace-Prospector.
 6. Right click on Boundaries and select Add....
 7. Set the Type to Data Clip. Click OK and select the closed polyline from the screen.
 8. In the Toolspace-Prospector, right click on DEM Files under the surface definition. Select Add...
 9. At the top of the dialogue box, select the DEM file. The file extension is ESRI Binary Grid (*.adf). 

You will see multiple .adf files in the data set downloaded. Choose the one with the largest file size.
 10. Set the CS Code to Lat Longs, NAD83 datum, Latitude-Longitude; Degrees. (Coordinate System 

Code is LL83) Click OK. Civil 3D will transform the DEM surface from Lat/Long to the coordinate 
system assigned to the drawing. However, it will not transform the elevations. This is why we first 
bring the DEM into a metric drawing.

 11. Click OK to finish loading the DEM file. The surface is now viewable according to the assigned style. 
This may take some time depending on the point density and area.

 12. In the Toolspace-Prospector, right click on the surface and select Export LandXML... Make sure 
the surface (only the surface) is selected in the Export to LandXML dialogue box. Click OK. Save 
the xml file to the BaseData\Other\USGS-DEM\ directory. Name the file USGS-DEM_meters.

 13. Save and Close the drawing.
 14. Create a new dwg file from the WisDOT template and save it as Surface-USGS-DEM_

USFoot.dwg.
 15. In the Drawing Settings, set the Zone to USA, Wisconsin, Wisconsin County Systems: {Your Pro-

ject County}, US Foot. Click OK.
 16. Data shortcut reference your roadway alignment or xreference your mapping to provide spatial ref-

erence.
 17. From the Insert Tab - Import Panel, click LandXML. Select the USGS-DEM_meters.xml file and 

click Open.
 18. Click OK at the Import LandXML dialogue box. The DEM surface will now appear in your drawing 

according to its assigned style. Save the drawing and create a data shortcut for the surface. The 
DEM surface now has elevations in feet.

Create drainage analysis surface from USGS data in Infraworks
Last updated: 2020-10-26

Total video time: 35:03

Warning: A known issue has been identified related to Wisconsin county coordinate projections. 
Please make sure to use to only use projections beginning with "WisDOT NAD83/". Please review 
Wisconsin coordinate projection problem - SDB/DWG for more information.

Exercise files: srfc-creat-dem-infrawrks-data-C3D14.zip

Introduction

srfc-creat-dem-infrawrks-01.mp4 5:26

 l Infraworks is capable of processing larger data sets. Therefore it is sometimes easier to consume 
DEM files, LiDAR files, or other large sets of data in Infraworks instead of working directly in Civil 
3D. Once the data is inside Infraworks, smaller sample surfaces can be exported to Civil 3D.

 l Another advantage to consuming data in Infraworks is coordinate transformations. Infraworks will 
automatically transform data to project specific coordinate systems. Then, when that data is expor-
ted to Civil 3D, it will appear in the correct location.

 l WisDOT employees can have Infraworks installed on their workstation by contacting the IT service 
desk.  http://dotnet/it/serviceportal/redirect.htm
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 l In this exercise, we will be using the same USGS data obtained in the surface from USGS data train-
ing topic. Download the project dataset to follow along. Alternatively, the dem data can be obtained 
from the national map viewer. http://viewer.nationalmap.gov/viewer/

 l In this example, we are going to download a topographic quad map and load it into the model. Aerial 
images can also be used.

 o https://www.topoquest.com/find/state.php?state=WI
 o Download the Dallas and Dorrity Creek Maps

Start an Infraworks project

srfc-creat-dem-infrawrks-02.mp4 4:55

 1. Start Infraworks
 2. Under Model, select New.

 3. Since the Infraworks model will only be used for consuming data, we recommend that the Infra-
works project be kept on the users' C-drive. Infraworks projects can grow quickly in size and take up 
unnecessary server space.

 4. Name the project the project ID and provide a descriptions such as the highway name and project 
title.

 5. It is important to define the model extents when practical. The model extents limit the Infraworks 
model to the area of interest. Without model extents, the Infraworks model will include the entire 
planet and performance would suffer. However, since the Infraworks engine can process large data, 
the model extents can be set significantly larger than the project. There are several options for set-
ting the model extents:

 o Option 1: One way to obtain coordinate values for the model extents, is to open the project 
mapping file in Civil 3D. Choose minimum coordinates representing a point southwest of the 
expected area of interest. Choose maximum coordinates representing a point northeast of 
the expected area of interest.

 o Option 2: The simplest way to set the model extents is with the data that will be consumed. 
By clicking on the Load Extents From File button, you can select the data that will be brought 
into Infraworks. The extents will be set automatically based on the spatial limits of the data.

In this example, we'll select the .adf file from our USGS DEM download. These extents will be much larger 
than what we will need. However, we can reduce the model extents later.

Page: 219

Published on: 5/1/2024

Create drainage analysis surface from USGS data in Infraworks

http://viewer.nationalmap.gov/viewer/
https://www.topoquest.com/find/state.php?state=WI
https://c3dkb.dot.wi.gov/video/srfc/srfc-creat-dem-infrawrks-02.mp4


 6. Under Advanced Setting, there are some options regarding coordinate systems. These can be left 
as the default even if they do not match your project coordinate system. The UCS coordinate sys-
tem can be changed to the project coordinate system if you wish. This will display the project 
coordinate system in the model. For our application, there is no need to change the database 
coordinate system.
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 7. Click Ok to create the model.

Model navigation

srfc-creat-dem-infrawrks-03.mp4 1:29

To navigate the model, hold the left mouse button down to orbit. Hold the right mouse button down to pan. 
Use the wheel to zoom in and out. To return to a top view with north up, hover the cursor over the viewcube 
and click on the home symbol. This is the default view for the home view. The home view can be changed if 
desired by click in the down arrow next to the view cube.

Load image data into model and refine model extents

srfc-creat-dem-infrawrks-04.mp4 4:58

 1. We can now begin to load data into the model. We recommend that you load an image file (or files) 
that encompasses the area of interest first. In this example, we are going to download a topographic 
quad map and load it into the model. Aerial images can also be used.
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 o https://www.topoquest.com/find/state.php?state=WI
 o Download the Dallas and Dorrity Creek Maps

 2. To load the images into the model, just drag and drop the image files (one at a time) into Infraworks.
 o Under the geolocation tab, there should not be any edits that are needed. The coordinate 

system of the image should automatically load.
 o Under the Raster tab, there are no required edits. However, since in this example we are 

loading a topographic quad map, we can change the classification to Topographic Map.
 o We recommend that you check the Clip to Model Extent box for all data loaded into Infra-

works.

 o Click the Close & Refresh button

 3. In this example, the area of interest spans 2 topographic quad maps. Repeat the previous step to 
load the second map. Now we can refine our model extents before loading our terrain data. From 
the Infraworks menu, select Model Settings. Under Extent, we can interactively define the model 
extents with a bounding box or polygon. Select the one that you prefer. For bounding box, first left 
click on one extent corner in the model. Next, double left click on the other extent corner in the 
model.
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 4. Click Save and then Click Close. The model extents are now refined.
 

Loading terrain data into model

srfc-creat-dem-infrawrks-05.mp4 1:48

 1. The process for loading terrain data is the same. Drag and drop the USGS .adf file into the model.
 2. Under the Raster Tab, it is important to check the Clip to Model Extent box for terrain data.
 3. Click Close & Refresh

Infraworks tools and tips

srfc-creat-dem-infrawrks-06.mp4 7:10

 l Terrain themes
 o Terrain Themes can be a very useful tool for analysis. Under the Analyze Tab, select Ter-

rain Themes. Click the green plus button to add a theme. You can make your own theme, or 
choose one of the preset themes. To access a preset them, click the palette type drop down 
menu. For USGS DEM files, the USGS National Map palette can be very useful. More than 
one theme can be loaded if desired.

 o Once a theme is added, it can be toggle on and off or edited. A common useful edit is trans-
parency. This allow you to view the images loaded into the model at the same time as the ter-
rain theme.

 l Surface layers
 o If more than one image is loaded and they overlap, the order can be adjusted to view one or 

the other in the overlap area. In the example, the 2 topographic quads overlap. To switch 
which image is on top, click the Manage Surface Layers button from the home tab. In the dia-
logue, the images can be turned on and off and reordered.

 l Visual effects
 o To adjust the visual effects, such as lighting, go to the Visual Effect tab. One common effect 

modification is the Light intensity. Often, the light intensity is set too high for optimal viewing 
of the topographic quad maps. Gradually slide the light intensity down until desired effect is 
achieved.

 l Terrain exaggeration
 o For flatter terrain, it can be difficult to distinguish watershed boundaries. Exaggerating the 

terrain in Infraworks can quickly reveal these boundaries. To exaggerate the terrain, right 
click on the .adf file under the data sources. Choose configure. In the geolocation tab, set 
the exaggeration under the z scale. In the example, we exaggerate by 5. Click Close & 
Refresh. Since the terrain has been exaggerated in the z direction, you may need to zoom 
out to bring it back into view. Also note, that new terrain themes will need to be added for the 
exaggerated data.

Export Infraworks terrain to Civil 3D

srfc-creat-dem-infrawrks-07.mp4 6:50
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Warning: IMPORTANT: You must remove any terrain exaggeration before export-
ing to Civil 3D.

 1. To export the terrain to Civil 3D, go to the Infraworks menu. Select Export – Export IMX
 2. Define the area of the model that you want to export using either a bounding box or polygon. If the 

model size is not large, the entire model can be exported. We recommend exporting only the area 
that is required. The exported area remains dynamic with the Civil 3D surface that is create. The 
Civil 3D surface reads the .imx file in its definition. Therefore, if the .imx file is updated the Civil 3D 
surface will update. 

 3. Set the target file/location to the Civil 3D project directory. N:\PDS\C3D\Pro-
jectID\BaseData\Other\USGSDEM\USGS-DEM-ProjectID.imx

 4. Click Export
 5. Open Civil 3D. Save a new drawing called N:\PDS\C3D\ProjectID\BaseData\Other\USGS-

DEM\USGS-DEMProjectID.dwg

Warning: IMPORTANT: Set the project coordinate system for the drawing in the 
drawing settings. This is how the terrain will get transformed to the project coordin-
ate system.

 6. Insert Tab - Import Panel – Import IMX. Select the IMX file.
 7. The surface will automatically be created and named AIM_Existing_Ground. Give the surface a 

logical name such as Exist-USGS-DEM
 8. If the surface extents need to be updated, just re-export the IMX file from Infraworks with the new 

extents. Overwrite the previous IMX file. The Civil 3D surface will update.

Update surface limits

srfc-creat-dem-infrawrks-08.mp4 2:27

 l The exported area remains dynamic with the Civil 3D surface that is creates. The Civil 3D surface 
reads the .imx file in its definition. Therefore, if the .imx file is updated the Civil 3D surface will 
update. If it is discovered that a larger (or smaller) area is needed for the Civil 3D surface, redefine 
the export extents in Infraworks.

 l If the surface extents need to be updated, just re-export the IMX file from Infraworks with the new 
extents. Overwrite the previous IMX file. The Civil 3D surface will update.
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Alignments

Alignment basics
Last updated: 2022-11-01

Total video time: 4:07

Alignments in context of project

ali-basc-01.mp4 2:05

Project index for location by station and offset.

Basis for design of corridors.

Targets for corridor design.

Basis for profiles, profile views, and sample lines.

Folder and object naming

In FDM 15-5-3 Att. 3.4 the folder location and the file naming is spelled out, with multiple examples.

Alignments will be created and saved with any related profiles. Multiple alignment/profile combinations can 
be stored in a single file or split up. In general, fewer files are better unless there is a need (such as multi-
user editing) to have multiple files. These will be data shortcut referenced so they can be shared among pro-
ject files.

Offset alignments, and their profiles, must be in the same file as the parent alignment.

Sites in relation to alignments

Sites are a control mechanism that allow objects to interact. These objects include parcels, grading ele-
ments and possibly alignments. Alignments are an option in the site control since they usually do not need 
the sort of interaction that is required, and can sometimes become a problem with other objects in the file. It 
is best to make sure the alignments you create are set to "No site" so that accidental interaction does not 
occur. Places where alignment interaction with objects is preferred would be with parcels, and will be dis-
cussed in detail there.

Alignment types

ali-basc-02.mp4 2:02

There are five types of alignments that can be created. Generally, users should only be concerned with two 
of those types, centerlines and rail, outlined below: 

 l Centerlines: Despite its name, centerline type alignments are not always centerlines of a design. 
These are alignments created by a user, and is the predominant type for designs. These can be 
used for design start locations, as well as targeting for design definitions (edge of travel ways, 
shoulder slope breaks, etc.) Centerline alignments can have superelevation assigned to them.

 l Rail: If you are creating rail design this type understands the Cant functionality, and will build with 
specific rail needs in mind. You should not use rail alignment types in other designs.

 l Offset: This type of alignment creates a child alignment that is geometrically tied to a parent align-
ment. This type is used for creating tapers and geometry parallel to centerline alignments.
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 l Curb Return: This type of alignment is built by the intersection tool to create curb return horizontal 
geometry. The user would not create a curb return alignment manually, and an alignment should 
never have the type changed to this after it is created. In the case this switch is made it has pre-
vented other functionality from working.

 l Miscellaneous: The alignment type is created from pipe networks. The user should not change an 
alignment to the miscellaneous type, and there is no acceptable way to create a miscellaneous type 
alignment manually.

Offset Alignments

This type of alignment creates a child alignment that is geometrically tied to a parent alignment. This will 
allow generally parallel design that moves to stay a defined offset from the parent alignment. This type does 
allow for widening while maintaining the geometric tie to the parent alignment. This type is created with spe-
cific creation commands, and you should not change an alignment you are creating to an offset type manu-
ally. In the case this switch is made it has prevented other functionality from working. If you need to create 
an offset alignment , select the parent alignment and choose Create Offset to create the geometric con-
nection.

Superelevation assignments in alignments

While creating corridor designs that utilize superelevation to transition subassembly slope over long dis-
tances, the data needed to accomplish this will be stored in the alignment. This alignment data will then 
work with properly attached subassemblies to create the needed slopes and transitions.

Create alignment for objects
Last updated: 2022-11-01

Total video time: 12:47

Cleaning up AutoCAD objects prior to conversion

ali-data-c3d22.zip

Video: ali-creat-frm-objct-01.mp4 2:11

Warning: It is preferred that you use the layout tools to build alignments. This prevents gaps in align-
ment objects that can cause problems in stationing, targeting, and other advanced functions. If you 
need to translate AutoCAD objects into alignment objects it is preferred that these objects be trans-
formed into singular polylines prior to conversion. This will prevent tangent segments that are not 
properly snapped from ending an alignment early.

Open drawing file

 1. Quick Access > Open
 2. Open File dialog box

 A. Look in: browse to folder dataset is saved.
 B. Select AliProf-All-ali-creat-frm-objct-clnup.dwg
 C. Open

Page: 227

Published on: 5/1/2024

Create alignment for objects

https://c3dkb.dot.wi.gov/data/ali/ali-data-c3d22.zip
https://c3dkb.dot.wi.gov/video/ali/ali-creat-frm-objct-01.mp4


Connect lines and arcs into a polyline

 1. Ribbon > Modify tab > Modify panel dropdown > Polyline Edit 
commandORCommandline:PEEnter for polyline edit.

 2. Commandline:MEnter for multiple.
 3. Select objects: Click and drag cursor over all lines and arcs.
 4. Convert lines, arcs, and splines to polylines:YEnter
 5. Enter an option:JEnter for join.
 6. Enter to end command
 7. Select polyline to verify all are connected.

Info: If there are lines/arcs not connected to the polyline it might be because the endpoints 
are not snapped together. To correct this:

 A. Select object
 B. Shift + Right-click > Endpoint
 C. Select connecting end grip point
 D. Enter to end command.
 E. Commandline:J Enter to join.
 F. Select objects to join: Click and drag cursor over objects.
 G. Enter

Create alignment from objects dialog

Video: ali-creat-frm-objct-02.mp4 3:12

Open drawing file

 1. Quick Access > Open
 2. Open File dialog box

 A. Look in: browse to folder dataset is saved.
 B. Select AliProf-All-ali-creat-frm-objct-dialg.dwg
 C. Open

Create alignment from objects

 1. Select object to verify it is a polyline; one complete/joined object. 
 2. Ribbon > Home tab > Create Design panel > Alignment dropdown > Create Alignment from 

Objects command
 3. Select the first line/arc/polyline: Select object south end of polyline.

Tip: Direction of an alignment should be west to east or south to north. When converting an 
alignment, selecting the west/south point will force the directional path of the alignment. If the 
path is in the wrong direction, the commandline will prompt you the option reverse the path.

 4. Press enter to accept alignment direction or (R)everse:Enter
 5. Create Alignment from Objects dialog box

 A. Name: type AliProf-All
 B. Starting station: delete what is there and type 33000
 C. General tab

 I. Site: <None>
 II. Leave Alignment style, layer, and label set as is.

 III. Conversion options: 
 a. Uncheck box Add curves between tangents
 b. Check box Erase existing entities
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 D. Design Criteria tab
 I. Starting design speed: 45m/h

 II. Check box Use criteria-based design
 III. Check box Use design criteria file
 IV. ...

 a. Look in: browse to Local Drive:\ProgramData\Autodesk\C3D 
20xx\enu\Data\Corridor Design Standards\Imperial

 b. Select file _WisDot Design Criteria 2009.xml 
 c. Open

 V. Default criteria
 a. Minimum Radius Table: WisDOT eMax 4%
 b. Transition Length Table: 1LaneRamp, 2LaneUnDiv@CL
 c. Attainment Method: Crowned Roadway

 E. OK

Reversing alignment direction during creation

Video: ali-creat-frm-objct-03.mp4 1:30

Open drawing file

 1. Quick Access > Open
 2. Open File dialog box

 A. Look in: browse to folder dataset is saved.
 B. Select AliProf-All-ali-creat-frm-objct-rvrs-dring.dwg
 C. Open

Create alignment from objects

 1. Select object to verify it is a polyline; one complete/joined object. 
 2. Ribbon > Home tab > Create Design panel > Alignment dropdown > Create Alignment from 

Objects command
 3. Select the first line/arc/polyline: Select object north end of polyline.
 4. Press enter to accept alignment direction or (R)everse:R Enter

Tip: Direction of an alignment should be west to east or south to north. 

 5. Create Alignment from Objects dialog box
 A. Name: type AliProf-All
 B. Starting station: delete what is there and type 33000
 C. General tab

 I. Site: <None>
 II. Leave Alignment style, layer, and label set as is.

 III. Conversion options: 
 a. Uncheck box Add curves between tangents

 D. OK
Station numbers should increase going south to north on the alignment.

Reversing alignment direction after creation

Video: ali-creat-frm-objct-04.mp4 2:02

Page: 229

Published on: 5/1/2024

Create alignment for objects

https://c3dkb.dot.wi.gov/video/ali/ali-creat-frm-objct-03.mp4
https://c3dkb.dot.wi.gov/video/ali/ali-creat-frm-objct-04.mp4


Open drawing file

 1. Quick Access > Open
 2. Open File dialog box

 A. Look in: browse to folder dataset is saved.
 B. Select AliProf-All-ali-creat-frm-objct-rvrs-aftr.dwg
 C. Open

Correct alignment label direction

When you select the alignment, notice the stationing numbers decrease going south to north.

 1. Select alignment. 
 2. Contextual Ribbon > Modify panel dropdown > Reverse Direction
 3. Warning! dialog box: OK

Confirm station numbers are reversed.

Exercise: Create alignment from objects

Video: ali-creat-frm-objct-05.mp4 3:52

Open drawing file

 1. Quick Access > Open
 2. Open File dialog box

 A. Look in: browse to folder dataset is saved.
 B. Select AliProf-All-ali-creat-frm-objct-exrcs.dwg
 C. Open

Cleanup and join all objects into a polyline

 1. Ribbon > Modify tab > Modify panel dropdown > Polyline Edit 
commandORCommandline:PEEnter for polyline edit.

 2. Commandline:MEnter for multiple.
 3. Select objects: Click and drag cursor over all lines and arcs.
 4. Convert lines, arcs, and splines to polylines:YEnter
 5. Enter an option:JEnter for join.
 6. Enter to end command
 7. Select polyline to verify all are connected.

Convert polyline to alignment

 1. Ribbon > Home tab > Modify panel dropdown > Create Alignment from Objects command
 2. Select the first line/arc/polyline: Select south end of polyline, forcing dir-

ection/path to go north.
 3. Press Enter to accept alignment direction or (R)everse:Enter
 4. Create Alignment from Objects dialog box

 A. Name: type AliProf-All
 B. Starting station: delete what is there and type 33000
 C. General tab

 I. Site: <None>
 II. Leave Alignment style, layer, and label set as is.
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 III. Conversion options: 
 a. Check box Add curves between tangents
 b. Default radius: 2865
 c. Check box Erase existing entities

 D. Design Criteria tab
 I. Starting design speed: 45m/h

 II. Check box Use criteria-based design
 III. Check box Use design criteria file
 IV. ...

 a. Look in: browse to Local Drive:\ProgramData\Autodesk\C3D 
20xx\enu\Data\Corridor Design Standards\Imperial

 b. Select file _WisDot Design Criteria 2009.xml 
 c. Open

 E. Default criteria
 I. Minimum Radius Table: WisDOT eMax 4%

 II. Transition Length Table: 1LaneRamp, 2LaneUnDiv@CL
 III. Attainment Method: Crowned Roadway

 F. OK
Polyline is converted to an alignment. Curve is added to north end of alignment.

Alignment layout tools
Last updated: 2022-11-01

Total video time: 11:24

Layout tool overview

Exercise file: ali-data-C3D22.zip

ali-lyout-tool-01.mp4 2:36

Open drawing file

 1. Quick Access > Open
 2. Open File dialog box

 A. Look in: browse to folder dataset is saved.
 B. Select AliProf-4thAve-ali-lyout-tool-01.dwg
 C. Open

Layout Creation Tools

 1. Ribbon > Home tab > Create Design panel > Alignment dropdown > Alignment Creation Tools
 2. Create Alignment - Layout dialog box

 A. Name: Lcl 4th Ave
 B. Type: Centerline
 C. Description: (added information about alignment) Leave blank
 D. Starting station: leave set to default, 0+00.00", but any start number can be given.
 E. Site: <None>
 F. Alignment style, layer, and label set: Leave as is.
 G. OK
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 3. Alignment Layout Tools toolbar

Info: The title bar displays the current alignment, Lcl 4th Ave.

 A. Left-click Draw Tangent-Tangent tool
 B. Specify first point: Left-click point 1201
 C. Specify next point: Left-click point 1202
 D. Specify next point: Continue left-click all points, west to east, ending at point 1205

Info: Direction of an alignment should be west to east or south to north.

 E. Right-click to end command

Alignment Layout Tools toolbar

The Alignment Layout Tools toolbar performs site specific design by layouts.

 l Design tangents, curves, and spirals.
 l Add or remove PI (point of intersection).
 l Convert AutoCAD lines and arcs to an alignment.
 l Reverse or edit created layout entities.
 l Delete sub-entities.
 l Display design elements in a table/grid format.

Curve settings

ali-lyout-tool-02.mp4 1:29

Open drawing file

 1. Quick Access > Open
 2. Open File dialog box

 A. Look in: browse to folder dataset is saved.
 B. Select AliProf-4thAve-ali-lyout-tool-01.dwg
 C. Open

Edit curve settings

 1. Ribbon > Home tab > Create Design panel > Alignment dropdown > Alignment Creation Tools
 2. Create Alignment - Layout dialog box

 A. Name: Lcl 4th Ave
 B. Leave all other setting as is.
 C. OK

 3. Alignment Layout Tools toolbar > Tangent-Tangent tool dropdown > Curve and Spiral Set-
tings...

 4. Curve and Spiral Settings dialog box
 A. Type: Clothoid
 B. Box checked Curve
 C. Default radius: 100
 D. OK

Tangent-Tangent no curves or with curves

ali-lyout-tool-03.mp4 2:22
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Open drawing file

 1. Quick Access > Open
 2. Open File dialog box

 A. Look in: browse to folder dataset is saved.
 B. Select AliProf-4thAve-ali-lyout-tool-01.dwg
 C. Open

Set Object Snap (OSnap) setting

 1. Status bar > Object Snap dropdown > Node (uncheck all other OSnaps)

Tangent-Tangent (no curves)

 1. Ribbon > Home tab > Create Design panel > Alignment dropdown > Alignment Creation Tools
 2. Create Alignment - Layout dialog box

 A. Name: Lcl 4th Ave
 B. Leave all other setting as is.
 C. OK

 3. Alignment Layout Tools toolbar > Tangent-Tangent tool dropdown > Tangent-Tangent (No 
curves)

 4. Specify start point: Left-click point 1201
 5. Specify next point: Left-click point 1202
 6. Specify next point: Left-click point 1203
 7. Right-click to end command

Tangent-Tangent (with curves)

 1. Alignment Layout Tools toolbar > Tangent-Tangent tool dropdown > Tangent-Tangent (With 
curves)

 2. Specify start point: Left-click point 1203
 3. Specify next point: Left-click point 1204
 4. Specify next point: Left-click point 1205
 5. Right-click to end command

PI (point of intersection) editing

 ali-lyout-tool-04.mp4 2:59

Open drawing file

 1. Quick Access > Open
 2. Open File dialog box

 A. Look in: browse to folder dataset is saved.
 B. Select AliProf-4thAve-ali-lyout-tool-04.dwg
 C. Open

Set Object Snap (OSnap) setting

 1. Status bar > Object Snap dropdown > Node (uncheck all other OSnaps)
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Add missing points to the alignment

 1. Left-click the alignment
 2. Contextual ribbon > Modify panel > Geometry EditorOR Right-click menu > Edit Alignment Geo-

metry...
 3. Alignment Layout Tools toolbar > Insert PI command
 4. Pick point near PI to insert: Hover over point 1204 and left-click to snap 
 5. Right-click to accept
 6. Alignment Layout Tools toolbar > Insert PI command
 7. Pick point near PI to insert: Hover over point 1207 and left-click to snap 
 8. Right-click to accept

Deleting PI from the alignment

 1. Alignment Layout Tools toolbar > Delete PI command
 2. Pick point near PI to delete: Hover over point 1207 and left-click to snap 
 3. Right-click to remove

Break-apart PI

 1. Alignment Layout Tools toolbar > Break-apart PI command
 2. Pick point near PI to split: Hover over point 1204 and left-click to snap 
 3. Enter distance by which to split PI:25Enter
 4. Right-click to accept

X to close Alignment Layout Tools toolbar

Sub-entity editing

ali-lyout-tool-05.mp4 1:58

Open drawing file

 1. Quick Access > Open
 2. Open File dialog box

 A. Look in: browse to folder dataset is saved.
 B. Select AliProf-4thAve.dwg
 C. Open

Reverse sub-entity direction

Looking at the alignment, the labeling stops midway. This means there is a sub-entity going in the wrong dir-
ection.

 1. Left-click the alignment
 2. Contextual ribbon > Modify panel > Geometry EditorOR Right-click menu > Edit Alignment Geo-

metry...
 3. Alignment Layout Tools toolbar > Reverse Sub-entity Direction command
 4. Select fixed line or curve to reverse: Left-click curve by point 1203

Labels should appear complete to the end of the alignment.
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Delete sub-entity

 1. Alignment Layout Tools toolbar > Delete Sub-entity command
 2. Select subentity to remove: Left-click line between points 1204 & 1205
 3. Right-click to accept.

Alignment lines and curves
Last updated: 2022-11-01

Total video time: 12:14

Line and curve overview

Exercise file: ali-data-C3D22.zip

Video: ali-lin-crv-01.mp4 1:54

Alignment line and curve tools, in the Alignment Creation Tools toolbar, allow you to draw the alignment 
segment by segment, close(???) subentity. It allows you to design with site specific design geometry; lines, 
curves, and spirals with specific tangency requirements. And these tools are different from the tools Tan-
gent-Tangent (no curves) and Tangent-Tangent (with curves). These will allow you to draw the alignment 
from start to finish without exiting the command.

The three main ways to draw these subentities are fixed, floating, and free geometry.

Fixed lines and curves

 l Are geometrically defined and locked or fixed in their precision and must be edited directly.
 l Are not affected by other geometry entities.
 l Do not maintain tangency.
 l Example: A three-point-curve

Floating lines and curves

 l Are constraint based alignment geometry.
 l Relative to other geometry.
 l Will maintain tangency.
 l Example: A curve tangent to line, through a point.

Free lines and curves

 l Are defined by other entities, their geometry, as that a fillet between two entities.
 l All definition relative to other geometry.
 l Will maintain tangency
 l Example: A curve tangent to two lines and/or a line tangent to two curves.

Alignment layout with fixed lines and fixed curve options

Video: ali-lin-crv-02.mp4 3:40
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Set Object Snap (OSnap) setting

 1. Status bar > Object Snap dropdown > Node

Open transparent commands

Transparent commands are commands used within a running command.

 1. By default, the commands can be found on the right edge in the drawing area. 
 2. If not displayed, Ribbon > View tab > Interface panel > Toolbars dropdown > CIVIL > select 

Transparent Commands.

Open drawing file

 1. Quick Access > Open
 2. Open File dialog box

 A. Look in: browse to folder dataset is saved.
 B. Select AliProf-All-ali-lin-crv-02.dwg
 C. Open

Create fixed line

 1. Ribbon > Home tab > Create Design panel > Alignment dropdown > Alignment Creation Tools
 2. Create Alignment - Layout dialog box

 A. Name: 4th Ave
 B. Leave all other settings as is.
 C. OK

 3. Alignment Layout Tools toolbar > Line tool dropdown > Fixed Line (Two points)
 4. Specify start point: Left-click point 1201

Info: Direction of an alignment should be west to east or south to north.

 5. Specify next point: Use Transparent command Bearing Distance.
 6. Specify quadrant (1-4): As you rotate around point 1201, there are 4 quadrants. Left-click 

in Quadrant: 1 - NE.
 7. Specify bearing:73.5147Enter
 8. Specify distance:234.85Enter
 9. Enter to end command

Create fixed curve

 1. Alignment Layout Tools toolbar > Curve tool dropdown > More Fixed Curves > Fixed Curve 
(From entity end through point)

 2. Select entity for start point and direction: Left-click on line
 3. Specify end point: Left-click point 1207
 4. Enter to end command

Alignment layout with floating line and floating curve options

Video: ali-lin-crv-03.mp4 1:43
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Open drawing file

 1. Quick Access > Open
 2. Open File dialog box

 A. Look in: browse to folder dataset is saved.
 B. Select AliProf-All-ali-lin-crv-03.dwg
 C. Open

Create floating line

 1. Alignment Layout Tools toolbar > Line tool dropdown > Floating Line (From curve end, length)
 2. Select entity to attach to: Left-click curve 
 3. Specify length:156Enter
 4. Enter to end command

Create floating curve

 1. Alignment Layout Tools toolbar > Curve tool dropdown > Floating Curve (From entity, radius, 
through point)

 2. Select entity to attach to: Left-click line
 3. Specify radius or [Degree of curvature]:90Enter
 4. Is curve solution angle [Greaterthan180/Lessthan180] 

<Lessthan180>:Enter
 5. Specify end point: Left-click point 1216
 6. Right-click or Enter to end command

Alignment layout with free line and free curve options

Video: ali-lin-crv-04.mp4 2:10

Open drawing file

 1. Quick Access > Open
 2. Open File dialog box

 A. Look in: browse to folder dataset is saved.
 B. Select AliProf-All-ali-lin-crv-04.dwg
 C. Open

Create free line

Add a line tangent between two curves with free line options.

 1. Left-click on the alignment
 2. Contextual ribbon > Modify panel > Geometry EditorOR Right-click menu > Edit Alignment Geo-

metry...
 3. Alignment Layout Tools toolbar > Line tool dropdown > Free Line (Between two curves)

Warning: Pay attention to the direction of the alignment. Direction of an alignment should be 
west to east or south to north.

 4. Select first entity: Left-click on west curve entity, incoming curve.
 5. Select next entity: Left-click on east curve entity, outgoing curve. 
 6. Right-click or Enter to end command
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Create free curve

Add a free curve tangent between two lines with free curve options. Curve will be between the two lines tan-
gents on east end of alignment.

 1. Alignment Layout Tools toolbar > Curve tool dropdown > Free Curve Fillet (Between two entit-
ies, radius)

 2. Select first entity: Left-click on the west line entity, incoming tangent.
 3. Select next entity: Left-click on the east line entity, outgoing tangent.
 4. Is curve solution angle [Greaterthan180/Lessthan180] 

<Lessthan180>:Enter
 5. Specify radius:90Enter
 6. Right-click or Enter to end command.

Changing curve types after placement

Video: ali-lin-crv-05.mp4 2:47

Open drawing file

 1. Quick Access > Open
 2. Open File dialog box

 A. Look in: browse to folder dataset is saved.
 B. Select AliProf-4thAve.dwg
 C. Open

Curve tangency constraint

 1. Left-click on the alignment
 2. Contextual ribbon > Modify panel > Geometry EditorOR Right-click menu > Edit Alignment Geo-

metry...
 3. Alignment Layout Tools toolbar > Alignment Grid View tool
 4. In Panorama

 A. Select Entity No. 2

Info: When selecting an entity in the chart, it will highlight the entity in the drawing.

 5. Left-click on that curve entity
 6. Left-click point-of-intersection grip point and move it down. Notice the radius, direction station, and 

all connecting entities change. Both sides of the curve change equally due to the tangency con-
straint.

Changing parameter constraint

 1. In Panorama
 A. Select Entity No. 2

 I. Tangency Constraint: Change to Constrained by Previous (Floating)
 II. Parameter Constraint Lock: Unlock

 III. Parameter Constraint: Radius and Length
 2. Left-click on curve entity
 3. Arrow grip appears on the east end of the curve allowing change to the length. It is free on the east 

constraint but not the west constraint.
 4. X to close panorama
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Alignment editing
Last updated: 2022-11-01

Total video time: 12:23

Alignment grip-point editing

Exercise file: ali-data-C3D22.zip

Video: ali-edit-01.mp4 1:56

Open drawing file

 1. Quick Access > Open
 2. Open File dialog box

 A. Look in: browse to folder dataset is saved.
 B. Select AliProf-All.dwg
 C. Open

Zoom to north end of alignment, north end to first curve.

Selection Cycling

If the cursor displays a double box icon this means the cursor pick box is over more than one object.

 1. Hover over alignment, double boxes appear > left-click > Selection Cycling dialog box > select 
Alignment

Grip point editing

 1. Left-click end grip point, furthest north, and drag left or right will change the alignment's bearing. 
Left-click to release.

 2. Left-click next grip point down and drag left or right will move the line segment while maintaining its 
bearing. Left-click to release.

 3. Left-click circular grip point, top of curve (or the bottom) will symmetrical change the length of the 
curve. Left-click to release.

 4. Left-click the middle circular grip point, of the curve, and drag left or right will change the curve's 
radius. Left-click to release.

 5. Left-click the middle triangle, perpendicular to the curve, and drag left or right will change the 
curve's radius and length at the same time. Left-click to release.
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 6. Left-click the point-of-intersection, triangle pointing north, moving it will change the bearing of both 
incoming and outgoing tangents.

Editing parameter constraint in the data grid

Video: ali-edit-02.mp4 3:19

 1. Open drawing file
 A. Quick Access > Open
 B. Open File dialog box

 I. Look in: browse to folder dataset is saved.
 II. Select AliProf-All.dwg

 III. Open
 2. Zoom to north end of alignment, north end to first curve.
 3. Hover over alignment > left-click > Selection Cycling dialog box > select Alignment

Data grid editing functions

 1. Contextual ribbon > Modify panel > Geometry EditorORRight-click menu > Edit Alignment Geo-
metry...

 2. Alignment Layout Tools toolbar > Alignment Grid View tool
 3. In Panorama

 A. Select Entity No. 5
 I. Tangency Constraint: Constrained by Previous (Floating)

 B. Select Entity No. 4
 I. Parameter Constraint Lock: Unlock

 II. Parameter Constraint: Radius and Length
 C. X to close

 4. Left-click alignment > Selection Cycling dialog box > select Alignment
 5. Left-click diamond grip point, at the end of curve, and drag south & west. This will change the 

curve's radius and length. Left-click to release.
 6. Left-click on square grip floating right side of alignment. This is tied to the original alignment's loc-

ation when first created. Move it and notice how the editing has changed due to the parameter con-
straint lock. Left-click to release.

 7. Alignment Layout Tools toolbar > Alignment Grid View tool

 8. In Panorama
 A. Select Entity No. 4

 I. Parameter Constraint Lock: Lock
 B. X to close

 9. Alignment Layout Tools toolbar > Pick Sub-entity tool
 10. Pan to south end of alignment and select curve
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 11. Left-click > Selection Cycling dialog box > select Alignment
 12. Alignment Layout Parameters dialog box

 A. Geometry
 I. Radius value: 2685Enter

 B. X to close dialog box
 13. X to close toolbar

Change alignment direction and add length

Video: ali-edit-03.mp4 4:14

Open drawing file

 1. Quick Access > Open
 2. Open File dialog box

 A. Look in: browse to folder dataset is saved.
 B. Select AliProf-4thAve.dwg
 C. Open

Correct alignment direction

Alignment stationing is on the wrong side of the alignment and numbering is in the wrong direction, north to 
south. 

Info: Direction of an alignment should be west to east or south to north.

 1. Left-click on the alignment
 2. Contextual ribbon > Modify panel dropdown > Reverse direction
 3. Warning dialog box > OK
 4. Keep alignment active and continue.

Lengthening alignment west end

The length will be added to the start point, on west end of the alignment.

 1. Contextual ribbon > Modify panel > Geometry Editor
 2. Alignment Layout Tools toolbar > Tangent-Tangent tool dropdown > Tangent-Tangent (No 

curve)
 3. Specify start point: Select any point beyond (west of) the alignment's start point.
 4. Specify next point:Shift + right-click > Endpoint OSnap > Left-click alignment start point
 5. Right-click to accept. 

Establish new start point

The new line segment added has a negative station number because it was added on to the start point, 
0+00, going west.

 1. Left-click on the alignment
 2. Contextual ribbon > Modify panel > Alignment Properties
 3. Alignment Properties dialog box

 A. Notice in station information, start station has a negative number.
 B. Station Control tab > Reference point box > select Pick reference point icon, next to Y 

coordinate.
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 C. Warning dialog box > OK
 D. Select alignment reference point location:Shift + right-click > Endpoint 

OSnap > Left-click alignment new start point
 E. Notice in station information, start station has changed to 0+00.
 F. OK to accept

Lengthening alignment east end

The length will be added to the end point, on east end of the alignment.

 1. Alignment Layout Tools toolbar > Tangent-Tangent tool dropdown > Tangent-Tangent (No 
curve)

 2. Specify start point:Shift + right-click > Endpoint OSnap > Left-click alignment end point
 3. Specify next point: Select any point beyond (east of) the alignment's end point.
 4. Right-click to accept.

Endpoint stationing continues in sequence.

Troubleshooting gaps

Video: ali-edit-04.mp4 2:54

Open drawing file

 1. Quick Access > Open
 2. Open File dialog box

 A. Look in: browse to folder dataset is saved.
 B. Select AliProf-4thAve.dwg
 C. Open

Zoom to east end of the alignment. The end segment is missing labeling, numbering is in the wrong dir-
ection and needs a curve.

Change line segment direction

 1. Left-click the alignment
 2. Contextual ribbon > Modify panel > Geometry Editor OR Right-click menu > Edit Alignment Geo-

metry...
 3. Alignment Layout Tools toolbar > Reverse Sub-entity Direction tool
 4. Left-click end line segment
 5. Right-click to accept.

Add curve

 1. Alignment Layout Tools toolbar > Curve tool dropdown > Free Curve Fillet (Between two entit-
ies, radius)

 2. Select first entity: Left-click on incoming line segment, the line before the end line seg-
ment

 3. Select next entity: Left-click end line segment
 4. Is curve solution angle (G)reaterthen180 (L)essthan180:LEnter
 5. Specify radius:90Enter

Page: 242

Published on: 5/1/2024

Alignment editing

https://c3dkb.dot.wi.gov/video/ali/ali-edit-04.mp4


Edit curve to include 90' radius

 1. Alignment Layout Tools toolbar > Delete Sub-entity tool
 2. Left-click on curve between stations 5+00 and 6+00.
 3. Right-click to accept
 4. Alignment Layout Tools toolbar > Curve tool dropdown > Free Curve Fillet (Between two entit-

ies, radius)
 5. Select first entity: Left-click on incoming line segment, west of break
 6. Select next entity: Left-click outgoing line segment, east of break
 7. Is curve solution angle (G)reaterthen180 (L)essthan180:LEnter
 8. Specify radius:90Enter

Alignment properties
Last updated: 2022-11-01

Total video time: 19:29

Reference point control

Exercise file: ali-data-C3D22.zip

Video: ali-prprtis-01.mp4 2:46

Open drawing file

 1. Quick Access > Open
 2. Open File dialog box

 A. Look in: browse to folder dataset is saved.
 B. Select AliProf-All-ali-prprtis-01.dwg
 C. Open

Move reference point

 1. Left-click Alignment STH25
 2. Hover over Alignment STH25, double boxes appear > left-click > Selection 

Cycling dialog box > select Alignment
 3. Contextual ribbon > Modify panel > Alignment Properties
 4. Alignment Properties dialog box

 A. Station Control tab > Reference point
 I. Select Pick Reference Point icon

 II. Warning dialog box > OK
 III. Shift + right-click > OSnap Apparent Intersect > Left-click cross point of Align-

ment 25 and Alignment 4th Ave.
 B. OK

 5. ECS to end command

Change reference point station number

 1. Left-click Alignment 25
 2. Hover over Alignment 25, double boxes appear > left-click > Selection Cyc-

ling dialog box > select Alignment
 3. Contextual ribbon > Modify panel > Alignment Properties
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 4. Alignment Properties dialog box
 A. Station Control tab > Reference point

 I. Station: type 10000
 B. OK

 I. Warning dialog box > OK
 C. OK

 5. ESC to end command

Station equation

Video: ali-prprtis-02.mp4 2:50

Open drawing file

 1. Quick Access > Open
 2. Open File dialog box

 A. Look in: browse to folder dataset is saved.
 B. Select AliProf-All-ali-prprtis-02.dwg
 C. Open

Add station equation

 1. Left-click alignment
 2. Hover over alignment, double box appears > left-click > Selection Cycling dialog box > select 

Alignment
 3. Contextual ribbon > Modify panel > Alignment Properties
 4. Alignment Properties dialog box

 A. Station Control tab > Station equations
 I. Select Add station equation icon

 II. Warning dialog box > OK
 B. Specify station along baseline: type 42759.12Enter
 C. Station Control tab > Station equations

 I. Station Ahead: type 42800
 II. Warning dialog box > OK

 D. OK
 5. ESC to end command

Remove station equation

 1. Left-click alignment
 2. Hover over alignment, double box appears > left-click > Selection Cycling dialog box > select 

Alignment
 3. Contextual ribbon > Modify panel > Alignment Properties
 4. Alignment Properties dialog box

 A. Station Control tab > Station equations
 I. Select Equation 1

 II. Select Delete station equation icon
 III. Warning dialog box > OK

 B. OK
 5. ESC to end command

Masking
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Video: ali-prprtis-03.mp4 3:15

Open drawing file

 1. Quick Access > Open
 2. Open File dialog box

 A. Look in: browse to folder dataset is saved.
 B. Select AliProf-All-ali-prprtis-02.dwg
 C. Open

Add masking region

 1. Left-click alignment
 2. Hover over alignment, double box appears > left-click > Selection Cycling dialog box > select 

Alignment
 3. Contextual ribbon > Modify panel > Alignment Properties
 4. Alignment Properties dialog box

 A. Masking tab > Masking regions
 I. Select Add masking region icon

 II. Specify first station for masking region: type 42325Enter
 III. Specify second for masking region: type 45535Enter

Info: In the Masking regions area, of the Alignment Properties dialog box, the 
green check mark under Mask indicates the region between the start and end 
stations is masked. The locks for start and end stations act as anchor points 
for the mask region, in case the alignment changes.

 B. OK
 5. ESC to end command

Remove masked region

 1. Left-click alignment
 2. Hover over alignment, double box appears > left-click > Selection Cycling dialog box > select 

Alignment
 3. Contextual ribbon > Modify panel > Alignment Properties
 4. Alignment Properties dialog box

 A. Masking tab > Masking regions
 I. Select Region 1 

 II. Select Delete masking region icon
 B. OK

 5. ESC to end command

Point of intersection and constraint editing settings

Video: ali-prprtis-04.mp4 3:20

Two types of Point of intersection

 l Explicit PI - The point at which two fixed tangents meet on a horizontal alignment, and can be 
labeled, moved, deleted, or broken apart.
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 l Implied PI - The computed PI at an alignment curve or curve group. The implied PI indicates where 
tangents would meet if they were extended outward. They can be labeled.

Open drawing file

 1. Quick Access > Open
 2. Open File dialog box

 A. Look in: browse to folder dataset is saved.
 B. Select AliProf-4th-Ave.dwg
 C. Open

Point of Intersection settings

 1. Left-click alignment
 2. Hover over alignment, double box appears > left-click > Selection Cycling dialog box > select 

Alignment
 3. Contextual ribbon > Modify panel > Alignment Properties
 4. Alignment Properties dialog box

 A. Point of Intersection tab
 I. Select radial button By individual curves and curve group

 B. OK
 5. Zoom to south curve, see PI displayed.

 o Point of Curve is the beginning of curve.
 o Point of Tangent is the end of curve.
 o Implied PI is found in between with a gray triangle grip point.

 6. Hover over gray triangle grip point to display Solve PI.
 7. Left-click gray triangle grip point.
 8. Grip point color changed to cyan. It is now an Explicit PI. It has the option to Move PI or Break-apart 

PI.
 9. ESC to end command

Constraint editing settings

 1. Left-click alignment
 2. Hover over alignment, double box appears > left-click > Selection Cycling dialog box > select 

Alignment
 3. Contextual ribbon > Modify panel > Alignment Properties
 4. Alignment Properties dialog box

 A. Constraint Editing tab 
 I. Check box Lock all parameter constraints

 II. Check box Always perform implied tangency constraint swapping
 III. OK

 5. ESC to end command

Design speed

Video: ali-prprtis-05.mp4 3:35
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Open drawing file

 1. Quick Access > Open
 2. Open File dialog box

 A. Look in: browse to folder dataset is saved.
 B. Select AliProf-All-ali-prprtis-02.dwg
 C. Open

Add design speeds

 1. Left-click alignment
 2. Hover over alignment, double box appears > left-click > Selection Cycling dialog box > select 

Alignment
 3. Contextual ribbon > Modify panel > Alignment Properties
 4. Alignment Properties dialog box

 A. Design Criteria tab > Design Speeds
 I. Select Add design speed icon

 II. The table populates with an entry.
 III. Change Design Speed to 45 mi/h
 IV. Select Add design speed icon
 V. The table populates with a new entry.

Info: When adding design speeds, the new entry will populate at the top of the 
table, using the design speed of the last entry.

 VI. In Entry 2, select Start Station. A Pick from Screen icon appears, left-click it.
 VII. Specify station along baseline:43775Enter

 VIII. Change Design Speed to 30 mi/h
 IX. Select Add design speed icon
 X. The table populates with a new entry.

 XI. In Entry 1, highlight Start Station and type 46675
 XII. Click somewhere outside that box. The table will auto-sort itself, Changing the first 

entry to be the lowest Start Station number. Entry 1 is now Entry 3.
 XIII. In Entry 3, change Design speed to 45 mi/h

 B. OK
 5. ESC to end command

Remove design speed

 1. Left-click alignment
 2. Hover over alignment, double box appears > left-click > Selection Cycling dialog box > select 

Alignment
 3. Contextual ribbon > Modify panel > Alignment Properties
 4. Alignment Properties dialog box

 A. Design Criteria tab > Design Speeds
 I. Select Entry 3

 II. Select Delete design speed icon
 III. Select Entry 2
 IV. Select Delete design speed icon

 B. OK
 5. ESC to end command

Criteria-based design
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Video: ali-prprtis-06.mp4 3:40

Open drawing file

 1. Quick Access > Open
 2. Open File dialog box

 A. Look in: browse to folder dataset is saved.
 B. Select AliProf-All-ali-prprtis-02.dwg
 C. Open

Adding WisDOT criteria-based design data

 1. Left-click alignment
 2. Hover over alignment, double box appears > left-click > Selection Cycling dialog box > select 

Alignment
 3. Contextual ribbon > Modify panel > Alignment Properties
 4. Alignment Properties dialog box

 A. Design Criteria tab
 I. Design Speeds box

 a. Select Add design speed icon
 b. The table populates with an entry.
 c. Change Design Speed to 45 mi/h

 II. Check box Use criteria-based design
 III. Check box Use design criteria file
 IV. Select ...

 a. Select Design Speed Table dialog box
 i. Look in: dropdown, browse to C:\ProgramData\Autodesk\C3D 

2020\enu\Data\Corridor Design Standards\Imperial
 ii. File name: select WisDOT Design Criteria 2009.xml
 iii. Open

 V. Default criteria box
 a. Minimum Radius Table > WisDOT eMax 4%
 b. Transition Length Table > 3LaneTWLWL@CL
 c. Attainment Method > Crowned Roadway

 VI. Check box Check for tangency between elements
 B. OK

 5. ESC to end command

Offset alignments and widenings
Last updated: 2022-11-01

Total video time: 36:22

Introduction to offset alignments and widening

Exercise file: ali-data-C3D22.zip

Video: ali-offst-widen-00.mp4 2:36

A roadway design consists of 3 main elements; alignment, profile, and cross-section. When combined, 
provides a 3D layout of the roadway.
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 l Alignment is the route of the road, defined by horizontal tangents and curves.
 l Profile is the vertical aspect of the road.
 l Cross-section shows the precision and number of lanes and sidewalks, cross slopes or banks, drain-

age features, and pavement structures.
 

Offset alignment function helps place identify the lanes, sidewalks, and other geometric physical elements 
of the road horizontally. Offset alignments are dynamically linked to a parent alignment and dependent on 
their geometry. Usually it is the centerline of the road. The offset alignment function is perfect for defining lin-
ear geometry as the roadway evolves.

Widening regions can be placed along the geometry of the offset alignments and useful for creating bus 
bays, medians, turn lanes, shoulders, and parking lanes. Offset widening should not be a negative offset 
value.

Creating offset alignments from parent alignment

Video: ali-offst-widen-01.mp4 5:37

Open drawing file

 1. Quick Access > Open
 2. Open File dialog box

 A. Look in: browse to folder dataset is saved.
 B. Select AliProf-All.dwg
 C. Open

Create offset alignment

 1. Ribbon > Home tab > Create Design panel > Alignment dropdown > Create Offset Alignment
 2. Select an alignment:Right-click > Select Alignment dialog box > select alignment 25 OK

Tip: When there are more than one alignment, right-click and select the alignment from the 
list in the Select Alignment dialog box.

 3. Create Offset Alignments dialog box
These settings are based off the parent alignment. We will keep most as is, but they can be edited.

 A. Incremental offset on left: type 12
 B. Incremental offset on right: type12
 C. General tab > Alignment style: dropdown and select RDWY Shoulder Paved
 D. General tab > Alignment label set: dropdown and select _No Labels
 E. OK

 4. Ribbon > Home tab > Create Design panel > Alignment dropdown > Create Offset Alignment
 5. Select an alignment:Right-click > Select Alignment dialog box > select alignment 25 OK
 6. Create Offset Alignment dialog box

 A. Incremental offset on left: type 15
 B. Incremental offset on right: type 15
 C. General tab > Alignment style: dropdown and select RDWY Pavement Edge
 D. General tab > Alignment label set: dropdown and select_No Labels
 E. OK

 7. Ribbon > Home tab > Create Design panel > Alignment dropdown > Create Offset Alignment
 8. Select an alignment:Right-click > Select Alignment dialog box > select alignment 25 OK

Page: 249

Published on: 5/1/2024

Offset alignments and widenings

https://c3dkb.dot.wi.gov/video/ali/ali-offst-widen-01.mp4


 9. Create Offset Alignment dialog box
 A. Incremental offset on left: type 25
 B. Incremental offset on right: type 25
 C. General tab > Alignment style: dropdown and select RDWY Shoulder Aggregate
 D. General tab > Alignment label set: dropdown and select _No Labels
 E. OK

The drawing now contains alignment 25 and offset alignments with object styles. If the parent alignment 
changes, the offset alignments are dynamically linked and will move along maintaining their offset values.

Cleanup offset alignment names

Video: ali-offst-widen-02.mp4 8:46

Open drawing file

 1. Quick Access > Open
 2. Open File dialog box

 A. Look in: browse to folder dataset is saved.
 B. Select AliProf-All-ali-offst-widen-02.dwg
 C. Open

Viewing alignments and offset alignments in Toolspace

 1. Toolspace > Prospector tab
In Master View, Open Drawings should be expanded and list all drawings. The drawing in bold font 
is the active drawing.

 2. Expand AliProf-All > expand Alignments > expand Centerline Alignments and Offset Align-
ments

How to open Alignment Properties dialog box

 l Left click alignment 
 l Contextual ribbon > Modify panel > Alignment Properties
 l Right-click menu > Alignment Properties...
 l Toolspace > Prospector tab > expand Alignments > expand Offset Alignment > right-click align-

ment > Properties...

Renaming offset alignments

 1. Toolspace > Prospector tab > expand Alignments > expand Offset Alignment > right-click offset 
alignment 25-Left-12.000 > Properties...

 2. Alignment Properties dialog box
 A. Information tab > Name: type 25-L-ETW (edge of travel way)
 B. OK

 3. Continue down the list for each offset alignment listed in Toolspace.
 4. Right-click offset alignment 25-Left-15.000 > Properties...
 5. Alignment Properties dialog box

 A. Information tab > Name: type 25-L-EPS (edge of paved shoulder)
 B. OK

 6. Right-click offset alignment 25-Left-25.000 > Properties...
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 7. Alignment Properties dialog box
 A. Information tab > Name: type 25-L-EGS (edge of gravel shoulder)
 B. OK

 8. Right-click offset alignment 25-Right-12.000 > Properties...
 9. Alignment Properties dialog box

 A. Information tab > Name: type 25-R-ETW
 B. OK

 10. Right-click offset alignment 25-Right-15.000 > Properties...
 11. Alignment Properties dialog box

 A. Information tab > Name: type 25-R-EPS
 B. OK

 12. Right-click offset alignment 25-Right-25.000 > Properties...
 13. Alignment Properties dialog box

 A. Information tab > Name: type 25-R-EGS
 B. OK

Check your work

 1. Left-click furthest left/west offset alignment
 2. Properties palette > Information

 A. Confirm Style: RDWY Shoulder Aggragate
 B. Confirm Name: 25-L-EGS

 3. ESC to end

Save drawing and close drawing

 1. Quick Access > SaveORCtrl + S
 2. Close drawing, left-click X on AliProf-All tab, at the top of Modelspace.

Open drawing file

 1. Quick Access > Open
 2. Open File dialog box

 A. Look in: browse to folder dataset is saved.
 B. Select AliProf-4thAve-ali-offst-widen-02.dwg
 C. Open

Renaming offset alignments

 1. Toolspace > Prospector tab > expand Alignments > expand Offset Alignment > right-click offset 
alignment 4thAve-Left-12.000 > Properties...

 2. Alignment Properties dialog box
 A. Information tab > Name: type 4thAve-L-ETW
 B. OK

 3. Right-click offset alignment 4thAve-Left-18.000 > Properties...
 4. Alignment Properties dialog box

 A. Information tab > Name: type 4thAve-L-EGS
 B. OK

 5. Right-click offset alignment 4thAve-Right-12.000 > Properties...
 6. Alignment Properties dialog box

 A. Information tab > Name: type 4thAve-R-ETW
 B. OK

 7. Right-click offset alignment 4thAve-Right-15.000 > Properties...
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 8. Alignment Properties dialog box
 A. Information tab > Name: type 4thAve-R-EPS
 B. OK

Check your work

 1. Left-click furthest left/north offset alignment
 2. Properties palette > Information

 A. Confirm Style: RDWY Shoulder Aggragate
 B. Confirm Name: 4thAve-L-EGS

 3. ESC to end

Add widening to offset alignment

Video: ali-offst-widen-04.mp4 4:38

Open drawing file

 1. Quick Access > Open
 2. Open File dialog box

 A. Look in: browse to folder dataset is saved.
 B. Select AliProf-All.dwg
 C. Open

Open Toolspace palette

The Toolspace palette helps to navigate through, gives details of what Civil3D objects exist in the drawing, 
and styles or settings that can be selected and are available. Two ways to open the Toolspace palette:

 l Commandline: type Toolspace
 l Ribbon > Home tab > Palettes panel > Toolspace and anchor to left or right side of the drawing 

area.

Add widening to offset alignment

Adding widening to the road allows more room to get around turns, create off ramps, turn lanes, and bus 
bays.

 1. Toolspace > Prospector tab > expand Alignments > expand Centerline and Offset Alignments
 2. Offset Alignments > Right-click 25-R-ETW > Add Widening...
 3. Create Widening portion as a New Alignment? [Yes/No]:YEnter
 4. Select start station:38370Enter
 5. Select end station:38462Enter
 6. Enter widening offset:22Enter
 7. Specify side [Left/Right]:REnter
 8. Offset Alignment Parameters dialog box

Changing properties in Alignment Parameters dialog box

Zoom into widening area of the alignment to visually see the changes. The component that is changing will 
highlight in the drawing.

 1. Transition Parameters at Exit > Transition Length: type 1Enter
 A. Notice transition taper is gone and there's a sharp return.
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 2. Transition Parameters at Entry > Transition Length: type 50Enter
 A. Notice start station changed from 383+70.00' to 383+45.00'.
 B. Notice region length increased from 92' to 117'.

 3. Widening Parameters > Start station: type 38350Enter
 A. Notice it maintained the 50' transition length, but moved the station forward and reduced the 

region length.
 4. Widening Parameters > End station: type 38367Enter

 A. Notice region length decreased.
 5. Transition Parameters at Entry > Taper Input Type: change to By Taper Ratio
 6. Transition Parameters at Entry > Taper Ratio: type 3Enter (it will assume the 1: portion)

 A. Notice widening area in the drawing, measuring 1' in length.

Adding widening areas to the EPS alignment

Video: ali-offst-widen-05.mp4 3:16

Open drawing file

 1. Quick Access > Open
 2. Open File dialog box

 A. Look in: browse to folder dataset is saved.
 B. Select AliProf-All.dwg
 C. Open

Add widening to EPS alignment

 1. Toolspace > Prospector tab > expand Alignments > expand Centerline and Offset Alignments
 2. Offset Alignments > Right-click 25-R-EPS > Add Widening...
 3. Create Widening portion as a New Alignment? [Yes/No]:NEnter
 4. Select start station:Shift + right-click > Osnap Endpoint > select start station point of 

previous widening area.
 5. Select end station: Select end station point of previous widening area.
 6. Enter to end command
 7. Enter widening offset:37Enter
 8. Offset Alignment Parameters dialog box

 A. Transition Parameters at Entry > Taper Input Type: change to By Taper Ratio
 B. Transition Parameters at Entry > Taper Ratio: type 3Enter
 C. Widening Parameters > Start station: select Green Box icon - Select from Screen

 I. Shift + right-click > Osnap Endpoint > select start station point of previous widen-
ing area.

 D. Transition Parameters at Exit > Transition Length: type 1Enter
 E. Select X to close Offset Alignment Parameters dialog box 

Create a masked area

Video: ali-offst-widen-06.mp4 2:38
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Open drawing file

 1. Quick Access > Open
 2. Open File dialog box

 A. Look in: browse to folder dataset is saved.
 B. Select AliProf-All.dwg
 C. Open

Add masking to offset alignment 12-R-ETW

The masking properties allows a selected area or region, along the alignment, to be masked or hidden. 
Even though the area isn't visible, the information still exists; the stationing and geometry is still active.

 1. Toolspace > Prospector tab > expand Alignments > expand Offset Alignments > Right-click 12-
R-ETW > Properties...

 2. Alignment Properties dialog box
 A. Masking tab > Masking regions > Add masking region icon
 B. Specify first station for masking region: type 33000Enter
 C. Specify second station for masking region:OSnap to the start point of the 

widening transition area. Enter
 3. Alignment Properties dialog box

 A. Masking tab > Masking regions > Add masking region icon
 B. Specify first station for masking region:OSnap to the end point of the 

widening transition area.
 C. Specify second station for masking region: type 48519Enter

 4. Alignment Properties dialog box
 A. OK

Adding widening areas during offset alignment creation

Video: ali-offst-widen-07.mp4 4:04

Open drawing file

 1. Quick Access > Open
 2. Open File dialog box

 A. Look in: browse to folder dataset is saved.
 B. Select AliProf-4thAve.dwg
 C. Open

Create offset alignment with widening

 1. Ribbon > Home tab > Create Design panel > Alignment dropdown > Create Offset Alignment
 2. Select an alignment: Left-click alignment
 3. Create Offset Alignments dialog box

 A. Alignment to offset from: 4thAve
 B. Offsets name template: Leave as is
 C. Station range: Check box From start and check box To end
 D. No. of offsets on left: 1
 E. No. of offsets on right: 0
 F. Incremental offset on left: 18
 G. General tab

 I. Site: <None>
 II. Alignment style: RDWY Lane Edge
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 III. Alignment layer: P_ALI-Base
 IV. Alignment label set: _No Labels

 H. Create Offset Profile tab
 I. Check box Create profile for offset alignment

 II. Leave all other settings as is.
 I. Widening Criteria tab

 I. Check box Add widening around curves
 II. Property Widening to Apply on: Inside Only

 III. Increase in width: 4
 IV. Transition length: 50

 J. OK

Edit widening

 1. Left-click offset alignment
 2. Locate Padlock symbol, this is where widening occurs. 
 3. Left-click the padlock, this will unlock and allow edits.
 4. Contextual ribbon > Modify panel > Offset Parameters
 5. Offset Alignment Parameters dialog box
 6. As you select each Property type, it will highlight in the drawing. Change the values to edit the widen-

ing.

Edit parameters of widened offset alignment

Video: ali-offst-widen-08.mp4 2:02

Open drawing file

 1. Quick Access > Open
 2. Open File dialog box

 A. Look in: browse to folder dataset is saved.
 B. Select AliProf-4thAve.dwg
 C. Open

Edit widening parameters

 1. Toolspace > Prospector tab > expand Alignments > expand Offset Alignments > Right-click 
4thAve-Left-18.000 > Edit Offset Parameters...

 2. Offset Alignment Parameters dialog box
 A. Nominal Offset: 15Enter

Info: When entering a value, the placement of the offset decides if the value is pos-
itive or negative. Since the offset is to the left, this value will automatically be neg-
ative.

 B. Transition In > Transition Length: 45Enter
 C. Widening Region > Increased Width from Standard: 10Enter
 D. X to close box

Edit widening to offset alignment graphically

Video: ali-offst-widen-09.mp4 2:11
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Open drawing file

 1. Quick Access > Open
 2. Open File dialog box

 A. Look in: browse to folder dataset is saved.
 B. Select AliProf-4thAve-ali-offst-widen-09.dwg
 C. Open

Edit widening to offset alignment

 1. Left-click the offset alignment
 2. Notice the different grip points along the parent and offset alignments.
 3. Left-click the cyan diamond grip point on the east end of alignment.

 A. Specify stretch point: slide the grip point left/west 20' OR point the grip west and 
type 20Enter

 4. Left-click the cyan diamond grip point on the west end of alignment.
 A. Specify stretch point: slide the grip point right/east 20' OR point the grip east and 

type 20Enter
 5. Left-click the cyan plus symbol to create an offset widening area.
 6. Left-click the gray circle grip in transition. Two cyan circle grips appear on either side. Left-click and 

drag the cyan grips to make a tapered transition.
 A. Notice two gray diamond grips on the parent alignment. These will also adjust to transition 

ends along the parent alignment.
 7. Left-click the cyan triangle grip point and drag up or down. This will change the offset distance of the 

widened area.

Alignment from best fit
Last updated: 2022-11-01

ali-data-c3d22.zip

Create Fixed Line – Best Fit entity

 1. Open AliProf-All.dwg
 2. Home tab > Create Design panel > Alignment drop-down > Alignment Creation Tools 
 3. Alignment Layout toolbar > Line drop-down > Fixed Line - Best Fit
 4. From the Tangent by Best Fit dialog select From COGO points
 5. OK
 6. Select the south-most grouping of points, and the one point just north of that group.
 7. Right-click > Enter 
 8. Review the Regression Graph and click the green check mark in the upper right corner to close it 

and create the alignment.
 9. Click Save.

Create Floating Curve – Best Fit entities

 1. Open AliProf-All.dwg.
 2. Select the 25 alignment.
 3. Select the Geometry Editor
 4. Alignment Layout toolbar > Curve drop-down > Floating curve - Best Fit
 5. When prompted at the command line to select the entity to attach to select, graphically select the 

tangent alignment entity at the south of the project.
 6. In the Curve by Best Fit dialog select the From COGO Points option 
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 7. OK
 8. Graphically select the points that are grouped in the lower part of the southern curve.
 9. Right-click > Enter

 10. In the Regression Graph scroll to the bottom and turn on the Pass Through option for the last point.
 11. Click the green check mark in the upper right corner to close it and create the alignment.
 12. Zoom into the curve that was just created and graphically select it.
 13. Select the circular grip point at the mid-point of the curve. Drag the grip point back to be in line with 

the COGO point objects.

Create compound curve with Floating Curve – Best Fit

 1. Alignment Layout toolbar > Curve drop-down > Floating curve - Best Fit
 2. When prompted at the command line to select the entity to attach to select, graphically select the 

curve alignment entity that was just created.
 3. In the Curve by Best Fit dialog select the From COGO Points option 
 4. OK
 5. Graphically select the points that are grouped in the upper part of the southern curve.
 6. Right-click > Enter
 7. In the Regression Graph scroll to the bottom and turn on the Pass Through option for the last point.
 8. Click the green check mark in the upper right corner to close it and create the alignment.
 9. Save

Create Fixed Curve – Best Fit

 1. Open AliProf-All.dwg.
 2. Select the 25 alignment.
 3. Select the Geometry Editor
 4. Alignment Layout toolbar > Curve drop-down > Fixed curve - Best Fit
 5. In the Curve by Best Fit dialog select the From COGO Points option 
 6. OK
 7. Graphically select the points that are grouped in the lower part of the northern curve.
 8. Right-click > Enter
 9. In the Regression Graph scroll to the bottom and turn on the Pass Through option for the last point.

 10. Click the green check mark in the upper right corner to close it and create the alignment

Parcels/Plats

Parcel basics
Last updated: 2021-06-29

Parcel anatomy

prcl-basc-01.mp4 5:03

Exercise files: prcl-basc-data-begin-c3d20.zip

Parcel objects are made up of line and curve segments but is only the area within these segments is the par-
cel area.
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Two ways to access parcel properties

 1. Select parcel object label (found in the center of object)
 A. Ribbon > Parcel tab > Modify panel > Parcel Properties

 2. Select parcel object label (found in the center of object)
 A. Right-click > select Parcel Properties... from drop-down menu

Editing parcel segment label style

 1. Select label on a line segment
 2. Ribbon > Label-Parcel Segement Label tab > Mobify panel > Label Properties
 3. AutoCAD Properties dialog box

 A. Design tab > Expand Information dropdown > Line Label Style > Parcel Line Label Style > 
Distance

Tip: You can use either General Line Label Styles or Parcel Line Label Styles from 
list.

 II. X to close properties palette

Editing parcel segment style

Info: Parcel segment styles can not be modified in the Properties palette.  It must be done through the 
parcel object label.

 1. Select parcel object label (found in the center of object)
 2. Ribbon > Parcel tab > Modify panel > Parcel Properties > Parcel Properties dialog box > Inform-

ation tab
 A. Object Style: Select style from dropdown

 3. OK (and Esc to deselect object)

Editing parcel object label style

 1. Select parcel object label (found in the center of object)
 2. Ribbon > Parcel tab > Modify panel > Parcel Properties > Parcel Properties dialog box > Com-

position tab
 A. Area selection label style dropdown, select style from list

 3. OK (and Esc to deselect object)

Parcel properties

prcl-basc-02.mp4 3:47

Ways to access parcel properties dialog box

Select parcel object label (found in the center of object)

 1. Select parcel object label (found in the center of object)
 A. Contextual Ribbon > Parcel tab > Modify panel > Parcel Properties

 2. Select parcel object label (found in the center of object)
 A. Right-click > select Parcel Properties... from drop-down menu

 3. Toolspace > Prospector tab > Parcel > expand Sites > expand Field Survey > expand Parcels > 
right-click on parcel name > select Properties...
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About properties dialog box

 1. Information tab
 A. Name of parcel

Info: This will be grayed-out if you have "Use name template in parcel style" check-
box checked. Uncheck to edit name.

 B. Description of parcel
 C. Object Style

 I. Once you select an object style from dropdown list, click Apply to see the line type 
change.

 2. Composition tab
 A. Area selection label style 

 I. Changes the parcel object label
 B. Parcel statistics 

 I. Contains area and perimeter measurements
 3. Analysis tab

 A. User can run two different types of analyses
 I. Inverse analysis

 II. Mapcheck analysis
 B. Calculation Setting

 I. Contains the "Point of Beginning", X & Y coordinates

Info: Point of beginning is either the starting point of the parcel created manu-
ally with parcel creation tools or, from an object, it's the first vertice of the 
object.

 II. To redefine your point of beginning
 a. Select green pick-box button and object will have arrows showing direction of 

analysis
 b. Select a new point of beginning.

 III. Process segment order counterclockwise checkbox
 a. To change the direction of analysis

 4. User Defined Properties tab
 A. To change Property Data values

Tip: Drawing files started with the plat-start WisDOT template file will have many user 
defined property fields available to fill in if possible. This data could appear in tables 
and Excel spreadsheets.

Parcel properties

prcl-basc-03.mp4 3:45

Ways to access Parcel Style dialog box

Select parcel object label (found in the center of object)

 1. Select parcel object label (found in the center of object)
 A. Ribbon > Parcel tab > Modify panel > select Parcel Properties dropdown > select Edit 

Parcel Style
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 2. Select parcel object label (found in the center of object)
 A. Right-click > select Edit Parcel Style... from dropdown menu

 3. Toolspace > Settings tab > expand Parcel > expand Parcel Styles > select parcel style in use > 
right-click for dropdown > select Edit...

About Parcel Style dialog box

 1. Information tab
 A. Name of style
 B. Description of style
 C. Created by and date
 D. Last modified by and date

 2. Design tab
 A. Parcel pattern fill

 I. Observe fill distance checkbox and measurement; the distance from the line seg-
ments to the interior that is filled/hatched.

Info: To see style applied, go to Display tab > Component display box > Parcel 
Area Fill > Select lightbulb to on.

 B. Parcel name template
 I. Select template icon to access properties used to populate the name template

 3. Section tab
 A. Object Display > Parcel Segments Marker Styles 

 I. Contains marker styles inside the multipurpose settings within the WisDOT Stand-
ards

 4. Display tab
 A. View direction

 I. Plan, model, or section
 B. Component Diplay

 I. Parcel Segments, displays outside geometry of parcel.
 II. Parcel Area Fill, displays the fill/hatch area.

Info: To view Parcel Segment Marker, change view direction to Section.

 C. Component hatch display
 I. User can edit pattern, angle, and scale of fill/hatch.

 5. Summary tab
 A. Contains information and Design data.

Create/edit parcels
Last updated: 2021-06-28

Total video time: 7:42

Create parcels from object

prcl-creat-edit-01.mp4 3:51

Exercise files: prcl-creat-edit-data-begin-c3d20.zip

Parcels created from an object is the preferred method for parcel creation.  A parcel can be created from 
lines, polylines, and arcs, and these need to be connected/snapped at the endpoints to create a closed 
boundary.
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 1. Using polyline command to create an object.

 A. Ribbon > Home tab > Draw panel > Polyline

Tip: Have object snap set to Node only to make selection easier.

 B. Specify start point: Select node for start point and continue to each node to create 
perimeter of object.

 C. To close object: Select final node or type "C" in the command line to auto-snap to starting 
node and Enter.

 D. Create a second smaller object, repeating steps A - C, attached to first object.  Node snap 
last point to close.

 E. Home tab > Create Design panel > Parcel dropdown > Create Parcel from Objects
 F. Select lines, arcs, or polylines to convert into parcels: Select a 

polyline from both objects, Enter
 G. Create Parcels - From objects dialog box

 I. Site: Select Edit icon to create new site
 a. Site Properties - Field Survey dialog box 

 i. Name: Rename to Field Survey
 ii. OKOK

 II. Parcel Style: RW PLE Proposed
 III. Label styles box

 a. Area label style: Area Acres and SF
 b. Automatically add segment labels: Uncheck box

Info: Unchecking this box due to the overlap of polylines between 
objects.  Overlapping lines will need to be labeled manually.

 IV. Erase existing entities: Check box
 V. OK

Create parcels from union

prcl-creat-edit-02.mp4 3:51

Creating a new parcel next to existing parcels

 1. Ribbon > Home tab > Create Design panel > select Parcel dropdown > select Parcel Creation 
Tools

 2. Parcel Layout Tools toolbar
 A. Select icon Add Fixed Line - Two Points

 I. Create Parcels - Layout dialog box 
 a. Verify Site: Field Survey
 b. Parcel Style: RW PLE Proposed
 c. Label styles box 

 i. Area label style: Area Acres and SF
 d. Automatically add segment labels: Uncheck box

 II. OK
 B. Specify start point: Select start point
 C. Specify start point: Select next point
 D. Prompt: Press Enter to start a new lot line, or select from layout tools or Exit: Select Enter
 E. Shift+Right-click menu > Select Endpoint
 F. Select last parcel line point
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 G. Node snap to endpoint

Info: Creating a new closed shape out of parcel segments that are adjacent to exist-
ing parcels will create a new parcel.

 H. Enter and Esc to end command

Creating a parcel union

 3. Ribbon > Home tab > Create Design panel > select Parcel dropdown > select Parcel Creation 
Tools

 4. Parcel Layout Tools toolbar
 A. Select icon Parcel Union dropdown > select Parcel Union
 B. Select the destination parcel: Select parcel to the north/top.
 C. Select Parcels and press enter: Select lower left parcel and north/top parcel.
 D. Both parcels become unified, area label has changed to show this.

Dissolve a parcel union

 5. Home tab > Create Design panel > select Parcel dropdown > select Parcel Creation Tools
 6. Parcel Layout Tools toolbar

 A. Select icon Parcel Union dropdown > select Dissolve Parcel Union
 B. Select parcel: Select parcel that was unified.
 C. Parcel union is dissolved
 D. Exit

Parcel labels
Last updated: 2021-06-28

Total video time: 5:10

Parcel segment labels

prcl-lbl-01.mp4 5:10

Exercise data: prcl-lbl-data-begin-c3d20.zip

Open prcl-lbl-C3D18.dwg.

Parcels segment labels are created with parcel or manually after parcel creation

Add parcel segment labels manually per segment

 1. Select parcel area label onscreen.
 2. Parcel contextual ribbon tab > Labels and tables panel > Add Labels drop-down > Single Seg-

ment command
 A. Cursor becomes pick-box. Select anywhere along parcel segment.
 B. Observe that segment label appears.
 C. Add more labels by picking same segment in different location, or by picking additional par-

cel segments.
 D. Enter to end command.

Page: 262

Published on: 5/1/2024

Parcel labels

https://c3dkb.dot.wi.gov/video/prcl-plat/prcl-lbl-01.mp4
https://c3dkb.dot.wi.gov/data/prcl-plat/prcl-lbl-data-begin-c3d20.zip


Tip: 
Notice a default label style is applied automatically without any prompt allowing you 
to choose a label style on-the-fly.

To change the style of of a segment label (or all segment labels at once), select the 
labels you'd like to change and choose Label Styles from the contextual tab of the 
ribbon. This brings up the AutoCAD Properties dialog box where both the Line Label 
Style and the Curve Label Style can be changed to the desired parcel line and/or 
curve label style, or general line and/or curve label style.

Notice the label appears wherever you selected along the segment line, not neces-
sarily at the midpoint of the line.

Add multiple parcel segment labels manually, all at once

 1. Select parcel area label onscreen.
 2. Parcel contextual ribbon tab > Labels and tables panel > Add Labels drop-down > Multiple Seg-

ment command
 A. Cursor becomes pick-box. Select parcel area label for parcel whose segments you'd like to 

label and choose clockwise, or counterclockwise, to choose direction you'd like labels to 
measure.

 B. Observe that default style segment label appears at midpoint of every segment.
 C. Enter to end command.

Tip: 
Notice a default label style is applied automatically without any prompt allowing you 
to choose a label style on-the-fly.

To change the style of a segment label (or all segment labels at once), select the 
labels you'd like to change and choose Label Styles from the contextual tab of the 
ribbon. This brings up the AutoCAD Properties dialog box where both the Line Label 
Style and the Curve Label Style can be changed to the desired parcel line and/or 
curve label style, or general line and/or curve label style.

Add parcel segment labels manually through the Add Labels dialog box

 1. Annotate tab > Labels and Tables panel > Label icon (or Parcel > Add Labels drop-down > 
hover over Parcels heading > choose Add Parcel Labels from resulting fly-out menu

 B. In resulting floating Add Labels dialog box:
 I. From Feature Type drop-down, select Parcel as feature type to label.

 II. From Label type drop-down, choose Single Segment, Multiple Segment.
 a. Select Replace Multiple Segment commands if you already placed labels 

and want to replace them.
 b. Ignore Area label types because we are experimenting with segment labels 

in this exercise.
 III. Choose Line label style you'd like to apply.
 IV. Choose Curve label style you'd like to apply.
 V. Add.

 a. Select parcel area label (centroid label) for parcel whose segments you'd like 
to label and choose clockwise, or counterclockwise, to choose direction 
you'd like bearings to read along the segments.

 b. Direction chosen also controls order of number for segment if label becomes 
tag for use in segment table.
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 VI. Enter to end command.

 VII. Close in Add Labels dialog box when done creating new labels.

Tip: 
The benefit to using this dialog box is that you can change the Line label 
style and the Curve label style as you apply your labels as opposed to doing 
so from the AutoCAD Properties dialog box after creating labels as we saw 
before.

Choosing Replace Multiple Segment from the Label Type drop-down of the 
Add Labels dialog box allows users to replace already created segment 
labels with new labels without having to delete the old labels first and then 
create new labels from scratch afterward.

Edit parcel segment labels with grips

 1. Select a segment label and observe that two grips appear, a diamond shaped grip and a square 
grip.

 2. Left-click on diamond shaped label grip to slide label to new location along parcel segment line.
 3. Left-click on square label grip to move segment label into dragged state complete with leader point-

ing at object being labeled.
 4. With label selected in dragged state, reset label to original location by selecting label onscreen and 

choosing Reset Label command in contextual tab of ribbon, or by selecting label onscreen, right-
clicking and choosing Reset Label from right-click menu.

 5. Whether label is in dragged state or not, Flip Label is also command option in contextual tab of rib-
bon, or right-click menu, when label is selected and displaying grips. This command changes order 
of label components onscreen to opposite configuration. For instance, if line length component is 
usually above line being labeled and bearing component is below, length component will now be 
below line and bearing component will appear above it.

 6. Whether label is in dragged state or not, Reverse Label is also command option in contextual tab of 
ribbon, or right-click menu, when label is selected and displaying grips. If order labels were placed 
around parcel was originally clockwise from point of beginning, or first parcel segment, Reverse 
Label command will reconfigure segment labels to appear counterclockwise around parcel from 
point of beginning or first parcel segment.

Tip: If you'd like to choose your line and/or curve style for your parcel segment labels at the 
same time you are creating the labels, as opposed to editing the labels later to choose a style 
other than the default label style, go to the Annotate tab of the ribbon, the Labels & Tables 
panel, the Add Labels drop-down, and choose the top parcel label heading, Add Parcel 
Labels. This launches a dialog box allowing you to specify the style of the labels as you are 
creating them.

Parcel tables
Last updated: 2021-06-28

Total video time: 3:10

prcl-tbl-01.mp4 3:10

Exercise data: prcl-tbl-data-begin-c3d20.zip

Open prcl-tbl-C3D18.dwg.

Parcels tables are created from parcel segment labels.
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Parcel segment labels are converted to table tags.

 1. Select parcel area label onscreen.
 2. Parcel contextual ribbon tab > Labels & Tables panel > Add Tables drop-down > Add Line

 A. In resulting Table Creation dialog box, select green, Pick On-Screen button.
 B. Cursor becomes pick-box. Select all parcel segment labels in drawing window you'd like 

included in table to be created.

Tip: 
Or, in the Select by label or style: portion of the dialog box, select the styles of the 
already existing parcel segment labels you'd like to include in your table. If segment 
labels using that style exist in your drawing, they will automatically be added to the 
table when the OK button is selected when executing the table creation command 
after filling out the rest of the dialog box.

The four table types (four table commands) available in the Add Tables drop-down 
are Add Line, Add Curve, Add Segment, and Add Area. Add Line and Add Curve cre-
ate tables consisting of only those segment types, respectively. Add Segment cre-
ates tables with both line and curve segments included. Add Area creates tables 
consisting of, for instance, every overall parcel name and its area in square feet 
and/or acres.

 C. Select table layer or accept default WisDOT object layer for tables.
 D. Choose to split table after specifying number of rows allowed per table, or tables per table 

stack, to be created.
 E. Choose an offset distance between tables as they are placed in drawing window if multiple 

tables are being created simultaneously due to choice made in split table option.
 F. Choose how tables are to be tiled/arranged onscreen if multiple tables are being created 

simultaneously due to choice made in split table option.
 G. Choose whether tables will be Static (unchanging), or Dynamic (automatically updated) if 

underlying parcel segment data is edited.
 H. OK

 3. As a test, if your table was made to be dynamic in the preceding steps, select a parcel segment 
onscreen that is included in the table, select one of its grips, change length of parcel segments by 
moving grip associated with vertex grip. Observe table update with new parcel segment lengths 
and/or area.

Create existing r/w
Last updated: 2021-06-29

Total video time: 27:13

Create a new drawing file

plat-creat-ex-row-01.mp4 4:00

Exercise data: plat-creat-ex-row-data-begin-c3d20.zip

 1. Application menu  > New
 2. Select template dialog box

 A. Look in: Templates\Begin-dwg\plat-start.dwt
 B. Open
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 3. Once open, Application menu > Save As
 A. Save Drawing As dialog box 

 I. Save in: Local Disk:\WisDOT\Design\c3d\12345678\RW\DWG
 II. File name: 81100024-ERW

 III. Save

Creating and using data shortcuts (aka DREFs)

plat-creat-ex-row-02.mp4 4:21

Set up working folder

 1. Toolspace > Prospector tab > right-click Data Shortcuts > select Set Working Folder...
 2. Browse For Folder dialog box

 A. Find and select c3d folder (Local Disk\WisDOT\Design\c3d)

Info: Set the working folder 2 levels above your "_Shortcuts" folder location (which is 
in your project folder).

 B. OK

Set up data shortcut project folder

This will verify your data shortcuts are available.

 3. Toolspace > Prospector tab > right-click Data Shortcuts > select Set Data Shortcuts Project 
Folder...

 4. Set Data Shortcut Folder dialog box
 A. verify box is checked for project 12345678
 B. OK

Adding data shortcuts to base drawing

Adding alignments from data shortcuts to drawing

 5. Toolspace > Prospector tab > expand Data Shortcuts > expand Alignments > expand Cen-
terline Alignments > right-click CTH T-ExistROWRefLine > Create Reference...

 A. Leave default settings  OK
 6. Toolspace > Prospector tab > expand Data Shortcuts > expand Alignments > expand Cen-

terline Alignments > right-click STH64-ExistingROWRefLine > Create Reference...
 A. Leave default settings  OK

Two methods of promoting data shortcuts

Both methods will create permanent copies into the base drawing.

 7. Created through the Ribbon
 A. Select alignment object STH64-ExistingROWRefLine

 I. In Selection Cycling box, select Alignment

Tip: Having Selection Cycling on will make this step easier. You can find more 
here: "Status bar" on page 17

 B. Contextual ribbon > Alignment STH64-ExistingROWRefLine tab > Modify panel > Pro-
mote Data Reference
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 C. To verify 
 II. Toolspace > 81100024-ERW > Alignments > Centerline Alignments

 D. Alignment STH64-ExistingROWRefLine is permanent and does not have a shortcut sym-
bol before the name.

 8. Created through Toolspace
 A. Toolspace > 81100024-ERW > Alignments > right-click CTH T-ExistROWRefLine > Pro-

mote...

Add topo and section line XREFs

plat-creat-ex-row-03.mp4 4:07

Attaching XREFs

 1. Ribbon > Insert tab > Reference panel > select Attach
 2. Select Reference File dialog box

 A. While here, set quick access for Project folder
 I. Look in: Browse to c3d folder (Local Disk:\WisDOT\Design\c3d)

 II. Select 12345678 folder and drag to Places List

Tip: Use of the WisDOT custom command Load Xref on Layer can be seen in 
"Plat sheet details" on page 294.

 B. Look in: 12345678\BaseData\Mapping\Orig
 C. Select Base Map.dwg

Info: (Detailed explanation at 1:36 of video) "Topo-Ex.dwg" is used in future videos. It 
is identical to "Base Map.dwg" file used here except that the objects have been 
placed on layers adhering to the current WisDOT layer naming regime.

 D. Open
 3. Attach External Reference dialog box

 A. Name: Base Map
 B. Reference Type: Overlay
 C. Scale: X = 1.00, Y = 1.00, Z = 1.00
 D. Insertion point: X = 0.00, Y = 0.00, Z = 0.00
 E. Path type: Relative path
 F. Rotation > Angle: 0
 G. OK

Tip: You can adjust the brightness of the Xref display by typing "OP" for OPTIONS in command line. 
The Options dialog box will open. Select Display tab > Fade control > Xref display to adjust.

Attaching a second file

 4. Ribbon > Insert tab > Reference panel > select Attach
 5. Select Reference File dialog box

 A. Select 12345678 project folder from Places list
 B. Select RW\DWG\81100024-ERW-SectLines.dwg
 C. Open

 6. Attach External Reference dialog box
 A. Keep settings and select OK
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Adding right of way polylines using offset command

plat-creat-ex-row-04.mp4 5:00

 1. Open title and right of way plat information
 A. Open File Explorer
 B. Titles: Local Disk:\WisDOT\Design\c3d\12345678\RW\Misc_Info\TitleSearches
 C. Right of Way: Local Disk:\WisDOT\Design\c3d\12345678\RW\Misc_Info\Misc\rwplat-

81100024.pdf
 2. Continuing with .dwg from previous exercise.
 3. Open specific layer to work on

 A. Open Layer Properties Manager: LA
 I. Filters: Select Right of Way

 II. Layer Name: Double-click E_RW_Existing to make it current layer

Adding offsets north side, along alignment CTH T

 4. Ribbon > Home tab > Modify panel > select Offset command
 B. Specify offset distance: 33
 C. Select object to offset: Due to multiple objects overlapping, user should have 

Selection Cycling turned on.
 I. Select Selection Cycling in Status bar.

 D. Specify offset distance: Should read 33 from previous entry, Enter
 E. Select object to offset: Select alignment CTH T

 I. Selection dialog box > select Alignment
 F. Select point on side of offset: select right side (NE) of alignment CTH T
 G. Select object to offset: Select alignment CTH T

 I. Selection dialog box > select Alignment
 H. Select point on side of offset: select left side (NW) of alignment CTH T

 5. Use Trim command to create a cutting edge at crossing alignment
 A. Ribbon > Home tab > Modify panel > Trim dropdown > Trim
 B. Select cutting edges...Select objects: Select alignment STH64

 I. Selection dialog box > select Alignment
 C. Enter
 D. Select object to trim: Select both offset lines continuing south of alignment STH64 

to be deleted.

Adding offsets south side, along alignment CTH T

 6. Ribbon > Home tab > Modify panel > select Offset command2. Specify offset distance: 
40 3. Select object to offset: Select alignment CTH T

 A. Selection dialog box > select Alignment
 B. Select point on side of offset: Select right side (SE) of alignment CTH T
 C. Enter to end command and Enter to reset offset distance
 D. Specify offset distance: 45
 E. Select object to offset: Select alignment CTH T

 I. Selection dialog box > select Alignment
 F. Select point on side of offset: Select left side (SW) of alignment CTH T

 7. Use Trim command to create a cutting edge at crossing alignment
 A. Ribbon > Home tab > Modify panel > Trim dropdown > Trim
 B. Select cutting edge...Select object: Select alignment STH64

 I. Selection dialog box > select Alignment
 C. Enter
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 D. Select object to trim: select both offset lines continuing north of alignment STH64 
to be deleted.

Adding offsets east side, along alignment STH64

 8. Ribbon > Home tab > Modify panel > select Offset command
 9. Specify offset distance: 75

 10. Select object to offset: Select alignment STH64
 A. Selection dialog box > select Alignment
 B. Select point on side of offset: Select top side (NE) of alignment STH64
 C. Enter to end command and Enter to reset offset distance
 D. Specify offset distance: 60
 E. Select object to offset: Select alignment STH64

 I. Selection dialog box > select Alignment
 F. Select point on side of offset: Select bottom side (SE) of alignment STH64

 11. Use Trim command to create a cutting edge at crossing alignment
 A. Ribbon > Home tab > Modify panel > Trim dropdown > Trim
 B. Select cutting edge...Select object: Select alignment CTH T

 I. Selection dialog box > select Alignment
 C. Enter
 D. Select object to trim: select both offset lines continuing west of alignment CTH T 

to be deleted.

Adding offsets west side, along alignment STH 64

 12. Ribbon > Home tab > Modify panel > select Offset command

2. Specify offset distance: 80

3. Select object to offset: Select alignment STH64

 A. Selection dialog box > select Alignment
 B. Select point on side of offset: Select top side (NW) of alignment STH64
 C. Enter to end command and Enter to reset offset distance
 D. Specify offset distance: 55
 E. Select object to offset: Select alignment STH64

 I. Selection dialog box > select Alignment
 F. Select point on side of offset: Select bottom side (SW) of STH64 alignment

 13. Use Trim command to create a cutting edge at crossing alignment

 A. Ribbon > Home tab > Modify panel > Trim dropdown > Trim
 B. Select cutting edge...Select object: Select alignment CTH T

 I. Selection dialog box > select Alignment
 C. Enter
 D. Select object to trim: select both offset lines continuing east of alignment CTH T to 

be deleted.

Correcting polyline offset

plat-creat-ex-row-05.mp4 4:45

Page: 269

Published on: 5/1/2024

Create existing r/w

https://c3dkb.dot.wi.gov/video/prcl-plat/plat-creat-ex-row-05.mp4


Using C3D transparent command to correct polyline offset

 1. Ribbon > Home tab > Draw panel > Polyline

Info: This activates polyline command

 2. Transparent Commands toolbar > Select Station Offset

Info: This activates transparent command

 A. Specify station along baseline: 24000Enter
 B. Specify station offset: -50Enter

Info: Negative numbers place offset to the left of station, positive numbers to the right.

 C. Specify station along baseline: 25000Enter
 D. Specify station offset: -50Enter
 E. Specify station along baseline: 25000Enter
 F. Specify station offset: -80Enter
 G. Esc to exit transparent command
 H. Esc to exit polyline command

Correcting r/w editing

plat-creat-ex-row-06.mp4 4:53

Editing using offset command

Need to adjust the plat widening in the northwest corner of the intersection.

 1. Home tab > Modify panel > Offset command
 A. Specify offset distance: 50
 B. Select object to offset: Select the 80' r/w offset line
 C. Specify point on side to offset: Select to the north of 80' r/w offset line
 D. Select object to offset: Select alignment CTH T

 I. Selection dialog box > select Alignment
 E. Specify point on side to offset: Select to the west of alignment CTH T

Use Trim command to create cutting edges

 2. Home tab > Modify panel > Trim dropdown > Trim

 A. Select cutting edge...Select object: Select lines that are cutting edges.

Tip: Use crossing window select to select multiple lines.

 B. Enter
 C. Select object to trim: select all offset lines that cross past the actual r/w line.

Tip: Any lines that should be removed, but were not by the trim command, use select 
and delete to remove.
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Removing extra geometry

Removing Xrefs displayed

 1. Open Xref Manager, on command line type XR

 2. Right-click Base Map > Detach

Tip: To hide Xrefs, select Unload.

 3. Right-click Section Info > Detach

Removing centerline alignments

 1. Toolspace > Prospector tab > Alignments > Centerline Alignments > right-click STH64-
ExistROWRefLine > Delete

 2. Are you sure you wish to delete 'STH64-ExistROWRefLine'? Yes

Using Fillet command to connect line segments

 1. Connecting segment to offset line
 A. Select Fillet command 

 I. Home tab > Modify panel > Fillet dropdown > Fillet
 B. Keep radius at 0
 C. Select two lines; segment and offset line, excess will trim off.

 2. Doing multiple Fillet commands
 A. Select Fillet command
 B. In command line, select Multiple
 C. Select two lines and repeat around intersection.

Create proposed r/w
Last updated: 2021-06-29

Total video time: 20:22

Creating proposed r/w file

plat-creat-prop-row-01.mp4 4:49

Exercise data: plat-creat-prop-row-data-begin-c3d20.zip

 1. Application menu  > New
 2. Select template dialog box

 A. Look in: Templates\Begin-dwg\plat-start.dwt
 B. Open

 3. Application menu > Save As
 4. Save Drawing As dialog box

 A. Select 12345678 folder in the Places List
 B. Save in: 12345678\RW\DWG
 C. File name: 81100024-PRW
 D. Save
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Adding data shortcuts to proposed r/w file

Set working folder

 5. Toolspace > Prospector tab > right-click Data Shortcuts > select Set Working Folder...
 6. Browse For Folder dialog box

 A. Local Drive:\WisDOT\Design\c3d

Info: Set the working folder 2 levels above your "_Shortcuts" folder location (which is 
in your project folder).

 B. OK

Set data shortcuts project folder

This will verify your data shortcuts are available.

 7. Toolspace > Prospector tab > right-click Data Shortcuts > select Set Data Shortcuts Project 
Folder...

 8. Set Data Shortcut Folder dialog box
 A. Check box next to current project number, 12345678
 B. OK

Create reference data shortcut alignments

 9. Add Surface
 A. Toolspace > Prospector tab > Data Shortcuts > Surfaces > right-click RoadwayModel-

Datum > Create Reference...
 I. Create Reference dialog box 

 a. Information > Style: Select ellipse (...)
 i. Select Surface Style dialog box

 i. Select dropdown > Slope Intercept
 ii. OK

Info: If your 81100024-PRW drawing file was created 
from WisDOT Civil 3D 2020 Plat-start template, you 
may not have "Slope Intercept" style available.  Use 
"Standard" style instead.

 b. OK

 II. Use Zoom Extents; double-click mouse wheel or type Z+Enter and E+Enter
 10. Add data shortcuts (DREFs)

 A. Toolspace > Prospector tab > Data Shortcuts > Alignments > Centerline Alignments > 
right-click CTH T-ProposedROWRefLine > Create Reference...

 I. No changes and select OK
 B. Toolspace > Prospector tab > Data Shortcuts > Alignments > Centerline Alignments > 

right-click STH64-ProposedROWRefLine > Create Reference...
 I. No changes and select OK

 11. Promote data shortcuts
 A. Toolspace > Open Drawing > 81100024-PRW > Alignments > Centerline Alignments > 

right-click CTH T-ProposedROWRefLine > Promote...
 B. Toolspace > Open Drawing > 81100024-PRW > Alignments > Centerline Alignments > 

right-click STH64-ProposedROWRefLine > Promote...
 C.  

 12. Save file
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Adding XREFs to proposed r/w

plat-creat-prop-row-02.mp4 4:45

Opening Xref Manager/External Reference palette 2 ways

 1. Turned on Dynamic Input (found on status bar)
 2. Type XR or XREF
 3. Enter

OR

 1. Ribbon > Insert tab > Reference panel
 2. Select diagonal arrow in lower right corner of panel

Tip: To keep palette from docking; right-click on External Reference bar, left-click to uncheck Allow Dock-
ing.

Adding XREF 81100024-ERW.dwg

 3. XRef Manager
 A. Select File Source dropdown > select Attach DWG...

 4. Select Reference File dialog box
 A. Select project folder 12345678 in Places List
 B. Select RW\DWG\81100024-ERW.dwg
 C. Open

 5. Attach External Reference dialog box
 A. Name: 81100024-ERW
 B. Reference Type: Overlay
 C. Scale: X=1.00, Y=1.00, Z=1.00
 D. Path Type: Relative path
 E. Insertion Point: X=0.00, Y=0.00, Z=0.00
 F. Rotation Angle: 0
 G. OK

Tip: Use of the WisDOT custom command Load Xref on Layer can be seen in "Plat 
sheet details" on page 294.

Adding XREF 81100024-ERW-SectLines.dwg

 6. XRef Manager
 A. Select File Source dropdown > select Attach DWG...

 7. Select Reference File dialog box
 A. Select project folder 12345678 in Places List
 B. Select RW\DWG\81100024-ERW-SectLines.dwg
 C. Open

 8. Attach External Reference dialog box
 A. Name: 81100024-ERW-SectLines
 B. Reference Type: Overlay
 C. Scale: X=1.00, Y=1.00, Z=1.00
 D. Path Type: Relative path
 E. Insertion Point: X=0.00, Y=0.00, Z=0.00
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 F. Rotation Angle: 0
 G. OK

Finished adding XREFs, close External Reference palette by selecting the "x" in upper left corner.

Create proposed r/w boundary lines

Info: Set working environment: open title files and legal docs as needed.

 9. Open 12345678\RW\Misc_Info\TitleSearches\titles\8110-00-24.pdf, Parcel 1-Gillis Trust.pdf, 
Parcel 2-Cody Trust.pdf, and Parcel3-Krampert.pdf.

 10. Also open 12345678\RW\Misc_Info\Misc\rwplat-81100024.pdf.
 11. Open and peruse 12345678\RW\Misc_Info\TitleSearches\Misc\6424\rwplat\rwplat-

81100024.pdf, or other documents available in these folders, as needed.

Create proposed r/w alignment southwest

 12. Ribbon > Home tab > Create Design panel > Alignment dropdown > select Alignment Creation 
Tools

 13. Create Alignment - Layout dialog box
 A. Name: type Proposed ROW RT Southwest
 B. Type: Miscellaneous
 C. Starting Station: 0+00.00'
 D. Site: None
 E. Alignment Style: dropdown > select RW Proposed
 F. Alignment layer: Browse

 I. Object Layer dialog box 
 a. Based layer name: Browse > select P_RW_ProposedOK

 II. OK
 G. Alignment label set: dropdown > select _No Labels
 H. OK

 14. First turn on OSNAPS
 A. Object Snap settings in Status bar, select check boxes for Endpoint and Nearest, then 

select OK.
 15. Alignment Layout Tools toolbar

 A. Alignment creation dropdown > Tangent-Tangent (No curves)

Create proposed r/w boundary lines (cont.)

plat-creat-prop-row-03.mp4 4:59

Create proposed r/w alignment southwest

 1. Alignment Layout Tools toolbar
 A. Select Alignment creation dropdown > Tangent-Tangent (No curves)
 B. Specify start point: Select Transparent command toolbar > Station Offset
 C. Select alignment: select centerline alignment STH64

 I. Selection dialog box: select Alignment
 D. Specify station along baseline: 26000Enter
 E. Specify station offset:

Info: Be sure OSnaps are turned on; Object Snap settings in status bar, check boxes 
for endpoint and nearest, then OK.
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 I. Snap to nearest ROW line south of STH64.
 F. Specify station along baseline:26200Enter
 G. Specify station offset: 75Enter
 H. Specify station along baseline:26450Enter
 I. Specify station offset: 75Enter
 J. Esc to exit transparent command
 K. Esc to exit alignment command

 2. Alignment Layout Tools toolbar

 A. Select Alignment creation dropdown > Tangent-Tangent (No curves)
 B. Specify start point: Select Transparent command toolbar > Station Offset
 C. Select alignment: select centerline alignment CTH T
 D. Specify station along baseline: 2. select endpoint from previous alignment
 E. Specify station offset: select same point again
 F. Specify station along baseline:9800Enter
 G. Specify station offset: use the nearest OSnap to snap to r/w line west of CTH T.
 H. Esc to exit transparent command
 I. Esc to exit alignment command

 3. Close Alignment Layout Tools toolbar

Create proposed r/w alignment northwest

 4. Home tab > Create Design panel > Alignment dropdown > select Alignment Creation Tools

 5. Create Alignment - Layout dialog box

Info: Some of these options are defaults from the previous settings.

 A. Name: type Proposed ROW LT Northwest
 B. Type: Miscellaneous
 C. Starting Station: 0+00.00'
 D. Site: None
 E. Alignment Style: RW Proposed
 F. Alignment layer: Browse 

 I. Object Layer dialog box 
 a. Based layer name: browse > select P_RW_ProposedOK

 II. OK
 G. Alignment label set: dropdown > select _No Labels
 H. OK

 6. Alignment Layout Tools toolbar
 A. Select Alignment creation dropdown > Tangent-Tangent (No curves)
 B. Specify start point: Select Transparent command toolbar > Station Offset
 C. Select alignment: select centerline alignment STH64

 I. Selection dialog box: select Alignment
 D. Specify station along baseline: 26100Enter
 E. Specify station offset: 2. Use the nearest OSnap to snap to offset line north of 

STH64
 F. Specify station along baseline:26200Enter
 G. Specify station offset: -100Enter
 H. Specify station along baseline:26400Enter
 I. Specify station offset: -100Enter
 J. Esc to exit transparent command
 K. Esc to exit alignment command
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 7. Alignment Layout Tools toolbar
 A. Select Alignment creation dropdown > Tangent-Tangent (No curves)
 B. Specify start point: Select Transparent command toolbar > Station Offset
 C. Select alignment: select centerline alignment CTH T
 D. Specify station along baseline: 

 I. Turn on OSnaps; Object Snap settings in status bar, check boxes for endpoint and 
nearest, then OK.

 II. select endpoint from previous alignment
 E. Specify station offset: select same point again
 F. Specify station along baseline:10225Enter
 G. Specify station offset: use the nearest OSnap to snap to r/w line west of CTH T
 H. Esc to exit transparent command
 I. Esc to exit alignment command

Create proposed r/w boundary lines (cont.)

plat-creat-prop-row-04.mp4 5:51

Create proposed r/w alignment northeast

Tip: Every time you end the command, there is a chance the OSnaps need to be added again.  Turn 
on OSnaps; Object Snap settings in status bar, check boxes for endpoint and nearest, then OK.

 1. Ribbon > Home tab > Create Design panel > Alignment dropdown > select Alignment Creation 
Tools

 2. Create Alignment - Layout dialog box

 A. Name: type Proposed ROW LT Northeast

All other settings should carryover, exception for Alignment Layer.

 B. Alignment layer: Browse
 I. Object Layer dialog box 

 a. Based layer name: browse > select P_RW_ProposedOK
 C. OK

 3. Alignment Layout Tools toolbar
 A. Check OSnaps 

 I. Turn on OSnaps; Object Snap settings in status bar, check boxes for endpoint and 
nearest, then OK.

 B. Select Alignment creation dropdown > Tangent-Tangent (No curves)
 C. Specify start point: Select Transparent command toolbar > Station Offset
 D. Select alignment: select centerline alignment CTH T
 E. Specify station along baseline: 10225Enter
 F. Specify station offset: use the nearest OSnap to snap to offset line east of CTH T
 G. Specify station along baseline:10150Enter
 H. Specify station offset: 40Enter
 I. Esc to exit transparent command
 J. Esc to exit alignment command

 4. Alignment Layout Tools toolbar
 A. Check OSnaps 

 I. Turn on OSnaps; Object Snap settings in status bar, check boxes for endpoint and 
nearest, then OK.

 B. Select Alignment creation dropdown > Tangent-Tangent (No curves)
 C. Specify start point: Select Transparent command toolbar > Station Offset
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 D. Select alignment: select centerline alignment STH64
 E. Specify station along baseline: select endpoint from previous alignment
 F. Specify station offset: select same point again
 G. Specify station along baseline:26670Enter
 H. Specify station offset: use the nearest OSnap to snap to r/w line north of STH 64
 I. Esc to exit transparent command
 J. Esc to exit alignment command

Create proposed r/w alignment southeast

 5. Ribbon > Home tab > Create Design panel > Alignment dropdown > select Alignment Creation 
Tools

 6. Create Alignment - Layout dialog box
 A. Name: type Proposed ROW RT Southeast

 I. All other settings should carryover, exception for Alignment Layer.
 B. Alignment layer: Browse

 I. Object Layer dialog box
 II. Based layer name: browse > select P_RW_ProposedOK

 C. OK
 7. Alignment Layout Tools toolbar

 A. Check OSnaps 
 I. Turn on OSnaps; Object Snap settings in status bar, check boxes for endpoint and 

nearest, then OK.
 B. Select Alignment creation dropdown > Tangent-Tangent (No curves)
 C. Specify start point: Select Transparent command toolbar > Station Offset
 D. Select alignment: select centerline alignment STH64

 I. Selection dialog box: select Alignment
 E. Specify station along baseline: 26900Enter
 F. Specify station offset: use the nearest OSnap to snap to offset line south of 

STH64
 G. Specify station along baseline:26800Enter
 H. Specify station offset: 90Enter
 I. Specify station along baseline:26680Enter
 J. Specify station offset: 90Enter
 K. Esc to exit transparent command
 L. Esc to exit alignment command

 8. Alignment Layout Tools toolbar
 A. Check OSnaps 

 I. Turn on OSnaps; Object Snap settings in status bar, check boxes for endpoint and 
nearest, then OK.

 B. Select Alignment creation dropdown > Tangent-Tangent (No curves)
 C. Specify start point: Select Transparent command toolbar > Station Offset
 D. Select alignment: select centerline alignment CTH T
 E. Specify station along baseline: select endpoint from previous alignment
 F. Specify station offset: select same point again
 G. Specify station along baseline:9800Enter
 H. Specify station offset: use the nearest OSnap to snap to r/w line north of CTH T
 I. Esc to exit transparent command
 J. Esc to exit alignment command

Warning: Correction: "Create proposed r/w alignment southeast" was created in the wrong direction, 
against the flow of the alignment stationing.  Here's how to correct that:
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 9. Select the alignment
 10. Ribbon > Alignment ProposedROW RT Southwest tab > Modify panel dropdown > Reverse Dir-

ection
 11. Warning prompt > OK
 12. Save file

Create ultimate r/w
Last updated: 2021-06-28

Total video time: 6:28

plat-creat-ultmt-row-01.mp4 6:28

Exercise data: plat-creat-ultmt-row-data-begin-c3d20.zip

Creating ultimate r/w alignments

Turn on OSnaps

 1. Status bar > Object Snap settings menu > select Endpoint
 2. Make sure the OSNAPS are turned on.

Create ultimate r/w alignment southwest

 3. Ribbon > Home tab > Create Design panel > Alignment dropdown > Alignment Creation Tools
 4. Create Alignment - Layout dialog box

 A. Name: Ultimate ROW Southwest
 B. Type: Miscellaneous
 C. Site: None
 D. Alignment style: RW Ultimate
 E. Alignment layer: Browse

 I. Object Layer dialog box 
 a. Based layer name: Browse > select P_RW_UltimateOK

 II. OK
 F. Alignment label set: _No Labels
 G. OK

 5. Alignment Layout Tools toolbar
 A. Alignment command dropdown > select Tangent-Tangent (No Curves)
 B. Using the Endpoint OSnaps and selecting each point as described: Begin alignment at 

western most endpoint (SW) of the existing eastbound ROW boundary line. Next point will 
be at the first convergence of the western most endpoint of the proposed ROW line, con-
tinuing to each endpoint along the geometry until it converges with the proposed west side 
of the southbound ROW line. Last point will be at the southern most endpoint of this ROW 
line.

 C. Enter to end command
 6. Verify alignment appears in Miscellaneous Alignments

 A. Toolspace > Prospector tab > expand Alignments > expand Miscellaneous Alignments > 
Ultimate ROW Southwest

 7. X to close Alignment Layout Tools toolbar
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Create ultimate alignment r/w southeast

 8. Ribbon > Home tab > Create Design panel > Alignment dropdown > Alignment Creation Tools

 9. Create Alignment - Layout dialog box

All settings should be retained from previous setup except:

 A. Name: Ultimate ROW Southeast
 B. Alignment layer: Browse

 I. Object Layer dialog box 
 a. Based layer name: Browse > select P_RW_UltimateOK

 II. OK
 C. OK

 10. Alignment Layout Tools toolbar
 A. Select Alignment command dropdown > Tangent-Tangent (No Curves)
 B. Using the Endpoint OSnaps and selecting each point of Proposed SE alignment as 

described: Begin alignment at southern most endpoint (SE) of the existing northbound ROW 
boundary line. Next point will be at the first convergence of the proposed ROW line, con-
tinuing to each endpoint along the geometry until it converges with the south side of the pro-
posed eastbound ROW line. Last point will be at the eastern most endpoint of this ROW line.

Tip: Creating the ROW alignments in consistent direction can be beneficial if you 
need to use them as targets later in the design.

 C. Enter to end command
 11. Verify alignment appears in Miscellaneous Alignments

 A. Toolspace > Prospector tab > expand Alignments > expand Miscellaneous Alignments > 
Ultimate ROW Southeast

 12. X to close Alignment Layout Tools toolbar

Create ultimate r/w alignment northeast

 13. Ribbon > Home tab > Create Design panel > Alignment dropdown > Alignment Creation Tools
 14. Create Alignment - Layout dialog box

All settings should be retained from previous setup except:

 A. Name: Ultimate ROW Northeast
 B. Alignment layer: Browse

 I. Object Layer dialog box 
 a. Based layer name: Browse > select P_RW_UltimateOK

 II. OK
 C. OK

 15. Alignment Layout Tools toolbar
 A. Select Alignment command dropdown > Tangent-Tangent (No Curves)
 B. Using the Endpoint OSnaps and selecting each point of Proposed NE alignment as 

described: Begin alignment at eastern most endpoint (NE) of the existing westbound ROW 
boundary line. Next point will be at the first convergence of the proposed ROW boundary 
line, continuing to each endpoint along the geometry until it converges with the east side of 
the northbound ROW line. Last point will be at the northern most endpoint of this ROW line.

 C. Enter to end command
 16. Verify alignment appears in Miscellaneous Alignments

 A. Toolspace > Prospector tab > expand Alignments > expand Miscellaneous Alignments > 
Ultimate ROW Northeast
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 17. X to close Alignment Layout Tools toolbar

Create ultimate r/w alignment northwest

 18. Ribbon > Home tab > Create Design panel > Alignment dropdown > Alignment Creation Tools

 19. Create Alignment - Layout dialog box

All settings should be retained from previous setup except:

 A. Name: Ultimate ROW Northwest
 B. Alignment layer: Browse 

 I. Object layer dialog box 
 a. Base layer name: Browse > select P_RW_UltimateOK

 II. OK
 C. OK

 20. Alignment Layout Tools toolbar

 A. Select Alignment command dropdown > Tangent-Tangent (No Curves)
 B. Using the Endpoint OSnaps and selecting each point of Proposed NW alignment as 

described: Begin alignment at northern most endpoint (NW) of the existing southbound 
ROW boundary line. Next point will be at the first convergence of the proposed ROW bound-
ary line, continuing to each endpoint along the geometry until it converges with the north 
side of the westbound ROW line. Last point will be at the western most endpoint of this ROW 
line.

 C. Enter to end command
 21. Verify alignment appears in Miscellaneous Alignments

 A. Toolspace > Prospector tab > expand Alignments > expand Miscellaneous Alignments > 
Ultimate ROW Northeast

 22. X to close Alignment Layout Tools toolbar

Create TLE 1 alignment

 23. Ribbon > Home tab > Create Design panel > Alignment dropdown > Alignment Creation Tools

 24. Create Alignment - Layout dialog box

All settings should be retained from previous setup except:

 A. Name: TLE 1
 B. Type: Miscellaneous
 C. Site: None
 D. Alignment style: RW Temp Limited Easement
 E. Alignment layer: Browse

 I. Object layer dialog box 
 a. Base layer name: Browse > select P_RW_FeePatterns_TLEOK

 II. OK
 F. Alignment label set: _No Labels
 G. OK

 25. Alignment Layout Tools toolbar

 A. Select Alignment command dropdown > Tangent-Tangent (No Curves)
 B. Select Transparent command > Alignment Station Offset
 C. Select STH 64 alignment 

 I. Selection dialog box > select Alignment
 D. Specify station along baseline: 26250
 E. Specify station offset: 75
 F. Specify station along baseline: 26250
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 G. Specify station offset: 125
 H. Specify station along baseline: 26300
 I. Specify station offset: 125
 J. Specify station along baseline: 26300
 K. Specify station offset: 75
 L. Esc to exit transparent command

 M. Use OSnap and select beginning point (NW corner) to close

To clean up the ultimate r/w file

 26. Remove Xrefs
 A. Ribbon > Insert tab > Reference panel diagonal arrow

 I. Xref manager > File References 
 a. right-click 81100024-ERW > Detach
 b. right-click 81100024-ERW-SecLines > Detach

 27. Remove data shortcuts
 A. Toolspace > Prospector tab > expand Surfaces

 I. right-click RoadwayModel-Datum > Delete...
 II. Are you sure you want to delete 'RoadwayModel-Datum'? Yes

Save file

 28.  Application menu > Save As...
 A. Save Drawing As dialog box 
 B. Save in: Local drive:\WisDOT\Design\c3d\12345678\RW\DWG
 C. File name: 81100024-Ult-RW.dwg

Create takings parcels
Last updated: 2021-06-28

Total video time: 29:34

Create takings parcel with proposed r/w alignments

plat-creat-tkng-prcl-01.mp4 5:47

Exercise data: plat-creat-tkng-prcl-data-begin-c3d20.zip

Open drawing file and create data shortcuts (DREFs)

 1. Select Open Files... from main screen window
 2. Select File dialog box

 A. Select project folder 12345678 from Places List
 3. Look in: 12345678\RW\DWG 3. Select 81100024-PRW.dwg
 4. Open
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Set working folder

 5. Toolspace > Prospector tab > right-click Data Shortcuts > select Set Working Folder...
 6. Browse For Folder dialog box

 A. Local Drive:\WisDOT\Design\c3d

Info: Set the working folder 2 levels above your "_Shortcuts" folder location (which is 
in your project folder).

 B. OK

Set data shortcuts project folder

 7. Toolspace > Prospector tab > right-click Data Shortcuts > select Set Data Shortcuts Project 
Folder...

 8. Set Data Shortcut Folder dialog box
 A. Verify box is checked for project 12345678
 B. OK

Create data shortcuts

 9. Toolspace > Prospector tab > right-click Data Shortcuts > select Create Data Shortcuts...
 10. Create Data Shortcuts dialog box

 A. Expand Miscellaneous Alignments 
 I. Check boxes for: Proposed ROW LT Northeast, Proposed ROW LT Northwest, 

Proposed ROW RT Southeast, Proposed ROW RT Southwest.
 B. OK

 11. Toolspace > Prospector tab > Data Shortcuts > Alignments > Miscellaneous Alignments
 A. Verify alignments appear here; Proposed ROW LT Northeast, Proposed ROW LT North-

west, Proposed ROW RT Southeast, Proposed ROW RT Southwest.

Create a new takings drawing

 12. Select application menu (A in upper left corner) > New
 13. Select template dialog box

 A. Look in: Templates\Begin-dwg
 B. Select plat-start.dwt
 C. Open

 14. Select application command > Save As
 15. Save Draw As dialog box

 A. Select 12345678 folder in the Places List
 B. Save in: 12345678\RW\DWG
 C. File name: 81100024-Tkng-PRW
 D. Save

Create reference to data shortcuts

Proposed ROW alignments

 16. Toolspace > Prospector tab > Data Shortcuts > Alignments > Miscellaneous Alignments > right-
click Proposed ROW LT Northeast > select Create Reference...
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 17. Create Alignment Reference dialog box
 A. Alignment style: RW Proposed
 B. Alignment layer: Browse

 I. Object Layer dialog box 
 a. Based layer name: browse > select P_RW_ProposedOK

 II. OK
 C. Alignment label set: _No Labels
 D. OK

 18. Use Zoom Extents; double-click mouse wheel or Z+Enter and E+Enter
 19. Repeat steps 1-3 for each of the remaining miscellaneous alignments; Proposed ROW LT North-

west, Proposed ROW RT Southeast, Proposed ROW RT Southwest.
 20. Verify alignments are active in the drawing:

 A. Toolspace > Prospector tab > 81100024-Tkng-PRW > Alignments > Miscellaneous 
Alignments

 B. There will be a little "box with arrow" in front of the alignment name. This symbol means it is 
a data shortcut (DREF). Temporary Limited Easement (TLE) alignment

 21. Open Ultimate ROW drawing file
 A. Quick Access toolbar > Open command
 B. Select File dialog box 

 I. Look in: 12345678\RW\DWG
 II. Select 81100024-Ult-RW.dwg

 III. Open
 22. Toolspace > Prospector tab > right-click Data Shortcuts > select Create Data Shortcuts...

 A. Create Data Shortcuts dialog box 
 I. Expand Miscellaneous Alignments, checkmark TLE 1

 II. OK
 23. Toolspace > Prospector tab > Data Shortcuts > Alignments > Miscellaneous Alignments > right-

click TLE 1 > select Create Reference...
 A. Create Alignment Reference dialog box 

 I. Alignment style: RW Temp Limited Easement
 II. Alignment layer: Browse 

 a. Object Layer dialog box 
 i. Based layer name: browse > select P_RW_FeePatterns_TLEOK

 b. OK
 III. Alignment label set: _No Labels
 IV. OK

 B. Use Zoom Extents; double-click mouse wheel, or Z+Enter and E+Enter

Info: The above Proposed ROW... alignments could have been added from the 
Ultimate ROW drawing file, reducing the amount of steps performed.

XREF existing row (ERW) file

 24. Opening Xrefs Manager palette
 A. Insert tab > Reference panel > select diagonal arrow (in lower right corner of panel)
 B. XRef Manager palette 

 I. Select File Source dropdown > select Attach DWG...
 II. Select Reference File 

 a. Look in: DWG\81100024-ERW.dwg
 b. Open

 III. Attach External Reference dialog box 
 a. Name: 81100024-ERW
 b. Reference Type: Overlay

Page: 283

Published on: 5/1/2024

Create takings parcels



 c. Scale: X=1.00, Y=1.00, Z=1.00
 d. Path Type: Relative path
 e. Insertion Point: X=0.00, Y=0.00, Z=0.00
 f. Rotation Angle: 0

 g. OK
 IV. Close Xref Manager

Create takings parcel (part 1)

plat-creat-tkng-prcl-02.mp4 5:01

Alignment geometry cannot be used to create Civil 3D parcels. Parcels are a 3D object known as a feature 
line, a special kind of polyline. They are collected in Sites in the Prospector.

Create takings parcel with Parcel Creation Tools command

 1. Home tab > Create Design panel > Parcel dropdown > select Parcel Creation Tools
 2. Parcel Layout Tools toolbar

 A. Select first icon, Create Parcel
 B. Create Parcels - Layout dialog box 

 I. Site: select action button, to create new site 
 a. Site Properties - Site dialog box 

 i. Information tab 
 i. Name: TakingsParcels

 ii. Numbering tab 
 i. Parcel: Next Automatic Area Counter: 1001
 ii. Parcel: Next Manual Area Counter: 1

 iii. OK
 II. Parcel style: RW Property Existing

 III. Layers: No change, according to the template
 IV. Label Styles 

 a. Area label style: Parcel Number
 V. Uncheck Automatically add segment labels

 VI. OK
 C. Select OSnap settings > checkmarkEndpoint
 D. On toolbar, select Add Fixed Line by Two Points command.
 E. On drawing, southwest corner, start selecting alignment geometry by clicking the beginning 

and endpoint for each segment line individually. Finishing at the point of beginning point.
 F. ESC twice to end command

 3. Select area label > right-click menu > Properties...

Tip: Civil 3D area label appear too small in the AutoCAD drawing window, click the annota-
tion scale button (in status bar) and choose a scale that displays the at a  readable scale while 
you are designing. This does not affect label height when labels are printed. C3D Label 
Styles control printed label heights.

 A. Parcel Properties dialog box
 I. Information tab

 a. Object style: RW Property Fee S135'
 II. User Defined Properties tab

 a. Property Data 
 i. Owner ID Number: 2
 ii. Interest required: FEE & TLE
 iii. Owners Name: James A. and Arliss Cody Trust
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 b. General 
 i. Parcel Tax ID: 0

 c. Utility Data 
 i. Volume/Page/Document: No Easement Information Found

Info: This parcel's information came from ...\c3d\12345678\RW\Misc_
Info\TitleSearches\titles\Parcel 2-Cody Trust.pdf

 III. Composition tab
 a. Area Section label style dropdown > select Owner ID

 IV. OK

Tip: 
Ways to access parcel properties

2 Ways parcel area labels help to access the parcel properties or other editing commands:

 1. Select area label
 A. Right-click > select Parcel Properties... > Parcel Properties dialog box

 2. Select area label
 A. Parcel tab > Modify panel > select Parcel Properties > Parcel Properties dialog 

box

If you don't have an area label, you can still access the parcel properties through the Prospector:

 1. Toolspace > Prospector tab > Sites > TakingsParcels > Parcels > right-click parcel's 
name > select Properties... > Parcel Properties dialog box

Creating takings parcel

plat-creat-tkng-prcl-03.mp4 5:00

Continue with 81100024-Tkng-PRW.dwg from the previous exercise section, or download a completed-to-
this-point version of the 81100024-Tkng-PRW.dwg at the following link if you've gotten lost or would like to 
check your work:

Watch the beginning of the video for the Parcel 1 properties details that were filled, off camera.

Create boundary polylines (Parcel 3)

Create Parcels from Objects command requires creating a parcel from AutoCAD lines, arcs, or polylines. 
First create a 2D polyline using the Boundary Creation command before using Create Parcels from Objects 
command.

 1. Start Boundary Creation command
 A. Home tab > Draw panel > Hatch dropdown > select BoundaryOR Type in command line 

BPOLY or BO
 2. Boundary Creation dialog box

 A. Boundary retention
 I. Object type: Polyline

 B. Island detection unchecked

Tip: This is used to avoid drawing polylines over label and other object within the 
selected area.
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 C. Select Pick Points icon
 I. Select northeast and southeast parcel areas in which to create the boundary within.  

If areas look correct, hit Enter to accept and end command.

Tip: If the area(s) do not look correct, hit ESC to cancel the command and restart the 
command.

Create takings parcel with Create Parcel from Objects command

Northeast Parcel

 3. Home tab > Create Design panel > Parcel dropdown > Create Parcel from Objects
 A. Curser becomes a pick box. Select boundary polyline of northeast parcel. 

 I. Selection box 
 a. Select Polyline and Enter

 4. Create Parcels - From objects dialog box

Info: The difference between this dialog box and the Create Parcels - Layout dialog box is 
this dialog box has "Erase existing entities" option. Checking this box will erase the polyline 
used to create this parcel as the new parcel is created.

 A. Site: TakingsParcels
 B. Parcel style: RW Property Fee S90
 C. Layers: No change, according to the template
 D. Label Styles 

 I. Area label style: Parcel Number
 E. Check Erase existing entities
 F. OK

 5. Select area label

 6. Parcel tab > Modify panel > select Parcel Properties

 A. Parcel Properties dialog box 
 I. User Defined Properties tab 

 a. Property Data 
 i. Owner ID Number: 3

 II. Composition tab 
 a. Area Section label style dropdown > select Owner ID

 III. OK

Southeast Parcel

 7. Home tab > Create Design panel > Parcel dropdown > Create Parcel from Objects

 A. Curser becomes a pick box. Select boundary polyline of southeast parcel. 
 I. Selection box 

 a. Select Polyline and Enter
 8. Create Parcels - From objects dialog box

 A. Site: TakingsParcels
 B. Parcel style: RW Property Fee S90
 C. Layers: No change, according to the template
 D. Label Styles 

 I. Area label style: Parcel Number
 E. Check Erase existing entities
 F. OK

 9. Select area label
Page: 286

Published on: 5/1/2024

Create takings parcels



 10. Parcel tab > Modify panel > select Parcel Properties

 A. Parcel Properties dialog box 
 I. User Defined Properties tab 

 a. Property Data 
 i. Owner ID Number: 3

 II. Composition tab 
 a. Area Section label style dropdown > select Owner ID

 III. OK

TLE 1 parcel, creating boundary polylines and takings parcel

 11. Home tab > Draw panel > Hatch dropdown > select Boundary
 12. Boundary Creation dialog box

 A. select Pick Points icon 
 I. Select within the TLE 1 parcel

 II. Enter to accept
 13. Home tab > Create Design panel > Parcel dropdown > Create Parcel from Objects

 A. Cursor becomes a pick box. Select boundary polyline of TLE 1 parcel. 
 I. Selection box 

 a. Select Polyline and Enter
 14. Create Parcels - From objects dialog box

 A. Site: TakingsParcels
 B. Parcel style: RW TLE Proposed
 C. Layers: No change, according to the template
 D. Label Styles 

 I. Area label style: Parcel Number
 E. Check Erase existing entities
 F. OK

 15. Select area label
 16. Parcel tab > Modify panel > select Parcel Properties

 A. Parcel Properties dialog box 
 I. User Defined Properties tab 

 a. Property Data 
 i. Owner ID Number: 2

 II. Composition tab 
 a. Area Section label style dropdown > select Owner ID

 III. OK

Edit user defined parcel properties (this is not included in the video)

 17. Select parcel label > right-click menu > Parcel Properties
 B. On User Defined Properties tab, make sure parcel numbers start at 1001 and go to 1005 for 

the SW, NW, NE, SE, TLE parcels respectively.
 I. If they don't, go to Information tab, uncheck Use name template in parcel style 

check-box.
 II. Type proper parcel numbers into name value cell for each parcel respectively.

Tip: Parcel names initially come from the Parcel style applied when the parcel 
is first created. If you need to adjust the standard WisDOT numbering applied 
via these styles, go to the Numbering tab in the style and set the beginning 
number for your purposes.
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 C. Input utility easement data, and property data, like Owner ID Number, Owners Name, 
Volume/Page/Document, etc. from title docs/easement docs found in project folder under 
C:\WisDOT\Design\c3d\12345678\RW\Misc_Info\TitleSearches\titles (see videos).

 D. In this case, Owner ID Number should be set to 1 for NW parcel.
 E. Owner ID Number should be set to 2 for SW parcel and TLE 1 parcel.
 F. Owner ID Number should be set to 3 for NE and NW parcels.
 G. Click Apply if you'd like to observe changes onscreen before leaving Parcel Properties dia-

log box.
 H. Or click OK to apply changes and close Parcel Properties dialog box simultaneously.

 18. Save and Close file.

Creating parcel data table

plat-creat-tkng-prcl-04.mp4 6:06

To view and copy all user defined parcel properties

 1. Select Item Preview toggle, icon in upper left of Toolspace (square with magnifying glass). This will 
display item preview in bottom half of the Toolspace.

 2. Toolspace > Prospector tab > Sites > TakingsParcels > right-click Parcels > Properties...
 A. Site Parcel Properties dialog box 

 I. User defined property classification dropdown > All
 II. OK

 3. Toolspace > Prospector tab > Sites > TakingsParcels > right-click Parcels > Refresh
 4. Toolspace > Prospector tab > Sites > TakingsParcels > click on Parcels

With it highlighted, the Item Preview displays all of the user defined parcel data for each parcel.

 5. In Item Preview, Select all rows. Select top row, Hold Shift, then bottom row.  All rows should be 
highlighted.

 6. Right-click on selection for menu and Copy to clipboard.

Populate table in Excel

 7. In Excel, open Schedule of L&I Template.xslx

Info: You may need to find the location of this Excel spreadsheet if it is not in your project 
folder. (Local Disk:\WisDOT\Design\c3d\12345678\BaseData\Other)

 8. File > Save As

 A. Save in: Local Disk:...\WisDOT\Design\c3d\12345678\RW\Misc_Info\Reports
 B. File Name: 81100024-ParcelInfoTable
 C. Save as type: Excel Worksheet (.xlsx)

Info: A completed version of this Excel file already exists in the Reports folder.  You can over-
write it or give your file a unique name.

 9. Select a cell below the existing table, right-click for menu and paste.

 10. Using = sign in the existing spreadsheet, select corresponding data from the copied data table to 
populate the data.  Hit Enter after each selection.  Some columns may need = + formula (ex: Sq.Ft. to 
Acres).

Tip: Watch the video for a better visual explanation.
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Copy table from Excel and paste special into Civil 3D

 11. Highlight table cells to be displayed in Civil 3D drawing.
 12. Right-click on selection for menu and Copy
 13. Return to drawing in Civil 3D
 14. Home tab > Clipboard panel > Paste dropdown > Paste Special
 15. Paste Special dialog box

 A. Select Paste radio button
 B. OK

 16. Select desired location within Civil 3D drawing window to insert table.
 17. SCEnter, to launch AutoCAD Scale command.

 A. Select object: Select table
 B. Specify base point: Select bottom-left corner of inserted table
 C. Specify scale factor: 100Enter

Updating table

 18. Copy any revised data from the Item Preview
 19. Return to the Excel file and update the spreadsheet
 20. Select the updated table, right-click and copy to the clipboard
 21. Delete the old table from Civil 3D drawing
 22. Repeat the Paste Special process mentioned above

Creating r/w traverse alignment

plat-creat-tkng-prcl-05.mp4 7:39

Continue working with 81100024-Tkng-PRW.dwg

Data shortcut centerline alignments

 1. Toolspace > Prospector tab > Data Shortcuts > Alignments > Centerline Alignments > right-
click CTH T-PropsoedROWRefLine > Create Reference...

 A. Alignment style: RW Proposed
 B. Alignment label set: 1IN 100FT-Ticks 200' Major:100' Minor
 C. OK

 2. Toolspace > Prospector tab > Data Shortcuts > Alignments > Centerline Alignments > right-
click STH64-PropsoedROWRefLine > Create Reference...

 A. Alignment style: RW Proposed
 B. Alignment label set: 1IN 100FT-Ticks 200' Major:100' Minor
 C. OK

Create traverse alignment

 3. Home tab > Create Design panel > Alignments dropdown > select Alignment Creation Tools
 4. Create Alignment - Layout dialog box

 A. Name: ProposedROWTraverse
 B. Site: None
 C. Alignment style: RW Traverse
 D. Alignment layer: Browse

 I. Object Layer dialog box 
 a. Based layer name: Browse > select P_RW_TraverseOK

 II. OK
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 E. Alignment label set: select dropdown > _No Labels
 F. OK

 5. Alignment Layout Tools - ProposedROWTraverse toolbar
 A. Select Alignment creation dropdown > Tangent-Tangent (No curves)
 B. Use Endpoint OSnaps to snap to each vertex
 C. Start the traverse alignment at the horizontal PI 259+88.04 along the proposed STH64 align-

ment.
 D. Continue selecting each vertex along the outside edge of the takings parcels, in the direction 

you would like the stationing to follow.
 E. For the last station, left-click the point-of-beginning, PI 259+88.04.
 F. "X" to close Alignment Layout Tools toolbar

Create points for traverse alignment

 6. Home tab > Create Ground Data panel > Points dropdown > select Point Creation Tools
 7. Create Points toolbar

 A. Select chevron button, to expand toolbar
 B. Expand Points Creation

 I. Prompt For Elevations: None
 II. Prompt For Point Names: None

 III. Prompt For Description: None
 IV. Disable Description Keys: True
 V. Collapse Point Creation

 C. Expand Default Styles
 I. Point Style: WisDOT Standard with RW Marker

 II. Point Label Style: Browse > select PRW Pnt Number 070 90 degOK
 D. Expand Default Name Format

 I. Point Name Template: Browse 
 a. Name Template dialog box 

 i. Name: <[Next Counter(CP)]>
 ii. Number style: 1, 2, 3...
 iii. Starting number 1
 iv. Increment value: 1

 b. OK
 E. Expand Point Identity

 I. Next Point Number: 1
 F. Select chevron button, to collapse toolbar
 G. Select Create Misc Points dropdown (first icon) > Manual
 H. Using Endpoint OSnap, begin at the start point, PI 259+88.04, and select each vertex point 

along the traverse alignment clockwise. At the last point, just before the starting point, hit 
ESC to finish point creation command.

 I. Select starting point > right-click > Edit Label Text...
 J. Select a text component to edit: Select point label 

 I. Text Component Editor - Label Text dialog box 
 a. In label editor box, Change name to TRAV<[Point Number]>
 b. OK

 II. Observe label change, on screen, to starting point

Create points for TLE parcel

 8. Create Points toolbar 
 A. Select chevron button, to expand toolbar
 B. Expand Default Styles

 I. Point Label Style: Browse > select TLE Pnt Number 070 90 degOK
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 C. Select chevron button, to collapse toolbar
 D. Select Create Misc Points dropdown (first icon) > Manual
 E. Using Endpoint OSnap, begin at the start point, NW point, and select each vertex point 

along the TLE alignment counterclockwise. At the last point, Esc to finish point creation com-
mand.

 F. "X" to close Create Points toolbar

Zoom out to see your completed work so far and Save the drawing.

Create plat sheets
Last updated: 2021-06-29

Total video time: 15:41

Prepare sheet

plat-creat-sht-01.mp4 7:20

Exercise data: plat-creat-sht-data-begin-c3d20.zip

 1. Remove L&I table with Erase command
 A. Select table
 B. Home tab > Modify panel > Erase

 2. Data shortcut centerline alignments
 A. Verify working folder is in correct location. 

 I. Toolspace > Prospector tab > right-click Data Shortcuts > Set Working Folder...
 II. Browse For Folder dialog box 

 a. Browse to WisDOT\Design\c3d
 b. OK

 III. Toolspace > Prospector tab > right-click Data Shortcuts > Set Data Shortcuts 
Project Folder...

 IV. Set Data Shortcuts Folder dialog box 
 a. Check box next to current project number
 b. OK

 B. Toolspace > Prospector tab > expand Data Shortcuts > expand Alignments > expand 
Centerline Alignments > right-click CTH T-ExistROWRefLine > Create Reference...

 I. No changes and select OK
 C. Toolspace > Prospector tab > expand Data Shortcuts > expand Alignments > expand 

Centerline Alignments > right-click STH64-ExistROWRefLine > Create Reference...
 I. No changes and select OK

 3. Promote centerline alignments
 A. Toolspace > Prospctor tab > expand Alignments > expand Centerline Alignments > 

right-click CTH T-ExistROWRefLine > Promote
 B. Toolspace > Prospctor tab > expand Alignments > expand Centerline Alignments > 

right-click STH64-ExistROWRefLine > Promote
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Create view frames

 4. Setup View Boundary using output tools
 A. Output tab > Plan Production panel > launch Create View Frames command
 B. Create View Frames - Alignment wizard

 I. Alignment page
 a. Alignment: dropdown and select STH64-ProposedROWRefLine
 b. Station Range: Automatic
 c. Next

 II. Sheets page
 a. Sheet Setting: Plan(s) only
 b. Template for Plan sheet: Select ellipsis (...)

 i. Select Layout as Sheet Template dialog box
 i. Drawing template file name: Select ellipsis (...)

 i. Look in: WisDOT...\Templates\Sheets folder
 ii. Scroll and select 04-TPP34-wdot18.dwt

Tip: WisDOT plat sheets templates start with 
"04-TPP", then a measurement.  If there is a "R" 
next, that means the sheet was rotated 90 
degrees.

 iii. Open
 ii. Select a layout to create new sheets: select TPP 34 1 IN 200 

FT
 iii. OK

 c. View Frame Placement: select Along alignment
 d. Next

 III. View Frame Group page
 a. Name: add 0401 and remove brackets so it reads, VF - 0401<|Next Counter

(CP)|>
 b. Select Name Template icon 

 i. Incremental number format > Style: 1,2,3...
 ii. Starting number: 1
 iii. Incremental value: 1
 iv. OK

 c. Next
 IV. Match Lines page

 a. Uncheck Insert match line, since this is a single sheet
 V. Create View Frames

 VI. Zoom out
 VII. View frame should have label: VF - 04011, the last "1" is supplied by the counter in 

the name template.

Create plat sheets

plat-creat-sht-02.mp4 8:21
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 1. Output tab > Plan Production panel > Create Sheets command

 A. Create Sheets - View Frame Group and Layouts wizard
 I. View Frame Group and Layouts page

 a. View Frame Group: VFG - STH64-ProposedROWRefLine - (1)
 b. Layout Creation:

 i. Number of layouts per raw drawing: 1, since there is only a single 
sheet.

Tip: This number can be increased for larger plans set with 
more collaborators.

 c. Layout Name: add 0401 and remove brackets so it reads, 0401<|Next 
Counter(CP)|>

 i. Select Name Template icon
 ii. Incremental number format > Style: 01,02,03...
 iii. Starting number: 1
 iv. Incremental value: 1
 v. OK

 d. Choose the north arrow block to align in layouts: GN
 e. Next

 II. Sheets Set page

 a. Sheet Set
 i. Select Add to existing sheet set
 ii. Select ellipsis (...)
 iii. Browse the sheet set file dialog box 

 i. Look in: 12345678\SheetsPlan\planproduction.dst
 ii. Open

 b. Sheets
 i. Sheet files storage location: Select ellipsis (...)

 i. Browse for Folder
 i. Select Project folder 12345678\RW\DWG
 ii. Open

 ii. OK
 ii. Sheet file name: 12345678 - 0401<|next Counter|>-rp

Requirement: The naming convention is found at FDM15-5 
attachment 3.3

 i. Select Name Template icon
 ii. Incremental number format > Style: 01,02,03...
 iii. Starting number: 1
 iv. Incremental value: 1
 v. OK

 c. Next
 III. Data References page

 a. No changes
 IV. Create View Frames

Prompt: To complete this process your current drawing will be saved. OK

 B. Sheet Set Manager should be open automatically

Tip: If the Sheet Set Manager does not open, in the command line type "SSM."
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Printing plats

 2. From Sheet Set Manager
 A. Single plat sheet 

 I. right-click layout name, 1 - 040101 > Publish > Publish to PDF
 B. Several plat sheets 

 I. right-click subset heading > Publish > Publish to PDF

Info: If you have several subsets and plats sheets, right-click the sheet set name.  Sheets will publish 
in the same order as they are in the sheet set.

Go to "Plat sheet details" below  for instruction on finishing the plat sheet.

Plat sheet details
Last updated: 2021-06-29

Total video time: 1:26:32

Creating a plat sheet layout

plat-sht-dtl-01.mp4 5:36

Exercise data: plat-sht-dtl-data-begin-c3d20.zip

This is an alternative process to using the Plan Production tools.

Create a paperspace sheet

 1. WisDOT Sheets tab > select Palettes ON/OFF button to activate tool palette
 2. WisDOT Sheets tab > Sheet Creation panel > select ROW/Plat
 3. Tool Palette > Startup Main tab

 A. Scroll to Sheet Layout (TPP Layout 34")
 B. Select 04-TPP-34" Landscape 1=200 (04-TPP34-wdot18)

 4. Type NEW name for Layout: 040102Enter

Info: This was just an example of how to create.  Since we don't need it, right-click on the drawing tab 
(found in bottom left of screen) labeled "040102", and select delete. You will continue using layout 
040101.

Tip: You need to decide whether if it is better to put each sheet in its own file or create a separate lay-
out tab for each sheet within an overall sheets drawing or RP drawing file.

Editing plat sheet layout

Edit space for adding notes and legends

 5. Select drawing tab 12345678-040101-rp
 6. Single left-click on viewport border, grips will appear on each corner and midpoint.
 7. Select both, top and bottom, mid-grip points and adjust border to desired size, to the edge of the 

model.

Tip: To keep the viewport polylines strictly horizontal/vertical, select the Ortho setting in the 
status bar.
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 8. Double-click inside viewport to activate it.
 9. Select Viewport padlock in status bar to unlock it.  This allows you to move/pan the model.

 10. Select and drag model to the right, being careful not to touch the mouse wheel which changes the 
model's scale.

 11. Double-click outside viewport to deactivate it.
 12. Single left-click on viewport border.
 13. Select left mid-grip point and adjust to edge of the model.

Tip: If you roll the mouse and resized the model, to return it to the correct scale, select Scale 
dropdown in the status bar and select the scale to reset (1IN:200FT for this exercise)

Reading ROW lines

The XREF didn't bring the ROW lines into the current RP drawing because the information was attached as 
an overlay from the first drawing file to the second drawing file.  This then did not bring the information to the 
third drawing file. This needs to be corrected by using the Attach option instead.

 14. Select drawing tab 81100024-Tkng-PRW
 15. Launch Xref Manager

 A. Insert tab > Reference panel > launcher arrow in lower right corner
 B. Xref Manager 

 I. Select 81100024-ERW
 II. Details, change Type from Overlay to Attach

 16. X to close Xref Manager
 17. Select drawing tab 12345678-040101-rp
 18. Launch Xref Manager

 A. Insert tab > Reference panel > launcher arrow in lower right corner
 B. Xref Manager 

 I. Right-click 81100024-Tkng-PRW > Reload
 19. X to close Xref Manager

ROW lines should be in model.

Editing a plat sheet layout

plat-sht-dtl-02.mp4 6:22

Plat sheets, starting with a custom WisDOT sheet, have a deed recoding section and surveyor's inform-
ation section prebuilt into the layout.  These are required by statue and are placed in their mandated loc-
ations.  There are 2 versions of the surveyor's information box, depending on if WisDOT's surveyors did the 
work or an outside firm.

Adding notes and legends

 1. Open ROW/Plat tool palette.
 A. Home tab > Palettes panel > Select ROW/Plat tool palette

Tip: If the ROW/Plat palette is not available in the Palette panel, it can be added. WisDOT 
Sheets tab > Sheet Creation panel > select ROW/Plat

 2. ROW/Plat palette > Line & Symbols tab > TPP Title Sheet Block
 A. Select TPP Project Info, this is required by statue. Place on top of the sheet, if possible, 

next to the deeds recording section. Otherwise it can be placed where space is available.
 B. Select TPP Notes, describes the coordinate reference system. Place on left of Viewport.
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Tip: Some of these blocks have attributes that can be editted with custom inform-
ation. To edit the block definition, double-click on the block to open Block Editor; Edit 
Block Definition dialog box > OK. Edit as needed, then select Close Block Editor 
command in the ribbon > Save the changes...

 C. Select each of these legends and place them on the bottom of the sheet: TPP Conv Abbre-
viations, TPP Conv Symbols, TPP Conv Utility Symbols, and TPP Curve Data Abbre-
viation.

 D. Close ROW/Plat palette

Adding Tables

 3. SL&I table (Schedule of Land and Interest table)
 4. Utility Interests Required table, utilities within the project area.
 5. Sign Schedule table, any commercial advertising signs impacted by the project.

Location is Local Drive:\WisDOT\Design\c3d\12345678\RW\Misc_Info\Reports

The table are Excel templates and can be edited in Excel. To learn how to create and edit the tables, watch 
video plat-creat-tkng-prcl-04, Create Taking Parcels #4.

To add the tables to your sheet, follow this process or watch video @ 2:56.

 6. Select the applicable cells from the SL&I table of the spreadsheet
 A. Right-click for menu, select Copy

 7. Return to Civil3D.  Use special paste command.
 A. Home tab > Clipboard panel > Paste dropdown > Paste Special
 B. Paste Special dialog box > OK
 C. Select sheet for table to appear and rescale it (50%) to fit in upper left corner 

 I. Type SC
 II. Scale select objects: Select table

 III. Select Endpoint OSNAP, then select upper left corner of table.
 IV. Specify scale factor: type .5
 V. Type M

 VI. Select table and use Endpoint OSNAP to move to upper left corner.
 8. Repeat steps for Utility Interests Required and Sign Schedule tables.

Add north arrow block

 9. Home tab > Palettes panel > Select ROW/Plat tool palette
 10. ROW/Plat palette > Line & Symbols tab > Title Sheet Misc Blocks > North Arrow
 11. Add to top right corner of model area.

Add scale bar

Add property location map

 12. Select Model layout tab
 13. Open Xref Manager

 A. Insert tab > Reference panle > launcher arrow in lower right
 B. Attach dropdown > Attach DWG
 C. Select Reference File dialog box 

 I. Look in: 12345678\RW\Misc_Info\County_Info\STCROIX.dwg
 II. OK

 14. Select 040101 layout tab
 15. MV Enter

Page: 296

Published on: 5/1/2024

Plat sheet details



 16. Draw rectangle to place viewport
 17. Double-click inside the viewport
 18. Z Enter, E Enter

 19. Pan and Zoom to desired map location
 20. Open drawing scale

 A. Choose Custom...
 B. Edit Drawing Scales dialog box 

 I. Add
 II. Add Scale dialog box 

 a. Name appearing in scale list: type 1IN=10000FT
 b. Scale Properties > Draw Units: type 10000
 c. OK

 III. OK
 21. Open drawing scale

 A. Select 1IN=10000FT
 22. Adding MTEXT above map

 A. Annotate tab > Text panel > Multiline Text
 B. Draw rectangle above map
 C. Type LOCATION MAP NOT TO SCALE
 D. Center above map

 23. Adding project location in map
 A. Select Model layout tab
 B. Home tab > Draw panel > Rectangle tool
 C. Draw a rectangle over traverse alignment
 D. Select and drag rectangle to open space
 E. Home tab > Draw panel > Hatch dropdown > Hatch > Pattern panel > Solid
 F. Select inside rectangle
 G. Select hatched rectangle with a crossing window
 H. Drag over to map and place in location

 24. Select 040101 layout tab
 25. Add text and leader to project location

 A. WisDOT Sheets tab > WisDOT Annotation panel > Multileader
 B. Specify leader arrowhead location: Select project location in viewport
 C. Specify leader landing location: Select another point
 D. Type PROJECT LOCATION
 E. Move label to inside viewport 

 I. Select label and move using square grip

Editing a plat sheet layout

plat-sht-dtl-03.mp4 6:00

Prep before adding labels

 1. Select/Open 81100024-Tkng-PRW drawing file.

We'll begin adding additional labels to the model itself using the takings parcels drawing since that's 
the drawing containing the model which is XREFed into our sheet. Therefore, when we add addi-
tional labels and model elements to the takings parcels file and then save the file, the XREF of this 
file will be updated in our sheet file either automatically or when we reload it. To reload, in the com-
mandline type XR to open XREF Manager.  Right-click on the takings parcels file (81100024-Tkng-
PRW) and select Reload.
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 2. Go to status bar and verify you are using 1IN=200FT scale, otherwise use the dropdown arrow and 
select it.

As we move through the process of adding more labels in the model drawing it makes sense to 
mimic the 1IN=200FT environment we're using in our sheet viewport because otherwise our labels 
don't appear the same height and take up the same amount of space.

Adding labels

Adjusting the point labels that appeared when we created traverse points along the traverse alignment.

 3. Ribbon> Annotate tab > Add Labels dropdown > Alignment > select Add Alignment Labels
 4. Add Labels dialog box

 A. Feature: Alignment
 B. Label Type: select dropdown, Station Offset-Fixed Point
 C. Station offset label style: select dropdown, RW Sta Off 070 90 degrees
 D. Marker style: None

Tip: Doing this removes the overlay of alignment label markers over already existing 
point markers.

 E. Add

Info: Dialog box remains visible in case you need to return to it at any time.

 5. The curser becomes a select/pick box
 6. Select alignment: select centerline alignment STH64
 7. On the status bar, select OSnaps menu and check boxes Endpoint and Node
 8. Select point: select each point along the takings parcel and the label will appear.
 9. Esc to exit labeling command.

Rotate point and alignment station offset labels

Civil 3D doesn't allow rotating both labels at the same time, you need to do each individually.

 10. Start by rotating the point label, then rotate its associated station offset label.
 A. Select point label, hover over square grip, and select Rotate label from menu. You can 

either type in a degree measurement or rotate with the mouse to where you'd like it to be.
 B. Repeat above for station offset label.
 C. This proces scan be repeated if labels need to be adjusted again.

 11. If your alignment station offset labels are not plan readable, but the setting should always be set to 
plan readable.

 A. Select label > right-click menu > select Edit Label Style
 B. Station Offset Label Style dialog box 

 I. Select second dropdown and Edit Current Selection
 II. Label Style Composer dialog box 

 a. General tab > Plan Readablity > Plan readable set to True
 b. OK

Editing alignment segment labels

plat-sht-dtl-04.mp4 4:58
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Placing segment labels

 1. Annotate tab > Labels & Tables panel > Add Labels dropdown > Alignment > select Add Align-
ment Labels

 2. Add Labels dialog box
 A. Feature: Alignment
 B. Label type: dropdown, select Single Segment
 C. Line label style: dropdown, select RW Bearing over Dist 070
 D. Curve label style: _No Display
 E. Spiral label style: _No Display
 F. Add

Tip: Note: Dialog box remains visible in case you need to return to it at any time.

 3. The curser becomes a select/pick box
 4. Status bar > Selection Cycling is on.  With this on, if there are multiple objects overlapping the align-

ment you are selecting, a menu box will appear a list of objects. Select Alignment.
 5. Select traverse alignments along parcel. A label will appear on each line.
 6. Close Add Labels dialog box

Editing segment labels

 7. Moving the label
 A. Select label, using diamond-shaped grip, drag label to desired placement.

 8. Right-click menu options, select label and right-click
 A. Reverse Label, reverse the direction of the label.
 B. Flip Label, swaps label to the opposite side of the line.
 C. Label Properties, opens Properties palette, where you can change the styles.

Watch video @4:17 to the end to see final look of drawing.

Editing traverse segment label tags and tables

plat-sht-dtl-05.mp4 7:21

If the segment being labeled is shorter than the label itself or if other labels occupying the space where the 
segment label is needed, labels can be converted into tags that correlate with a table listing instead of using 
full labels. The TLE parcel is perfect for the example.

Confirm the direction of the alignments

Tip: When doing a drawing, alignments should always be drawn in a clockwise direction, to ensure 
the table appears in numeric order.

 1. Bring the TLE parcel to the front of the display order
 A. Select > right-click menu > Display Order > Bring to Front

 2. Hover over alignment for Tool Tips box to appear.  Look at Station location for each alignment. The 
TLE parcel was drawn in the wrong direction.

 3. Select TLE parcel
 4. Alignment TLE1 > Modify panel dropdown > Reverse Direction
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Info: The Reverse Direction command is only available for alignments that actually occupy 
the current drawing.  Therefore, the data shortcut for the miscellaneous TLE alignment was 
promoted into this file between videos.

 5. Reversing the alignment will remove all station equations, design speeds, superelevation data, 
dynamic offset, curb return alignments, and may adversely affect objects and data already created 
from the alignment.  Select OK.

 6. Esc to deselect TLE parcel
 7. Hover over alignment and check Station locations again.

Change alignment ordinate station

Since the north TLE segment line is already accounted for in the southern ROW traverse alignment, the 
beginning station of 0+00 needs to be changed to the upper right corner.

 8. Select alignment
 9. Alignment TLE1 tab > Modify panel > select Alignment Properties

 10. Alignment Properties dialog box
 A. Station Control tab 

 I. Reference point box 
 a. Right of the X & Y coordinates, select Pick Reference Point button

 II. Warning appears, select OK
 B. Dialog box temporarily disappears for you to select a new point
 C. Make sure OSNAPs is on, with Endpoint or Intersection selected
 D. Select top right corner of TLE alignment
 E. Return to dialog box and select OK

Create initial segment labels

 11. Ribbon> Annotate tab > Add Labels dropdown > Alignment > select Add Alignment Labels
 12. Add Labels dialog box

 A. Feature: Alignment
 B. Label type: dropdown, select Single Segment
 C. Line label style: dropdown, select RW Bearing over Dist 070
 D. Curve label style: _No Display
 E. Spiral label style: _No Display
 F. Add

Info: Dialog box remains visible in case you need to return to it at any time.

 13. The curser becomes a select/pick box
 14. Select eastern TLE alignment segment line. If there are multiple objects, select Alignment from 

Selection box.
 15. Continue selecting southern segment line and western segment line.
 16. Close Add Labels dialog box

Create table

 17. Annotate tab > Label & Tables panel > Add Tables dropdown > hover over Alignment > fly-out 
menu > select Add Line

 18. Table Creation dialog box
 A. Table style: Traverse Table 070
 B. Select button next to No tags selected

Page: 300

Published on: 5/1/2024

Plat sheet details



 19. Return to draw and select tags in the order they were created, clockwise direction.
 A. Create Table - Convert Child Styles dialog box 

 I. Select Convert all selected label styles to tag mode
 20. Table Creation dialog box

 A. Do not select any label styles, only want the 3 TLE segment labels selected.
 B. OK

 21. Table will be attached to cursor. Place to the right, outside the model area

Steps for creating section corner labels

plat-sht-dtl-06.mp4 8:32

 1. Open 12345678-040101-rp file
 2. Look at the current viewport and decide where you will place the section labels.

 A. We are doing 3 section corner labels; one in NW corner, one in NE corner, last one in SW 
corner.

XREF viewport into seclines drawing

We need to XREF the viewport into this file to see which actual section corner point objects we need for the 
section labels.

 3. Open 81100024-ERW-SecLines.dwg file
XREF

 4. Xref Manager dialog box 
 A. Select Attach dropdown > Attach DWG
 B. Select Reference dialog box 

 I. Look in: Local Disk:\WisDOT\Design\c3d\12345678\RW\DWG
 II. Select 81100024-Tkng-PRW.dwg

 III. Open
 C. Attach External Reference dialog box 

 I. Reference Type: Overlay
 II. Scale: X = 1.00, Y = 1.00, Z = 1.00

 III. Insertion point: X = 0.00, Y = 0.00, Z = 0.00
 IV. Path type: Relative path
 V. Rotation > Angle: 0

 VI. OK
 D. XREF files should appear under Reference Name column
 E. X to close dialog box

Adding section corner labels using left point

 5. Home tab > Palettes panel > Tool Palettes button
 6. Tool Palette > Section Corners tab > select Corner (1 Town & Range)
 7. Left-click on block section

 A. Right-click and change Scale to 100
 B. Left-click and drag to location

 8. Edit text attributes
 A. Double-click block
 B. Enhanced Attribute Editor dialog box 

 I. SEC-NW, Value: 27
 II. SEC-NE, Value: 26

 III. SEC-SW, Value: 34
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 IV. SEC-SE, Value: 35
 V. TOWN, Value: 31

 VI. RANGE, Value: 17
 VII. T-D, Value: N

 VIII. R-D, Value: W
 IX. select OK to accept changes

 9. Annotate tab > Add Labels dropdown > Notes
 10. Add Labels dialog box

 A. Note label style: dropdown, select N E

Info: This will pull the Northing-Easting value from what you select on-screen

 B. Select Add
 11. Select the center of the section corner point 3117266 using endpoint or node OSNAP
 12. Label is populated. Select it and use square grip to drag label and place below the section corner 

block.
 13. Remove leader line, select leader > right-click menu > select Toggle Leader
 14. Select label > right-click menu > select Edit Label Text...

 A. Text Component Editor - Label Text dialog box 
 I. In Preview window 

 a. Left-click to the left of the Northing information and hit ENTER. This will add a 
line above the Northing text.

 b. Left-click on this new line, type SEC 801 and hit ENTER
 c. On new line type RAILROAD SPIKE

 II. Select OK
 15. New data should be added to the label.  Select label and drag to move if needed.

Adding section corner labels using middle point

 16. Home tab > Palettes panel > Tool Palettes button
 17. Tool Palette > Section Corners tab > select Quarter (1 Town & Range NS)
 18. Left-click on block section

 A. Right-click and change Scale to 100
 B. Left-click and drag to location

 19. Edit text attributes
 A. Double-click block
 B. Enhanced Attribute Editor dialog box 

 I. SEC-N, Value: 26
 II. SEC-S, Value: 35

 III. TOWN, Value: 31
 IV. RANGE, Value: 17
 V. T-D, Value: N

 VI. R-D, Value: W
 VII. select OK to accept changes

 20. Annotate tab > Add Labels dropdown > Notes
 21. Add Labels dialog box

 A. Note label style: dropdown, select N E
 B. Add

 22. Select the center of the section corner point 3117267 using endpoint or node OSNAP
 23. Label is populated. Select it and use square grip to drag label and place below the section corner 

block.
 24. Remove leader line, select leader > right-click menu > select Toggle Leader
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 25. Select label > right-click menu > select Edit Label Text...
 A. Text Component Editor - Label Text dialog box 

 I. In Preview window 
 a. Left-click to the left of the Northing information and hit ENTER. This will add a 

line above the Northing text.
 b. Left-click on this new line, type SEC 800 and hit ENTER
 c. On new line type BRASS MONUMENT

 II. Select OK
 26. New data should be added to the label.  Select label and drag to move if needed.

Adding section corner labels using right point

 27. Home tab > Palettes panel > Tool Palettes button
 28. Tool Palette > Section Corners tab > select Corner (1 Town & Range)
 29. Left-click on block section

 A. Right-click and change Scale to 100
 B. Left-click and drag to location

 30. Edit text attributes
 A. Double-click block
 B. Enhanced Attribute Editor dialog box 

 I. SEC-NW, Value: 26
 II. SEC-NE, Value: 25

 III. SEC-SW, Value: 35
 IV. SEC-SE, Value: 36
 V. TOWN, Value: 31

 VI. RANGE, Value: 17
 VII. T-D, Value: N

 VIII. R-D, Value: W
 IX. select OK to accept changes

 31. Annotate tab > Add Labels dropdown > Notes
 32. Add Labels dialog box

 A. Note label style: dropdown, select N E
 B. Select Add

 33. Select the center of the section corner point 3117256 using endpoint or node OSNAP
 34. Label is populated. Select it and use square grip to drag label and place below the section corner 

block.
 35. Remove leader line, select leader > right-click menu > select Toggle Leader
 36. Select label > right-click menu > select Edit Label Text...

 A. Text Component Editor - Label Text dialog box 
 I. In Preview window 

 a. Left-click to the left of the Northing information and hit ENTER. This will add a 
line above the Northing text.

 b. Left-click on this new line, type SEC 805 and hit ENTER
 c. On new line type RAILROAD SPIKE

 II. Select OK
 37. New data should be added to the label.  Select label and drag to move if needed.

Adding bearing and distance labels along section lines

plat-sht-dtl-07.mp4 7:14

Page: 303

Published on: 5/1/2024

Plat sheet details

https://c3dkb.dot.wi.gov/video/prcl-plat/plat-sht-dtl-07.mp4


Westside bearing and distance label

 1. Annotate tab > Add Labels dropdown > hover over Line and Curve > fly-out menu > select Add 
Line and Curve Labels

 2. Add Labels dialog box
 A. Label type: Single Segment
 B. Line label style: dropdown, select Bearing

Tip: Bearing style was picked due to it only having one component to edit.

 C. Add
 3. Cursor becomes a pick box.
 4. Select point on entity: Staying to the west of the intersection, select the section line that 

runs down the middle of STH64 ROW.
 5. Esc to end labeling command
 6. Select label > right-click menu > Edit Label Text...
 7. Select a text component to edit: select the label
 8. Text Component Editor - Label Text dialog box

 A. In Preview window, select/highlight text
 B. Properties: Format, change to DD MM'SS.SS" (the format with no spaces)
 C. Select ARROW button to push changes into the highlighted text

Warning: If you don't not select the ARROW button the edits/changes will not take 
place.

 D. We need to add a second component. In Preview window, left-click at the end of the text line 
and add a SPACE

 E. Properties: dropdown, select General Segment Length
 F. Properties: Precision, change to 0.01
 G. Select ARROW button to push changes
 H. In Preview window, left-click at the beginning of all the text, and type SECTION LINE=

Warning: Make sure to add a SPACE at the end of what you are typing to separate it 
from the other component.

 I. OK to accept changes
 9. Label is populated.  Select label and use diamond grip to drag to desired placement.  If the label over-

strikes other annotations, it's okay for now and will be cleared up in future videos.

Eastside bearing and distance label

 10. Add Labels dialog box should still be open.  If not, go to Annotate tab > Add Labels dropdown > 
hover over Line and Curve > fly-out menu > select Add Line and Curve Labels

 11. Add Labels dialog box
 A. Label type: Single Segment
 B. Line label style: dropdown, select Bearing
 C. Add

 12. Cursor becomes a pick box.
 13. Select point on entity: Staying to the east of the intersection, select the section line that 

runs down the middle of STH64 ROW.
 14. Esc to end labeling command
 15. Select label > right-click menu > select Edit Label Text...
 16. Select a text component to edit: select the label
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 17. Text Component Editor - Label Text dialog box
 A. In Preview window, select/highlight text
 B. Properties: Format, change to DD MM'SS.SS" (the format with no spaces)
 C. Select ARROW button to push changes into the highlighted text
 D. We need to add a second component. In Preview window, left-click at the end of the text line 

and add a SPACE
 E. Properties: dropdown, select General Segment Length
 F. Properties: Precision, change to 0.01
 G. Select ARROW button to push changes
 H. In Preview window, left-click at the beginning of all the text, and type SECTION LINE=

Warning: Make sure to add a SPACE at the end of what you are typing to separate it 
from the other component.

 I. OK to accept changes
 18. Label is populated.  Select label and use diamond grip to drag to desired placement.

Adding section corner markers (watch video @4:44)

Since two of our section corner points are outside of the viewport, special labeling is needed for those.  
Stand-in marker will be needed for those.  The middle point is the only one we can see within our viewport.

Left side marker

 19. Change the current layer
 A. Home tab > Layers panel > Layer dropdown > select P_RW_SectionLine

 20. Open Tool Palette
 A. Home tab > Palettes panel > Tool Palettes button

 21. Open Block palette
 A. WisDOT Sheets tab > Standard Components panel > Components Palettes dropdown > 

Block Palette
 22. Return to Tool Palette > Plat Blocks tab > select Section Corner Monument
 23. Before you place the marker

 A. right-click to change the scale to 0.15, which is the same size as the traverse markers.
 B. Change OSNAP to Nearest

 24. Left-click on the section line, just to the east of the 16ths section line, to place marker.
 25. Add line break symbol with polyline command to the right of marker

 A. Home tab > Draw panel > Polyline command (upper right corner button)
 26. Using the polyline command again and setting OSNAP to Center, select the section corner marker 

and make a new leader to the section block containing the section annotations.

Right side marker

 27. Return to Tool Palette > Plat Blocks tab > select Section Corner Monument
 28. Before you place the marker

 A. right-click to change the scale to 0.15, which is the same size as the traverse markers.
 B. Change OSNAP to Nearest

 29. Left-click on the section line to place marker.
 30. Add line break symbol with polyline command to the left of marker

 A. Home tab > Draw panel > Polyline command (upper right corner button)
 31. Using the polyline command again and setting OSNAP to Center, select the section corner marker 

and make a new leader to the section block containing the section annotations.
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Middle marker

Since the middle marker is visible, a new polyline leader is the all that needs to be done.

 32. Using the polyline command again and setting OSNAP to Center, select the mid-point marker and 
make a new leader to the section block containing the section annotations.

Adding traverse tie-in label

plat-sht-dtl-08.mp4 5:16

On the west side of the traverse, we placed a stand-in section corner point to represent the actual section 
corner point that is outside of the view port. To get the bearing distance measurement, we will add a tem-
porary AutoCAD line from the actual section corner point to the starting point of the project traverse.

 1. Home tab > Draw panel > Line command dropdown > select Create Line
 2. Specify first point: Select actual section corner point, using Node or Endpoint OSNAP
 3. Specify next point: Select traverse start point
 4. Esc to end command
 5. Annotate tab > Add Labels dropdown > Line and Curve menu > select Add Line and Curve 

Labels
 6. Add Labels dialog box

 A. Label type: Single Segment
 B. Line label style: dropdown, select Bearing
 C. Add

 7. Select point on entity: Select Line
 8. Selection dialog box > Line
 9. Select bearing label > right-click menu > Flip Label

The label appears on the bottom side of line

 10. Select bearing label > right-click menu > Edit Label Text...
 11. Select a text component to edit: select bearing label
 12. Text Component Editor - Label Text dialog box

 A. In Preview window, select/highlight text
 B. Properties: Format, change Value to DD MM'SS.SS" (the format with no spaces)
 C. Select ARROW button to push changes into the highlighted text

Warning: If you don't not select the ARROW button the edits/changes will not take 
place.

 D. We need to add a second component. In Preview window, left-click at the end of the text line 
and add a SPACE

 E. Properties: dropdown, select General Segment Length
 F. Properties: Precision, change to 0.01
 G. Select ARROW button to push changes
 H. OK to accept changes

 13. Next, draw a polyline which will connect the bearing/distance label to the two points.
 A. Home tab > Draw panel > Polyline command
 B. Specify start point: select stand-in section corner point and drop down below line 

break symbol.
 C. Specify next point: continue polyline below the labels, parallel to segment line.
 D. Specify next point: continue polyline up to traverse starting point.
 E. Esc to end command

 14. Explode bearing label

This is only to connect the bearing label to the polyline/leader just created.
Page: 306

Published on: 5/1/2024

Plat sheet details

https://c3dkb.dot.wi.gov/video/prcl-plat/plat-sht-dtl-08.mp4


 A. Select bearing label
 B. Type X and select X (EXPLODE)

 15. Select the original AutoCAD line and delete it.  It is no longer needed.
 16. Use AutoCad Break command to create space in the polyline for the bearing label

 A. Home tab > Modify panel dropdown > Break command
 B. Select object: Select polyline where you would like to start the break, using the bearing 

label for guidance.
 C. Specify second break point: Again using bearing label, select end of break.

 17. Select bearing label > right-click menu > Basic Modify Tools > Move
 A. Place bearing label inside the gap of the polyline
 B. Esc to end command

Adjust section labels size to fit into the viewport

 18. Double-click on section label
 19. Text Editor tab > Style panel > expand > select 140

This represents Modelspace text type

 20. Multiline Text - Text Style Change prompt box > select Yes
 21. Use grip edits to resize and move

Repeat for each section label, 4 in all.

Final Steps

We are done adding and editing section information labels.

Before leaving file, detaching the Takings Parcel file, which was used as an overlay.

 22. XREF

 23. Xref Manager Palette
 A. Select 81100024-Tkng-PRW > right-click menu > Detach
 B. X to close

Now SAVE the SecLines file.

Label clean up and r/w labels

plat-sht-dtl-09.mp4 4:41

Insert SecLine drawing file

 1. Open Xref Manager
 A. Home tab > Reference panel > launcher arrow
 B. Attach dropdown > Attach DWG
 C. Select Reference File dialog box 

 I. Look in: DWG folder
 II. Select 81100024-ERW-SecLines.dwg

 III. Open
 D. Attach External Reference dialog box 

 I. Reference Type: Attachment
 II. Scale: X = 1.00, Y = 1.00, Z = 1.00

 III. Insertion point: X = 0.00, Y = 0.00, Z = 0.00
 IV. Path type: Relative path
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 V. Rotation > Angle: 0
 VI. OK

Clean up of label overstrikes

 2. Move alignment geometry labels

Tip: When selecting a label, if you notice other labels highlighting this means they are 
grouped together. To select an individual label, press CTRL key while selecting.

 A. Rotate label to read at 0 degrees/horizontal.

If you have a group of labels selected, these changes will affect all of them. If you select a 
single label, with the CTRL key, the changes will only affect the one label.

 I. Select label group > right-click menu > Properties...
 II. Properties palette > Design tab > Labeling > Geometry Point Label Style drop-

down > select WisDOT Standard 0 Rotation
 B. Select square grip of label and move to new placement.

 3. Deleting a single label
 A. Alignment station 268 label overstrikes the label created to annotate the section line text 

coming from the SecLine's XREF.
 B. CTRL + select station label > DELETE key

 4. Adjust any non-alignment labels
 A. Rotating a traverse label and off-set label 

 I. Select label, right-click square grip for menu and select Rotate Label
 II. Adjust label

 B. Move a traverse label 
 I. Select label, using square grip, move

 C. Move parcel labels out with leader line 
 I. Select label, using square grip, move

 5. Move TLE parcel table
 A. Select table, using square grip, move to location within the Viewport.

Add bearing labels for CTH T, along northern and southern ROW centerlines

 6. Annotate tab > Add Labels dropdown > hover over Line and Curve > fly-out menu > select Add 
Line and Curve Labels

 7. Add Labels dialog box
 A. Label type: Single Segment
 B. Line label style: dropdown, select Bearing
 C. Add

 8. Cursor becomes a pick box.
 9. Select point on entity: North of the intersection, select the section line that runs down the 

middle of CTH T ROW.

Info: If there are multiple objects, you will get a menu.  Select Alignment from menu.

 10. Esc to end labeling command
 11. Select label, using the diamond grip, and move where label is visible
 12. Annotate tab > Add Labels dropdown > hover over Line and Curve > fly-out menu > select Add 

Line and Curve Labels
 13. Add Labels dialog box

 A. Label type: Single Segment
 B. Line label style: dropdown, select Bearing
 C. Add
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 14. Cursor becomes a pick box.
 15. Select point on entity: South of the intersection, select the section line that runs down the 

middle of CTH T ROW.
 16. Esc to end labeling command
 17. Select label, using the diamond grip, and move where label is visible

Adding ROW dimensions

plat-sht-dtl-10.mp4 5:00

 1. Change layer
 A. Home tab > Layers panel > Layer Manager dropdown > select P_RW_Text

 2. Annotate tab > Dimensions panel > Dimension Styles dropdown > select 070-LANE & SHLD

If you don't see any styles, to populate them in, go to WisDOT Sheets > Standards Components 
panel > Add All Components button.

 3. Annotate tab > Dimensions panel > Dimension Styles dropdown > select Linear Dimension com-
mand

 4. Specify first extension line origin: Placement will be west of intersection, northside 
of alignment between stations 262 & 264.

 A. Hold SHIFT + right-click for OSNAP menu and select Nearest
 B. Snap to the alignment
 C. Hold SHIFT and right-click for OSNAP menu and select Perpendicular
 D. Snap to North RW line

 5. Edit dimension
 A. Select object > right-click menu > Properties...
 B. Properties palette > Design tab > Lines and Arrows 

 I. Dim Line 1 dropdown > Off
 II. Dim Line 2 dropdown > Off

 6. Repeat step 4 for each dimension, place on each side of each ROW.

Add curve label for STH64

 7. Annotate tab > Label & Tables panel > Add Labels dropdown > hover over Alignment > fly-out 
menu > Add Alignment Labels

 8. Add Labels dialog box
 A. Label type: Single Segment
 B. Line label style: PI XY ^ D T L R PC XY PT XY DB DA
 C. Add

 9. Select point on entity: Select STH 64 alignment
 10. Label will populate
 11. Select label, using the square grip. move out into a space near the TLE parcel segment table.

CORRECTION: Traverse point labels

In video plat-sht-dtl-03, all of the traverse point labels were placed in association with STH 64, but 4 points 
need to be associated with CTH T; PRW5, PRW6, PRW12, and PRW13.

 12. The point labels are correctly label, only the station off-set labels need to change.
 A. CTRL + select each station offset label for each point
 B. Delete 

 13. Annotate tab > Add Labels dropdown > hover over Alignment > fly-out menu > select Add Align-
ment Labels
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 14. Add Labels dialog box
 A. Label type: Station Offset - Fixed Point
 B. Station offset label style: RW Sta Off 070 90
 C. Add

 15. Select alignment: Select CTH T alignment
 16. SHIFT + right-click to open OSNAP menu and select Endpoint
 17. Select point: Select point marker for PRW5
 18. Label populates
 19. Select station offset label > hover over the square grip > select Rotate Label from menu
 20. Align label with corresponding point label leader line.
 21. Repeat steps 5 - 9 for points PRW6, PRW12, & PRW13.

Adding adjacent parcels information

plat-sht-dtl-11.mp4 6:48

Adding additional property line information to display the location of any parcels not involved in the takings 
directly, but that might need to be included because they're located directly adjacent to the project.

 1. Import as a block, to utilize the Civil3D labels in this drawing
 A. Command line: type I for Insert
 B. Insert dialog box 

 I. Browse 
 a. Select Drawing File dialog box 

 i. Look in DWG folder (Local 
drive:\WisDOT\Design\c3d\12345678\RW\DWG)

 ii. Select 81100024-ERW-Parcels.dwg
 iii. Open

 II. Insertion point: X = 0.00, Y = 0.00, Z = 0.00
 III. Scale: X = 1.00, Y = 1.00, Z = 1.00
 IV. Rotation > Angle: 0
 V. Check box Explode

 VI. OK
 2. Exploded geometry appears
 3. Some of the needed property lines overlap the TLE Parcel Segment Table. Move the table NW of 

intersection.
 4. Change Layer

 A. Home tab > Layers panel > Layer Manager dropdown > select P_RW_PropertyLine
 5. Use polyline command

 A. Home tab > Draw panel > Polyline command
 6. Set OSNAP to Endpoint
 7. Trace the property lines, west of TLE parcel, that come off the intersection and aren't part of the ori-

ginal parcel drawing.
 8. Where necessary, flip labels

 A. Select label > right-click menu > Flip Label
 9. Other edits include

 A. Move label, use diamond grip to slide labels and make visible
 B. Delete label, select label and DELETE
 C. Edit label 

 I. Select label > right-click menu > Edit Label Text
 II. Add text to preview window

 III. OK
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Hide unnecessary visible property lines

 10. Toolspace > Prospector tab > expand Sites > expand Existing Parcels
 A. If there isn't an Existing Parcels, right-click on Sites and select Refresh

 11. Verify these are the newly inserted parcels
 A. Expand Parcels, to see all parcels
 B. Right-click on one of the parcels and select Select, to verify this isn't one of the original tak-

ings parcels.
 12. Add new parcel style to hide parcels instead of displaying them

 A. Right-click on Parcels > select Properties...
 B. Site Parcel Properties dialog box

 I. Composition tab > Site parcel dropdown > select _No Display

 II. Apply

Make sure new style appears on top of list in Parcel style display order preview

 III. OK
 13. Return Toolspace...Parcels > right-click 1001 > select Properties...

 A. Parcel Properties - 1001 dialog box 
 I. Information tab > Object Style dropdown > select _No Display

 II. OK
 14. Repeat step 4 for each parcel; 1002, 1003, & 1004.

Adding existing topography and labels (part 1)

plat-sht-dtl-12.mp4 6:20

Xref topo drawing

 1. Use Load Xref on Layer command

 A. For Civil3D 2018: WisDOT Sheets tab > Manage panal > Xrefs dropdown > Load Xref on 
Layer

On later version: WisDOT Sheets tab > Manage panal > Load Xref on Layer

 2. Select a File to Xref dialog box

 A. Look in: Local drive: WisDOT\Design\c3d\21345678\RW\Misc_Info\TOPO
If the file is not there, check here: Local drive: WisDOT\Design\c3d\21345678\BaseData\Other

 A. select Topo-Ex.dwg
 B. Open

Xref opens on it's own layer.  If you hover over the layer, it is labeled Xref-Topo-Ex.

In the command line, you can type XLIST, select and object and it will tell you the layer it is on.

Editing power poles

 3. WisDOT Sheets tab > Standard Components panel > Component Palettes dropdown > Block 
Palette

 4. Change layer
 A. Home tab > Layers panel > Layers Manager dropdown > select E_UTL_EGuyPole

 5. Block Palette > Topo Symbol Blocks tab > scroll to Lighting/Poles > select Power Pole
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 6. Change scale
 A. Right-click menu > Scale > type .25

 7. Change OSNAP
 A. Status bar > OSNAP menu > select Center

 8. Select power pole
 9. Home tab > Modify panel > Copy

 10. Select pole again and, with Center OSNAP, continue selecting all power poles within Viewport.
 11. Esc to end command

Editing utility pedestal

 12. WisDOT Sheets tab > Standard Components panel > Component Palettes dropdown > Block 
Palette

 13. Change layer
 A. Home tab > Layers panel > Layers Manager dropdown > select E_UTL_AG

 14. Block Palette > Topo Symbol Blocks tab > scroll to Utilities > select Utility Pedestal
 15. Change scale

 A. Right-click menu > Scale > type .5
 16. Change OSNAP

 A. Status bar > OSNAP menu > select Geometric Center
 17. Select utility pedestal, in center of polygon
 18. Home tab > Modify panel > Copy
 19. Select pedestal again and continue selecting all power poles within Viewport.
 20. Esc to end command

Adding existing topography and labels (part 2)

plat-sht-dtl-13.mp4 4:47

Filter out unnecessary layers

 1. LA

 2. Layers Properties Manager palette
 A. Filters 

 I. Scroll to Xref > expand Xref > select Topo-Ex
 B. In the list, select all of the layers by selecting the first layer and SHIFT + selecting last layer.
 C. Click on lightbulb so all layers are deselected.
 D. Select lightbulbs for: Topo-Ex|E_UTL_EPowerPole, Topo-Ex|E_UTL_AG, Topo-Ex|E_

SGN, Topo-Ex|E_RDWY_Name, and Topo-Ex|E_BLD
 E. X to close

Replicate buildings

 3. Change layer
 A. Home tab > Layers panel > Layers Manager dropdown > select E_BLD

 4. NCOPY

 5. Select nested objects to copy: Select all buildings
 6. ENTER  to finish selection
 7. Specify base point: Select one of the buildings, drag slightly away but return back to same 

position.
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Replicate signs

Continuing on the BLD Layer and will change that later.  There is a sign, NW of intersection, with 3 parts.  We 
will copy all 3 parts using NCOPY.

 8. NCOPY

 9. Select nested objects to copy: Select the word SIGN and two lines
 10. ENTER to finish selection
 11. SHIFT + right-click to select Endpoint OSNAP
 12. Select an endpoint, drag objects
 13. Drag objects back to original location
 14. Select object again
 15. Change layer

 A. Home tab > Layers panel > Layers Manager dropdown > select E_BLD

Replicate road names

Continuing on the BLD Layer and will change that later.  There are road names STH 64 and CTH T that 
need to be added to our drawing.

 16. NCOPY

 17. Select nested objects to copy: Select STH 64 on west side of intersection
 18. ENTER to finish selection
 19. SHIFT + right-click to select Endpoint OSNAP
 20. Select an endpoint, drag objects
 21. SHIFT + right-click to select Endpoint OSNAP
 22. Drag objects back to original location
 23. Select object again
 24. Change layer

 A. Home tab > Layers panel > Layers Manager dropdown > select P_RW_Text
 25. Repeat for other road names; STH64 and CTH T.
 26. CTH T needs to be labeled north of the intersection.

 A. CO

 B. Select object and select a base point
 C. Drag to location

Delete Xref

 27. XREF

 28. Xref Manager palette
 A. Select Topo-Ex - right-click menu - Detach

Add addition utilities, clean-up, and review

plat-sht-dtl-14.mp4 7:30

Xref utilities drawing

 1. Use Load Xref on Layer command
 A. WisDOT Sheets tab > Manage panal > Load Xref on Layer

 2. Select a File to Xref dialog box
 A. Look in: Local drive: WisDOT\Design\c3d\21345678\BaseData\Other
 B. select CTHT-UTILS.dwg
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 C. Open
 3. This drawing needs to be attached to both RP plan sheet and takings parcel design file.

 A. XREF

 B. Xref Manager palette 
 I. Select CTHT-UTILS

 II. Details > Type > change to Attach
 III. X to close

Add gas, phone, and sign labels

 4. On RP plan sheet, find tables containing utilities and sign numbers
 A. Gas lines: 10
 B. Phone lines: 20
 C. Sign: 2-1

 5. Return to takings parcel design sheet

Gas Label

 6. Annotate tab > Labels & Tables panel > Add Labels dropdown > Notes
 7. Add Labels dialog box

 A. Note label style: select Utility Parcel Label
 B. Marker style: none
 C. Add

 8. Pick label location: Select location to place label, double bubble with XX inside
 9. Label and leader edits

 A. Move label 
 I. Select label and, using square grip, drag to new location.

 B. Remove leader tail 
 I. Select label > right-click menu > Label Properties...

 II. Properties palette > Annotation > Leader Tail Visibility dropdown > select Always 
Hide

 C. Remove leader line within bubble 
 I. Select leader and, using diamond grip, drag to outer edge of bubble.

 D. Drag arrow, using square grip to point to gas line
 E. Change text in bubble 

 I. Select label > right-click menu > Edit Label Text...
 II. Text Component Editor dialog box 

 a. In preview window, highlight XX and type 10
 b. OK

Phone line label

 10. Annotate tab > Labels & Tables panel > Add Labels dropdown > Notes
 11. Add Labels dialog box

 A. Note label style: select Utility Parcel Label
 B. Marker style: none
 C. Add

 12. Pick label location: Select location to place label, double bubble with XX inside
 13. Label and leader edits

 A. Move label 
 I. Select label and, using square grip, drag to new location.

 B. Remove leader tail 
 I. Select label > right-click menu > Label Properties...

 II. Properties palette > Annotation > Leader Tail Visibility dropdown > select Always 
Hide
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 C. Remove leader line within bubble 
 I. Select leader and, using diamond grip, drag to outer edge of bubble.

 D. Drag arrow, using square grip to point to phone line
 E. Change text in bubble 

 I. Select label > right-click menu > Edit Label Text...
 II. Text Component Editor dialog box 

 a. In preview window, highlight XX and type 20
 b. OK

Sign label

 14. WisDOT Sheets tab > WisDOT Annotation panel > Multileader Style dropdown > select 070-
HEX TAG

 15. WisDOT Sheets tab > WisDOT Annotation panel > Multileader button
 16. Specify leader arrowhead location: Select place on drawing
 17. Specify leader landing location: Select next point
 18. Edit Attributes dialog box

 A. Edit tag number: 2-1
 B. OK

Corrections

Look over and make adjustments for any overlays.

Northing-Easting label is outside of viewport

 19. XR

 20. Right-click 81100024-ERW-SecLines > Open
 21. Select northing-easting label and move to the right, using square grip.
 22. On 81100024-ERW-SecLines tab, select X to close, Yes save changes
 23. Return to 81100024-Tkng_PRW
 24. XR

 25. Right-click 81100024-ERW-SecLines > Reload
 26. Correction should appear

Make project location label in location map viewport readable

 27. Double-click label
 28. MTEXT Editor

 A. Ribbon > Style panel > Mask 
 B. Background Mask dialog box 

 I. Use background mask: checked
 II. Use drawing background color: checked

 III. Border offset factor: 1.5
 IV. OK

 29. Select outside the box to close MTEXT Editor.

Adjust the model viewport

 30. Left-click westside viewport border
 31. Select mid-grip and drag east to 16th line.
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Edit TPP Info block

 32. Double-click block
 33. Enhanced Attributes Editor dialog box
 34. Update highway name and county information

Preview before printing plot

 35. Quick Access toolbar > Printer icon
 36. Plot dialog box

 A. Preview button in lower left corner

Import survey data

plat-imprt-srvy-data-01.mp4 6:06

Exercise data: plat-imprt-srvy-data-begin-c3d20.zip

Creating base data file from points

Open and save new file

 1. Civil 3D Start screen > Start Drawing: Templates dropdown
 A. Scroll and select plat-start.dwt

 2. Application menu > Save As
 A. Save Drawing As dialog box 

 I. Save in: Local drive:\WisDOT\Design\c3d\12345678\BaseData\Survey
 II. File name: Section Information.dwg

Insert survey points

Tip: Civil 3D can import file types; such as, .csv, .txt, .rtf, among others.

 3. Ribbon > Insert tab > Import panel > select Points from File
 A. Import Points dialog box

 I. Selected Files: select Add files icon
 a. Select Source File dialog box

 i. Change File of type: All Files
 ii. Look in: ...12345678\BaseData\Survey
 iii. Select file StCr Co Section Corners.csv (Excel file)
 iv. Open

 II. Specify point file format:
 a. Select Toggle filtering icon
 b. Scroll and select PNEZD (comma defined)

 III. Preview: Will display a sample based on format selections above.
 IV. Check box Add Points to Point Group.
 V. Next to Point Group dropdown, select Create Group icon

 a. Point File Formats - Create Group dialog box 
 i. Type StCr Co Section Corners
 ii. OK

 b. Dropdown displays new Point Group name
 VI. No Advanced options

 VII. OK
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 B. Prompt: Duplicate Point Number dialog box
 I. Duplicate point number resolution 

 a. Resolution dropdown > select Overwrite
 II. OK

 C. If points don't display, perform Zoom Extents (double-click mouse wheel or Z+Enter 
E+Enter)

 D. Save file before continuing (Qsave, quick access bar and save)
 E. Use the Line Creation command to create section lines from the section corner points. (done 

off camera)
 F. Once finished, save file

 I. Application menu > Save As
 a. Save Drawing As dialog box 

 i. Save in: Local drive:\WisDOT\Design\c3d\12345678\RW\DWG
 ii. File name: 81100024-ERW-SecLines

Exercise data: plat-sht-complete-data-end-c3d20.zip

Plan production

Plan production basics

Datasets for live training

 l trn-pln-prod-bscs-c3d22-begin.zip
 l trn-pln-prod-bscs-c3d22-end.zip

Sheet sets

Last updated: 2020-10-26

Total video time: 11:19

Create new sheet set #create

pln-prod-basc-sht-set-01.mp4 3:08

Exercise data: plan-prod-basc-sht-set-data-c3d18.zip

SSM Enter  or Home tab > Palettes > Sheet Set Manager

 1. New Sheet Set
 A. Begin

 I. An example sheet set: checked Next
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 B. Sheet Set Example
 I. Select a sheet set to use as an example: checked

 II. ProjectSheetData18This SheetSet contains custom fields that populate the 
WisDOT sheet border blocks.

 III. Next
 C. Sheet Set Details

 I. Name of new sheet set: 11701970
 II. Store sheet set data file (.dst) here: <ProjectID>\SheetsPlan Open

 III. Create a folder hierarchy based on subsets: checked
 IV. Sheet Set Properties

 a. County: VILAS AND ONEIDA
 b. Highway: US51
 c. Project No: 1170-19-70

 d. OK

 V. 

Next

 D. Confirm
 I. Finish

 2. Right-click project number > Close Sheet Set
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Close Sheet Set Manager

Open existing sheet set

pln-prod-basc-sht-set-02.mp4 1:13

SSM Enter

 1. Open...

 A. <ProjectID >\SheetsPlan\11701970.dst Open
 2. Also available in Sheet Set Manager > Recent

Add sheets to sheet set manually #add

pln-prod-basc-sht-set-03.mp4 4:12

With Sheet Set open in Sheet Set Manager

Add a subset

 1. Select a subset > Right-click > New Subset...

 A. Subset Name: TYPICAL SECTIONS This populates the sheet title in layouts.
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 2. Click subset > Right-click > Import Layout as Sheet...

 A. Browse for Drawings...
 I. <ProjectID>\SheetsPlan Open

 B. Uncheck unwanted layouts. Layouts can only be in one SheetSet at a time. Layouts that all 
ready exist in another Sheet Set will not be available for import.

 C. Prefix sheet titles with file name: unchecked
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 D. Import Checked

 3. Double-click new sheet in Sheet Set Manager to open file and layout
 4. Adds or edits to fields in layouts will not update immediately. REAEnter to refresh all layouts and see 

edits.

Redefine broken sheet border fields
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pln-prod-basc-sht-set-04.mp4 2:44

Use this process when fields in the sheet border are not updating or are broken.

In layout with broken field

 1. Double-click field. Edit Text dialog will open.
 A. Text being driven by a field has a gray background. Regular text has a white background.
 B. To edit a field, Select field text > Right-click > Edit Field...

 I. Field Category: CurrentSheetSubSet or CurrentSheetSetCustom These are the 2 
categories that populate field values.

 II. Inspect Custom property name: values

 III. OK
 C. OK

 2. OK  Esc

Add WisDOT AutoCAD components

Last updated: 2020-10-26

Total video time: 2:48

pln-prod-basc-add-autocad-cmpnent-01.mp4 2:48

Exercise data: pln-prod-basc-add-autocad-cmpnent-data-c3d18.zip

Custom WisDOT AutoCAD components that assist with plan sheet creation are not contained in the tem-
plate sheet files. This keeps files that do not need them (such as design files) simpler and smaller. These 
custom components can be added to any file. This is helpful for migrating project files from previous ver-
sions to at all current components to it.

WisDOT Sheets tab > Standards Components panel >  Add All Components
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Unused AutoCAD components can be removed from a file with PURGE enter .

Tip: Only unused components are allowed to be purged. Sometimes Purge needs to be done more 
than once.

Xref topography file

Last updated: 2020-10-26

Total video time: 2:25

pln-prod-basc-xref-topo-01.mp4 2:25

Exercise files: pln-prod-basc-xref-topo-data-c3d18.zip

 1. New file >Save Drawing as... > 11701970\Design\ViewFrameGroups\VFG-US51.dwg > Save
 2. WisDOT Sheets tab > Manage panel > Load XREF on layer

 A. <ProjectID >\BaseData\Topo-Ex.dwg >Open
 

This creates an XREF with relative path, overlay, insertion point at 0, 0, 0, and on a custom layer with the 
format XREF-<file name>. These are often best practices for most real world XREFs and the custom layer 
allows for layer control on multiple XREFs.

Data shortcut alignment

Last updated: 2020-10-26

Total video time: 2:04

Exercise files: pln-prod-basc-dref-ali-data-c3d18.zip

Start with 11701970\Design\ViewFrameGroups\VFG-US51.dwg

pln-prod-basc-dref-ali-01.mp4 2:04

Save the file.

Confirm that you are in the correct working folder for Data Shortcuts. It should end in 11701970.

Prospector >Data shortcuts >Alignments >Centerline Alignments >Right-click 51 >Create Reference...

 1. Name: 51
 2. Alignment style: ALI Proposed
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 3. Alignment label set: 1IN 200FT-Ticks 500' Major: 100' Minor
 4. OK

Repeat for the 47 alignment.

 1. Name: 47
 2. Alignment style: ALI Proposed
 3. Alignment label set: 1IN 200FT-Ticks 500' Major: 100' Minor
 4. OK

Tip: Save the file after adding data shortcuts to the active file.

View frames and view frame groups

Last updated: 2020-10-26

Total video time: 12:08

Create single plan view frames and group #create

Exercise files: pln-prod-basc-vu-fram-and-grup-01-data-c3d18.zip

Start with 11701970\Design\ViewFrameGroup\VFG-US51.dwg

pln-prod-basc-vu-fram-and-grup-01.mp4 3:01

Output tab > Plan Production panel > Create View Frames

 1. Alignment
 A. Alignment: 51
 B. Next

 2. Sheets
 A. Sheet Settings: Plan(s) only
 B. Template for Plan sheet: ...

 I.  C:\WisDOT\Stnd\C3D2018\Templates\Sheets\05-PN-wdot18.dwt
 II. Layout: Plan 1 IN 40 FT

 III. OK
 C. Next

 3. View Frame Group
 A. Leave all defaults
 B. Next

 4. Match Lines
 A. Insert match lines: checked
 B. Positioning

 I. Snaps patient value down to the nearest: checked, 1
 II. Allow additional distance for repositioning (increases few overlap): 100'

 C. Create View Frames
Prospector >Data Shortcuts >Right-click >Create Data Shortcuts...

 1. VFG - 51 - (1): checked
 2. OK

Create dual plan view frames and group #create-dual

Exercise files: pln-prod-basc-vu-fram-and-grup-02-data-c3d18.zip

pln-prod-basc-vu-fram-and-grup-02.mp4 2:36
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Output tab > Plan Production panel > Create View Frames

 1. Alignment
 A. Alignment: 51
 B. Next

 2. Sheets
 A. Sheet Settings: Plan(s) only
 B. Template for Plan sheet: ...

 I.  C:\WisDOT\Stnd\C3D2018\Templates\Sheets\05-PN-DUAL-PLN-wdot18.dwt
 II. Layout: Plan Dbl 1 IN 40 FT

 III. OK
 C. Next

 3. View Frame Group
 A. Leave all defaults
 B. Next

 4. Match Lines
 A. Insert match lines: checked
 B. Positioning

 I. Snaps patient value down to the nearest: checked, 1
 II. Allow additional distance for repositioning (increases few overlap): 100'

 C. Create View Frames
Prospector >Data Shortcuts >Right-click >Create Data Shortcuts...

 1. VFG - 51 - (1): checked
 2. OK

Edit view frames

Exercise files: pln-prod-basc-vu-fram-and-grup-03-data-c3d18.zip

pln-prod-basc-vu-fram-and-grup-03.mp4 2:39

Tip: Creating layouts from view frames takes a snapshot from the view frame location. Layouts do 
not have a live link to view frames. Any changes to view frame locations should be done prior to cre-
ating layouts.

View Frame grips

 l Green circle: rotate view frame
 l Blue square: move view frame within the limits of match lines
 l Blue diamond: slide view frame up and down stationing

View Frames are constrained by match lines. Match lines also have grips.
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 l Green circle: rotate match line
 l Blue arrowhead: lengthen/shorten match line
 l Blue diamond: slide match line up and down stationing

Stationing can be entered directly by

Select objects stationing grip >station/offset transparent command > Select alignment>type in sta-
tioning at command line

In example

Station: 52753Enter

Offset: 0Enter

Create additional view frame group

Exercise files: pln-prod-basc-vu-fram-and-grup-04-data-c3d18.zip

Start with 11701970\Design\ViewFrameGroup\VFG-US51-plan overview.dwg

pln-prod-basc-vu-fram-and-grup-04.mp4 3:51

In this example, a different scale of view frames is created for the same alignment and station range in a dif-
ferent view frame file. Different view frame groups can be stored in the same file if desired. Both options are 
accessible. Either way, view frame groups will be accessed from the Prospector > Data Shortcuts inter-
face.

Output tab > Plan Production panel > Create View Frames

 1. Alignment
 A. Alignment: 51
 B. Next

 2. Sheets
 A. Sheet Settings: Plan(s) only
 B. Template for Plan sheet: ...

 I.  C:\WisDOT\Stnd\C3D2018\Templates\Sheets\05-PN-wdot18.dwt
 II. Layout: Plan 1 IN 100 FT

 III. OK
 C. Next

 3. View Frame Group
 A. View Frame Group Name: VFG - <[View Frame Group Alignment Name(CP)]> -pla-

noverview
 B. Next

 4. Match Lines
 A. Insert match lines: checked
 B. Positioning

 I. Snaps patient value down to the nearest: checked, 1
 II. Allow additional distance for repositioning (increases few overlap): 100'

 C. Create View Frames
Prospector >Data Shortcuts >Right-click >Create Data Shortcuts...

 1. VFG - 51 - planoverview: checked
 2. OK

Exercise files: pln-prod-basc-vu-fram-and-grup-05-data-c3d18.zip
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Create sheet files with layouts from view frame groups

Last updated: 2020-10-30

Total video time: 9:59

Add view frame group to file and create sheets

Exercise files: pln-prod-basc-creat-sht-fil-vu-frm-grup-begin-data-c3d18.zip

Start with xxx-begin.dwg

pln-prod-basc-creat-sht-fil-01.mp4 4:47

Prospector >Data Shortcuts >View Frame Groups >Right-click VFG - 51 - (1) >Create Reference...

Leave all defaults

OK

Warning: View frames should not be edited in the files they are referenced into. Civil 3D allows this, 
but these edits are not reflected back in the source file and if the source file is edited, these edits 
would be overwritten. Edits to objects should always be in the source file.

Output tab > Plan Production > Create Sheets

 1. View Frame Group and Layouts
 A. View Frame Group: VFG - 51 - (1)
 B. View frame range: All: checked
 C. Choose View Frames...

 I. Select VF - (1) through VF - (10)
 D. Layout Creation: All layouts in the current drawing checked

Warning: This option should always be used because options that involve new draw-
ings create a layer of XREF that can cause problems.

 E. Layout name: click template button
 I. Name: <[Next Counter]>

 II. Number style: 01, 02, 03...
 III. OK

 F. Next
 2. Sheet Set

 A. Add to existing sheet set: 11701970\SheetsPlan\11701970.dst
 B. Sheet file name: click template button

 I. Name: 0231<[Next Counter]>-pl
 II. Number style: 01, 02, 03...

 III. OK

 C. Create Sheets
 3. OK

Create additional set of sheet files

pln-prod-basc-creat-sht-fil-02.mp4 2:11
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Output tab > Plan Production > Create Sheets

 1. View Frame Group and Layouts
 A. View Frame Group: VFG - 51 - (1)
 B. View frame range: All: checked
 C. Choose View Frames...

 I. Select VF - (11) through VF - (30)
 D. Layout Creation: All layouts in the current drawing checked

Warning: This option should always be used because options that involve new draw-
ings create a layer of XREF that can cause problems.

 E. Layout name: click template button
 I. Name: <[Next Counter]>

 II. Number style: 01, 02, 03...
 III. Starting number: 11 Make sure this is correct.
 IV. OK

 F. Next
 2. Sheet Set

 A. Add to existing sheet set: 11701970\SheetsPlan\11701970.dst
 B. Sheet file name: click template button

 I. Name: 0231<[Next Counter]>-pl
 II. Number style: 01, 02, 03...

 III. Starting number: 11 Make sure this is correct.
 IV. OK

 C. Create Sheets
 3. OK

Modify sheet set to get fields correct in title block #modify

pln-prod-basc-creat-sht-fil-03.mp4 3:01

Layouts have been automatically added to subsets in sheet set manager based on the view frame group 
name. We will create an appropriate subset and move the sheets into that subset to get the title correct in 
the sheet border.

Move sheets to appropriate subset

 1. Sheet set manager > Open... > 11701970.DST
 2. Right-click subset 02- > New Subset...

 A. Subset Name: Planting

 B. OK
 3. Shift-select sheets 1-10
 4. Drag to subset Planting
 5. REAEnter
 6. Titles will refresh on all sheets.
 7. Shift-select sheets 11-30
 8. Drag to subset Planting

Rename sheets

Any sheets can be renamed in sheet set manager at any time with this process.

Right-click sheet > Rename & Renumber... > Number: empty > Next
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Continue for all sheets that need to be renumbered.

pln-prod-basc-creat-sht-fil-vu-frm-grup-end-data-c3d18.zip

Create layout manually

Last updated: 2022-05-12

Total video time: 5:26

Exercise files: pln-prod-basc-creat-sht-fil-mnul-data-c3d18.zip

Start with Permit Area.dwg

pln-prod-basc-creat-sht-fil-mnul-01.mp4 5:26

Add layout to file

 1. WisDOT Sheets tab > Sheet Creation panel > Detail tool palette > 02-Plan Details 1=100 (02-
PD-wdot18)

 2. Layout name: PermitAreaEnter

Set viewport to area of interest

 3. Double-click inside viewport to activate it.
 4. Unlock the viewport to be able to move it to the project area.

 5. Double-click inside the viewport again to resume to the extents of the project.
 6. Zoom into area of interest.
 7. Set scale of viewport to 1 IN:100 FT to make sure scale is exact.
 8. WisDOT [***] tab > View panel > Rotate View

 9. First point: Click origin
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 10. Second point: Click desired positive X axis
 11. Reset scale to 1 IN:100FT
 12. REAEnter to refresh all graphics.
 13. Lock the viewport.

 14. Double-click layout title. Delete field reference. Type "PERMIT AREA" OK

 15. Save the file.

Page setups

Last updated: 2020-10-26

Total video time: 5:43

Add page setup to single layout

Exercise files: pln-prod-basc-pag-setup-data-c3d18.zip

Start with xxx-begin.dwg

pln-prod-basc-pag-setup-01.mp4 3:03

Page setups are a collection of attributes related to plotting for a layout. Page setups can be saved and 
applied to layouts for functionality such as ensuring uniformity or quickly switching to a different plot con-
figuration.

 1. WisDOT Sheets tab > Plot Configuration panel > Page Setups

 2. Page Setups tool palette > PDF-11x17-stnd to add page setup to the file.
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 3. Right-click layout > Page Setup Manager... > Click PDF-11X17-stnd > Set Current

Add page setup to multiple layouts #add

pln-prod-basc-pag-setup-02.mp4 2:40

Page setups are a collection of attributes related to plotting for a layout. Page setups can be saved and 
applied to layouts for functionality such as ensuring uniformity or quickly switching to a different plot con-
figuration.

 1. WisDOT Sheets tab > Plot Configuration panel > Page Setups

 2. Page Setups tool palette > PDF-11x17-stnd to add page setup to the file.
 3. WisDOT Sheets tab > Plot Configuration panel > Multi-PageSetup

 A. May need to click Refresh All to load current file into tool.
 B. Show Modle space in Layouts: unchecked
 C. Select: All
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 D. Apply

Results
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Plotting

Last updated: 2020-10-26

Total video time: 13:27

Single layout plotting

Exercise files: pln-prod-basc-plot-data-c3d18.zip

Start with 023001-up.dwg

pln-prod-basc-plot-01.mp4 4:16

Three different options all give you the same results.

 1. Right-click layout > Plot...
 2. Output tab > Plot panel > Plot
 3. Quick Access toolbar > Plot

Opens up the Plot dialog which has all page setup settings.

 1. Printer/plotter
 2. Paper size
 3. Plot area
 4. Plot scale
 5. Plot style table
 6. Plot options
 7. Preview... to preview plot.
 8. OK to plot.
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Multiple layout plotting in Civil 3D

pln-prod-basc-plot-02.mp4 5:17

This batch plot function allows for

 1. Specifying the order of sheets for plotting
 2. Plotting layouts from multiple DWGs, including ones not currently open.
 3. Working in the background

Tip: This funcitonality is also located in DWG TrueView software. Plotting is often fastest from 
TrueView because it opens files read-only and not for editing. TrueView batch plot

Output tab > Plot panel > Batch Plot

 1. Add/remove sheets
 2. Reorder sheets
 3. Apply page setups that exist in DWGs.
 4. Save/open sheets sets.
 5. Publish
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Multiple layout plotting in sheet set manager

pln-prod-basc-plot-03.mp4 3:53

Home tab > Palettes panel > Sheet set manager or SSM Enter

Open... > 11701970\SheetsPlan\11701970.dst > OK>

Right-click sheet set > Publish... > Publish to Plotter

Right-click sheet set > Publish > Sheet Set PDF Publish Options... is where the folder for resulting file 
will be published to.
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Subsets and single sheets can be multi-selected for plotting.

WisDOT dimensions and multileaders

Last updated: 2020-10-29

Total video time: 9:58

Add dimensions and multileaders

Exercise files: pln-prod-basc-dimnsn-multildr-data-c3d18.zip

Start with xxx-begin.dwg

pln-prod-basc-dimnsn-multildr-01.mp4 4:46

"Add WisDOT AutoCAD components" on page 322

Dimension

 1. WisDOT Sheets > WisDOT Annotation panel > Linear style: 060-LANE & SHLD
 2. WisDOT Sheets > WisDOT Annotation panel > Linear dimension
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 3. Place dimension in paperspace. Size will be correct, but not value. 060-LANE & SHLD 
PAPERSPACE style is built for this.

 4. Double-click viewport to activate modelspace. Value will be correct, but not size.
 5. Switch to modelspace. Dimension will work properly.

Multileader

 1. WisDOT Sheets tab > WisDOT Annotation panel > Multileader style: 060
 2. WisDOT Sheets tab > WisDOT Annotation panel > Mleader

 3. In text editor: BASE AGGREGATE SHOULDER > Click outside editor to finish > F3 to turn off 
snaps > Click to place arrowhead

Dimension and multileader tool palettes

pln-prod-basc-dimnsn-multildr-02.mp4 2:19

 1. WisDOT Sheets tab > Standards components panel > Components palettes dropdown > Dimen-
sions palette

 2. Arrow on dimension tools opens all dimension commands

 3. Dimension Styles tool palette > Linear command (default) 060-LANE & SHLD > Click start > 
Click end > Click dimension label offset
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 4. WisDOT Sheets tab > Standards components panel > Components palettes dropdown > Multi-
leader palette

 5. General tool palette > 060-Text

 6. Click text location
 7. Click arrowhead location
 8. Double-click text to open text editor: BASE AGGREGATE SHOULDER > Click outside editor to 

exit.

Blocks and dimensions in modelspace and paperspace

pln-prod-basc-dimnsn-multildr-03.mp4 2:53
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 l Blocks and dimensions placed in paperspace will only show up in the single layout.
 l Blocks and dimensions placed in modelspace will show up in all viewports with them in their 

extents.
 l Annotative blocks and dimensions placed in modelspace through an active viewport will have the 

wrong scale.

Adding civil object labels

Last updated: 2020-10-26

Total video time: 11:14

Add labels tool, surface example

Exercise files: pln-prod-basc-add-labl-data-c3d18.zip

Start with 01-pln-prod-basc-group-12.dwg

pln-prod-basc-add-labl-01.mp4 4:07

Annotate tab > Labels & tables panel > Add labels drop-down
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Starting a label command here will allow you to change the style before placing the label.

Warning: If you start a label with the image on the panel instead of the drop-down by the text, only 
the default style will be available.
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Civil 3D object labels are dynamic to the object. Here is an example of a spot elevation label on a surface.

Labels can also be placed by first selecting the object and then using the contextual ribbon commands. 
Here is an example of the surface contextual ribbon. Only surface-type labels are available.
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The same dialog box will appear through this method.

Profile label examples

pln-prod-basc-add-labl-02.mp4 2:06

 1. Click profile view > contextual ribbon > Labels panel
 2. Click profile > contextual ribbon > Labels panel 

Both access profile labels

Edit Profile Labels > Import label set... > WisDOT Standard > OK
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Cancel

Add View Labels > Depth > Select profile view > Pick first point > pick second point

Add View Labels > Station Offest > Select profile view > Specify station > Specify elevation

To change label style

Click label > Right-click > Label Properties... > Profile Station Elevation style > WisDOT Standard
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Parcel label examples

pln-prod-basc-add-labl-03.mp4 2:29

Annotate tab > Labels panel > Add labels text > Figure > Add Figure Labels

Feature: Survey Figure

Label type: Single Segment

Line label style: UG Gas Line (3D Survey)

Add

Annotate tab > Labels panel > Add labels text > Figure > Add Figure Labels

Feature: Survey Figure

Label type: Single Segment

Line label style: Basic
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Add

Line, curve and note label examples

pln-prod-basc-add-labl-04.mp4 2:32

Line, curve and note labels do not require Civil 3D objects.

Annotate tab > Labels panel > Add labels text > Line and Curve > Add Line and Curve Labels

Feature: Line and Curve

Label type: Single Segment

Line label style: Bearing Distance

Add

Click polyline

Annotate tab > Labels panel > Add labels text > Note > Add Note Label

Feature: Note

Label type: Note

Note label style: N E

Marker style: Basic

Add

Click modelspace

Adding civil object tables

Last updated: 2020-10-26

Total video time: 6:38

Point table example

Exercise files: pln-prod-basc-add-tabl-data-c3d18.zip

Start with 01-pln-prod-basc-group-12.dwg

pln-prod-basc-add-tabl-01.mp4 3:26

Need to first create labels for objects to populate tables.

Labels are then turned into tags to populate table rows.

Annotate tab > Labels & Tables panel > Add Point Table
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Table style: RW Points Y X Z

Points can be selected by:

 1. Active style
 2. Point group
 3. Graphically in modelspace

All tables have split logic and reactivity behavior.
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Alignment table example

pln-prod-basc-add-tabl-02.mp4 3:12

Annotate tab > Labels & Tables panel > Add Labels > Alignment > Add Alignment Labels

Add labels

Feature: Alignment

Label type: Multiple Segment

Line label style: Bearing Distance

Curve label style: PI ^ D T L R PC PT

Ok
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Annotate tab > Labels & Tables panel > Add Tables > Alignment > Add Segment

Table style: Standard

By alignment: CthE

OK

Tables can be sorted by editing the style and selecting a sorting column.
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Inserting blocks

Last updated: 2020-10-26

Total video time: 10:33

Blocks from tool palettes and design center

Exercise files: pln-prod-basc-insrt-blk-data-c3d18.zip

Start with 05001-tc.dwg

pln-prod-basc-insrt-blk-01.mp4 3:53

Many WisDOT blocks are available from tool palettes.

WisDOT Sheets tab > Sheet Creation Components > Signs > M-signs > M1-4
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All blocks are available through DesignCenter.

WisDOT Tools tab > Standards Components > Open Design Center or Home tab > Palettes > Design 
Center

Design Center allows you to browse files for blocks and other AutoCAD components.

C:\WisDOT\Stnd\C3D2018\Components\Blocks\MarkingSigning18.dwg\Blocks

Blocks can be dragged and dropped from Design Center into modelspace or paperspace.

Dynamic blocks, grips and fields

pln-prod-basc-insrt-blk-02.mp4 2:59

Dynamic blocks have multiple grips that do different things.
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Some blocks also have text attributes that can be changed.

Info: Grey in Value means that the text is coming from a field and cannot be edited here.

Blocks in modelspace and paperspace

pln-prod-basc-insrt-blk-03.mp4 3:40

Blocks in paperspace

 1. Will only show up in one layout.
 2. Will align with top of layout with no rotation.

Blocks in modelspace
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 1. Will show up all layouts.
 2. Will align with positive Y-axis with no rotation.

Some blocks are scaled for modelspace, paperspace, or both. If a block does not work in one, you may 
need to place it in the other space or scale it.
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Data exchange

Export DWG to DGN workflow using Civil 3D
Last updated: 2020-10-26

Overview

This is a workflow to translate a Civil 3D DWG format file to a MicroStation DGN format file. The workflow is 
Civil 3D based and the final deliverable is a DGN file.

Export Civil 3D DWG to MicroStation DGN

 1. Open the target DWG to export.
 2. C3D Application Menu > Export > Export Civil 3D Drawing or EXPORTC3DDRAWING at the com-

mand line.
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 3. The Export Autodesk Civil 3D Drawing dialog box will appear. Use the following settings:
 A. Export to file type: MicroStation DGN
 B. External DWG references: Bind and Insert
 C. Files to Export: Current drawing on

 4. Destination Folder: Click ... to choose the save location of the DGN.
 5. OPTIONAL: Enter a Destination file name prefix or Destination file name suffix to the exported DGN 

filenames.
 6. OPTIONAL: Checkmark: Include sheets (To also export layout sheets.)
 7. In the Files to Export column, check or uncheck the files to be exported.

Page: 355

Published on: 5/1/2024

Export DWG to DGN workflow using Civil 3D



 8. Export Settings....

 9. In the Export Settings dialog box set the following:
 A. Export file type: MicroStation DGN

 B. DGN file version: V8
 C. Conversion units: Master
 D. ... to select the Seed file: C:\WisDOT\Stnd\C3D20xx\Templates\Conversion\wisdot-

seed3d.dgn
 E. Mapping setup: WisDOT DWG-DGN EXPORT
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 F. OK.

 11. In the Export Autodesk Civil 3D Drawing dialog box Export . 

 12. The Export Status progress dialog will appear. Wait for the DGN(s) to be created. The export pro-
cess may take some time to complete.
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Warning: The Export to MicroStation DGN process doesn't always complete successfully. It will 
sometimes fail, hang, or crash Civil 3D without warning. If this happens contact sup-
port.cae@dot.wi.gov for troubleshooting help.

 13. When the button is no longer grayed out, click OK to dismiss the Export Status progress dialog.
 14. Click the exit button (X) to close the Export Autodesk Civil 3D Drawing dialog box.
 15. Individual DGN files will be exported to the folder specified, one DGN for model space and one DGN 

for each individual layout (if layouts are selected).

Translate DGN to DWG workflow using Civil 3D 2016
Last updated: 2020-10-26

Translate DGN to DWG workflow using Civil 3D 2016

This workflow document will outline the steps involved to translate a MicroStation DGN file to AutoCAD 
2016 DWG file format. The workflow will be Civil 3D based and the final deliverable will be the DWG file.

Warning: The DGN import and export capabilities are designed to provide a fundamental exchange 
of information between MicroStation V8 DGN files and AutoCAD DWG files. However, translating 
data from one format to a completely different format has inherit compromises and substitutions.

Simple elements: Simple geometric objects such as lines, arcs, and circles, and properties such as layer 
assignments correlate directly between the DWG and DGN data formats.

Elements with custom properties: Data with built-in features or variations are visually approximated. For 
example, text and dimensions might have specialized formatting, and color definitions might be cus-
tomized.

Product-specific features: Some data cannot be translated completely. For example, product-specific fea-
tures such as data fields or dynamic blocks can be represented visually but not behaviorally.

No symbol color: AutoCAD only supports colors for lines so all entities in the DGN file that have a color 
property set for a symbol in MicroStation lose the symbol color when imported as a block.

Multilines do not retain linetypes: When importing DGN files that contain multilines, any linetypes asso-
ciated with the multilines do not display.

Closed property of polyline not retained: The closed property of a DGN polygon or closed polyline is auto-
matically set to No when imporproting a DGN file into AutoCAD. This is done to ensure that linetypes dis-
play properly.

Import to AutoCAD

 1. In AutoCAD Civil 3D create a New drawing.
 2. From the Application Menu Button select Open > DGN. The Import DGN File dialog will appear. 

Command: DGNIMPORT
 3. Select the file you want to convert and then select Open. The DGN Import Settings dialog will 

appear.
 4. Check ON Import into current drawing and select Ignore duplicate names radio button.
 5. In the External DGN references section of the dialog select the radio button Translate references to 

blocks or xrefs.
 6. In the Specify DGN units to convert to DWG units select the Master units radio button.
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Info: 
In the Import DGN Settings dialog box, if you select "Import into Current Drawing" and select the 
"Translate References to Blocks or Xrefs" option in the External DGN references section, all ref-
erenced DGN files are converted to block references. If you do not select "Import into Current Draw-
ing" and select the "Translate References to Blocks or Xrefs" option, then all referenced DGN files 
are converted to DWG external references.

If you are importing a V7 DGN file that MicroStation V7 DGN file does not have ByLayer setting for 
color. The user may want to use the Standard DGN mapping rather than the WisDOT one to pre-
serve colors.

 7. Click the WisDOT DGN-DWG IMPORT as the setup.
 8. Click the OK button. The Import DGN dialog will close and the file will be imported.
 9. Zoom extents the drawing and Select All the elements.

 10.  Properties dialog
 l Color = ByLayer
 l Linetype = ByLayer
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 l Lineweight = ByLayer

Verify the imported drawing

 1. In AutoCAD Civil 3D go to the Ribbon and the View tab > Coordinates panel select World icon.

Info: 
World aligns the UCS with the world coordinate system (WCS). You can also click the UCS icon 
and choose World from the origin grip menu.From the pull down menu View > 3D Views > Plan 
View > World UCS
Command: PLAN [W]Enter

Plan view set to World displays an orthographic view of the XY plane of a specified user coordinate 
system.

 2. Locate a known coordinate location in the file and verify the coordinates out to 3 decimal points.
 3. Save drawing and then Exit AutoCAD Civil 3D.

Importing PDF and XLS files
Last updated: 2012-01-10

Total video time: 2:05

Importing PDF and XLS files

data-xchng-imprt-pdf-xls-01.mp4 2:05

Insert (PDF) and Paste (XLS)
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Non-Survey base data

Working with spatially referenced DWG, image, and GIS files
Last updated: 2024-03-19

Info: 
The WisDOT coordinate projection zone category which was in use through Civil 3D 2016 and 2018 
has been retired and is no longer needed in Civil 3D 2020 and beyond.

Coordinate systems in Civil 3D should only be applied when a projection transformation is needed.

Projections for Civil 3D 2020 and beyond should be selected from the Zone Category: USA, Wis-
consin. WISCRS projections begin with NSRS2011 Wisconsin County CRS

Projections for Civil 3D 2016 and 2018 should be selected from the Zone Category: WisDOT.

Warning: 
Data connected to through the Map Workspace is not available in applications that do not use Map 
3D.

Such applications include

 l DWG TrueView
 l Publish Collections Manager

Plotting solutions with Map Workspace data need to be in active session with Civil 3D.

Assign coordinate system to active DWG and any DWG files to be attached

 1. Application Menu > Drawing Utilities > Drawing Settings.
 o Drawing Settings dialog box > Units and Zone tab.

 n In the zone area at the bottom of the tab, change the category to "USA, Wisconsin".
 n Change the available coordinate system to the one desired. Make sure that the units 

are set correctly.
 n OK

If other DWG files are to be georeferenced, repeat this process for all DWG used to be used.

Open the map task pane or Mapconnect

There are two options for connecting to spatial data

 1.  MAPWSPACE Enter.  Enter at the next prompt to set the task pane on. The Task Pane should be vis-
ible. This method is necessary for attachng to a spatially-referenced DWG.

 2. MAPCONNECT Enter If using this method, go directly to "How to use a data connection #connection" 
on the next page

The rest of the commands can all be found in the same area, but have slightly different options depending 
on what type of file is being attached.

Attach DWG

 1. Map Task Pane > Display Manager tab > Data button > Add Drawing Data > Attach Source 
Drawings

 o This will open the Define/Modify Drawing Set dialog box.
 o Click Attach... This will open the Select Drawings to Attach dialog box.
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 o The first time this dialog is used, an alias will need to be set for any drives other than the C 
drive.

Set N drive as an alias

 1. Select Drawings to Attach dialog box > Create/Edit Aliases  
 o It can be found two buttons to the right of the drive letter dropdown. This will open the Drive 

Alias Administration dialog box.
 o For Drive Alias Details Drive Alias: N
 o Actual Path: \\wis31fp1\n3public (This is an example in drive for the Wisconsin Rapids 

office. A user's individual in drive can be found by looking at the path after the N drive in My 
Computer in Windows Explorer.)

 2. Click Add. The alias letter and path should appear in the Drive List window. Click Close.
 3. Select the alias letter where the DWGs are in the Look in: window.
 4. Navigate to the folder with the DWGs. Highlight the files to attach. Click Add.
 5. When all of the DWGs have been selected, click OK. This will return the user to the Defined/Modify 

Drawing Set dialog box.
 6. Click on the drawings to be attached, or click Select All. Click OK.
 7. The files may not display immediately. If this occurs, in the Task Pane, click the Map Explorer tab. 

The attached files should show up under Drawings. Right-click on the file name and click "Quick 
View" to view the file.

How to use a data connection #connection

All types of data connections work in a similar manner. The following instructions will use a shape file for an 
example. Data connections to local files can either be at the folder level or at the file level. A folder full of 
shape files can be managed through one data connection.

 1. Click Add SHP Connection.
 o Connection name: Set this to something meaningful. "Dane County Tax Parcels" for 

instance.
 o Source file or folder: Click either the Open File or Browse Folder buttons to navigate to the 

correct location. This field will then fill in with the correct information.
 o When the source is populated, the Connect button will be enabled. Click Connect . This will 

open the AddDatatoMap dialog.
The available files will display in a window. If Civil 3D can read the files projection information, it will show 
up here under Coordinate System. If a coordinate system is not found,<unknown > will be displayed.

 2. To set the coordinate systems for files, click on the file to set under Schema, then click the Edit 
Coordinate Systems button. This will open the Edit Spatial Contexts dialog box.

 o Click on the files to set the coordinate system for and click Edit.... This will open the Coordin-
ate System Library dialog box.

 n In the Category: window, select the appropriate category of coordinate systems. 
This should always be the WisDOT category.

 n In the Unit: window, select the appropriate unit. For example, US Survey Foot.
 n In the main window, click the coordinate system to be assigned to the referenced file.
 n Click Select. This will bring back the Edit Spatial Contexts dialogbox.

 o Click OK. This will bring back the AddDatatoMap dialog. The correct coordinates system 
should show up in the main window.

 o Click Add to Map. The contents of the file should show up in model space and also show up 
in the Task Pane. Raster images will also show up in the AutoCAD reference dialog.

Working with GIS data
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This section will not attempt to go into all of the different options available to work with GIS data in Civil 3D.

 l In Task Pane > Display Manager, right-click on any data layer to see all of the possible options 
associated with it.  From this right-click menu, data display, selection, labeling, data table viewing, 
and other options can be accessed.
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